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Dorico 6.1 

26 September 2025 

Highlights 

Automatic playback template 
As further new sound content is added to Dorico, the number of factory playback 

templates needed to accommodate various combinations of content has continued 

to grow to the point that it is often difficult to determine which playback template 

you should choose. To make this simpler, Dorico 6.1 introduces a new automatic 

playback template, which uses all the factory content installed on the system, 

following a recommended priority such that each instrument you add to your 

project uses the best available sound. 

When you first run Dorico 6.1, if the Default playback template setting on the Play 

page of Preferences is set to use one of the existing factory playback templates, you 

will be asked during start-up whether you want to switch to using the new 

automatic playback template. If you click Use Auto Playback Template, Dorico will 

adjust the Default playback template setting for you. If you are using another 

playback template by default – for example, NotePerformer or another third-party 

sound library – Dorico will not prompt you to use the new automatic playback 

template by default. You can make this change yourself on the Play page of 

Preferences. 

To apply the automatic playback template to an existing project, choose Play ▶ 

Playback Template, choose Auto, and click Apply and Close. 

You will notice that by default most of the factory playback templates you will be 

familiar with from previous versions are no longer listed: you can show them by 

clicking the Show All Factory button in the action bar in the Apply Playback 

Template dialog. 

As further sound content is added in future versions of Dorico, or if you choose to 

install existing content that you had previously chosen not to install, the automatic 

playback template will be updated to make optimal use of it. 

To see which content sets are currently used in the automatic playback template on 

your system, or to change the relative priority of those content sets (which 

influences how Dorico assigns sounds to instruments), select Auto from the list in 

the Apply Playback Template dialog, and click the Edit button. 

Condensing 
Rests on condensed staves. It is now possible to set certain properties on rests in 

condensed staves. Until now, it has been impossible to influence the appearance 



도리코 6.1 

2025년 9월 26일 

하이라이트 

자동재생템플릿 

도리코에 새로운 사운드 콘텐츠가 추가되면서 다양한 조합의 콘텐츠를 수용하기 위해 필요한 공 

장 재생 템플릿의 수가 계속 증가하여 어 떤 재생 템플릿을 선택해야 할지 결정하기 어 려운 경우 

가 많습니다 이를 더 간단하게 만들기 위해 Dorico 6.1 은 시스템에 설치된 모든 공장콘텐츠를 

사용하는 새로운 자동 재생 템플릿을 도입하여 프로젝트에 추가하는 각 악기가 사용 가능한 최상 

의 사운드를 사용하도록 권장 우선 순위에 따라 사용합니 다. 

처음 도리코 6. 1 을 실행할 때, 기본 설정의 플레이페이지의 기본 재생 템플릿 설정이 기존 공장 

재생 템플릿 증 하나를 사용하도록 설정되어 있으면, 시작 중에 새로운 자동 재생 템플릿 사용으 

로 전환할 것인지 여부를 질문받게 됩니다. 자동 재생 템플릿 사용을 클릭하면 도리코가 기본 재 

생 템플릿 설정을 조정합니 다 다른 재생 템플릿을 기본적으로 사용하는 경우(예: 

NotePerformer 또는 다른 타사 사운드 라이브러 리) 도리코는 기본적으로 새 자동 재생 템플릿 

을 사용하도록 표시하지 않습니다. 이 변경은 선호도 재생 페이지에서 직접 할 수 있습니다. 

자동 재생 템플릿을 기존 프로젝트에 적용하려면 재생 ► 재생 템플릿을 선택하고 자동 

을 선택한 다음 신청 및 닫기를 클릭합니다. 

기본적으로 이전 버전에서 익숙할 대부분의 공장 재생 템플릿이 더 이상 나열되지 않음을 

알 수 있습니댜 재생 템플릿 신청 대화의 액션 바에서 전체 공장 표시 버튼을 클릭하여 표시 

할수있습니다. 

도리코의 향후 버전에 추가사운드 콘텐츠가추가되거나 기존에 설치하지 않기로 결정한 기존 콘 

텐츠를 설치하기로 선택하면 자동 재생 템플릿이 업데이트되어 최적으로 사용할 수 있습니다. 

현재 시스템의 자동 재생 템플릿에서 사용되는 콘텐츠 세트를 확인하거나 해당 콘텐츠 세트의 상 

대적 우선 순위를 변경하려면(도리코가 악기에 소리를 할당하는 방식에 영향을 미칩니다), 재생 

템플릿 적용 대화의 목록에서 자동을 선택하고 편집 버튼을 클릭합니다. 

응축 

응축된 오선지 위에 받침대를 놓습니다. 이제 응축된 오선지에서 받침대에 특정 속성을 설정하는 

것이 가능합니다. 지금까지는 외관에 영향을 미치는 것이 불가능했습니다. 

도리코 6판역사 
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and position of rests in condensed music, but this limitation has now largely been 

addressed – though there are some things to watch out for. 

By default, rests in Dorico are implicit: they are created automatically by the 

software to fill in the gaps between notes. Rests only exist as real items – known as 

explicit rests – once you edit them, for example when you set properties to change 

their staff position, or force their duration. When you edit a rest in a condensed 

staff, that rest becomes explicit, and it is will affect the notation of the instrument to 

which it belongs. 

When you, say, set the Rest pos. property on a condensed rest to adjust its vertical 

position, the property value itself will apply only to the condensed staff, as you 

would expect, but in order for that property to be saved, the rest needs to be made 

explicit, and it has to be stored in the musical data belonging to the instrument. 

Normally this will create no problems: in most cases, the rest that you see in the 

condensed music corresponds exactly to an existing implicit or explicit rest in one 

or more of the source instruments whose music is notated on the condensed staff: 

the rest in the source instrument has the same duration, so adjusting its position 

has no visible effect on the uncondensed music, which appears in the part layout, or 

in the full score when condensing is disabled. 

However, in some circumstances, the rest that appears in the condensed staff may 

not match an existing implicit or explicit rest in the uncondensed source material. 

If you adjust the vertical position of such a rest, it becomes explicit, and will now 

appear in the uncondensed source music with that duration – though the 

adjustment to its vertical position will only take effect in the condensed music. 

Instrument change warnings and labels. It is now possible to interact with instrument 

change warnings and labels on condensed staves, in the same way as for 

instrument changes on regular, uncondensed staves. 

Etude Elements 
Now included at no extra charge to Dorico Pro 6 and Dorico Elements 6 users, Etude 

Elements is an entry-level version of Etude, Steinberg’s deeply-sampled Yamaha 

C3X grand piano library for HALion and HALion Sonic. Carefully reduced in scope 

from the full 18GB Etude library, Etude Elements provides a beautiful and 

expressive set of grand piano patches that provide a significant increase in sound 

quality and timbre over the standard Yamaha S90 Piano patch used by default in 

previous versions of Dorico. 

If you are using the new automatic playback template, Dorico will use the Concert 

Grand Elements patch from Etude Elements for piano instruments in newly-

created projects. To use Etude Elements in an existing project, either apply the 



응축된 음악에서 휴식을 취하는 위치와 이 한계는 이제 대부분 해결되었습니다. 주의해야 할 

점이 있지만요. 

기본적으로 도리코의 휴식은 앙시적입니다. 매모 사이의 공백을 채우기 위해 소프트웨어에 의해 

자동으로 생성됩니다. 휴식은 실제 항목으로만 존재합니다. 명시적 휴식으로 알려져 있습니다. 예 

를 들어, 사용자가 직원 위치를 변경하거나 지속 시간을 강제할 때와 같이 편집하면 휴식이 명시 

적이 되며, 이는 속한 악기의 표기법에 영향을 미칩니다. 

예를 들어, 압축된 받침대에 Rest pos 속성을 설정하여 수직 위치를 조정할 때, 속성 가치 자체 

는 예상대로 압축된 스태프에게만 적용됩니다. 그러나 그 속성을 저장하기 위해서는 나머지 부 

분이 명시되어야 하며, 악기에 속한음악 데이터에 저장되어야 합니다. 

일반적으로 이것은 문재를 일으키지 않습니다. 대부분의 경우에는 나머지에서 볼 수 있는 것들입니다. 

응축된 음악은 기존의 암묵적이거나 명시적인 휴식과 정확히 일치합니다. 

음악이 압축된 오선보에 기보된 소스 악기 증 하나 이상: 

소스 악기의 나머지 부분은 동일한 지속 시간을 가지므로 위치를 조정하는 것은 부분 레이아웃이 

나 전체 악보에 나타나는 비응축 음악에 가시적인 영향을 미치지 않습니다. 

그러나 어떤 상황에서는 응축된 스태프에 나타나는 나머지가 비응축된 소스 자료의 기존 암묵적 

또는 명시적 나머지와 일치하지 않을 수 있습니다. 

그러한 휴지의 수직 위치를 조정하면 명시적이 되며, 수직 위치에 대한 조정은 응축된 음악 

에서만 효과가 있지만 해당 기간 동안 비응축 소스 음악에 나타납니다. 

악기 변경 경고 및 라벨. 이제 일반, 비축약된 스테이브의 악기 변경과 동일하게 응축된 스테이브의 

악기 변경 경고 및 라벨과 상호 작용할 수 있습니다. 

에뛰드요소 

이제 도리코 프로 6와 도리코 엘리먼트 6 사용자에게 추가 요금이 부과되지 않는 에뛰드 엘리먼 

트는 에뛰드의 보급형 버전으로, 스타인버그의 HALION과 HALION 소닉을 위한 야마하 C3X 그 

랜드 피아노 라이브러리입니다. 전체 18GB 에뛰드 라이브러리에서 범위률 조심스럽게 줄인 에 

뛰드 엘리먼트는 이전 버전의 도리코에서 기본적으로 사용되었던 표준 야마하 S90 피아노 패치 

보다 음질과 음색을 크게 향상시키는 아름답고 표현력 있는 그랜드 피아노 패치 세트를 제공합니 

댜 

새로운 자동 재생 템플릿을 사용하는 경우, 도리코는 새로 만들어진 프로젝트에서 피아노 악기 

률 위해 에뛰드 엘리먼트의 콘서트 그랜드 엘리먼트 패치를 사용할 것입니다. 기존 프로젝트에 

서 에뛰드 요소률 사용하려면 다음을 적용하십시오. 
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automatic playback template, or manually load one of the Etude Elements patches 

into HALion Sonic in Play mode. 

Proofreading 
Instrument ranges. A new category of issue has been added to the Proofreading panel: 

Instrument ranges. When this category is enabled, Dorico will identify notes in any 

instrument that are outside its standard and advanced ranges: these are the notes 

that are colored bright or dark red if View ▶ Note and Rest Colors ▶ Notes Out of 

Range is activated. However, proofreading also checks for some additional special 

cases: 

§ For flute, the B below middle C (B3) will show a warning: not all flutes have a 

foot key that enables them to play this pitch. 

§ For tenor trombone: 

o the pitches C2 to Eb2 require the instrument to have an F 

attachment, otherwise they can only be played as false tones. This is 

possible, but not particularly easy, and the stability and tuning of the 

notes will be poor. (An F attachment is common on classical 

instruments, but less so on jazz instruments.) 

o Dorico will warn that the pitch B2 is not playable at all unless the 

instrument has an F attachment. 

o Dorico will warn that the pitches E1 to Bb2 are only playable as pedal 

notes. Similar to the false tones, this is possible, but not particularly 

easy, also affecting the stability, tuning and tone of the notes. 

§ For harp: 

o Dorico will warn about notes that contradict the prevailing pedal 

settings. These notes are not technically out of range, but are 

nevertheless also shown in the score in bright red if Notes Out of 

Range is enabled. 

o Dorico will warn if a very low B is written. The three possible notes 

when written for the very lowest string can only be C flat, C natural 

or C sharp. Enharmonic equivalents are not possible. 

o Dorico will warn if conflicting pitches on the bottom two lowest 

strings (C and D) or the highest string (G) are found. Unlike all the 

other strings on the instrument, these strings are not attached to 

pedals, so cannot be easily retuned. They are tunable, but only using 

a tuning key. 

§ For organ, Dorico will warn if a note has been written above the written G 

below middle C, for the pedals only. 

Dorico also considers the notes described by trills, and will warn if a trill will result 

in out of range notes. Dorico also checks whether trills are playable on flute, 



자동 재생 템플릿 또는 플레이 모드에서 에뛰드 요소 패치 중 하나를 할리온 소닉에 수동으로 

로드합니다. 

검침 

기기 범위. 프루프 리딩 패널에 새로운 범주의 문제가 추가되었습니다. 

악기 범위입니다 이 범주가 활성화되면 도리코는 표준 및 고급 범위를 벗어난 모든 악기의 음을 

식별합니댜 이음은 ► 노트보기 및 범위를벗어난노트► 색상이 활성화되면 밝거나짙은빨간 

색으로 표시되는 음입니다 그러나 교정은 또한 몇 가지 추가적인 특별한 경우를 확인합니다. 

§ 플루트의 경우, 중간 C 아래의 8(83)에 경고가 표시됩니다: 모든 플루트에 이 음정을 
연주할수 있는 풋 키가 있는 것은 아닙니다. 

§ 테너 트롬본의 경우: 

오 C2에서 Eb2의 음정은 악기가 F를 가져야 합니댜 

첨부 파일, 그렇지 않으면 그것들은 거짓 음으로만 연주될 수 있습니다. 이것은 

가능하지만 특별히 쉬운 일은 아니며, 음의 안정성과 튜닝이 좋지 않을 것입니 

댜 (F 애착은 클래식 악기에서는 일반적이지만 재즈 악기에서는 그렇지 않습니 

다.) 

오 도리코는 악기에 F 부착물이 없는 한 음정 82는 전혀 연주할 수 없다고 경 
고할것입니다 

오 도리코는 음정 E1 에서 8b2는 페달 음으로만 연주할수 있다고 경고할 것입니 

다 거짓 음색과 유사하게, 이것은 가능하지만 특히 쉽지는 않으며, 음의 안정 

성, 조율 및 톤에도 영향을 미칩니다. 

하프를 위한§: 

오 도리코는 기존의 페달 설정과 모순되는 매모에 대해 경고할 것입니다. 이 음 

들은 엄밀히 말하면 범위를 벗어난 것은 아니지만, 범위를 벗어난 음들이 활 

성화되면 악보에 밝은 빨간색으로 표시됩니다. 

오 만약 B가 매우 낮게 나오면 도리코가 경고할 것입 니 다. 가장 낮은 줄에 대해 

쓰여질 때 세 가지 가능한 음은 C플랫, C내추럴 또는 C샤프일 수밖에 없습니 

다 고조파 등가물은 불가능합니 다 

오 도리코는 가장 낮은 두 줄(C와 D) 또는 가장 높은 줄(G)에서 상충되는 음정이 

발견되면 경고할 것입니다. 악기의 다른 모든 현과 달리 이 현은 페달에 부착되 

어 있지 않기 때문에 쉽게 조정할수 없습니다. 튜닝이 가능하지만튜닝 키만사 

용합니다 

§ 오르간의 경우, 도리코는 페달에만 해당하는 증간 C 아래에 음이 쓰여 있는 경우 경 
고할 것입니다. 

도리코는또한트릴로 설명된 음을 고려하며, 트릴이 음 범위를 벗어나게 되면 경고할 것입니 

댜 도리코는 또한 플루트에서 트릴을 연주할 수 있는지 확인합니다. 

도리코 6판역사 
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recorder, oboe, saxophone, bassoon, and trumpet, and will warn about any 

problematic cases; where good information was readily available about difficulties 

with two-note tremolos, Dorico will similarly warn about them. 

Repeat structures. Dorico's checks for invalid or ambiguous repeat structures has been 

significantly expanded, and now checks for the following: 

§ Duplicate markers of the same appearance. For example, if two or more 

segno markers with the same appearance (i.e. with the same marker index) 

are present in the same flow, either at the same or different rhythmic 

positions. 

§ Repeat markers in a dubious order. For example, if there are two segno 

markers, one would expect the first marker (i.e. the one with a marker index 

of 1) to occur before the second segno (i.e. the one with a marker index of 2). 

If their relative order is the wrong way round, Dorico will flag this. 

§ Missing associated jump repeat markers. For example, a segno marker is 

present in the flow, but an associated D.S. marker is nowhere to be found. 

§ Missing “intermediate” repeat markers. For example, if a coda is specified, 

but there is no marking that specifies where the jump to the coda should 

occur. 

§ Missing associated section repeat markers. For example, a D.S. marker is 

present in the flow, but an associated segno marker is nowhere to be found. 

§ Missing “until” (or “al”) markers. For example, if D.C. al coda is present but 

there is no associated coda, Dorico will flag this. 

Dorico will also report the following issues: 

§ Repeat markers that don’t coincide with a barline. 

§ Passages that will never be played. (For example, if you position “D.S.” before 

a segno marker, Dorico will jump forwards, skipping any bars in between.) 

§ Any end repeat barlines that are missing from all but the last section of any 

repeat ending structure. 

§ Any end repeat barline that is present within the final section of any repeat 

ending structure (as this results in an infinite repeat), unless it is also 

preceded by a start repeat barline within the same final repeat ending 

section. 

§ Any start repeat barlines that are missing an associated end repeat barline. 

§ Rhythmically-mismatched repeat barlines. (For example, if your score is in 

4/4 and starts with a crotchet up-beat, placing an end repeat barline such 

that it naturally coincides with a barline would cause an additional, 

unexpected beat to be played when the player goes back to the start. It’s 

more likely that a start repeat barline should be placed on the barline 



녹음기, 오보에, 색소폰, 바순, 트럼펫이 있으며, 문제가 되는 경우에 대해 경고합니다. 2음 트레 

몰로의 어 려움에 대한 좋은 정보를 쉽게 얻을 수 있었던 경우, 도리코도 마찬가지로 경고할 것 

입니다 

반복 구조. 도리코의 유효하지 않거나 모호한 반복 구조에 대한 검사가 크게 확장되었으며 이제 다 

음을 확인합니다. 

§ 
동일한 외관의 중복 마커. 예를 들어, 동일한 외관을 가진 두 개 이상의 세뇨 마커(측, 

동일한 마커 인덱스)가 동일한 흐름에 존재하는 경우 동일하거나 다른 리듬 위치에 있 

습니댜 

§ 의심스러운 순서로 마커를 반복합니다 예를 들어, 두 개의 세뇨 마커가 있는 경우 첫 
번째 마커(즉 마커 지수가 1 인 것)가 두 번째 세뇨보다 먼저 발생할 것으로 예상할 수 

있습니다 

만약 그들의 상대적인 순서가 잘못된 방향이라면, 도리코는 이것율 표시할 것입니다. 

§ 

§ 

관련 점프 반복 마커가 누락되었습니다. 예를 들어, 흐름에는 세뇨 마커가 있지만 관 

련 D.S 마커는 어디에도 없습니다. 
"중간’’ 반복 마커가 누락되었습니다. 예를 들어, 코다가 지정되었지만 코다로의 점프 

가 발생해야 하는 위치를 지정하는 표시가 없는 경우입니다. 

§ 관련 섹션 반복 마커가 누락되었습니다 예를 들어, D.S. 마커가 흐름에 존재하지만 관 
련 세뇨 마커는 어디에서도 찾을 수 없습니다. 

§ '＇까지”(또는 "al") 마커가 누락됩니다 예를 들어, DC a| 코다가 존재하지만 관련 코 
다가 없는 경우 도리코가 이를 표시합니다. 

도리코는 또한 다음과 같은 문제를 보고할 것입니다. 

§ 기준선과 일치하지 않는 마커를 반복합니다. 

§ 절대 연주되지 않을 통로들입니다 (예를 들어, 만약 당신이 "D. S.”를 세뇨 마커 앞에 놓 
으면, 도리코는 그 사이의 막대를 건너뛰면서 앞으로 점프할 것입니다.) 

§ 모든 반복 끝 부분에서 누락된 반복 바라인이 있습니다 

§ 동일한 최종 반복 종료 섹션 내에 시작 반복 표시선이 선행되지 않는 한, 모든 반복 종 

료 구조의 마지막 섹션 내에 존재하는 모든 끝 반복 표시선(이로 인해 무한 반복이 발생 

합니다). 

§ 관련된 종료 반복 표시줄이 없는 모든 시작 반복 표시줄입니다. 

§ 리듬이 맞지 않는 반복 표시줄입 니 다. 예를 들어, 점수가 4/4이고 크로셰 업 비트로 시 

작하는 경우, 끝 반복 바라인을 배치하여 자연스럽게 바라인과 일치하도록 하면 플레이 

어가 다시 시작할 때 예상치 못한 추가 비트가 재생됩니다. 시작 반복 표시줄이 표시줄 

위에 설치될 가능성이 더 높습니다. 

도리코 6판역사 
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following the upbeat, or the end repeat barline should have been created 

one beat earlier.) 

Category filter. A new Categories section has been added to the Proofreading page of 

Preferences, allowing you to specify which categories of proofreading results 

should be shown by default in the Proofreading panel when starting a new project, 

or opening a project last saved in Dorico 6.0 or earlier. Once you save your project in 

Dorico 6.1, the current state of the Categories filter in the panel will take 

precedence over the initial defaults specified in Preferences, so your choice of 

which issue categories to show is persisted in the project and will be restored when 

you next open it. 

Improvements 

Arpeggio signs 
Minimum length for slash voices. On the Arpeggio Signs page of Library ▶ Engraving 

Options, it is possible to specify whether arpeggio signs should appear on slash 

voices. A new Minimum length option has been added to the Rhythmic Slashes 

section, allowing you to specify the minimum length in spaces of the arpeggio sign. 

By default in new projects this is set to three spaces, but to preserve the appearance 

of existing projects, it is set to zero in existing projects. 

Articulations 
Staccatissimo design. A new Staccatissimo design property has been added to the 

Articulations group in the Properties panel, allowing you to override the 

appearance of a staccatissimo articulation for a single note or chord, choosing 

between Normal, Wedge, and Stroke. 

Staccatissimo positioning inside the staff. A new option Position staccatissimo on 

closest staff line for notes in a space has been added to the Advanced Options 

section of the Vertical Position section of the Articulations page of Engraving 

Options. When articulations are inside the staff it is usually desirable to ensure a 

clear space between the articulation and the notehead or stem end. With this option 

turned on, staccatissimo articulations will be allowed closer than this. 

Audio engine 
Detecting changes in available devices. If an audio device is connected or disconnected 

while Dorico is running, the list of available devices in Edit ▶ Device Setup will 

reflect the current set of available devices, so you do not need to restart the 

application to switch to a newly connected device. 

Barlines 
Repeat barlines. A new option Changes of time and key signature at coincident repeat 

barlines has been added to the Repeats section of the Barlines page of Engraving 



업비트 다음에 오거나, 종료 반복 바라인이 한 박자 더 일찍 만들어졌어야 했습니다.) 

범주 필터 Preferences의 Proofreading 페이지에 새로운 범주 섹션이 추가되어 새 프로젝트를 시 

작하거나 도리코 6.0 또는 그 이전에 마지막으로 저장된 프로젝트룰 열 때 어떤 범주의 교정 결과를 기 

본적으로표시해야 하는지 지정할수 있습니다. 프로젝트를 도리코 6. 1 에 저장하면 패널의 범주 필터 

의 현재 상태가 Preferences에 지정된 초기 기본값보다 우선합니다. 따라서 귀하의 어떤 문제 범주 

률 보여줄지 선택하는 것은 프로젝트에서 지속되며 다음에 열 때 복원됩니다. 

개선점 

아르페지오부호 

슬래시 음성의 최소 길이. 라이브러리 ► 각인 옵션의 아르페지오 사인 페이지에서 슬래시 음성에 아 

르페지오 사인이 나타나야 하는지 여부를 지정할 수 있습니다. 리듬 슬래시 섹션에 새로운 최소 길이 

옵션이 추가되어 아르페지오 사인의 간격에 최소 길이를 지정할 수 있습니다. 

기본적으로 신규 프로젝트에서는 3칸으로 설정되지만, 기존 프로젝트의 외관을 보존하기 위해 기 

존 프로젝트에서는 0으로 설정됩니다. 

항변 

스타카티시모 디자인. 새로운 스타카티시모 디자인 속성이 속성 패널의 아티큘레이션 그룹에 추 

가되어 단일 음이나 코드에 대해 스타카티시모 아티큘레이션의 외관을 무시할 수 있습니다. 

스태프 내부에 스타카티시모 위치 지정. 새로운 옵션인 음표 위치 지정 지정 옵션이 각인 옵션 페이지 

의 수직 위치 섹션의 고급 옵션 섹션에 추가되었습니다. 조음이 스태프 내부에 있을 때는 일반적으로 

조음과노트헤드또는스템 끝사이에 명확한공간을확보하는 것이 바람직합니다. 이 옵션이 켜져 있 

으면 스타카티시모 조음이 더 가깝게 허용됩니다. 이거. 

오디오 

사용 가능한 장치의 변경 사항 감지 . 도리코가 실행되는 동안 오디오 장치가 연결되거나 연결이 끊 

어진 경우 편집 ► 장치 설정의 사용 가능한 장치 목록에 현재 사용 가능한 장치 세트가 반영되므로 

새로 연결된 장치로 전환하기 위해 애플리케이션을 다시 시작할 필요가 없습니다. 

Barlines 반복 표시줄 새로운 옵션 시간 변경 및 일치 반복 표시줄의 키 서명이 새김의 Barlines 페이지 

의 반복 섹션에 추가되었습니다. 

도리코 6판역사 
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Options. This allows you to determine whether changes of clef, key and time 

signature should appear between the end and start repeat barlines, as has always 

been the default in Dorico, or to instead place them to the right of the combined 

end-start repeat barline. 

Double barlines at the start of single-staff systems. When Barline at start of system with 

double barline at end of previous system is set to Double barline on the Barlines 

page of Notation Options, Dorico will now show a double barline at the start of a 

system if the previous system ends with an end repeat barline. 

Bar numbers 
Selecting bar numbers. Two new commands have been added to the Edit category in the 

Key Commands page of Preferences to make it easier to select bar numbers. These 

commands can have custom shortcuts assigned to them, or can be invoked via the 

jump bar. 

Particularly when showing bar numbers on every bar, or at intervals of 5 or 10 bars, 

it may be necessary to adjust the positions of bar numbers relative to items in the 

middle of the bar or at barlines. However, selecting bar numbers to adjust their 

positions in Engrave mode can be tricky, because items like slurs and ties can have 

click areas for their control handles that overlap with bar numbers. So to quickly 

select bar numbers, you can now make a selection in the range where you want to 

select bar numbers, then invoke Select Bar Numbers. This clears the existing 

selection, and selects all bar numbers in the originally selected range. 

In a similar vein, Add Bar Numbers to Selection simply adds any bar numbers in 

the selected range to the selection, without first clearing it. 

Chord diagrams 
Choice of chord diagrams. When Dorico chooses a specific chord diagram fingering for a 

chord symbol, it draws from its library of chord shapes. Instead of having fixed 

shapes for specific chords, Dorico instead has a database of all reasonable 

combinations of fret positions across fretted strings, considering the physical 

capabilities of the human hand. This can mean that if you have a specific shape in 

mind for a particular chord, it might not be the first shape that Dorico chooses, and 

indeed Dorico might make choices that you would prefer not to see at all – for 

example, because you are focusing on student players who may not have mastered 

more complex fingerings. You have always been able to define your own chord 

shapes in Library ▶ Chord Diagrams, and Dorico will prefer user-defined chord 

shapes when they apply, but it has not been possible to exclude any of Dorico's 

default shapes such that they are never chosen. 

In Library ▶ Chord Diagrams, you can now adjust this for each chord shape: if you 

want to exclude a shape from consideration altogether, simply deactivate the 



선택입니다 이를 통해 도리코에서 항상 기본값이었던 것처럼 끝과 시작 반복 바라인 사이에 

음표, 키 및 시간 서명이 나타나야 하는지 여부를 결정하거나, 대신 결합된 끝-시작 반복 바라인 

의오른쪽에 배치할수있습니다. 

단일 스태프 시스템 시작 시 이중 바라인. 이전 시스템 종료 시 이중 바라인이 있는 시스템 시작 시 바 

라인이 표시 옵션의 바라인 페이지에 이중 바라인으로 설정되면 이전 시스템이 종료 반복 바라인으로 

종료되면 도리코는 이제 시스템 시작 시 이중 바라인을 표시합니다. 

1::1~코드 

막대 번호 선택. 두 개의 새로운 명령이 설정 키 명령 페이지의 편집 카테고리에 추가되어 막대 번호 

를 더 쉽게 선택할수 있습니다. 이 명령에는사용자지정 단축키가할당되거나점프 바를통해 호출될 

수있습니다 

특히 모든 막대에 막대 번호를 표시하거나 5 또는 10개의 막대 간격으로 표시할 때, 막대 중앙이 

나 기준선에 있는 항목에 따라 막대 번호의 위치를 조정해야 할 수도 있습니다. 그러나 인그레이 

브 모드에서 위치를 조정하기 위해 막대 번호를 선택하는 것은 까다로울 수 있습니다. 왜냐하면 

슬러어나 타이 같은 항목에는 막대 번호와 겹치는 제어 핸들의 클릭 영역이 있을 수 있기 때문입 

니다 따라서 막대 숫자를 빠르게 선택하려면, 이제 막대 숫자를 선택하고자 하는 범위에서 선택 

을 한 다음, 선택 막대 숫자를 호출할 수 있습니다. 이렇게 하면 기존 선택이 삭제되고, 원래 선택 

한 범위의 모든 막대 번호가 선택됩니다. 

비슷한 맥락에서, 선택에 막대 숫자 추가는 먼저 지우지 않고 선택된 범위의 막대 숫자를 선택 

에추가합니다 

코드도 

코드 다이어그램의 선택 . 도리코가 코드 기호에 대한 특정 코드 다이어그램 운율을 선택할 때, 그것은 

코드 형태의 라이브러리에서 끌어옵니다. 도리코는 특정 코드에 대한 고정된 형태 대신, 인간의 신체 

적 능력을 고려하여 프렛 스트링에 걸친 프렛 위치의 모든 합리적인 조합의 데이터베이스를 가지고 있 

습니다 이것은 특정 코드에 대한 특정 형태를 염두에 두고 있다면, 그것이 도리코의 첫 번째 형태가 아 

닐 수도 있다는 것을 의미할수 있습니다. 선택은, 그리고 실제로도리코는 당신이 전혀 보지 않기를 원 

하는 선택을 할 수 있습니다. 예를 들어, 당신은 더 복잡한 손가락질을 마스터하지 못한 학생 연주자들 

에게 초점을 맞추고 있기 때문입니다. 당신은 항상 라이브러리 ► 코드 다이어그램에서 자신의 코드 

모양을 정의할 수 있었고, 도리코는 그들이 적용할 때 사용자 정의 코드 모양을 선호할 것입니다. 그러 

나 도리코의 기본 모양을 배제하는 것은 불가능하여 결코 선택되지 않습니다. 

라이브러리 ► 코드 다이어그램에서 이제 각 코드 모양에 대해 이것을 조정할 수 있습니다. 어 

떤 모양을 고려 대상에서 완전히 제외하려면 단순히 비활성화하십시오. 

도리코 6판역사 
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Match slide switch. Any chord shape that has Match deactivated will never be 

shown as a candidate chord diagram. You can alternatively influence how Dorico 

uses a particular shape: with Match activated, you can either choose to match All 

chord notes, or Some chord notes. 

When All chord notes is selected, the chord shape will only be chosen by Dorico if 

all the notes in the requested chord are represented by the chord diagram, and no 

extra notes are present. The settings on the Chord Diagrams page of Library ▶ Note 

Input Options are still considered, so for example they might allow the root to be 

omitted, or not always the lowest notes, as well as allowing some notes to be 

omitted in extended chords. 

When Some chord notes is selected, this allows the chord diagram to be chosen by 

Dorico when only a subset of the notes in the requested chord are represented by 

the chord diagram. This is the default setting for user-defined chord shapes. 

Finally, a new filter button has been added to the list of chord diagrams on the left of 

the dialog. When the filter is activated, all chord shapes where Match has been 

deactivated will be removed from the list. 

Library management. It is now possible to export the chord shapes from your project so 

that you can import them into other projects, or create multiple chord diagram 

libraries for different uses. 

In Library ▶ Chord Diagrams, click Export Library to export a library file containing 

all the chord diagrams used in the project, all chord diagrams saved as defaults, and 

any changes to factory chord diagrams (for example, whether Match is activated or 

deactivated). 

To import a library of chord shapes into another project, open the project, choose 

Library ▶ Chord Diagrams, and click Import Library to choose the library file to 

import. 

Root notes on instruments with fewer than five strings. When fretted instruments have 

fewer than five strings, it can be impossible to find chords with the root on the 

lowest string, especially if there is a desire to keep chords clustered around a 

specific fret position, rather than moving up and down the neck a lot. This 

restriction is easier to satisfy when the instrument has more strings, but with 

ukulele, for example, it can result in some chord symbols being unable to show a 

valid chord diagram. 

To address this, a new option For instruments with fewer than five strings, if root 

is included in chord has been added to the Chord Diagrams page of Library ▶ Note 

Input Options. In new projects, this is set to May be anywhere in chord, which 
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매치 슬라이드 스위치입니다. Match가 비활성화된 코드 모양은 후보 코드 다이어그램으로 표 

시되지 않습니다. 또는 도리코가 특정 모양을 사용하는 방식에 영향을 미칠 수 있습니다: 일치 

가 활성화된 상태에서 모든 코드 음과 일치하거나 일부 코드 음을 선택할 수 있습니다. 

모든 코드 음이 선택될 때, 요청된 코드의 모든 음이 코드 다이어그램으로 표시되고 추가 음이 없 

는 경우에만 코드 모양이 도리코에 의해 선택됩니다. 라이브러리 ► 노트 입력 옵션의 코드 다이 

어그램 페이지의 설정은 여전히 고려되므로, 예를 들어 루트를 생략하거나 항상 가장 낮은 음은 

아닐 뿐만 아니라 확장된 코드에서 일부 음을 생략할 수 있습니다. 

일부 화음이 선택될 때, 이는 요청된 화음의 일부 음만 화음 다이어그램으로 표현될 때 도리코에 

의해 화음 다이어그램을 선택할 수 있게 합니 다. 이것은 사용자가 정의한 코드 모양에 대한 기본 

설정입니다 

마지막으로, 대화의 왼쪽에 있는 코드 다이어그램 목록에 새로운 필터 버튼이 추가되었습니다. 필 

터가 활성화되면 Match가 비활성화된 모든 코드 모양이 목록에서 제거됩니다. 

라이브러리 관리. 이제 프로젝트에서 코드 모양을 내보내어 다른 프로젝트로 가져오거나 다양한 용 

도로 여러 코드 다이어그램 라이브러리를 만들 수 있습니다. 

라이브러리 ► 코드 다이어그램에서 라이브러리 내보내기를 클릭하여 프로젝트에 사용된 모든 

코드 다이어그램, 기본값으로 저장된 모든 코드 다이어그램, 공장 코드 다이어그램의 변경 사항 

(예 일치가 활성화되었는지 비활성화되었는지 여부)을 포함하는 라이브러리 파일을 내보냅니다. 

코드 모양 라이브러리를 다른 프로젝트로 가져오려면 프로젝트를 열고 라이브러리 ► 코드 다 

이어그램을선택한다음라이브러리 가져오기를클릭하여 가져올 라이브러리 파일을선택합니 

댜 

5개 미만의 현을 가진 악기에는 루트 음이 있습니다. 프렛 악기의 현이 5개 미만인 경우, 특히 목을 

많이 위아래로 움직이는 것보다 특정 프렛 위치를 중심으로 코드를 계속 모으려는 경우 가장 낮은 

현에 루트가있는코드를찾는것이 불가능할수있습니다. 이러한제한은악기에 더 많은현이 있을 

때 더 쉽게 만족할 수 있지만, 예를 들어 우쿨렐레의 경우 일부 코드 기호가 사용할 수 없게 될 수 있 

습니 다. 유효한 코드 다이어그램을 보여주세요. 

이를 해결하기 위해, 현이 5개 미만인 악기의 경우, 라이브러리 ► 노트 입력 옵션의 코드 다이어 

그램 페이지에 루트가 포함된 경우 새로운 옵션이 추가되었습니다. 새로운 프로젝트에서는 이것 

이 어디에나 적용될 수 있도록 설정되어 있습니다. 
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relaxes this restriction and makes it easier for Dorico to find an appropriate chord 

shape. 

Chord symbols 
Editing alterations. For chord symbols with stacked alterations, like b9 #11, it was 

previously difficult to edit the appearance of the individual alterations in the stack, 

for example to change the accidental glyph used. When editing a chord symbol 

appearance – either by double-clicking a chord symbol in Engrave mode, or using 

Library ▶ Chord Symbols – it’s now possible to double-click the alteration stack to 

edit it, and furthermore to edit an individual alteration within the stack in order to 

edit the accidental and interval components individually. 

Dynamics 
Edit Font. When right-clicking a dynamic and choosing Edit Font from the context 

menu, Dorico now edits the Dynamic Text Font or Dynamic Music Text Font font 

style as appropriate. 

Engrave mode 
Lock Layout. A new option Create system breaks when using Lock Layout has been 

added to the Note Input and Editing page of Preferences. This preference is 

activated by default. 

When using the Lock Layout command in Engrave mode, you may prefer Dorico to 

completely lock the system formatting, such that a frame break is created at the 

start of each frame, and a system break is created at the start of each system. If you 

want to make it easier to subsequently change the system formatting within a 

frame, you may prefer only to create frame breaks, in which case deactivate this 

preference. 

Guitar techniques 
Vibrato bar scoops. A new option Scoop appearance has been added to the Vibrato Bar 

section of the Guitar Techniques page of Engraving Options, allowing you to choose 

between two appearances for scoops: Straight produces a scoop that looks like a 

tick or checkmark, positioned to the left of the note; Curved produces a curved 

arrow positioned above the note. Further options in the same section allow you to 

tweak the default placement of scoops using the new curved appearance. 

In addition, new properties have been added to allow the adjustment of the position 

of individual vibrato bar scoops, and these properties apply both to straight and 

curved scoops. 
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화음 

이 제한을 완화하고 도리코가 적절한 코드 모양을 더 쉽게 찾을 수 있게 해줍니 다. 

변경 사항편집. b9 #11 과 같이 변경이 쌓인 코드 기호의 경우, 예를 들어 사용된 우연한문자를 변 

경하기 위해 스택의 개별 변경의 모양을 편집하는 것이 이전에는 어려웠습니다. 코드 기호 모양을 

편집할 때 - 인그레이브 모드에서 코드 기호를 두 번 클릭하거나 라이브러리 ► 코드 기호를 사용하 

여 - 이제 변경 스택을 두 번 클릭하여 편집하고 내부에서 개별 변경을 편집할 수 있습니다. 우발적 

요소와 간격 요소를 개별적으로 편집하기 위해 쌓습니다. 

역동성 

글꼴 편집. 동적 버튼을 누르고 컨텍스트 매뉴에서 글꼴 편집을 선택하면 도리코는 이제 동적 텍스 

트 글꼴 또는 동적 음악 텍스트 글꼴 스타일을 적절하게 편집합니다. 

앵그레이브모드 

잠금 레이아웃. 락 레이아웃을 사용할 때 새로운 옵션 생성 시스템이 추가되었습니다. 이 선호도 

는 기본적으로 활성화됩니다. 

기타기법 

Engrave 모드에서 Lock Layout 명령을 사용할 때 시스템 형식을 완전히 잠그는 것을 선호할 수 

있습니다 따라서 각프레임이 시작될 때프레임 브레이크가생성되고 각시스템이 시작될 때 시 

스템 브레이크가생성됩니다. 프레임 내에서 시스템 형식을 변경하는 것을 더 쉽게 만들려면 프레 

임 파손만 만드는 것을 선호할 수 있습니 다. 이 경우 이 선호도가 비활성화됩 니 다. 

비브라토 바 스쿠프. 새로운 옵션 스쿠프 모양이 추가되어 옵션 조각 기타 테크닉 페이지의 비브라토 

바 섹션에 추가되어 스쿠프에 대한 두 가지 모양 중 하나를 선택할 수 있습니다: 스트레이트는 노트 왼 

쪽에 위치한 똑딱이 또는 체크마크처럼 보이는 스쿠프를 생성합니다. 곡선은 노트 위에 위치한 곡선 화 

살표를 생성합니다. 같은 섹션의 추가 옵션을 사용하면 새로운 곡선을 사용하여 스쿠프의 기본 배치를 

조정할 수 있습니다. 외모. 

또한개별 비브라토 바스쿠프의 위치를조정할수 있도록새로운속성이 추가되었으며,이러한 

속성은 직선형 및 곡선형 스쿠프 모두에 적용됩니다. 
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Harmonics 
Artificial harmonics. The Node property in the Harmonics group in the Properties panel 

is now dependent on the Partial property. Only valid nodes will now appear for the 

chosen partial. 

For stringed instruments, the Node property now also affects the notation of 

harmonics on notation staves; previously, artificical harmonics for stringed 

instruments would always be notated as if the first node was used, regardless of the 

state of the Node property. In addition, the playback of natural harmonics using the 

White diamond notehead style is now correct regarding the choice of node. 

Lines 
Tapered curve line bodies. It is now possible to specify dashed, half-dashed and dotted 

tapered curve line bodies in Library ▶ Line Bodies. 

Music fonts 
Bravura. Bravura has been updated to version 1.455, and includes new characters for 

editorial tuplet brackets, and new symbols for curved guitar vibrato bar scoops. 

Using Sonata Std with Dorico. Sonata Std is the OpenType version of Adobe's venerable 

Sonata font. It is the only known font to encode its glyphs using the code points in 

the Unicode Musical Symbols range, U+1D100–U+1D1FF. This range lies in the 

Supplementary Multilingual Plane of the Unicode standard, and glyphs in this range 

have not previously been properly supported by Dorico. It is now possible to specify 

these code points in Dorico's music symbols editor and for them to appear properly 

in the software. 

MusicXML export 
Graphical information. Dorico's MusicXML export has been enriched with more 

graphical and positioning information. The following information is now exported: 

§ Stem lengths (the default-y attribute on the note element) 

§ Horizontal note positioning (default-x on note) 

§ Bar width (width on measure) 

§ Slur and tie positioning (default-x and default-y for end point positioning, 

bezier-x and bezier-y for control point positioning on slur and tied) 

§ Brackets and braces (part-group in part-list, together with group-barline 

for barline joins) 

§ Tempo and metronome mark export now includes font information and 

default-y for words and metronome directions 

§ Fermatas (default-x, default-y, relative-x and relative-y) 

§ Staff-attached text items (default-x, default-y, relative-x and relative-y) 

§ Default line widths, note scale factors etc. (appearance element) 

§ Precise horizontal placement of grace notes (default-x on note with grace) 



조화학 

인공 고조파입니다 속성 패널의 고조파 그룹에 있는 노드 속성은 이제 부분 속성에 의존합니다. 이제 

선택한 부분에 대해 유효한 노드만 나타납니다. 

현악기의 경우 노드 속성은 이제 기보 스테이브의 고조파 기보에도 영향을 미칩니다. 이전에는 현 

악기의 인공 고조파가 노드 속성의 상태에 관계없이 항상 첫 번째 노드가 사용된 것처럼 기보되었 

습니다 또한, 이제 노드 선택과 관련하여 화이트 다이아몬드 노트헤드 스타일을 사용한 자연 고 

조파의 재생이 정확합니다 

선
 

테이퍼 곡선 라인 본체. 이제 라이브러리 ► 라인 본체에서 점선, 반점선 및 점선의 테이퍼 곡선 라 

인 본체를 지정할 수 있습니 다. 

악보 

브라부라 브라부라는 버전 1.455로 업데이트되었으며, 편집 튜플렛 브래킷의 새로운 문자와 커 

브드 기타 비브라토 바 스쿠프의 새로운 기호가 포함되어 있습니다. 

Sonata Std를 도리코와 함께 사용합니다. 소나타 Std는 Adobe의 존경받는 소나타 글꼴의 

OpenType 버전입니다 유니코드 음악 기호 범위의 코드 포인트를 사용하여 글리프를 인코딩하는 유 

일한 알려진 글꼴입니다. U+1D100-U+1D1FF. 이 범위는 유니코드 표준의 보충 다국어 평면에 있으 

며 이 범위의 글리프는 이전에 도리코에서 제대로 지원되지 않았습니다. 이제 도리코의 음악 기호 편집 

기에서 이러한코드 포인트를 지정할수 있습니다. 소프트웨어에 제대로 나타납니다. 

뮤직XML 수출 

그래픽 정보. Dorico의 MusicXML 내보내기는 더 많은 그래픽 및 위치 정보로 풍부해졌습니다 
이제 다음 정보가 내보내집니다. 

§ 줄기의 길이(음 요소의 기본-y 속성) 

§ 가로음 위치 지정(기본 x 음표) 

§ 통너비 

§ Slur 및 tie 위치 지정(끝점 위치 지정의 경우 기본 x 및 기본 y, Slur 및 tie의 제어점 
위치 지정의 경우 기본 x 및 기본 y) 

§ 괄호와 중괄호(파트리스트의 일부 그룹, 바라인 결합을 위한 그룹 바라인과 함께) 

§ 템포 및 매트로놈 표시 내보내기에는 이제 글꼴 정보가포함됩니다. 

대문짝 

§ 페르마타 

§ 직원별 텍스트 항목(기본값"X, 기본값"y, 상대값-x, 상대값-y) 

§ 기본 선폭, 음계 요소 등(외관 요소) 

§ 정확한 수펑 배치(은혜가 있는 음표에는 기본 x) 
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§ Vertical placement of rests and bar rests (display-step and display-octave 

on rest) 

§ Precise horizontal and vertical placement of ornaments and trills (default-x, 

default-y, relative-x and relative-y) 

Buzz rolls. Buzz roll (z on stem) tremolos are now correctly exported to MusicXML. 

Tempo. When exporting tempo and metronome marks to MusicXML, the engraving 

option for the relative order of tempo and metronome mark is now respected. 

Margins. When exporting the system-margins element to MusicXML, Dorico now 

correctly accounts for any system indent applied to the right-hand side of the 

system, and similarly handles an unjustified final system in the flow correctly. 

Pedal lines 
Alignment across the system. A new option Align pedal lines across width of system has 

been added to the Vertical Position section of the Pedal Lines page of Engraving 

Options, activated in newly-created projects but deactivated in existing projects. 

When activated, Dorico aligns all pedal lines on the system at the same vertical 

position across the whole system. 

As a result of the implementation of this new behavior, you may see changes in the 

appearance of existing projects where pedal lines of different types (for example, 

but sustain and sostenuto or una corda pedals) overlap. In previous versions, Dorico 

would nest a pedal line that both starts and ends within the span of an existing 

pedal line inside that pedal line, closer to the staff. Now, Dorico always orders pedal 

lines into rows, with a new pedal line starting later than an ongoing pedal line 

positioned outside, further from the staff. If pedal lines begin at the same position, 

the sustain pedal will be positioned closest to the staff, with sostenuto or una corda 

pedal lines positioned further from the staff. 

If the option to align pedal lines across the width of the system is deactivated, 

Dorico will nevertheless resolve groups of overlapping pedal lines within the 

system and position them together, to avoid them colliding or overprinting. This is 

always the behavior in galley view, regardless of whether the option to align pedal 

lines is activated. 

Alignment of pedal lifts. A new option Position of end of pedal line if coincident with 

barline has been added to the Horizontal Position section of the Pedal Lines page of 

Engraving Options, allowing you to specify that when a pedal line ends at a barline, 

the lift should stop at the barline, or should align with the left-hand side of the note 

or chord following the barline. 



§ 

§ 

받침대와 막대 받침대의 수직 배치(디스플레이-스텝 및 디스플레이-옥타브) 

휴무) 

장식품과 트릴(기본-X, 기본-y, 상대-x 및 상대-y)의 정확한 수평 및 수직 배치 

버즈 롤 버즈 롤(z on stem) 트레몰로는 이제 MusicXML로 올바르게 내보냈습니 다 

템포 MusicXML에 템포와 메트로놈 마크를 내보낼 때 템포와 메트로놈 마크의 상대적인 순서 

에 대한 각인 옵션이 존중됩니다 

마진 시스템 마진 요소를 MusicXML로 내보낼 때, 도리코는 이제 시스템의 오른쪽에 적용된 

모든 시스템 들여쓰기룰 올바르게 설명하고, 마찬가지로 흐름에서 정당하지 않은 최종 시스템 

을을바르게처리합니다. 

페달 

시스템 전체에 정렬 새로운옵션:시스템 너비에 걸쳐 페달라인을정렬하기 위한새로운옵션이 추가 

되었습니다 이는 새로 생성된 프로젝트에서는 활성화되었지만 기존 프로젝트에서는 비활성화되었습 

니댜 

활성화되면, 도리코는 시스템의 모든 페달 라인을 전체 시스템에 걸쳐 동일한 수직 위치에 

정렬합니다 

이 새로운 행동의 구현 결과로, 다양한 유형의 페달 라인(예: 서스테인 및 Sostenuto 또는 쿠나 

코르다 페달)이 겹치는 기존 프로젝트의 모습의 변화를 볼 수 있습니다. 이전 버전에서 도리코는 

페달 라인 내부에 시작과끝이 모두있는페달라인을스태프에 더 가깝게 배치합니다. 이제 도리 

코는 항상 페달 라인을 열로 정렬합니다. 페달 라인은 진행 중인 페달 라인보다 늦게 시작됩니다. 

페달 라인이 같은 위치에서 시작되면 서스테인 페달이 직원에게 가장 가깝게 위치하며, 

Sostenuto 또는una 코르다페달 라인은 직원으로부터 더 멀리 위치합니다. 

시스템 너비에 걸쳐 페달 라인을 정렬하는 옵션이 비활성화되면, 도리코는 시스템 내에서 겹치 

는 패달 라인 그룹을 해결하고 서로 배치하여 충돌하거나 과도하게 인쇄되는 것을 방지합니 

다 이것은 페달 라인을 정렬하는 옵션이 활성화되었는지 여부와 상관없이 항상 갤리 뷰에서 

나타나는 행동입니다. 

페달 리프트의 정렬 라인과 일치하는 경우 페달 라인의 끝 위치라는 새로운 옵션이 추가되어 페달 라 

인이 기준선에서 끝날 때 리프트가 기준선에서 멈추거나 기준선을 따라 음표 또는 코드의 왼쪽과 일치 

해야합니다 
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Percussion 
Grid group names. It is now possible for group names for percussion kits using the grid 

presentation type to use rich text formatting, like other staff labels. 

Platform support 
iPadOS 26. The latest version of iPadOS features significant changes to the way app 

windows are handled. It now requires a double-tap on the project title in the toolbar 

on Dorico for iPad to open the Project Info dialog. This allows you to tap and hold on 

that part of the toolbar to move the project window around the iPad display. 

Playback 
Per-switch delay. By default, the Delay value defined for a base switch in an expression 

map applies to the note onset (start), offset (end), and any MIDI controllers required 

to trigger the switch. 

However, some users prefer that note offsets and MIDI controllers are not affected 

by the delay. To accommodate this, it is now possible in Library ▶ Expression Maps 

to determine whether the delay should apply to End offsets and Controllers 

independently. 

Tremolo playback on percussion. A new option Apply accent to all notes for unpitched 

percussion measured tremolo has been added to the Dynamics page of Playback 

Options. When activated, Dorico will apply an accent written on a single-note 

tremolo to all notes in the tremolo, but only on unpitched percussion instruments; 

on pitched instruments, an accent still applies only to the initial note in the tremolo. 

Project files 
Revert. A new File ▶ Revert command has been added. When you invoke this command, 

Dorico will warn you that unsaved changes will be lost, and if you proceed, Dorico 

will close the project without saving it and then reopen it. 

Selections 
Select More. When using Edit ▶ Select More starting from a single selected system or 

frame break, Dorico will now select only breaks of the same type. 

Tablature 
Enclosures around tab numbers. When Enclosures for notes and chords longer than a 

quarter note (crotchet) is set to either Ellipse or Rounded rectangle in the 

Enclosures section of the Tablature page of Engraving Options, it is now possible to 

control the padding between the tablature numbers and their enclosure, with 

independent horizontal and vertical control for rounded rectangles, and diameter 

control for ellipses. 



도리코 6판역사 

타악71 

그리드 그룹 이름. 이제 그리드 프레젠테이션 유형을 사용하는 타악기 키트의 그룹 이름은 다른 스 

태프 레이블과 같이 풍부한 텍스트 형식을사용할수 있습니다. 

플랫폼지원 

재생 

iPadOS 26. 최신 버전의 iPadOS는 앱 창을 처리하는 방식에 상당한 변화를 제공합니다. 이제 iPad 

가 프로젝트 정보 대화를 열려면 도리코의 도구 모음에 있는 프로젝트 제목을 두 번 눌러야 합니다. 이 

를 통해 도구 모음의 해당 부분을 눌러 아이패드 디스플레이 주변으로 프로젝트 창을 이동할 수 있습니 

댜 

스위치별 지연 기본적으로 표현 맵에서 기본 스위치에 대해 정의된 지연 값은 노트 시작(시작), 오프 

셋(종료) 및 스위치를 트리거하는 데 필요한 모든 MIDI 컨트롤러에 적용됩니다. 

그러나 일부 사용자는 노트 오프셋과 MIDI 컨트롤러가 지연의 영향을 받지 않는 것을 선호합니 

댜 이를 수용하기 위해 라이브러 리 ► 표현 맵스에서 지연이 End Offset 및 Controller에 독립 

적으로 적용되어야 하는지 여부를 결정할 수 있습니다. 

타악기에서 트레몰로 재생. 새로운 옵션: 음정이 없는 타악기 측정 트레몰로에 대해 모든 음에 악센트 

를 적용하십시오. 재생 옵션의 동적 페이지에 추가되었습니다. 활성화되면 도리코는 단일 음 트레몰로 

에 적힌 악센트를 트레몰로의 모든 음에 적용하지만 음정이 없는 타악기에만 적용됩니다. 음정 악기에 

서는 여전히 악센트가 트레몰로의 초기 음에만 적용됩니다. 

프로젝트파일 

선정 

표 

Revert. 파일 ► Revert 명령이 새로 추가되었습니다 이 명령을 호출하면 도리코가 저장되지 않은 

변경 사항이 손실될 것이라고 경고하고, 진행하면 도리코가 프로젝트를 저장하지 않고 종료한 후 다시 

열것입니다 

더 많이 선택합니다 편집 ► 선택된 단일 시스템 또는 프레임 브레이크에서 시작하여 더 많이 선 

택하기를 사용할 때 도리코는 이제 같은 유형의 브레이크만 선택합니다. 

탭 번호 주변의 인클로저. 4분음표보다 긴 음과 코드에 대한 인클로저가 타원형 또는 둥근 직사각 

형으로설정되어 있을 때 

인그레이빙 옵션의 표식 페이지의 인클로저 섹션, 이제 둥근 직사각형에 대한독립적인 수평 및 

수직 제어 및 타원에 대한 직경 제어를 통해 표식 숫자와 인클로저 사이의 패딩을 제어할 수 있습 

니댜 
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Stems in tablature. A new Inner stem adj. property has been added, allowing the 

adjustment of the vertical position of the end of the stem closest to the tablature 

number. 

Tied notes. Two new choices have been added to the Tied notes in tablature option in 

the Ties section of the Tablature page of Engraving Options, which allow Dorico to 

support the conventions for tied notes popularized by Total Guitar, Guitar 

Techniques and Guitarist magazines from the UK, and which are now also followed 

by the Trinity/Rock School electric guitar syllabus. 

By convention, only the starting note of the tie chain is shown in tablature, with no 

tie shown, and no indication of the tied-to note or notes. The exception, however, is 

if something is attached to the tied-to note – for example, a bend, slide, or similar. 

When something is attached to the tied-to note, it is displayed inside square 

brackets. 

To use this convention, choose Hide fret numbers, tied notes with attachments in 

square brackets, per string. If you prefer a single square bracket that encloses fret 

numbers on adjacent strings, choose Hide fret numbers, tied notes with 

attachments in square brackets, grouped. 

The further new options Square bracket thickness and Square bracket hook 

length provide control over the appearance of the square brackets themselves. 

Text 
Smart quotes. A new Smarten quotation marks option has been added to the Text page 

of Engraving Options. When activated, Dorico will automatically convert straight 

quotes into appropriate smart quotes for text everywhere it appears in the project; 

however, even when it is deactivated, quotes will still be smartened in text frames, 

lyrics, and staff labels, as these have always used smart quotes. 

In addition, a new Quotation marks style option has been added, allowing you to 

choose between three different conventions for quotation marks, as most 

commonly used in English, French, and German. 

Character styles in Project Info. It is now possible to specify changes of character style in 

the fields in File ▶ Project Info, providing greater flexibility in formatting subsets of 

the text that appears in text frames when using tokens corresponding to these 

fields. 

The special pair of tokens {@style:All Caps@} and {@/style@} are used to enclose 

the text that should apply the character style. In this example, the name of the All 

Caps character style is used, but of course you should substitute the name of 

whichever character style you want to use. 



표의 줄기. 새로운 내부 줄기 부속 속성이 추가되어 표 번호에 가장 가까운 줄기 끝의 수직 위치 

를조정할수있습니다. 

묶인 메모. 표의 묶인 메모에 두 가지 새로운 선택지가 추가되었습니다. 

Total Guitar, Guitar Techniques 및 기타리스트 잡지에 의해 대중화된 묶인 음표에 대한 관 

습을 도리코가 지원할 수 있도록 하는 인그레이빙 옵션의 테이블러처 페이지의 타이 섹션입니 

다 그리고 현재는 트리니티/록 스쿨 일렉트릭 기타 강의 계획서도 있습니다. 

관례에 따라 타이 체인의 시작 음만 표로 표시되며 타이는 표시되지 않고 타이와 연결된 음이나 

음표에 대한표시도 없습니다. 그러나 예외는, 예를 들어 구부러지거나슬라이드또는 이와유사 

한 것과 같은 묶인 음에 무언가가 부착되어 있는 경우입니다. 

묶인 노트에 무언가가 부착되면 대괄호 안에 표시됩니다. 

이 규칙을 사용하려면 문자열마다 대괄호 안에 첨부 파일이 있는 묶인 노트인 숨기기 프렛 번호 

롤 선택하십시오. 인접한 문자열에 프렛 번호를 묶는 단일 사각 괄호를 선호하는 경우, 그룹화된 

대괄호에 첨부 파일이 있는 묶인 노트인 Hide 프렛 번호를 선택하세요. 

추가로 새로운 옵션인 스퀘어 브래킷 두께와 스퀘어 브래킷 후크 길이는 스퀘어 브래킷 자체 

의 외관을 제어할수 있습니다. 

글
 

스마트 인용문. 인그레이빙 옵션의 텍스트 페이지에 새로운 스마트 인용문 표시 옵션이 추가되었습니 

다 활성화되면 도리코는 프로젝트에 나타나는 모든 곳에서 스트레이트 인용문을 텍스트에 대한 적절 

한 스마트 인용문으로 자동 변환합니다. 그러나 비활성화되더라도 인용문은 항상 스마트 인용문을 사 

용했기 때문에 텍스트 프레임, 가사 및 스태프 라벨에서 여전히 스마트화됩니다. 

또한 새로운 따옴표 스타일 옵션이 추가되어 영어, 프랑스어, 독일어에서 가장 일반적으로 사 

용되는 따옴표에 대한 세 가지 다른 규칙 증에서 선택할 수 있습니 다. 

프로젝트 정보의 문자 스타일. 이제 파일 ► 프로젝트 정보의 필드에서 문자 스타일의 변경 사항을 지 

정할 수 있게 되어 이러한 필드에 해당하는 토큰을 사용할 때 텍스트 프레임에 나타나는 텍스트의 하 

위 집합을 형식화하는 데 더 큰 유연성을 제공합니다. 

문자 스타일을 적용해야 하는 텍스트롤 둘러싸기 위해 사용되는 특별한 토큰 쌍 {@style:AII 

Caps@} 및 {@/style@}을 사용합니다 이 예제에서는 All Caps 캐릭터 스타일의 이름이 사 

용되지만 물론 사용하고자 하는 캐릭터 스타일의 이름을 대체해야 합니다. 
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Crimson Pro font family. The Crimson font family – a recreation of old-style serif 

typefaces like Garamond – has been included with Dorico since version 1.0. 

However, Crimson has now been succeeded by a redesigned evolution of the 

original family, Crimson Pro, and that updated family is now included with Dorico in 

preference to the original Crimson family. Crimson Pro offers eight weights, has 

expanded language and script support, and provides improved legibility and optical 

refinement. 

Ties 
Ties over system breaks. A new option Minimum length for ties at the start of the 

system has been added to the Length section of the Ties page of Engraving Options. 

In new projects, this is set to 1.5 spaces, and ensures that ties into the first note or 

chord at the start of a new system are not so short that they look distorted; in 

existing projects, this is set to zero, to avoid changing their appearance on loading. 

Tuplets 
Bracketed tuplet digits. A new Ratio bracket type property has been added to the Tuplets 

group in the Properties panel. When activated, Dorico draws parentheses (curved 

brackets) or square brackets around the tuplet digit or ratio. You can choose 

whether the brackets should be italic or roman. 

When Tuplet digit type is set to Bold weight or Regular weight, brackets will only 

appear correctly when the Tuplet Font font style is set to use Bravura. No other 

music font has the required bracket symbols. However, when Plain font is chosen, 

Dorico will use the parentheses and brackets from the font specified by the Tuplet 

Plain Font font style.  

User interface 
Alphabetic ordering in lists. Where possible, Dorico now uses natural sort order for 

alphabetically sorted lists, instead of the default lexicographical sort order. 

Standard lexicographical sort order compares characters strictly by their Unicode 

or ASCII values, so it would sort the same list as file1.txt, file10.txt, file2.txt, because 

1 comes before 2 in character-by-character comparison. Similarly, in handling 

accented characters, é would be sorted far from e because they have different code 

points. 

By contrast, natural sort order arranges items in the way a human would typically 

expect, especially when numbers are involved. For example, it sorts file1.txt, 

file2.txt, file10.txt in that order. Natural sort order treats accented characters like é, 

è, or ö as variants of their base letters (e, o) to group similar items together in a way 

that feels intuitive. 
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넥타01 

크림슨 프로 폰트 제품군. 크림슨 폰트 제품군은 가라몬드와 같은 오래된 스타일의 서체를 

재현한 것으로 버전 1.0부터 도리코에 포함되었습니다. 

그러나 크림슨은 이제 원래 제품군인 크림슨 프로의 재설계된 진화에 의해 계승되었으며, 업데이 

트된 제품군은 이제 원래의 크림슨 제품군보다 도리코와 함께 포함되었습니다. 크림슨 프로는 8 

가지 가중치를 제공하며, 언어 및 스크립트 지원이 확장되었으며, 향상된 가독성 및 광학적 개선 

기능을제공합니다. 

시스템 파손에 대한 타이. 새로운 옵션 시스템 시작 시 타이에 대한 최소 길이가 옵션 조각 타이 페이 

지의 길이 섹션에 추가되었습니다. 

새로운 프로젝트에서는 이를 1.5칸으로 설정하여 새로운 시스템이 시작될 때 첫 음이나 코드 

의 연결이 왜곡되어 보이지 않도록 합니다. 기존 프로젝트에서는 로딩 시 외관이 변하지 않도 

록 0으로설정합니다. 

쌍둥01 

괄호 표시된 튜플렛 숫자. Pers의 Tuplets Group에 새로운 Ratio 괄호 유형 속성이 추가되었습니 

다 활성화되면 Dorico는 Tuplet 숫자 또는 비율 주위에 괄호(곡선 괄호) 또는 대괄호를 그립니다. 괄 

호는 이탤릭체 또는 로마자여야 하는지 선택할 수 있습니다. 

Tuplet 숫자 유형이 Bold weight 또는 Regular weight로 설정되 면 Tuplet Fontfont 스타일 

이 Bravura를 사용하도록 설정되었을 때만괄호가올바르게 나타납니다. 다른 어떤 음악폰트 

에도 필요한 괄호 기호가 없습니다. 그러나 Plain 폰티스를 선택하면 도리코는 Tuplet Plain 

폰트 스타일로 지정된 폰트의 괄호와괄호를 사용합니다. 

인터페이스 

목록에서 알파벳 순서 지정. 가능한 경우, 도리코는 이제 기본 사전식 정렬 순서 대신 알파벳순 

으로 정렬된 목록에 자연스러운 정렬 순서를 사용합니다. 

표준 사전식 정렬 순서는 문자들을 유니코드 또는 ASCII 값으로 엄격하게 비교하기 때문에, 
file1 .txt, file1 0.txt, file2.txt와 같은 목록을 정렬합니 다. 

l 문자별 비교에서는 2 앞에 나옵니다. 마찬가지로, 처리 과정에서 

악센트가 있는 문자들은 코드 포인트가 다르기 때문에 e에서 멀리 정렬될 것입니다. 

대조적으로, 자연스러운 정렬 순서는 특히 숫자가 포함될 때 인간이 일반적으로 예상하는 방식으 

로 항목을 배열합니다. 예를 들어, file1 .txt, file2.txt, file1O.txtin 순서로 정렬합니다. 자연 정렬 

순서는 e, e 또는 하와 같은 악센트가 있는 문자를 기본 문자(e, o)의 변형으로 취급하여 직관적으 

로 유사한 항목을 함께 그룹화합니다. 
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Status bar summary. When multiple implicit rests are selected, the time duration of the 

selection is now displayed as expected. When a staff- or system-attached text item 

is selected, Dorico now displays the name of the paragraph style used by the text 

item, together with the font family and style names. If the text item has a local 

override to the font or style, an asterisk is appended. 

Expression map switch names. In Library ▶ Expression Maps, if the name for a base or 

add-on switch contradicts the combination of playback techniques it is set to 

produce, the names of the playback techniques are automatically appended to the 

name of the switch in the dialog. 

Counterpart layout. Using Window ▶ Counterpart Layout to toggle between full score 

and part layouts in Engrave mode now maintains the selection, resulting in the 

selection being kept in view correctly in the new layout. 

Graphic slices. Selecting a graphic slice in the panel in Engrave mode now navigates to 

the location of that frame in the current layout. 

Proofreading panel. The size of the Ignore button in the Proofreading panel has been 

increased, to make it easier to click on. 

Video 
Warning about synchronization. When Pre-roll before flow is set to a non-zero value on 

the Timing page of Library ▶ Playback Options, attached videos will not play in sync 

as expected. Dorico now shows a warning to that effect if you change this setting 

when a video is attached to one or more flows in the project. 
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상태 표시줄 요약. 여러 개의 암시적 휴식이 선택되면 이제 예상대로 선택 시간이 표시됩니다. 스태프 

또는 시스템에 부착된 텍스트 항목이 선택되면 도리코는 이제 텍스트 항목에서 사용하는 단락 스타일 

의 이름을폰트계열 및 스타일 이름과함께 표시합니다. 텍스트 항목에 폰트또는스타일에 대한로컬 

오버라이드가 있는 경우 별표가 추가됩니다. 

표현 지도 스위치 이름. 라이브러리 ► 표현 지도에서 기본 또는 추가 스위치 이름이 생성하도록 설 

정된 재생 기술의 조합과 모순되는 경우 재생 기술의 이름이 대화의 스위치 이름에 자동으로 추가됩 

니댜 

카운터파트 레이아웃. 창을 사용하여 전체 점수와 부분 레이아웃 사이를 전환하는 카운터파트 레이 

아웃을사용하면 이제 선택이 유지되므로새 레이아웃에서 선택이 올바르게표시됩니다. 

그래픽 슬라이스. 판넬에서 그래픽 슬라이스를 선택하면 현재 레이아웃에서 해당 프레임의 위치로 

이동합니다 

프루프 리딩 패널. 프루프 리딩 패널의 무시 버튼 크기를 늘려 클릭하기 쉽게 만들었습니다. 

비디오 

동기화에 대한 경고. 라이브러리 ► 재생 옵션의 타이밍 페이지에서 흐름 전 사전 롤이 0이 아닌 값으 

로 설정되면 첨부된 비디오가 예상대로 동기화되지 않습니다. 도리코는 이제 프로젝트의 하나 이상의 

흐름에 비디오가 첨부되어 있을 때 이 설정을 변경하면 그런 취지의 경고를 보여줍니다. 
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Issues resolved 
Component Issue 

Chord diagrams Editing a chord diagram in Library ▶ Chord Diagrams no longer causes it to appear twice in 

the list of alternative chord diagrams. 

Chord symbols When de-synchronizing a roman and italic chord symbol appearance that applies to all roots, 

Dorico now correctly ensures that independent components are created for each component 

in the appearance. 

Chord symbols It incorrectly appeared to be possible to delete the factory chord symbol kerning pairs; this has 

now been fixed. 

Chord symbols Properties on chord symbols on staves other than the top staff in the score layout now once 

again propagate correctly to part layouts. 

Chord symbols Dorico could crash when drawing a chord symbol containing a component drawn using SVG; 

this has now been fixed. 

Condensing Enabling and disabling condensing no longer causes markers that appear above a condensed 

staff to temporarily disappear. 

Condensing When multiple instruments of the same type are assigned to the same player, Dorico no 

longer incorrectly fails to draw the music when condensing is enabled. 

Dynamics Under some circumstances, deleting a dynamic group containing immediate dynamics with a 

hidden intensity marking would result in the dynamic signpost remaining visible; this has 

now been fixed. 

Flows When importing flows from another project, Dorico will now only allow players to be merged 

if their type (i.e. single vs. section) matches. 

Flows The list of flows in Edit ▶ Go To now always uses the same number that appears in the Flows 

panel in Setup mode; previously these numbers would differ if the current layout does not 

include all flows. 

Holds and pauses When a breath mark appears at the end of the system, it could sometimes be incorrectly 

displaced by items to the left of the first note or chord on the following system; this has now 

been fixed. 

Key Editor Under some circumstances, edits in the music could be missed by the Key Editor if they occur 

in the dead time before Dorico recalculates playback; this has now been fixed. 

Localization When running Dorico in Chinese or Japanese, English note names are now used instead of 

solfège note names in signposts for key signatures. 

MIDI export Notes produced by the chord track in Play mode are once more correctly included when 

exporting MIDI. 



과제 

성분 

코드도 

화음 

화음 

화음 

화음 

응축 

응축 

역동성 

흐름 

흐름 

보류 

주필 

국산화 

수출 
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문제 

라이브러리 ► 코드 다이어그램에서 코드 다이어그램을 편집하면 더 이상 대체 코드 다이어그램 목록에 

두 번 나타나지 않습니다. 

모든 어근에 적용되는 로마자 및 이탤릭체 코드 기호 모양을 비동기화할 때, 도리코는 이제 모양의 각 구성 

요소에 대해 독립적인 구성 요소가 생성되도록 올바르게 보장합니다. 

공장코드 기호 커닝 쌍을 삭제하는 것이 잘못 가능한 것으로 나타났습니다. 이것은 이제 수정되었습니다. 

악보 레이아웃의 상위 오선보 이외의 오선보에 있는 코드 기호에 대한 속성은 이제 다시 한 번 파트 레이 

아웃으로 율바르게 전파됩 니 다. 

SVG률 사용하여 그린 성분이 포함된 코드 기호률 그릴 때 도리코가 충돌할 수 있습니다. 이것은 이제 수정 

되었습니댜 

응축을 활성화하고 비활성화하면 응축된 스태프 위에 나타나는 마커가 더 이상 일시적으로 사라지지 않습 

니다 

같은종류의 악기가여러 대 같은연주자에게 할당되면,콘덴싱이 활성화되면 도리코는 더 이상음악 

을 잘못 그리지 않습니다. 

어떤 상황에서는 숨겨진 강도 표시로 즉각적인 역학율 포함하는 동적 그룹율 삭제하면 동적 표지석이 계속 

보이게 됩니다 이것은 이제수정되었습니다. 

다른 프로젝트에서 흐름율 가져율 때, 도리코는 이제 플레이어 유형(즉, 단일 대 섹션)이 일치하는 경우에만 

플레이어롤 병합할 수 있습니다. 

편집 ► Go To의 흐름 목록은 이제 설정 모드에서 흐름 패널에 표시되는 동일한 숫자롤 항상 사용합니 

댜 이전에는 현재 레이아웃에 모든 흐름이 포함되지 않으면 이 숫자가 다룰 수 있습니다. 

시스템의 끝에 호흡 표시가 나타나면 다음 시스템의 첫 음이나 화음의 왼쪽에 있는 항목에 의해 잘못 이 

동될 수 있습니다. 이것은 이제 수정되었습니다. 

어떤 상황에서는음악의 편집이 도리코가재생율 다시 계산하기 전에 데드 타임에 발생하면 키 에디터가놓 

칠 수 있습니다. 이것은 이제 수정되었습니다. 

중국어 또는 일본어로 도리코롤 실행할 때, 이제는 주요 서명을 위한 표지판에 솔페지 음 이름 대신 영어 

음이름을사용합니다. 

Play 모드에서 코드 트랙에 의해 생성된 음표는 MIDI를 내보낼 때 다시 한 번 올바르게 포함됩니다 
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Component Issue 

Music symbols Under some circumstances, Dorico would incorrectly choose a font style with a different size 

to that used to display a glyph in the music symbols editor; this has now been fixed. 

MusicXML export Lyrics on chords are now exported to MusicXML in such a way that improves compatibility 

with importing into Sibelius. 

MusicXML import When running Dorico in Japanese or Chinese, it was possible for Dorico to crash when 

importing a MusicXML file that requires a custom clef definition; this has now been fixed. 

Note input Inputting using the on-screen Fretboard panel no longer incorrectly modifies the pitch of the 

input notes according to the accidentals in the key signature. 

Note input Under some circumstances, pasting material into another flow could leave it apparently 

linked to the original flow; this has now been fixed. 

Note input Under some circumstances, pasting multiple copies of note-attached lines attached to 

different voices at their starts and ends would cause subsequent lines to become attached 

incorrectly; this has now been fixed. 

Ornaments Under some circumstances, the placement of trills relative to the staff could be unstable when 

editing music in their vicinity; this has now been fixed. 

Platform support It is once again possible for Dorico to be installed on ARM-based Windows systems; however, 

Dorico is still x86-only (Windows only). 

Playback D.C. al Segno now correctly interprets the segno mark as fine in playback. 

Playback The delay produced by the Delayed start option or property for glissando playback is now the 

same for glissandos played back via pitch bend and those played back by discrete notes. 

Playback Harmonics indicated by the circle above the note are now played at the correct pitch on harp. 

Playback Under some circumstances, the gap following a fermata would not be played correctly in 

repeated passages; this has now been fixed. 

Playback When exporting expression maps via Library ▶ Expression Maps, Dorico now correctly 

includes any playback techniques referenced by switches in the expression map in the 

exported library file. 

Playing techniques Under some circumstances, bracketing a playing technique could result in multiple sets of 

parentheses surrounding symbol and text parts of the playing technique; this has now been 

fixed. 

Print mode Empty text frames with filled, colored backgrounds now once more appear correctly when 

printed or exported to graphics. 



성분 

악보 

뮤직XML 수출 

뮤직XML수입 

노트 

노트 

노트 

장신구 

플랫폼지원 

재생 

재생 

재생 

재생 

재생 

주법 

인쇄모드 

도리코 6판역사 

문제 

어떤 상황에서는 도리코가 음악 기호 편집기에 문자를 표시하던 것과 다른 크기의 글꼴 스타일을 잘못 선택 

하기도 했습니다. 이것은 이제 수정되었습니다. 

코드의 가사는 이제 MusicXML로 내보내져 Sibelius로 수입할 때 호환성을 향상시킵니다 

일본어 또는 중국어로 도리코롤 실행할 때, 사용자 정의가 필요한 MusicXML 파일을 가져올 때 도리 

코가 충돌할 수 있었습니다. 이는 이제 수정되었습니다. 

화면에 있는 Fretboard 패널을 사용하여 입력하면 키 서명에 있는 실수에 따라 입력 노트의 음높이가 더 이 

상 잘못 수정되지 않습니다. 

어떤 상황에서는 재료를 다른 흐름에 붙이면 원래 흐름과 연결된 것처럼 보일 수 있습니다. 이것은 이 

제수정되었습니다. 

어떤 상황에서는 시작과 끝에서 다른 목소리에 부착된 노트 부착 줄의 여러 사본을 붙이면 후속 줄이 잘 

못 부착될 수 있습니다. 이것은 이제 수정되었습니다. 

어떤 상황에서는 스태프에 대한 트릴의 배치가 주변에서 음악을 편집할 때 불안정할 수 있습니다. 이것은 이 

제수정되었습니다 

ARM 기반 Windows 시스템에 도리코롤 설치하는 것이 다시 한 번 가능합니다 그러나 도리코는 여전히 

x86 전용입 니 다(Windows 전용). 

D.C. 알 세뇨는 파인 인 플레이백으로 세뇨 마크롤 정확하게 해석합니다. 

글리산도 재생을 위한 지연된 시작 옵션 또는 속성에 의해 발생하는 지연은 이제 피치 벤드를 통해 재생되 

는 굴리산도와 개별 음으로 재생되는 글리산도에서 동일합니다. 

음 위에 있는 원으로 표시된 화성은 이제 하프에서 정확한 음정으로 연주됩니다. 

어떤 상황에서는 페르마타 다음의 간격이 반복되는 악절에서 율바르게 연주되지 않을 것입니다. 이것 

은 이제 해결되었습니다. 

라이브러리 ► 표현 지도롤 통해 표현 지도를 내보낼 때, Dorico는 이제 내보낸 라이브러리 파일의 

표현 지도에 스위치가 창조하는 모든 재생 기술율 올바르게 포함합니다. 

어떤 상황에서는 연주 기법율 괄호로 묶으면 연주 기법의 기호와 텍스트 부분율 둘러싸는 여러 괄호 세트 

가 생성될 수 있습니다. 이것은 이제 수정되었습니다. 

채워진 색상의 배경이 있는 빈 텍스트 프레임은 이제 인쇄되거나 그래픽으로 내보낼 때 다시 한 번 올바 

르게 나타납니다. 
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Component Issue 

Print mode Rehearsal marks with their color overridden via properties now print or export to graphics 

correctly. 

Project files The instrumentation in the factory brass quartet template has been adjusted to the more 

traditional combination of two trumpets, horn, and trombone. 

Project files Importing a flow containing a percussion kit that includes a user-defined instrument no 

longer causes Dorico to crash. 

Proofreading Some issues that only apply to tenor trombones were additionally being reported for bass 

trombones; this has now been fixed. 

Proofreading Dorico no longer warns about the playability of the bottom E flat (written pitch) on bass 

clarinet. 

Proofreading Instruments with empty names are now handled more gracefully in the Proofreading panel. 

Proofreading The whistle tone playing technique is now correctly handled both for flute and voice. 

Proofreading In situations where a harmonic (of any type) could be played with either the left hand or the 

right hand, and one of them was easier than the other, Dorico would sometimes give the 

warning for the more difficult type; this has now been fixed. 

Proofreading Some low-level bugs in the way hand positions were calculated were fixed, particularly 

involving barrés. 

Proofreading The warnings about duplicate or conflicting playing techniques between main and ossia 

staves have been further refined. 

Proofreading Proofreading issues related to stringed instruments are now calculated more quickly in 

general. 

Proofreading Dorico no longer redundantly warns about dynamics on opposite sides of the same staff in 

keyboard music, provided they neither duplicate or contradict each other. 

Proofreading Dorico no longer sometimes redundantly warns about clefs that coincide with repeat barlines. 

Proofreading In large projects, Dorico could hang when proofreading playing techniques; this has now been 

fixed. 

Proofreading Dorico no longer warns when natural harmonics are written for wind instruments, if they are 

valid and can be played. 

Proofreading Dorico now correctly reports ambiguous playing techniques at changes of divisi. 

Tablature The color defined for Unplayable in tablature on the Colors page of Preferences is now 

correctly used. 



성분 

인쇄모드 

프로젝트파일 

프로젝트파일 

검침 

검침 

검침 

검침 

검칭 

검침 

검침 

검침 

검침 

검침 

검침 

검침 

검침 

표 

도리코 6판역사 

문제 

속성을 통해 색상이 무시된 리허설 마크는 이제 그래픽으로 율바르게 인쇄되거나 내보냅니다. 

공장 브라스 콰르텟 템플릿의 악기는 두 개의 트럼펫, 호른, 트롬본의 보다 전통적인 조합으로 조정되 

었습니댜 

사용자 정의 악기가 포함된 타악기 키트가 포함된 흐름을 가져오면 더 이상 도리코가 충돌하지 않습니 

다. 

테너 트롬본에만 해당되는 일부 문제가 베이스 트롬본에 대해서도 보고되고 있었습니다. 이는 이제 해 

결되었습니다. 

도리코는 더 이상 베이스 클라리넷에서 바닥 E플랫(작성 음정)의 연주 가능성에 대해 경고하지 않습 

니댜 

이름이 비어 있는 악기는 이제 프루프 리딩 패널에서 더 우아하게 처리됩니다. 

휘슬 톤 연주 기술은 이제 플루트와 목소리 모두에서 율바르게 다루어졌습니다. 

어떤 유형이든 조화를 연주할 수 있고 그 중 하나가 다른 하나보다 쉬운 상황에서 도리코는 때때로 더 어 

려운 유형에 대해 경고를 하곤 했습니다. 이것은 이제 수정되었습니다. 

손 위치를 계산하는 방식의 일부 저수준의 버그는 특히 바레와 관련하여 고정되었습니다. 

메인 스테이브와 오시아 스테이브 사이의 중복되거나 상충되는 연주 기술에 대한 경고는 더옥 정교해 

졌습니댜 

현악기와 관련된 문제는 이제 일반적으로 더 빠르게 계산됩니다. 

도리코는 더 이상 키보드 음악에서 같은 스태프의 반대쪽에 있는 역학에 대해 중복적으로 경고하지 않습 

니다 단,그들이 서로중복되거나모순되지 않는다면 말입니다. 

도리코는 더 이상 반복되는 바라인과 일치하는 음자리에 대해 중복적으로 경고하지 않습니다. 

큰 프로젝트에서 도리코는 연주 기술을 교정할 때 매달릴 수 있었습니다. 이것은 이제 수정되었습니다. 

도리코는 더 이상 관악기를 위해 자연 화성이 작곡될 때 그것이 유효하고 연주될 수 있다면 경고하지 않습 

니다 

도리코는 이제 디비지를 변경할 때 모호한 연주 기술을 정확하게 보고합니다. 

Preferences의 Colors 페이지에서 표로 재생 불가능하다고 정의된 색상이 이제 올바르게 사용되 
었습니다 
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Component Issue 

Tablature Several subtle problems involving the relative placement of tablature notes and stems in 

multiple voice contexts have been fixed. 

Tablature In some situations, tied notes were not correctly displayed at the ends of runs of bends; this 

has now been fixed. 

Text System-attached text whose style is set to align to the systemic barline now correctly updates 

its horizontal alignment when the casting off changes. 

Ties The behavior of the Consider 'Hide stem' property when positioning tie endpoints option 

has been improved, and now applies in more situations. 

Tremolos Tremolo beams can now be centered between double whole notes (breve) noteheads as well as 

whole note (semibreve) noteheads, if the appropriate option is set. 

User interface The rhythmic grid selector in the Key Editor toolbar now shows a tool tip when hovered. 

User interface The key commands for interacting with issues in the Proofreading panel now appear in a new 

Proofreading category in the Key Commands page of Preferences, rather than (confusingly) 

under Setup. 

  



성분 문제 

표 여러 음성 맥락에서 표음과줄기의 상대적인 배치와관련된 몇 가지 미묘한문제가해결되었습니다. 

표 어떤 상황에서는 묶인 음이 구부러진 부분의 끝에 율바르게 표시되지 않았습니다. 이것은 이제 수정되었 

습니다 

글
 

스타일이 시스템 기준선에 정렬되도록 설정된 시스템 부착 텍스트는 이제 캐스팅 오프가 변경될 때 수평 정 

렬을 을바르게 업 데 이트합니 다. 

넥타01 타이 엔드포인트 옵션을 배치할 때 고려 줄기 숨기기’ 속성의 동작이 개선되었으며 이제 더 많은 상황에 

서적용됩니다 

트레을로스 적절한 옵션이 설정되면 트레올로 빔은 이제 이중 전체 음표(브리브) 노트헤드와 전체 음표(세미브) 노트헤드 

사이에 증심을 잡을 수 있습니 다. 

인터페01스 이제 Key Editor 도구 모음의 리드미컬 그리드 셀렉터는 공중에 맴돌 때 도구 팁을 보여줍니다. 

인터페01스 Proofreading 패널의 문제와 상호 작용하기 위한 주요 명령은 이제 설정 아래에서 (혼란스럽게)가 아닌 기 

본 설정의 주요 명령 페이지의 새로운 Proofreading 범주에 나타납니다. 
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Dorico 6.0.22 

8 July 2025 

Issues resolved 
Component Issue 

Chord symbols Chord symbols no longer unexpectedly move vertically when inputting and editing in galley 

view. 

Chord symbols Propagating properties from chord symbols on staves other than the top staff now works as 

expected once more. 

File import Dorico no longer often crashes either during or immediately after importing a flow, MusicXML 

or MIDI file into an existing project. 

Key Editor The Dynamics editor is now always correctly populated after opening a project. 

Proofreading Ignoring proofreading issues now works correctly in Dorico Elements and Dorico SE. 

Text Text frames that contain no visible text but which have an overridden background color are 

once again correctly shown when printing and exporting graphics. 

  



도리코 6.0.22 

2025년 7월 8일 

과제 

성분 문제 

화음 코드 기호는 갤리 뷰에서 입력 및 편집할 때 더 이상 예상치 못하게 수직으로 움직이지 않습니다. 

화음 오선보 이외의 다른 오선보에셔 코드 기호로부터 속성을 전파하는 것은 이제 다시 한 번 예상대로 작동합 

니다 

파일수입 도리코는 더 이상 기존 프로젝트에 흐름, MusicXML 또는 MIDI 파일을 가져오는 동안이나 직후에 자주 충돌 
하지 않습니다. 

주필 다이내믹스 편집기는 이제 프로젝트롤 시작한 후 항상 올바르게 채워집니다. 

검침 교정 문제를 무시하는 것은 이제 도리코 엘리먼트와 도리코 SE에서 올바르게 작동합니다. 

글
 

눈에 보이는 텍스트는 포함되어 있지 않지만 배경 색상이 무시된 텍스트 프레임은 그래픽을 인쇄하고 내 

보낼 때 다시 한번 올바르게 표시됩니다. 
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Dorico 6.0.20 

29 June 2025 

Highlights 

Proofreading 
Ignoring issues by location. It is now possible to mark issues in the Proofreading panel as 

ignored, which temporarily stops them from appearing in the list. When you hover 

the cursor over an issue, a small eye icon appears in the bottom right-hand corner: 

click this to ignore the issue and temporarily remove it from the list. 

To see all the issues you have ignored, activate the Show ignored checkbox 

immediately above the list. Ignored issues then appear in the list in a dimmed color. 

To un-ignore an ignored issue, click the eye icon again. 

To un-ignore all ignored issues, click the Clear button immediately to the right of 

the Show ignored checkbox. If there are no ignored issues in your project, the Show 

ignored checkbox is disabled. The list of ignored issue locations is saved in the 

project, so ignored issues will not reappear when you next open the project. 

It’s important to understand how this mechanism works, since due to the dynamic 

nature of Dorico’s proofreading feature, when you mark an issue as ignored, you 

are not ignoring a specific issue, but rather ignoring the combination of the location 

where the issue has been identified and the type of reported issue. 

For proofreading, the location is the combination of flow, instrument, and rhythmic 

position (or range of rhythmic positions) where the issue is found. 

Each of the proofreaders that combine to produce the many categories of issues 

shown by Dorico report many different types of issues. Broadly speaking, each 

different textual description in the panel corresponds to a different issue type. 

Ignoring an issue will not prevent issues of other types being reported at that same 

location, but it will prevent another issue of the same type being reported there. 

Every time you edit the score, Dorico runs all the proofreading steps again, and 

there is no connection between the issues discovered on this check and the 

previous one. Dorico filters out combinations of locations and issue types that have 

previously been ignored, so it is possible for a new issue of the same type to be 

discovered but for it not to appear in the list, because it is at a location that has 

previously been ignored. 

This also means that large-scale edits to the musical content or structure of the 

project – for example, adding or removing bars – can result in previously ignored 

issues reappearing, because the relevant music now appears at a new location. 



도리코 6.0.20 

하이라이트 

검침 

도리코 6판역사 

2025년 6월 29일 

위치별 문제 무시. 이제 Proofreading 패널의 문제를 무시된 것으로 표시할 수 있으므로 목록에 표시 

하는 것이 일시적으로 중지됩 니 다. 문제 위에서 커서를 맴돌면 오른쪽 하단에 작은 눈 아이콘이 나타납 

니댜 

이것을 클릭하여 문제를 무시하고 목록에서 일시적으로 제거합니다. 

무시한 모든 문제를 확인하려 면 목록 바로 위에 있는 쇼 무시 체크박스를 활성화하세요. 그러 면 

무시된 문제가 희미한 색상으로 목록에 나타납니다. 

무시된 문제를 무시하지 않으려면 눈 아이콘을 다시 클릭하세요. 

무시된 모든 문제를 무시하려면 바로 표시 무시 체크박스 오른쪽에 있는 지우기 버튼을 클릭하세 

요 프로젝트에 무시된 문제가 없으면 쇼 무시 체크박스가 비활성화됩니다 무시된 문제 위치 목 

록은 프로젝트에 저장되므로 다음에 프로젝트를 열 때 무시된 문제가 다시 나타나지 않습니다. 

이 메커니즘이 어떻게 작동하는지 이해하는 것이 중요합니다. 왜냐하면 도리코의 교정 기능의 역 

동적인 특성 때문에, 문제를 무시하는 것이 아니라, 문제가 확인된 위치와 보고된 문제의 유형의 

조합을무시하기 때문입니다. 

교정을 위해 위치는 문제가 발견되는 흐름, 악기 및 리듬 위치(또는 리듬 위치의 범위)의 조합입니 

다 

도리코가 보여주는 다양한 범주의 문제를 생성하기 위해 결합된 각 교정자는 다양한 유형의 

문제를 보고합니다 일반적으로 말해서, 패널의 각각의 다른 텍스트 설명은 다른 이슈 유형 

에해당합니다 

문제를 무시한다고 해서 같은 위치에서 다른 유형의 문제가 보고되는 것을 막을 수는 없지만, 같 

은 유형의 또 다른 문제가 그곳에서 보고되는 것을 막을 수 있습니 다. 

당신이 악보를 편집할 때마다 도리코는 모든 교정 단계를 다시 실행하며, 이 수표에서 발견된 문 

제와 이전 문제 사이에는 연관성이 없습니다. Dorico는 이전에 무시되었던 위치와 이슈 유형의 

조합을 걸러내기 때문에 동일한 유형의 새로운 이슈가 발견되지만 이전에 무시되었던 위치에 있 

기 때문에 목록에 나타나지 않는 것이 가능합니다. 

이것은 또한 프로젝트의 음악적 내용이나 구조에 대한 대규모 편집, 예를 들어 막대를 추가하 

거나 제거하면 이전에 무시되었던 문제가 다시 나타날 수 있음을 의미합니다. 관련 음악이 이 

제 새로운 위치에 나타나기 때문입니다. 
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Conversely, issues that previously appeared may disappear from the list because 

they now fall at previously ignored locations. 

It is therefore advisable to ignore issues only when you are towards the end of the 

preparation process for your project. If you make large-scale changes to the flow, 

consider clearing ignored issues to make sure you don’t miss details that arise 

because of those changes. 

Keyboard navigation. New commands have been added to the Setup category in the Key 

Commands page of Preferences to allow you to interact with the Proofreading 

panel using the keyboard. Commands for navigating to the previous and next 

issues, ignoring an issue (or un-ignoring it, if ignored issues are shown), and 

clearing ignored issues are provided. 

Cantai support 
Dorico 6.0.20 provides initial support for the Cantai vocal synthesis plug-in in 

development by Turing Opera Workshop. To use the Cantai plug-in, add one 

instance to the VST and MIDI panel in Play mode for each voice instrument you 

want to be played by Cantai. In the Track Inspector panel, use the controls in the 

Routing section to connect each Cantai instance to the appropriate voice. The final 

step is to open the Cantai interface by clicking the Show Instrument button (which 

looks like a lowercase e) and choosing the appropriate instrument from the drop-

down in the plug-in interface. 

When you edit the music or lyrics on an instrument assigned to Cantai, Dorico 

updates a data file in the shared location that is automatically read by Cantai, and 

which then updates the vocal synthesis. 

For more information about Cantai, visit its web site at cantai.app. 

Improvements 

Barlines 
Wings on repeats. A new Show wings property has been added for repeat barlines, 

allowing you to override on a per-barline basis whether wings should appear. 

Bar numbers 
Bar number ranges below multi-bar rests. Bar number ranges below multi-bar rests are 

by default positioned below the staff using the Bar number range distance below 

staff option on the Rests page of Engraving Options. If you want to show bar 

number ranges at the same position relative to the staff as bar numbers shown on 

every bar, this presents a problem, as of course engraving options are global and 

apply to all layouts. 



개선점 
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반대로, 이전에 나타났던 문제는 이제 이전에 무시되었던 위치에 해당하기 때문에 목록에서 사 

라질수있습니다. 

따라서 프로젝트 준비 과정이 거의 끝나갈 때만 문제를 무시하는 것이 좋습니다. 흐름을 크게 

변경하는 경우 무시된 문제를 제거하여 이러한 변경으로 인해 발생하는 세부 사항을 놓치지 않 

도록 하십시오. 

키보드 탐색 키보드를 사용하여 Proofreading 패널과 상호 작용할 수 있도록 설정 항목에 새로운 명 

령이 추가되었습니 다 이전 및 다음 문제로 탐색하기, 문제 무시(또는 무시된 문제가 표시되는 경우 무 

시 해제) 및 무시된 문제를 제거하기 위한 명령이 제공됩니다. 

칸타이지지 

71준선 

도리코 6.0.20은 튜링 오페라 워크숍에서 개발 중인 칸타이 보컬 합성 플러그인에 대한 초기 지 

원을 제공합니다 칸타이 플러그인을 사용하려면 칸타이에서 연주하고자 하는 각 성악기에 대해 

플레이 모드의 VST 및 MIDI 패널에 인스턴스를 하나씩 추가하세요. 트랙 검사기 패널에서 라우 

팅 섹션의 컨트롤을 사용하여 각 칸타이 인스턴스를 적절한 음성에 연결합니다. 마지막 단계는 

Show Instrument 버튼(소문자 e처럼 보이는)을 클릭하고 플러그인 인터페이스의 드롭다운에 

서 적절한 악기를 선택하여 칸타이 인터페이스를 여는 것입니다. 

칸타이에 할당된 악기에 음악이나 가사를 편집하면, 도리코는 칸타이가 자동으로 읽는 공유 위 

치의 데이터 파일을 업데이트하고, 이를 통해 보컬 합성을 업데이트합니다. 

칸타이에 대한 자세한 내용은 웹사이트 cantai.app을 방문하세요. 

반복되는 날개. 반복되는 날개에 대해 새로운 쇼 날개 속성이 추가되어 날개가 나타나야 하는 

지 여부를 각 줄별로 무시할 수 있습니 다. 

Ut코드 

막대 번호 범위는 다중 막대 받침대 아래에 있습니다. 다중 막대 받침대 아래의 막대 번호 범위는 기 

본적으로 각인 옵션의 중지 페이지에서 막대 번호 범위 옵션 아래의 막대 번호 범위 거리를 사용하 

여 스태프 아래에 위치합니다. 모든 막대에 표시된 막대 번호와 동일한 위치에 막대 번호 범위를 표 

시하려면 각인 옵션이 전역적이며 모든 레이아웃에 적용되기 때문에 문제가 발생합니다. 
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To address this, a new Distance for bar number range below staff option has been 

added to the Multi-bar Rests section of the Rests page of Engraving Options. This 

can now be set to Layout Options, which means that Dorico will then position bar 

number ranges using the Minimum distance from staff option on the Bar 

Numbers page of Layout Options. 

Position relative to clef. A new option Minimum gap above treble G clef with 8 above n 

spaces has been added to the Clefs section of the Bar Numbers page of Engraving 

Options. This option also applies to a treble G clef with 15 above. Relatedly, the 

existing option Minimum gap below treble G clef with 8 below n spaces now also 

applies to a treble clef with 15 below. 

Chord diagrams 
Ukulele chord diagrams. The default chord shapes for chord diagrams for the standard 

ukulele tuning now more closely match the recommendations of the Ukulele 

Society of Great Britain for commonly used chords. 

Editing chord diagrams. In previous versions of Dorico, editing an existing factory chord 

shape would always add a whole new chord shape to the project’s library, which 

could quickly lead to a very large number of diagrams in the library. Now, when you 

edit a factory chord shape, Dorico effectively replaces the factory shape with your 

edited shape, so you will see your preferred version instead of the factory one. You 

can revert to the factory shape by clicking the Revert to Factory button in the action 

bar in Library ▶ Chord Diagrams. 

Chord symbols 
Capo chord symbols. A new option Scale factor for capo chord symbols n% has been 

added to the Capo section of the Chord Symbols page of Engraving Options. This 

allows you to specify that capo chord symbols should be made smaller than the 

corresponding main chord symbols. It is also now possible to specify that capo 

chord symbols should be neither shown in italics nor shown in parentheses if 

desired. 

Alignment and collision avoidance. With the addition of multiple lines of chord symbols, 

and chord symbols themselves being able to show extender lines, it was necessary 

to revamp collision avoidance for chord symbols and chord diagrams in this 

release. 

Chord symbols and their extender are now treated as a single unit – previously, it 

was possible for extender lines to become detached from the chord symbols to 

which they belong – and when Align chord symbols across the width of the 

system is activated, Dorico aligns all lines of chord symbols across the width of the 

system together. When alignment across the system is not activated, Dorico instead 
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이를 해결하기 위해 각인 옵션의 Rests 페이지의 다중 막대 Rests 섹션에 직원 옵션 아래의 막 

대 번호 범위에 대한새로운거리가추가되었습니다. 이제 이것은 레이아웃옵션으로설정할수 

있습니다 이는 도리코가 레이아웃 옵션의 막대 번호 페이지에서 직원으로부터의 최소 거리 옵션 

을 사용하여 막대 번호 범위를 배치한다는 것을 의미합니다. 

Clef에 대한 위차 8 이상의 고음 G Clef 위의 최소 간격이 있는 새로운 옵션이 n개의 간격이 있는 

Clef 섹션에 추가되었습니다. 이 옵션은 15 이상의 고음 G Clef에도 적용됩니다. 이와 관련하여 기 

존 옵션인 최소 간격이 8 미만인 고음 G Clefn 간격이 15 미만인 고음 G Clef에도 적용됩니다. 

코드도 

화음 

우쿨렐레 코드 다이어그램. 표준 우클렐레 튜닝을 위한 코드 다이어그램의 기본 코드 모양은 이제 

일반적으로사용되는코드에 대한영국우쿨렐레 협회의 권장사항과 더 가깝습니다. 

코드 다이어그램 편집. 이전 버전의 도리코에서는 기존 공장 코드 모양을 편집하면 항상 프로젝트의 

라이브러리에 완전히 새로운 코드 모양이 추가되므로 라이브러리에 매우 많은 수의 다이어그램이 있 

을 수 있습니다. 이제 공장 코드 모양을 편집할 때 도리코는 공장 모양을 편집된 모양으로 효과적으로 

대체하므로 공장 모양 대신 선호하는 버전을 볼 수 있습니다. 되돌리기를 클릭하여 공장 모양으로 되돌 

릴 수 있습니다. 라이브러리의 액션 바에 있는 팩토리 버튼은코드 다이어그램 ►. 

카포 코드 기호. 카포 코드 기호에 대한 새로운 옵션 스케일 팩 터가 n% 각인 옵션의 코드 기호 페이 

지의 카포 섹션에 추가되었습니다. 이를 통해 카포 코드 기호가 해당 주요 코드 기호보다 작게 만들 

어져야 함을 지정할수 있습니다. 또한 이제 카포 코드 기호가 이탤릭체로 표시되거나 원하는 경우 

괄호 안에 표시되어서는 안 된다는 것을 지정할수 있습니다. 

정렬 및 충돌 회피. 코드 기호가 여러 줄 추가되었고 코드 기호 자체가 확장선을 보여줄 수 있기 때 

문에 이번 릴리스에서 코드 기호와코드 다이어그램에 대한충돌회피를개선할필요가 있었습니다. 

코드 기호와그확장기는 이제 단일 단위로취급됩니다. 이전에는확장기 선이 그들이 속한코드 

기호에서 분리되는 것이 가능했습니다. 그리고 시스템 너비에 걸친 정렬 코드 기호가 활성화되면 

도리코는 시스템 너비에 걸친 모든 코드 기호 라인을 함께 정렬합니다. 시스템 전반에 걸친 정렬 

이 활성화되지 않으면 도리코가 대신 
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performs collision avoidance for chord symbols at the same rhythmic position, and 

at any other rhythmic positions affected by chord symbols’ extender lines. 

A new Avoid collisions option has been added to the Position section of the Chord 

Symbols page of Engraving Options, allowing you to determine whether chord 

symbols should avoid collisions with the staff and objects protruding from the staff 

by default; this can be overridden for individual chord symbols using the 

corresponding Avoid collisions property. 

Crosshair. The position of the crosshair for a selected chord symbol in Engrave mode has 

been improved. It is now correctly aligned with the baseline of the lower chord 

symbol (or the bottom of the chord diagram, if one is shown). This makes it easier to 

check the alignment of chord symbols across the width of the system. 

Vertical placement of extender line. When main and transposed chord symbols are 

shown, extender lines appear only once, on whichever chord symbol is closest to 

the staff. Similarly, when a chord diagram is shown, the extender line is centered 

vertically on the chord symbol immediately outside the extender line. 

Resetting kerning edits. In Library ▶ Chord Symbol Kerning Pairs, the Reset and Delete 

buttons now show a warning before carrying out the expected actions. 

Cues 
Ornaments. Jazz articulations and glissando lines are now included or excluded in cues 

according to the engraving option and property for the inclusion of ornaments in 

cues. 

Filters 
Filtering by pitch. A new Edit ▶ Filter ▶ Notes by Pitch submenu has been added, where 

the existing Notes by Pitch dialog is now called Specific Pitches. Additional 

commands for filtering notes expressed as triple sharps, double sharps, double 

flats, and triple flats have been added alongside the existing filters for all sharp and 

flat notes.  

Fonts 
Updated font families. Splentino version 1.1 and Nepomuk version 2.6 both now include 

tabular figures, which can be enabled via OpenType features. 

Lyrics 
Custom hanging punctuation. A new option Extra punctuation to ignore has been added 

to the Spacing section of the Lyrics page of Engraving Options. This allows you to 

specify additional characters that Dorico should treat as punctuation when aligning 

lyrics. 



단서 

필터 

서체 

작사 
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동일한 리듬 위치에서 코드 기호에 대해 충돌을 방지하고, 코드 기호의 연장선에 영향을 받는 다 

른 리듬 위치에서도 층둘을 방지합니다. 

새로운 충돌 회피 옵션이 새겨진 옵션의 코드 기호 페이지의 위치 섹션에 추가되어 코드 기호가 

기본적으로 오선보 및 오선보에서 돌출된 물체와의 충돌을 피해야 하는지 여부를 결정할 수 있습 

니다 이는 해당 충돌 회피 속성을 사용하여 개별 코드 기호에 대해 무시될 수 있습니다. 

십자선 Egrve 모드에서 선택된 코드 기호에 대한 십자선의 위치가 개선되었습니다 이제 하단 코드 

기호의 기준선(또는 코드 다이어그램의 하단)과 올바르게 정 렬되었습니 다. 이를 통해 시스템의 너 비 

에 걸친 코드 기호의 정렬을 더 쉽게 확인할 수 있습니다. 

확장선의 수직 배치. 주 코드 기호와 전치 코드 기호가 표시될 때 확장선은 어느 코드 기호가 오선 

에 가장 가까운 곳에 한 번만 나타납니다. 마찬가지로 코드 다이어그램이 표시될 때 확장선은 확장 

선 바로 밖에 있는 코드 기호에 수직으로 증심에 있습니 다. 

커닝 편집 재설정 라이브러리 ► 코드 심볼 커닝 페어에서 재설정 및 삭제 버튼은 이제 예상되는 

작업을 수행하기 전에 경고를 표시합니다. 

장식품. 재즈 아티큘레이션과 글리산도 라인은 이제 각인 옵션과 큐에 장식품을 포함하기 위한 속 

성에 따라큐에 포함되거나제외됩니다. 

피치별 필터링. 새로운 편집 ► 필터 ► 음정별 음정 하위 매뉴가 추가되었으며, 여기서 기존의 음정 

별 대화는 이제 특정 음정이라고 불립니다. 모든 음정별 음정에 대한 기존 필터와 함께 트리플샤프, 더 

블 샤프, 더블 플랫, 트리플플랫으로표현되는 음정을 필터링하기 위한추가 명령이 추가되었습니다. 

업데이트된 폰트 제품군. 스플렌티노 버전 1.1 과 네포묵 버전 2.6에는 모두 표 모양의 그림이 포함 

되어 있으며, 이는 OpenType 기능을 통해 활성화될 수 있습니 다. 

맞춤형 매달림 구두점. 새로운 옵션:각화 옵션의 가사 페이지 띄어쓰기 섹션에 무시할 추가 구두점이 

추가되었습니다 이를 통해 가사를 정렬할 때 도리코가 구두점으로 처리해야 할 추가 문자를 지정할 

수있습니다 
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Note input 
Multi-paste. When the caret is extended across multiple staves, Dorico now pastes 

across all the staves within the span of the caret; previously, material would be 

pasted only on the top staff. 

Pedal lines 
Offset of Ped. text. A new Offset for start of pedal line with text n spaces option has 

been added to the Advanced Options section of the Horizontal Position section of 

the Pedal Lines page of Engraving Options. This allows you to specify a horizontal 

offset for the Ped. text at the start of a pedal line, to allow fine positioning of the 

vertical stroke of the initial P, analogous to the existing option for offsetting the 

ornate P. 

Playback 
Playback updates. After each edit that changes the musical content of the flow, Dorico 

recalculates the playback information for the affected instrument or instruments. 

This normally takes only a fraction of a second, but in long flows, or flows with many 

changes of playback technique, or when your playback template uses complex 

expression maps with many switches, it can take a little longer. This can result in 

Dorico feeling a little less responsive when inputting and editing in such projects. 

To address this, Dorico now delays the recalculation of playback information until 

the application is idle for a moment, reducing the impact on the responsiveness of 

the application. 

Project templates 
Barbershop quartet template. The Barbershop quartet project template in the Choir 

category on the Create New page of the Hub has been improved to more closely 

match the notation guidelines published by the Barbershop Harmony Society 

(BHS), the leading organization for the promotion of barbershop singing in the US. 

The template now uses the expected two-staff short score instead of an open score 

written on four staves, and follows as closely as possible the recommendations for 

frequency of bar numbers, choices of fonts, and so on. 

Choral templates. All templates in the Choir category in the Hub now create projects with 

only a full score layout, and no part layouts, since these are normally not required. If 

you want to create part layouts in such a project, use Setup ▶ Create Default Part 

Layouts. 

  



도리코 6판역사 

노트 

페달 

재생 

다중 붙여넣기. 카렛이 여러 개의 오선지를 가로질러 확장되면 도리코는 이제 카렛의 범위 내에 

있는 모든 오선지를 붙여넣습니다. 이전에는 재료를 상단 스태프에만 붙여넣었습니다. 

Ped의 오프셋. 텍스트. 텍스트가 있는 페달 라인 시작을 위한 새로운 오프셋 n개의 간격 옵션이 각 

인 읍션 페이지의 수평 위치 섹션의 고급 옵션 섹션에 추가되었습니다. 이를 통해 페달 라인 시작 시 

Ped. 텍스트에 대한 수평 오프셋을 지정할 수 있으며, 기존 옵션과 유사하게 초기 P의 수적 스트로 

크를 미세하게 배치할 수 있습니다. 

재생 업데이트. 흐름의 음악적 내용을 변경하는 각 편집 후에 도리코는 영향을 받은 악기나 악기에 

대한 재생 정보를 다시 계산합니 다. 

이것은 보통 몇 분의 1 초밖에 걸리지 않지만, 긴 흐름이나 재생 기술의 변화가 많은 흐름에서는, 

또는 재생 템플릿이 많은 스위치가 있는 복잡한 표현 지도를 사용할 때는 시간이 조금 더 걸릴 수 

있습니다 이로 인해 도리코가 이러한 프로젝트를 입력하고 편집할 때 반응이 조금 떨어질 수 있 

습니댜 

이를 해결하기 위해 도리코는 이제 애플리케이션이 잠시 유휴 상태가 될 때까지 재생 정보의 

재계산을 지연시켜 애플리케이션의 응답성에 미치는 영향을 줄입니다. 

프로젝트템플릿 

Barbershop Quet template. Hub의 Create New 페이지에 있는 Barbershop Quetet 프로젝 

트 템플릿은 미국의 Barbershop Singing 진흥을 위한 선도적인 단체인 BHS(Barbershop 

Harmony Society)에서 발행한 표기 지침과 더 가깝게 개선되었습니다 

템플릿은 이제 4개의 오선지에 적힌 열린 악보 대신 예상되는 2개의 오선지 짧은 악보를 사용하 

며, 막대 수의 빈도, 글꼴 선택 등에 대한 권장 사항을 가능한 한 가깝게 따릅니다. 

합창 템플릿입니다 허브의 합창단 카테고리에 있는 모든 템플릿은 이제 전체 악보 레이아웃만 있고 

부분 레이아웃은 필요하지 않기 때문에 프로젝트를 만듭니다. 이러한 프로젝트에서 부분 레이아웃을 

만들려면 설정 ► 사용하여 기본 부분 레이아웃을 만들십시오. 
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Issues resolved 
Component Issue 

Accidentals The positioning of natural accidentals to the left of unshortened ledger lines has been further 

improved. 

Bar numbers Bar number ranges consisting of a single bar no longer incorrectly appear below multi-bar 

rests. 

Bar numbers Adding a clef change now immediately updates the vertical position of bar numbers shown 

above or below the clef at the start of following systems. 

Chord diagrams Dorico no longer incorrectly resets the chord diagram back to the nut when editing it. 

Chord diagrams Sometimes, when adding a chord diagram to the project, its fingering could be incorrectly 

updated; this has now been fixed. 

Chord symbols When Apply to All Roots is set for an existing customized chord symbol appearance, Dorico 

now removes any changes made to the root accidental appearance, as this will no longer 

apply. 

Chord symbols Dorico no longer incorrectly considers chord symbols in different lines when determining 

how much horizontal space is required. 

Chord symbols When cycling through roots for a chord symbol appearance that applies to all roots, if root 

accidentals have superscript or subscript positions, the remaining appearance is no longer 

incorrectly vertically offset. 

Chord symbols Chord symbols with extender lines that span more than one system break now appear 

correctly on all systems. 

Chord symbols Chord symbol extender lines no longer incorrectly cause cutaways to end. 

Chord symbols It is now possible to edit the kerning of chord symbols using Nashville root appearances. 

Chord symbols Adjustments to the position of sub-components in chord symbols set to apply to all roots are 

no longer unexpectedly lost when cycling through roots. 

Comments Under rare circumstances, Dorico could crash when selecting a comment; this has now been 

fixed. 

Comments Dorico now correctly sanitizes project and layout names that are used when building the file 

name for exported comments, to ensure the file is exported correctly. 

Coordination lines Coordination lines are now correctly erased when Erase background is set on a text item or 

dynamic. 

Dynamics Editing an mfz dynamic in the popover no longer incorrectly shows mfzz as the popover text. 



과제 

성분 

변고 

1::1~코드 

HE코드 

코드도 

코드도 

화음 

화음 

화음 

화음 

화음 

화음 

화음 

댓글 

대= 
^三

조정선 

역동성 
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문제 

짧아지지 않은 장부 선의 왼쪽에 자연 사고의 위치가 더욱 개선되었습니다. 

단일 막대로 구성된 막대 수 범위는 더 이상 다중 막대 받침대 아래에 잘못 나타나지 않습니다. 

이제 음표 변경을 추가하면 다음 시스템을 시작할 때 음표 위 또는 아래에 표시된 막대 숫자의 수직 위치 

가즉시 업데이트됩니다. 

도리코는 코드 다이어그램율 편집할 때 더 이상 코드 다이어그램을 다시 너트에 잘못 설정하지 않습니다. 

때때로 프로젝트에 코드 다이어그램을 추가할 떄 운지가 잘못 업데이트될 수 있습니다. 이것은 이제 수정 

되었습니댜 

기존의 맞춤형 코드 기호 모양에 대해 모든 루트에 적용하기 설정이 되면, 도리코는 이제 루트의 우연한 

모양에 대한 변경 사항을제거합니다. 이는 더 이상적용되지 않기 때문입니다. 

도리코는 더 이상필요한수평 공간을 결정할 때 다른 줄의 코드 기호를잘못고려하지 않습니다. 

모든 루트에 적용되는 코드 기호 모양을 위해 루트를 순환할 때, 루트 우연이 위 첨자 또는 아래 첨자 위치 

률 가지고 있으면 나머지 모양이 더 이상 수직으로 잘못 오프셋되지 않습니다. 

하나 이상의 시스템 파손에 걸쳐 있는 익스텐더 선이 있는 코드 기호는 이제 모든 시스템에 올바르 

게 나타납니다. 

코드 심볼 익스텐더 라인은 더 이상 컷어웨이가 끝나지 않게 합니다. 

이제 내슈빌 루트 모양을 사용하여 코드 기호의 커닝을 편집할 수 있습니다. 

모든 뿌리에 적용되도록 설정된 코드 기호에서 하위 구성 요소의 위치에 대한 조정은 더 이상 뿌리를 통과 

할 때 예기치 않게 손실되지 않습니다. 

드문 상황에서 도리코는 댓글을 선택할 때 충돌할 수 있습니다. 이것은 이제 수정되었습니다. 

이제 Dorico는 파일이 올바르게 내보내지도록 파일 이름을 만들 때 사용되는 프로젝트 및 레이아웃 이름을 

율바르게 새너마이징합니다. 

이제 텍스트 항목이나 동적 항목에 지우기 배경이 설정되면 조정 라인이 올바르게 지워집니다. 

mfz 다이내믹율 편집하면 더 이상 팝오버 텍스트로 mfzz가 잘못 표시되지 않습니다 
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Component Issue 

Dynamics Combined dynamics that start or end with mf or mp now have the correct effect in playback. 

Engrave mode It is now possible to assign key commands to toggle rulers and grids in Engrave mode so that 

those shortcuts can also be correctly assigned in other modes. 

Engrave mode Drag handles for gradual dynamics are now the correct size while dragging in Engrave mode. 

Graphics export Adding file name ingredients in the Export File Names dialog no longer sometimes incorrectly 

adds a separator. 

Jump bar Options that show a choice of language no longer show languages not currently available in 

Dorico. 

Library Manager Sometimes, Dorico would crash when closing a project with the Library Manager open; this 

has now been fixed (Windows only). 

Library Manager Applying layout options to all layouts, or notation options to all flows, from a library file (rather 

than a project file) in the Library Manager now works correctly. 

Library Manager Dorico now correctly prevents you from using an already open project as the source project in 

the Library Manager. 

Lines The Rotation option for music symbol-based line annotations is now correctly saved and 

loaded. 

Localization The translations of token placeholders and key signature signposts have been improved in 

Italian. 

Localization The {@dateDMY@} token now correctly shows a period (full stop) after the day number in 

German. 

Localization The order in which categories are listed in Dorico’s main options dialog now correctly 

considers accented characters. 

MIDI export Controller changes are no longer exported on a different channel to their corresponding notes 

for channel 10 and above. 

Music symbols Under some circumstances, adding a glyph to a music symbol would incorrectly use a font 

other than the one chosen in the Glyph panel on the right-hand side, due to a problem with 

matching up existing font styles; this has now been fixed. 

Music symbols Glyphs are no longer sometimes incorrectly offset in the music symbols editor. 

Music symbols When opening projects created in earlier versions, the scale factor for existing components is 

now always shown correctly in the editor. 

MusicXML import Circled noteheads are now correctly imported from MusicXML files. 



성분 문제 

역동성 mf또는 mp 로 시작하거나끝나는 결합된 역학은 이제 재생에서 올바른 효과를 냅니다 

앵그레이브모드 이제는 인그레이브 모드에서 자와 그리드를 토굴하기 위해 주요 명령을 할당할 수 있으므로 이러한 단축키 

가 다른 모드에서도 올바르게 할당될 수 있습니다. 

앵그레이브모드 점진적인 역학을 위한드래그 핸들은 이제 인그레이브 모드에서 드래그하는 동안 올바른 크기가 됩니다. 

그래픽수출 내보내기 파일 이름 다이얼로그에 파일 이름 성분을 추가하면 더 이상 분리자가 잘못 추가되지 않습니다. 

철봉 언어 선택을 보여주는 옵션은 현재 도리코에서 사용할 수 없는 언어를 더 이상 표시하지 않습니다. 

도서관장 때때로 도리코는 라이브러리 관리자가 열린 상태에서 프로젝트를 종료할 때 충돌하곤 했습니다. 이것은 

이제 수정되었습니다 (윈도우 전용). 

도서관장 라이브러리 관리자의 라이브러리 파일(프로젝트 파일이 아닌)에서 모든 레이아웃에 레이아웃 옵션을 적용하 

거 나 모든 흐름에 표기 옵션을 적용하면 이제 율바르게 작동합니 다. 

도서관장 이제 Dorico는 라이브러리 매니저에서 이미 공개된 프로젝트를 소스 프로젝트로 사용하지 못하게 올바르 

게 방지합니다. 

선
 

음악 기호 기반 라인 주석에 대한 회전 옵션은 이제 올바르게 저장되고 로드됩니다. 

국산화 토큰 폴레이스휼더와 주요 서명 표지판의 번역이 이탈리아어로 개선되었습니다. 

국산화 {@dateDMY@｝토큰은 이제 독일어로 날짜 번호 뒤에 마침표(완전 정지)를 정확하게 표시합니다. 

국산화 도리코의 주요 옵션 대화에서 카테고리가 나열되는 순서는 이제 악센트가 있는 문자를 올바르게 고 

려합니댜 

수출 컨트롤러 변경 사항은 더 이상 다른 채널에서 채널 10 이상에 대한 해당 메모로 내보내지지 않습니다. 

악보 어떤 상황에서는 음악 기호에 글립을 추가하면 기존 글립 스타일을 일치시키는 문제로 인해 오른쪽에 있 

는 굴립 패널에서 선택한 글립이 아닌 다른 글립을 잘못 사용하게 됩니다. 이것은 이제 수정되었습니다. 

악보 굴리프는 더 이상 음악 기호 편집기에서 잘못 상쇄되지 않습니다. 

악보 이전 버전에서 생성된 프로젝트롤 열 때 기존 구성 요소에 대한 스케일 계수가 항상 편집기에 율바르게 표 

시됩니댜 

뮤직XML 수입 동그라미 노트헤드는 이제 MusicXML 파일에서 율바르게 가져왔습니다 
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Component Issue 

Note input Under some circumstances, it was possible for Dorico to hang indefinitely when confirming 

the Shift+I note tools popover; this has now been fixed. 

Note input Dorico no longer allows you to paste staff count change signposts onto instruments where 

they would be invalid. 

Note input Retrospective Record now always adds the recorded music in the correct position, regardless 

of any existing selection in the flow. 

Note input When advancing the popover quickly in chord symbol, lyric, fingering, or figured bass input, 

Dorico would sometimes crash; this has now been fixed. 

Ossias Activating Show ossia staves on the Staves and Systems page of Layout Options now 

correctly immediately updates the layout. 

Percussion It is no longer possible to add slash instruments to a percussion kit using the Add Instrument 

to Kit button that shows the regular picker; instead, slash instruments must be added using 

the dedicated buttons in the action bar. 

Percussion The Grace notes follow default stem direction option in the Single-line Percussion section of 

the Percussion page of Engraving Options now works correctly for beamed groups of grace 

notes. 

Playback Switch actions defined in expression maps are now correctly played when the first note of the 

flow has a start offset. 

Playback The Pre-roll before flow value on the Timing page of Playback Options is now always correctly 

applied immediately after a project is opened. 

Playing techniques If the standard appearance of a playing technique is parenthesized, Dorico no longer 

incorrectly adds a second set of parentheses when the Parenthesized property is activated. 

Playing techniques Overrides to the color of an individual glyph or text item within a playing technique are now 

respected. 

Project files Under some circumstances, existing projects would be marked dirty immediately after 

opening them; this has now been fixed. 

Proofreading Dorico has a more nuanced understanding of how artificial harmonics can be played on 

fretted instruments, and no longer incorrectly warns about stretches that are too great. 

Proofreading Dorico no longer sometimes incorrectly identifies otherwise identical clefs as differing by 

their octave indicator. 

Proofreading Dorico no longer sometimes incorrectly identifies chords where the hand is forced up the 

neck of a stringed instrument. 
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문제 

어떤 상황에서는 Shift+| 노트 도구 팝오버를 확인할 때 도리코가 무기한 매달리는 것이 가능했습니다. 

이것은 이제 수정되었습니다. 

도리코는 더 이상 유효하지 않은 악기에 직원 수 변경 표지판을 붙일 수 없습니다. 

회고전 레코드는 이제 흐름의 기존 선곡에 관계없이 항상 정확한 위치에 녹음된 음악을 추가합니다. 

코드 기호, 가사, 운지법 또는 베이스 입력으로 팝오버를 빠르게 진행할 때, 도리코는 때때로 충돌하곤 했 

습니다 이것은 이제 수정되었습니다 

활성화 레이아웃 옵션의 스테이브 및 시스템 페이지에서 오시아 스테이브를 표시하면 레이아웃이 

측시 올바르게 업데이트됩니다. 

일반 피커를 보여주는 추가 악기 버튼을 사용하여 타악기 키트에 슬래시 악기를 추가하는 것은 더 이상 불 

가능합니다. 대신 액션 바의 전용 버튼을 사용하여 슬래시 악기를 추가해야 합니다. 

그레이스 노트는 이제 그레이빙 옵션의 타악기 페이지의 단일 줄 타악기 섹션에 있는 기본 스템 방향 옵션 

을따릅니다 

표현식 맵에 정의된 스위치 동작은 이제 흐름의 첫 음이 시작 오프셋을 가질 때 올바르게 재생됩니다. 

Playback Options의 Timing 페이지에 있는 Pre-roll Before flow 값은 이제 프로젝트가 열린 직후에 항 

상 올바르게 적용됩 니 다. 

연주 기술의 표준 모양이 괄호로 표시되면, 도리코는 괄호 속성이 활성화될 때 더 이상 두 번째 괄호 세트 

를 잘못 추가하지 않습니 다. 

이제는 연주 기법 내의 개별 문자나 텍스트 항목의 색상을 무시하는 것이 존중됩니다. 

어떤 상황에서는 기존 프로젝트가 오픈 직후에 더럽게 표시될 수 있습니다. 이것은 이제 수정되었습 

니다 

도리코는 인공 화성이 어떻게 프렛 악기에서 연주될 수 있는지에 대해 더 미묘한 이해를 가지고 있으 

며, 더 이상 너무 큰 스트레치에 대해 잘못 경고하지 않습니다. 

도리코는 더 이상 동일한 음자리표를 옥타브 지시자가 다른 것으로 잘못 식별하지 않습니다. 

도리코는 더 이상 현악기의 목 위로 손이 올라가는 코드를 잘못 식별하는 경우가 없습니다. 
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Component Issue 

Proofreading Dorico no longer sometimes incorrectly complains about combined dynamics that end in mf 

or mp. 

Proofreading Dorico now flags up playing techniques with a duration that do not coincide with a note onset 

position. 

Proofreading The handling of playing techniques that use the underlying Natural playback technique has 

been significantly improved, leading fewer false positives. 

Proofreading Dorico now correctly considers the repeat structure when deciding whether to warn about 

missing dynamics at an instrument’s new entry. 

Proofreading Dorico would not always navigate to the correct position when clicking a result in the 

Proofreading panel, if staves are hidden; this has now been fixed. 

Proofreading Dorico no longer incorrectly warns about duplicated playing techniques when the same 

playing technique is also written in an ossia. 

Properties The subheadings for articulations of duration, force, and stress now once again appear 

correctly in the Properties panel. 

Repeat endings Creating a repeat ending from a selection consisting of a mixture of notes, rests, and either 

bar repeat or slash regions now works as expected. 

Staff labels The Period (full stop) after abbreviated instrument names option on the Staff Labels page of 

Engraving Options no longer adds spurious periods (full stops) to staff labels using short 

player names. 

Tempo The gap between a tempo mark and its associated metronome mark no longer depends on the 

space size of the staff on which it appears. 

Tempo Gradual tempo changes that cross instrument changes appear correctly once more. 

Text The Insert Music Text dialog now once again shows the All ranges choice at the top of the list 

of glyph ranges. 

Text Text token placeholders on the same line as regular text no longer incorrectly appear even 

when the option to show them is deactivated. 

Text When exporting text from the project in CSV format, tempo and metronome marks now 

correctly reflect how parentheses appear in the score itself. 

Tuplets The Scale factor for digits/notes in tuplet ratio options in the Number and Ratio section of 

the Tuplets page of Engraving Options now work as expected once more. 



성분 문제 

검침 mf또는 mp로끝나는 결합역학에 대해 도리코는 더 이상잘못불평하지 않습니다 

검침 도리코는 이제 음 시작 위치와 일치하지 않는 지속 시간으로 연주 기술을 강화합니다. 

검침 기본적인 Natural 재생 기술을 사용하는 재생 기술의 처리가 크게 향상되어 잘못된 긍정이 줄어들었습니 
댜 

검침 이제 도리코는 악기의 새로운 진입 시 누락된 역학에 대해 경고할지 여부를 결정할 때 반복 구조룔 올바 

르게 고려합니다. 

검침 스테이브가 숨겨져 있는 경우, 도리코는 Proofreading 패널에서 결과를 클릭할 때 항상 올바른 
위치로 이동하지 않습니다. 이것은 이제 수정되었습니다. 

검칩 도리코는 같은 연주 기법이 골화로 쓰여질 때 더 이상 중복된 연주 기법에 대해 잘못 경고하지 않습니 

다. 

부동산 지속 시간, 힘 및 응력의 표현에 대한 소제목이 이제 속성 패널에 다시 한 번 올바르게 나타납니다. 

어미 음표, 쉼표, 막대 반복 또는 슬래시 영역의 혼합으로 구성된 선택에서 반복 끝을 만드는 것은 이제 예상대 

로 작동합니다. 

라벨 인그레이빙 옵션의 스태프 레이블 페이지에 있는 악어 악기 이름 옵션 이후의 마침표(완전 정지)는 더 이상 짧 

은 폴레이어 이름을 사용하여 스태프 레이블에 가짜 마침표(완전 정지)를 추가하지 않습니다. 

템포 템포 표시와 관련 매트로놈 표시 사이의 간격은 더 이상 나타나는 스태프의 공간 크기에 의촌하지 않습니다. 

템포 악기 변화를 가로지르는 점진적인 템포 변화가 한 번 더 정확하게 나타납니다. 

굴
 

삽입 음악 텍스트 대화자는 이제 글리프 범위 목록의 맨 위에 있는 모든 범위 선택을 다시 한 번 보여줍니다. 

글
 

일반 텍스트와 같은 줄에 있는 텍스트 토큰 플레이스홀더는 표시 옵션이 비활성화되어도 더 이상 잘못 표 

시되지 않습니다. 

글
 

CSV 형식으로 프로젝트의 텍스트롤 내보낼 때 템포와 메트로놈 표시는 이제 악보 자체에 괄호가 어떻 
게 나타나는지 율바르게 반영합니다. 

쌍둥이 음각 옵션의 튜플렛 페이지의 숫자 및 비율 섹션에 있는 튜플렛 비율 옵션의 숫자/노트에 대한 눈금 계수 

는 이제 다시 예상대로 작동합니 다. 
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Component Issue 

User interface It is no longer necessary to manually type U+ in the From and To edit controls in the Glyph tab 

of the music symbols editor. 

User interface Dorico no longer crashes when opening some dialogs when Full Keyboard Access is enabled in 

System Settings (Mac only). 

User interface Under some circumstances, Dorico could crash when triggering a script whose commands 

contain internal identifiers to specific projects or windows; such scripts should instead have 

no effect. 

User interface The Font Styles, Playing Techniques, Lines, and Line Annotations dialogs in the Library menu 

can now all be resized to a smaller size than their initial dimensions. 

User interface Under some circumstances, Dorico could crash when pressing a key while the help overlay is 

shown; this has now been fixed. 

User interface Under some circumstances, the wrong bar number would appear in the status bar; this has 

now been fixed. 

User interface The Graphic Slices panel in Engrave mode is no longer too wide when running Dorico in 

French. 

User interface Any previously entered text in the Project title and Composer fields in the Create New page of 

the Hub is now always removed, to avoid inadvertently creating a project with the same name 

as the previous one. 

User interface It is once again possible to apply formatting to selected text in the Edit Instrument Names, 

Edit Single Lyric, and Change Divisi dialogs. 

User interface The Click button in the Transport window now shows the correct state when the window is 

opened. 

Voices Notes in voice column 1 or higher no longer sometimes collide with noteheads in voice 

column 0 if the noteheads in voice column 0 are not all the same size. 

  



성분 

인터페이스 

인터페이스 

인터페이스 

인터페이스 

인터페이스 

인터페이스 

인터페이스 

인터페이스 

인터패이스 

인터페이스 

목소리 

도리코 6판역사 

문제 

더 이상 음악 기호 편집기의 Glyph 탭에서 "From" 및 "To'' 컨트롤을 수동으로 입력할 필요가 없습니다 

시스템 설정(Mac 전용)에서 전체 키보드 액세스가 활성화되면 일부 대화를 열 때 도리코가 더 이상 충돌하지 

않습니댜 

어떤 상황에서는 명령에 특정 프로젝트나 창에 대한 내부 식별자가 포함된 스크립트를 트리거할 때 도리코 

가 충돌할 수 있습니다. 그러한 스크립트는 대신 효과가 없어야 합니다. 

라이브러리 메뉴의 글꼴, 재생 기술, 줄 및 줄 주석 대화 대화는 이제 모두 초기 크기보다 작은 크기로 조정할 

수있습니다 

어떤 상황에서는 도움말 오버레이가 표시되는 동안 키를 누를 때 도리코가 충둘할 수 있습니다. 이것은 이 

제수정되었습니다 

어떤 경우에는 상태 표시줄에 잘못된 막대 번호가 표시됩니다. 이것은 이제 수정되었습니다. 

인그레이브 모드의 그래픽 슬라이스 패널은 프랑스어로 도리코를 실행할 때 더 이상 너무 넓지 않습니 

다 

이전에 허브의 Create New 페이지에 있는 프로젝트 제목과 작곡가 필드에 입력된 모든 텍스트는 이제 항상 

제거됩니다 이는 실수로 이전과 같은 이름의 프로젝트를 만드는 것을 방지하기 위함입니다. 

편집 도구 이름, 편집 단일 가사 및 변경 나누기 대화에서 선택된 텍스트에 포맷을 적용하는 것이 다시 한 

번 가능합니다. 

이제 전송 창의 클릭 버튼을 누르면 창이 열렸을 때 올바른 상태를 보여줍니다. 

음성 열 0의 노트헤드가 모두 같은 크기가 아니라면 음성 열 1 이상의 노트는 더 이상 음성 열 0의 
노트헤드와충돌하지 않습니다. 
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Dorico 6.0.10 

26 May 2025 

Improvements 

Arpeggio signs 
Position relative to accidentals. A new option, Gap between arpeggio line and chord 

with accidental, has been added to the Gaps section of the Arpeggio Signs page of 

Engraving Options. 

Barlines 
Double barline at start of first system. A new option, Barline at start of first system, if 

shown, has been added to the Barlines page of Notation Options, allowing you to 

specify that the first system should begin with a double barline if desired. 

Chord diagrams 
Barres and fingering. Dorico no longer attempts to automatically fill in the fingering 

numbers for chord diagrams as you edit the shape. While this was often helpful, it 

also resulted in limitations in the placement of barres, as Dorico will only show 

barres for strings played by the same finger, and it would sometimes refuse to allow 

non-contiguous strings to be played by the same finger. As a famous uncle once 

said, with great power comes great responsibility: it is now therefore possible to 

create invalid fingerings if you are not careful. 

However, this greater flexibility in specifying fingering results in greater flexibility 

in the placement of barres. Clicking a dot will only produce a barre if there are other 

dots on the same fret with the same assigned (or no) fingering, and that aren’t 

separated by a fingered note between them on a lower fret, or an open string. A 

muted string in the middle of a barre is permitted. Any dots without finger 

numbering that are incorporated into a barre will automatically be assigned the 

fingering used in the rest of the barre. 

As a result, it is possible to create more than one barre on the same fret if they both 

have different finger numbers. It is also possible to combine barres and adjacent (or 

non-adjacent) single fingerings along the same fret, again determined by the 

assigned fingerings. 

If a dot inside a barre is moved to a different fret, or assigned a different fingering, 

the barre contracts, or disappears altogether if no longer viable. If a dot is moved 

adjacent to an existing barre, then the barre expands to include this dot if it has the 

same assigned (or no) fingering. 



도리코 6.0.10 

개선점 

도리코 6판역사 

2025년 5월 26일 

아르페지오부호 

사고에 대한 위차 새로운 옵션인 아르페지오 라인과 우발적인 코드 사이의 간격이 각인 옵션의 아 

르페지오 사인 페이지의 간격 섹션에 추가되었습니다. 

71준선 

첫 번째 시스템 시작 시 이중 바라인입니다. 표시된 경우 새로운 옵션인 첫 번째 시스템 시작 시 바 

라인이 표시 옵션의 바라인 페이지에 추가되어 원하는 경우 첫 번째 시스템이 이중 바라인으로 시작 

되어야 함을 지정할 수 있습니다. 

코드도 

바레스와 운지법 도리코는 더 이상 코드 다이어그램의 운지법 숫자를 자동으로 채우려고 하지 않습니 

댜 이것은 종종 도움이 되었지만, 도리코는 같은 손가락으로 연주되는 현에 대해서만 바레스를 보여 

줄 것이고, 때로는 인접하지 않은 현이 같은 손가락으로 연주되는 것을 허용하지 않기 때문에 바레스 

배치에 한계가 있었습니다. 유명한삼촌이 말했듯이, 큰 힘에는 큰 책임이 따릅니다: 지금입니다. 따라 

서 주의하지 않으면 잘못된 손가락을 만들 수 있습니다. 

그러나 운지 지정의 이러한 더 큰 유연성은 바레 배치의 유연성을 증가시킵니다. 점을 클릭하는 

것은 같은 프렛에 있는 다른 점들이 있을 때만 의미를 만들며, 그것들이 더 낮은 프렛이나 열린 문 

자열 사이의 손가락음으로 구분되지 않습니다. 바레 중간에 음소거된 스트링이 허용됩니다. 막대 

에 통합된 손가락 번호가 없는 점은 나머지 막대에 사용되는 운지법이 자동으로 할당됩니다. 

결과적으로, 둘 다 손가락 번호가 다르면 동일한 프렛에 둘 이상의 막대를 만드는 것이 가능합니 

댜 또한 동일한 프렛을 따라 바레와 인접한(또는 인접하지 않은) 단일 핑거링을 결합하는 것도 

가능하며, 이는 할당된 핑거링에 의해 다시 결정됩니다. 

바레 안의 점이 다른 프렛으로 이동하거나 다른 운지법이 지정되면, 바레가수축하거나 더 이상 

생존할 수 없게 되면 완전히 사라집니다. 점이 기존 막대에 인접하게 이동되면, 동일한 할당된(또 

는 없음) 운지법을 갖는 경우 막대가 이 점을 포함하도록 확장됩니다. 
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Creating a lower-fingered dot or an open string within a barre breaks it. If the barre 

crosses sufficient strings such that it can be broken into two separate barres, the 

fingering is updated so that the two barres don’t have the same fingerings. Any un-

barred dots that use the same fingering as any barres will have their fingering reset 

(but you a free to reinstate the “wrong” fingering if you wish). 

Filters 
Suppressed playback. A new quick filter Edit ▶ Filter ▶ Suppressed Playback has been 

added, allowing you to select or deselect items that are suppressed in playback. 

Fingering 
Placement of alternative fingerings. The Placement for alternative fingerings option on 

the Fingering page of Engraving Options now includes a new setting, Above, which 

allows you to specify that alternative fingerings should be placed above main 

fingerings. 

MIDI import 
Preferences. The Add articulations to notes option now appears in the Recording 

section of the Play page of Preferences, as well as in the MIDI Import Options dialog. 

MusicXML import 
Chord symbols. If multiple chord symbols appear at the same rhythmic position with 

different vertical positions relative to the staff, Dorico now attempts to import them 

into multiple rows. 

MusicXML export 
Arranger. If the Arranger field in File ▶ Project Info is filled out, this information is now 

included in the <creator> element in exported MusicXML. 

Note input 
Select following notes of same pitch. If you hold Shift and double-click a note in the score, 

Dorico will now select all following notes of the same pitch in that voice. 

Octave lines 
Rhythm dots. A new option Right-hand position of octave line relative to rhythm dots 

on final note has been added to the Advanced Options section of the Horizontal 

Position section of the Octave Lines page of Engraving Options, allowing you to 

specify whether the width of rhythm dots should be considered when placing the 

right-hand end of the octave line relative to the note or chord at its end position. In 

new projects, this is set to After rhythm dots, but in existing projects it is set to 

Before rhythm dots to maintain their appearance. 



도리코 6판역사 

필터 

아래쪽손가락점이나열린 줄을 바레 안에 만들면 깨집니다. 막대가충분한문자열을 가로질러 

두 개의 분리된 막대로 끊어질 수 있는 경우, 두 막대가 같은 손가락질을 가지지 않도록 핑거링이 

업데이트됩니다 다른 바어와 동일한 운지법을 사용하는 바어 없는 점은 운지법이 초기화됩니다 

(하지만 원하는 경우 "잘못된" 운지법을 자유롭게 복원할 수 있습니다). 

재생 억재 새로운 퀵 필터 편집 ► 필터 ► 억제된 재생이 추가되어 재생이 억제된 항목을 선택하 

거나선택할수있습니다. 

손가락질 

대체 핑거링 배치. 각인 옵션의 핑거링 페이지에 있는 대체 핑거링 옵션 배치에는 이제 새로운 설정인 

위에 포함되어 있어 대체 핑거링이 메인 핑거링 위에 배치되어야 함을 지정할수 있습니다. 

증간수입 

선호 사항. 매모에 추가 설명 옵션은 이제 MIDI 가져오기 옵션 대화뿐만 아니라 선호 사항의 재생 페 

이지 녹음 섹션에도 나타납니 다 

뮤직XML 수입 

코드 기호. 만약 여러 개의 코드 기호가 같은 리듬 위치에 나타나고, 스태프에 대해 수직 위치가 다르 

다면, 도리코는 이제 그것들을 여러 줄로 가져오려고 시도합니다. 

뮤직XML 수출 

노트 

Arranger. 파일 ► 프로젝트 정보의 Arranger 필드가 작성되면 이 정보는 이제 내보낸 

MusicXML의 <크리에이터> 요소에 포함됩니다 

같은 음높이의 다음 음을 선택합니다. Shift를 잡고 악보에서 음을 두 번 클릭하면, 도리코는 이제 그 

목소리에서 같은 음높이의 모든 다음 음을 선택할 것입니다. 

옥타브선 

리듬 점들. 음각 옵션의 옥타브 라인 페이지의 수평 위치 섹션의 고급 옵션 섹션에 마지막 음의 리듬 점 

에 대한옥타브 라인의 오른쪽 위치가추가되어 리듬점의 너비를고려해야하는지 여부를 지정할수 

있습니다 신규 프로젝트에서는 After 리듬 닷으로 설정되지만, 기존 프로젝트에서는 Before 리듬 닷 

으로설정하여 외관을유지합니다. 
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Pedal lines 
Continuation symbol. The Text or symbol appearance at start of subsequent systems 

option in the Design section of the Pedal Lines page of Engraving Options now 

includes a new setting, No sign, which allows you to specify that a pedal line should 

show no sign when continuing onto a new system. 

Playback 
Dynamic curve. The graph illustrating the effect of the Dynamic curve power setting on 

the Dynamics page of Library ▶ Playback Options now shows the actual value for 

each dynamic level, and updates as you change the setting. 

The curve calculation has also been tweaked to remove a discontinuity that could 

occur around level 0, and to allow the mid-point of the curve to be shifted away 

from 0 if the Minimum dynamic level and Maximum dynamic level values are set 

asymmetrically. 

Proofreading 
Playing techniques. When checking playing techniques, Dorico now looks for text events 

denoting music written on a single staff belonging to a section player that should be 

played divisi. This prevents Dorico from showing warnings about duplicated playing 

techniques when they are written for each desk or subdivision. 

Damp techniques. Dorico no longer warns about damp techniques coinciding with rests, 

since this is how they are typically written, e.g. for harp. 

Ossias. Dorico no longer warns about duplicated playing techniques if they appear in an 

ossia. 

Instrument changes. Material written for marching percussion kits no longer generates 

warnings that the material cannot be played by a single player, since these kits are 

typically played by multiple musicians. 

Rulers and grid 
Changing units. You can now double-click the label showing the unit currently used for 

rulers to cycle through the available unit types. 

Label precision. The labels in the ruler showing the mouse cursor position now shows the 

measurements to a higher degree of precision. 

User interface 
Status bar. The information read-out on the status bar has been revised such that it 

takes up less horizontal space, and will not force the project window to be wider 

when the read-out is updated. Because the window can now be made narrower 

than the minimum width required to accommodate the complete read-out, 

hovering over the read-out will now show its complete text in a tool tip. 



도리코 6판역사 

페달 

재생 

검침 

계속 기호. 각인 옵션의 페달 라인 페이지 디자인 섹션에 있는 후속 시스템 옵션 시작 시 텍스트 또는 

기호 표시에는 이제 새로운 설정인 No sign이 포함되어 있어 새 시스템으로 계속 진행할 때 페달 라인 

이 표시되지 않아야 함을 지정할 수 있습니다. 

동적 곡선. 라이브러리 ► 의 동적 페이지에 동적 곡선 전원 설정의 효과를 보여주는 그래프는 이제 각 

동적 레벨에 대한 실제 값을 보여주며 설정을 변경함에 따라 업데이트됩니다. 

곡선 계산도 조정되어 레벨 0 부근에서 발생할 수 있는 불연속성을 제거하고 최소 동적 수준과 

최대 동적 수준 값이 비대칭적으로 설정되는 경우 곡선의 중간 지점이 0에서 멀어질 수 있도록 

했습니다 

재생 기술 도리코는 이제 재생 기술을 확인할 때 섹션 플레이어에 속한 단일 스태프에 적힌 음악을 나 

타내는 텍스트 이벤트롤 찾습니다. 디비시 . 이것은 도리코가 각 책상이나 세분화에 대해 작성될 때 중 

복 재생 기술에 대한 경고를 표시하는 것을 방지합니 다. 

댐프 기술. 도리코는 더 이상 휴식과 일치하는 댐프 기술에 대해 경고하지 않습니다. 왜냐하면 이것이 

일반적으로 하프의 경우 이렇게 쓰여지기 때문입니다. 

오시아스. 도리코는 더 이상 중복된 연주 기술이 오시아에 나타나면 경고하지 않습니다. 

악기 변경. 행진 타악기 키트를 위해 작성된 자료는 더 이상 한 명의 연주자가 연주할 수 없다는 경고 

롤 생성하지 않습니다. 왜냐하면 이러한 키트는 일반적으로 여러 음악가가 연주하기 때문입니다. 

자와격자 

단위 변경 이제 현재 사용되는 단위를 표시하는 라벨을 두 번 클릭하여 사용 가능한 단위 유형을 순 

환할수있습니다. 

라벨 정밀도. 마우스 커서 위치를 보여주는 자의 라벨은 이제 측정값을 더 높은 정밀도로 보여줍니다. 

인터페01스 

상태 표시줄. 상태 표시줄의 정보 읽기는 수평 공간을 덜 차지하도록 수정되었으며 읽기가 업데 

이트될 때 프로젝트 창이 더 넓어지도록 강요하지 않습니다. 이제 창을 전체 읽기를 수용하는 데 

필요한최소 너비보다좁게 만들수 있기 때문에 읽기 위를 맴둘면 이제 도구 팁에 전체 텍스트가 

표시됩니댜 
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Key commands. It is now possible to specify key commands for the commands in the 

View ▶ Pages submenu in the Key Commands page of Preferences. 

Text editor in dialogs. Text editor controls in dialogs – Edit Instrument Names, Edit 

Single Lyric, Change Divisi – now show a focus ring when the keyboard focus is in 

the text editor, to make it clear when you can type into the text editor. In the Edit 

Instrument Names and Edit Single Lyrics dialogs, the text in the editor is 

automatically selected when the editor gains focus, making it easier to type to 

replace it. 

  



도리코 6판역사 

주요 명령입니다 이제 기본 설정의 키 명령 페이지에 있는 보기 ► 페이지 하위 메뉴의 명령에 

대한주요 명령을 지정할수 있습니다. 

대화의 텍스트 편집기. 텍스트 편집기 컨트롤 - 도구 이름 편집, 단일 가사 편집, 변경 분할 - 이제 

키보드 초점이 텍스트 편집기에 있을 때 포커스 링을 표시하여 텍스트 편집기에 입력할 수 있는 시 

간을 명확하게 합니 다. 도구 이름 편집 및 단일 가사 편집 대화에서는 편집자가 초점을 잡으면 편집 

기의 텍스트가 자동으로 선택되어 입력을 쉽게 대체할 수 있습니다. 
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Issues resolved 
Component Issue 

Accidentals The placement of flat accidentals on the bottom line of the staff above a note with an 

unshortened ledger line has been improved. 

Bar numbers Ranges of bar numbers now draw below multi-bar rests as expected once more. 

Chord diagrams Dorico no longer crashes when choosing Library ▶ Chord Symbols with a chord symbol 

selected for an instrument with no chord diagram tuning chosen. 

Chord symbols Transposing chord symbols no longer incorrectly causes chord symbols beyond the first row 

to be removed. 

Chord symbols Adding parentheses to a custom chord symbol now works correctly. 

Chord symbols Center-aligned chord symbols no longer cause instability in rhythmic spacing. 

Chord symbols The placement of intervals and alterations relative to roots for chord symbol appearances set 

to apply to all roots when root accidentals use superscript positioning has been corrected. 

Chord symbols Chord symbols with altered bass notes now correctly use an overridden appearance if 

necessary. 

Chord symbols The alignment of chord symbols with overridden appearances with altered bass notes relative 

to other chord symbols on the system is now correct. 

Chord symbols Under some circumstances, chord symbol components could overprint each other 

unexpectedly; this has now been fixed (macOS only). 

Chord symbols Engrave mode editing of chord symbols with extender lines has been significantly improved. 

Some problems with collision avoidance for extender lines still remain to be resolved. 

Chord symbols The vertical position of the altered bass slash in a diagonal arrangement is now set relative to 

the baseline of the previous component, rather than the bottom of its bounding box; this may 

cause the horizontal position of the slash to move in existing projects. 

Clefs Restorative clefs no longer have octave shift properties set, unless an octave shift is actually 

required to restore the previous clef. 

Condensing Editing dynamics in one layout no longer sometimes causes unexpected changes in 

condensing in another layout. 

Condensing Dorico no longer sometimes leaves space for the wrong transposing key signature for 

condensed players with multiple instruments of different transpositions, which can result in 

an unnecessarily large gap at the end of the system and a cautionary time signature 

overlapping the page margin. 



과제 

성분 

변고 

UE코드 

코드도 

화음 

화음 

화음 

화음 

화음 

화음 

화음 

화음 

화음 

큘리프 

응축 

응축 

도리코 6판역사 

문제 

메모 위에 있는 직원의 하단 라인에 평평한 사고를 배치하는 것이 개선되었습니다. 

막대 번호의 범위는 이제 예상대로 다시 한 번 다중 막대 받침대 아래로 그립니다. 

도리코는 더 이상 코드 다이어그램 튜닝이 선택되지 않은 악기에 대해 선택된 코드 기호가 있는 라 

이브러리 ► 코드 기호를 선택할 때 충돌하지 않습니다. 

코드 기호룔 바꾸면 첫 번째 줄을 넘는 코드 기호가 더 이상 잘못 제거되지 않습니 다. 

맞춤 코드 기호에 괄호를 추가하는 것은 이제 올바르게 작동합니다. 

중심 정렬된 코드 기호는 더 이상 리듬 간격의 불안정성을 유발하지 않습니다. 

루트 우연이 위첨자 위치를 사용할 때 모든 루트에 적용되도록 설정된 코드 기호 모양에 대한 간격 및 루트 

에 대한 변경의 배치가 수정되었습니다. 

베이스 음이 변경된 코드 기호는 이제 필요한 경우 무시된 모양을 율바르게 사용합니다. 

시스템의 다른 코드 기호에 비해 베이스 움이 변경된 무시된 외관을 가진 코드 기호의 정렬이 이제 정확합 

니댜 

어떤 상황에서는 코드 기호 구성 요소가 예기치 않게 서로룔 과도하게 인쇄할 수 있습니다. 이 

것은 이제 수정되었습니다 (macOS 전용). 

익스텐더 라인이 있는 코드 심볼의 각인 모드 편집이 크게 개선되었습니다. 

익스텐더 라인에 대한 충둘 회피와 관련된 몇 가지 문제는 아직 해결되지 않았습니다. 

대각선 배열에서 변경된 베이스 슬래시의 수직 위치는 이제 경계 상자 하단이 아닌 이전 구성 요소의 기준 

선을 기준으로 설정됩니다. 이로 인해 기존 프로젝트에서 슬래시의 수평 위치가 이동할 수 있습니다. 

복원 음자리표는 더 이상 옥타브 이동 속성이 설정되어 있지 않습니다. 이전 음자리표를 복원하기 위해 

실제로 옥타브 이동이 필요하지 않습니 다. 

한 레이아웃에서의 편집 역학은 더 이상 다른 레이아웃에서 응축에 예상치 못한 변화를 일으키지 

않습니댜 

도리코는 때때로 다른 조치의 여러 악기를 가진 응축된 연주자를 위한 잘못된 조옮김 키 서명을 위한 공간 

율 남기지 않습니다. 이로 인해 시스템 끝에서 불필요하게 큰 간격이 발생하고 페이지 여백과 겹치는 주의 

시간서명이 발생할수 있습니다. 
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Component Issue 

Cues Under some circumstances, confirming a chosen instrument name from the cue popover 

would result in no cue being created; this has now been fixed. 

Fill view When the same layout is shown in multiple windows or splits within the same window in fill 

view, changing zoom level in one fill view no longer incorrectly affects the other view. 

Fill view Under some circumstances, Dorico could incorrectly show the music in fill view when 

switching to Engrave mode; this has now been fixed. 

Flows Write ▶ Split Flow now correctly handles splitting a flow at a barline position where the 

prevailing time signature has a pick-up; the new flow no longer incorrectly starts with a 

corresponding pick-up. 

Jump bar It is once again possible to trigger commands correctly in the jump bar when running Dorico 

in Japanese and Chinese. 

Library Manager Dorico now shows a warning if you attempt to load the open project as the secondary project 

in the Library Manager. 

Music fonts Under rare circumstances, changing the music font in a project could result in a crash; this 

has now been fixed. 

Note input After confirming a popover when editing an existing item, it is now possible to use Tab to cycle 

the selection to other items at the same position without clicking in the music area again to 

restore focus. 

Notes Note name and Figurenotes noteheads now appear correctly once more. 

Numbered bar 

regions 

The Show bar count in numbered bar regions option is no longer incorrectly deactivated 

when loading existing projects. 

Playback In rare circumstances, deactivating independent voice playback could cause a crash; this has 

now been fixed. 

Playback Changes of playing technique at the very start of the flow for a note with a positive offset now 

play back correctly. 

Playback Clicking Save as Stage Template or Save as Space Template in the Live Stage and Live Space 

windows no longer causes a crash. 

Project files Dorico no longer crashes when saving a project with no players. 

Project files Under some circumstances, Dorico could hang when saving a project file; this has now been 

fixed (macOS only). 

Proofreading Projects with some user-defined playing techniques no longer cause Dorico to crash after 

opening. 



성분 

단서 

평면도 

평면도 

흐름 

철봉 

도서관장 

악보 

노트 

메모 

번호봉 

지방 

재생 

재생 

재생 

프로젝트파일 

프로젝트파일 

검침 

도리코 6판역사 

문제 

어떤 상황에서는 큐 팝오버에서 선택한 악기 이름을 확인해도 큐가 생성되지 않습니다. 이것은 이제 수 

정되었습니다 

동일한 레이아웃이 여러 창에 표시되거나 동일한 창 내에서 분할된 경우, 한 채우기 뷰에서 줌 레벨을 변 

경해도 다른 뷰에 더 이상 잘못된 영향을 미치지 않습니다. 

어떤 상황에서는 도리코가 앵그레이브 모드로 전환할 때 음악을 채우기 보기에 잘못 표시할 수 있습 

니다 이것은 이제 수정되었습니다 

분할 흐름은 이제 기존 시간 서명이 픽업을 갖는 기준선 위치에서 흐름을 분할하는 것을 올바르게 처리 

합니다. 새로운 흐름은 더 이상 해당 픽업으로 잘못 시작하지 않습니다. 

일본어와 중국어로 도리코를 실행할 때 점프바에서 명령을 올바르게 트리거하는 것이 다시 한 번 가능합니 

다 

도리코는 이제 라이브러리 매니저에서 열린 프로젝트를 보조 프로젝트로 로드하려고 하면 경고를 표시합니 

다 

드문 상황에서 프로젝트에서 음악 글꼴을 변경하면 충둘이 발생할 수 있습니다. 이것은 이제 수정되었습 

니다 

기존 항목을 편집할 때 팝오버를 확인한 후, 이제 탭을 사용하여 다시 음악 영역을 클릭하지 않고 같은 위치의 

다른 항목으로 선택을순환하여 초점을 복원할수 있습니다. 

노트 이름과 그림 노트 노트 헤드가 다시 한 번 올바르게 나타납니 다. 

번호가 매겨진 막대 영역의 쇼 바 수 옵션은 기존 프로젝트를 로드할 때 더 이상 잘못 비활성화되지 않습 

니다 

드문 경우지만 독립적인 음성 재생을 비활성화하면 충돌이 발생할 수 있습니다. 이는 이제 해결되었습니다. 

음의 오프셋이 있는 음에 대한 흐름의 시작 부분에서의 연주 기술의 변화가 이제 올바르게 재생됩니다. 

라이브 스테이지 및 라이브 스페이스 창에서 "스테이지 템플릿으로 저장” 또는 “스페이스 템플릿으로 저 

장"을 클릭해도 더 이상 충돌이 발생하지 않습니다. 

도리코는 플레이어가 없는 프로젝트를 저장할 때 더 이상 충돌하지 않습니다. 

어떤 상황에서는 도리코가 프로젝트 파일을 저장할 때 매달릴 수 있습니다. 이것은 이제 수정되었습니다 

(macOS 전용). 

일부 사용자 정의 재생 기술이 있는 프로젝트는 더 이상 도리코가 개통 후 충돌하지 않습니다. 
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Component Issue 

Proofreading User-defined percussion kits are now handled correctly when checking instrument changes. 

Proofreading Dorico no longer warns about multiple instruments being played by a single player for 

marching percussion instruments and kits. 

Proofreading Warnings for pick-up bars where the pick-up is longer than half the duration of the prevailing 

time signature have been improved. 

Proofreading The detection of coincident or overlapping playing techniques on ossia staves has been 

improved. 

Proofreading The detection of dynamics both above and below the staff but where only a single voice is 

active has been improved. 

Repeat markers The horizontal positioning of To Coda marks has been corrected. 

Slurs It is now always possible to lengthen or shorten slurs to the next or previous note, even for 

long tied notes. 

Staff labels Player group labels now always correctly cover divisi staves that show no staff label, if 

required. 

Tempo Tempo marks are once again correctly shown in gray when playback is suppressed. 

Tempo Under some circumstances, changes on the Brackets and Braces page of Layout Options 

would not cause tempos to appear or disappear immediately at the expected system-attached 

item positions; this has now been fixed. 

Tempo When opening projects last saved in Dorico 5 or earlier, the notes in metronome marks are 

now always drawn at the correct size. 

Tempo Under some circumstances, edits to a tempo item could cause instability in the positioning of 

rehearsal marks at the same position; this has now been fixed. 

Tempo Tempo items created directly in the Tempo editor in the Key Editor no longer appear in the 

Used in This Flow section of the Tempo panel. 

Tempo When exporting text from the project, Dorico now correctly exports the visible abbreviated 

text for gradual tempos, if necessary. 

Text In a text frame with multiple paragraphs of text in different styles, if a paragraph ends up 

completely empty, the vertical space occupied by the paragraph would be incorrect, using the 

size of the following non-empty paragraph; this has now been fixed. 

Text Double-clicking a text frame after suppressing the dialog that allows you to choose what to do 

now correctly either opens Project Info or edits the frame as expected. 



성분 문제 

검침 이제 악기 변경 사항을 확인할 때 사용자 정의 타악기 키트를 올바르게 처리합니다. 

검침 도리코는 더 이상 여러 악기가 행진 타악기 및 키트를 위해 한 명의 연주자가 연주하는 것에 대해 경 

고하지않습니다 

검침 픽업 시간이 기존 타임 서명 기간의 절반 이상인 픽업 바에 대한 경고가 개선되었습니다. 

검침 골증 오선보에서 일치하거나 겹치는 연주 기술의 감지가 항상되었습니다. 

검침 직원 위아래의 역학 감지 기능이 향상되었지만 단일 음성만 활성화되는 곳에서는 감지 기능이 항상되 

었습니댜 

리피트마커 To Coda 마크의 수평 위치가 수정되었습니다. 

비방어 이제는 긴 묶인 노트에도 다음 노트나 이전 노트의 슬러를 늘이거나 줄이는 것이 항상 가능합니다. 

라벨 플레이어 그룹 레이블은 이제 필요한 경우 스태프 레이블이 표시되지 않는 분할 스테이브롤 항상 율 

바르게 덮습니다. 

템포 재생이 억제되면 템포 표시가 다시 한 번 회색으로 울바르게 표시됩니다. 

템포 어떤 상황에서는 레이아웃 옵션의 괄호 및 괄호 페이지의 변경으로 인해 예상되는 시스템 부착 항목 위치에 템 

포가 즉시 나타나거나 사라지지 않습니다. 이것은 이제 수정되었습니다. 

템포 도리코 5 또는 그 이전에 마지막으로 저장된 오프닝 프로젝트를 시작할 때, 매트로놈 표시의 메모는 이제 
항상 정확한 크기로 그려집니다. 

템포 어떤 상황에서는 템포 항목을 편집하면 같은 위치에 리허설 마크의 위치가 불안정해질 수 있습니다. 이것 

은 이제 수정되었습니다. 

템포 Key Editor의 Tempo 편집기에서 직접 생성된 Tempo 항목은 더 이상 Tempo 패널의 이 흐름 부분에 

서사용되지않습니다. 

템포 프로젝트에서 텍스트롤 내보낼 때, 도리코는 이제 필요한 경우 점진적인 템포를 위해 눈에 보이는 축약 

된 텍스트롤 올바르게 내보냅니다. 

글
 

여러 문단의 텍스트가 다른 스타일로 구성된 텍스트 프레임에서 단락이 완전히 비어 있으면 단락이 차지하 

는 수직 공간이 잘못되어 다음과 같은 비어 있지 않은 단락의 크기를 사용합니다. 이것은 이제 수정되었습 

니댜 

굴
 

대화를 억제한 후 텍스트 프레임을 더블 클릭하면 지금 할 일을 을바르게 선택할 수 있습니다. 프로젝트 정 

보를 열거나 예상대로 프레임을 편집합니다. 
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Component Issue 

Text Empty text frames showing borders but containing no text once again appear correctly when 

printing and exporting graphics. 

Text The minimum actual size for a text item is now clamped to 0.5pt; this prevents text items from 

snapping to a larger size when scaling them to very small sizes. 

Text Capsule and angled end rectangle borders are now positioned correctly for right-aligned text 

in frames. 

Text Under some circumstances, the preview in the Paragraph Styles dialog would not correctly 

show the inherited OpenType font features for the current style; this has now been fixed. 

Text Under rare circumstances, Dorico could remove text from text items that are updated to 

replace a missing font; this has now been fixed. 

Text If a paragraph style uses a non-default Case setting, token placeholders in that paragraph 

style could unexpectedly be included when printing or exporting graphics; this has now been 

fixed. 

Ties Under some circumstances when multiple voices are active, ties set to start after rhythm dots 

could instead start from the left-hand side of the notes in the first voice column; this has now 

been fixed. 

Time signatures Under rare circumstances, Dorico could crash when creating or deleting a time signature in a 

passage using interchangeable or alternating time signatures; this has now been fixed. 

Tuplets When a tuplet ends with a rest, but the rest is not shown because it is consolidated with a rest 

in a tuplet in another voice, the end position of the tuplet bracket is now correct. 

User interface The appearance of the controls in the Manual placement section of the Time Signatures page 

of Layout Options has been improved. 

User interface Dorico no longer sometimes crashes when scrolling through a layout containing divisi in 

galley view. 

User interface The information read-out in the status bar now shows the bar number of the selected item in 

more circumstances. 

User interface Clicking in the display area in the Edit Accidentals dialog no longer causes the accidental to 

disappear. 

User interface Interacting with the Key Signature and Accidentals panel after changing the application 

language in Preferences no longer causes a crash. 

User interface The list of flows shown in Override Flow Headings no longer includes flows that are not 

attached to the current layout. 



성분 문제 

글
 

테두리를 보여주지만 텍스트가 포함되어 있지 않은 빈 텍스트 프레임은 그래픽을 인쇄하고 내보낼 때 다시 

한 번 올바르게 나타납니 다. 

글
 

텍스트 항목의 최소 실제 크가는 이제 0.5pt로 고정됩니다 이를 통해 텍스트 항목을 매우 작은 크기로 조정 

할 때 더 큰 크기로 스냅되는 것을 방지할 수 있습니다. 

굴
 

캡슐과 각진 끝 직사각형 테두리는 이제 프레임의 오른쪽 정렬된 텍스트를 위해 올바르게 배치됩니다. 

글
 

어떤 상황에서는 스타일 문단 대화의 미리보기가 현재 스타일에 대해 물려받은 OpenType 글꼴 기능을 
올바르게 표시하지 않습니다. 이것은 이제 수정되었습니다. 

글
 

드문 상황에서도 도리코는 누락된 글꼴을 대체하기 위해 업데이트된 텍스트 항목에서 텍스트를 제거 

할 수 있습니다. 이것은 이제 수정되었습니다. 

굴
 

단락 스타일이 기본이 아닌 경우 설정을 사용하는 경우 해당 단락 스타일의 토큰 플레이스홀더가 예기치 않 

게 포함될 수 있습니다. 이제 이것이 수정되었습니다. 

넥타이 어떤 상황에서는 여러 목소리가 활성화되어 있을 때 리듬 점 이후에 시작되도록 설정된 타이가 첫 번째 성 

부 열의 음의 왼쪽에서 시작될 수 있습니다. 이것은 이제 고정되었습니다. 

박표 드문 상황에서 도리코는 교체 가능하거나 교대하는 시간 서명을 사용하여 구절에서 시간 서명을 생성하거 

나 삭제할 때 충둘할수 있습니다. 이것은 이제 수정되었습니다. 

쌍둥01 튜플렛이 휴지로 끝나지만 다른 성부의 튜플렛에서 휴지로 통합되어 나머지가 표시되지 않을 때, 이제 튜플 

렛 브래킷의 끝 위치가 정확합니다. 

인터페01스 레이아웃 옵션의 시간 서명 페이지의 수동 배치 섹션에 있는 컨트롤의 외관이 개선되었습니다. 

인터페01스 도리코는 갤리 뷰에서 디비지가 포함된 레이아웃을 스크롤할 때 더 이상 충돌하지 않습니다. 

인터페01스 상태 표시줄에서 읽은 정보는 이제 더 많은 상황에서 선택된 항목의 표시줄 번호를 보여줍니다. 

인터패01스 사고 편집 대화의 표시 영역을 클릭해도 사고가 더 이상 사라지지 않습니다. 

인터페01스 Preferences에서 응용프로그램 언어를 변경한후주요서명 및사고패널과상호작용해도 더 이상 

충돌이 발생하지 않습니다. 

인터페01스 Override Flow Headings에 표시된 흐름 목록에는 현재 레이아웃에 첨부되지 않은 흐름이 더 이 
상포함되지않습니다. 
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Component Issue 

User interface The width of spin controls in the Properties panel has been improved (Windows only). 

Video Connecting or disconnecting an external display could cause a crash when a video file is 

attached; this has now been fixed (macOS only). 

  



성분 

인터페이스 

비디오 

도리코 6판역사 

문제 

특성 패널의 스핀 컨트롤 폭이 개선되었습니다 (윈도우 전용). 

외부 디스폴레이를 연결하거나 분리하면 비디오 파일이 첨부되어 있을 때 충돌이 발생할 수 있습니다. 

이것은 이제 수정되었습니다(macOS 전용). 
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Dorico 6.0 

28 April 2025 

Highlights 

Proofreading 
We like to say that working in Dorico is like having an 

intelligent assistant at your side, taking care of many of the 

laborious details of producing a beautiful score, so you can 

focus on being creative. With the new proofreading features 

in Dorico 6, we are taking this further than ever. 

We have introduced an entirely new framework that allows 

Dorico to check your project for dozens of potential issues 

and report them to you in the new Proofreading panel in 

Write mode. These checks are run in the background when 

you are not actively working, so they have no impact on the 

performance of the application. 

The goal is to help identify possible issues that could cost you 

time when your music is rehearsed and performed by other 

people. Dorico can check for many common – and quite a few 

uncommon – situations and prompt you to consider making 

changes to address them. 

In this release, Dorico reports on the following categories of 

issues: 

§ Metrical problems, including irregular bars that don’t 

match the prevailing time signature, hidden time 

signatures, repeated time signatures, etc.; 

§ Superfluous or repeated markings, including key signatures, clefs, 

dynamics, and playing techniques 

§ Problems with instrument changes, including changes that are too quick to 

be practical 

§ Playability problems in music written for stringed instruments 

We plan to continue to expand on these checks in future updates and have many 

ideas for how to help make your music more successful in rehearsal and 

performance. 

Proofreading panel. The Proofreading panel is found in the toolbox on the right-

hand side in Write mode. The number of issues that Dorico is reporting for 

the categories and flows for which you have chosen to see results is shown in a red 



도리코 6.0 

2025년 4월 28일 

하이라이트 

검침 

우리는 도리코에서 일하는 것이 마치 뛰어난 조수를 옆에 두고 아름 

다운 악보를 만들기 위한 많은 힘든 세부 사항을 처리하는 것과 같아 

서, 창의력에 집증할 수 있다고 말하고 싶습니다. 도리코 6의 새로운 

교정 기능으로 우리는 이 작업을 그 어느 때보다 더 발전시키고 있습 

니댜 

우리는 도리코가 수십 가지 잠재적인 문제에 대해 프로젝트롤 확인하 

고 쓰기 모드의 새로운 Proofreading 패널에서 보고할 수 있도록 완 

전히 새로운 프레임워크를 도입했습니다. 이러한 체크는 작업을 활발 

히 하지 않을 때 백그라운드에서 실행되므로 애플리케이션의 성능에 

영향을 미치지 않습니다. 

목표는 다른 사람들이 당신의 음악을 리허설하고 공연할 때 시간을 낭 
비할수 있는 가능한 문제를 식별하는 데 도움을 주는 것입니다. 도리코 
는 많은 공통점을 확인할 수 있습니다. 그리고 꽤 많은 공통점을 확인할 
수있습니다 

혼하지 않은 - 상황과 고려하도록 촉구합니다. 

그것들을 다루기 위한 변화입니다. 

이 릴리스에서 도리코는 다음과 같은 범주의 문제에 대해 보고합니 

다. 

§ 일반적인 박자 서명과 일치하지 않는 불규칙한 막대, 숨겨진 

박자 서명, 반복된 박자 서명 등을 포함한 계량 문제; 
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§ 주요 서명, 음표, 셈여림, 연주 기법 등 불필요하거나 반복되는 표시 

§ 너무 빠른 변경을 포함한 악기 변경의 문제 

§ 현악기용 음악의 연주성 문제 

우리는 향후 업데이트에서 이러한 점검을 계속 확장할 계획이며, 리허설과 공연에서 음악을 

더 성공적으로 만드는 데 도움이 될 수 있는 많은 아이디어를 가지고 있습니다. 

Proofreading 패널 Proofreading 패널은 쓰기 모드의 오른쪽에 있는 도구 상자에서 찾을 수 있 

습니다 당신이 결과를 보기 위해 선택한 카테고리와 흐름에 대해 도리코가 보고하고 있는 문제의 '’’ 
수는 빨간색으로 표시됩니다. 

도리코 6판역사 42 스타인버그 미디어 테크놀로지스 GmbH 

42/106 



 

 

Dorico 6 Version History 43 Steinberg Media Technologies GmbH 

badge at the bottom of its button. Click the button or choose Write ▶ Panels ▶ 

Proofreading to open the panel. 

At the top of the panel, the Categories list allows you to choose which types of 

results you want to see. To quickly find a category, type into the Filter field; click 

Select All or Select None to quickly include or exclude results from all categories. 

Click the Clear Filter button  to reset the filter and show results from all 

categories. 

The Flows list similarly allows you to choose from which flows you want to see 

results: click the Edit Flows button  to open a drop-down from which you can 

choose which flows to include. 

At the bottom of the panel, a label shows Proofreading complete if the results 

shown in the panel are up to date, or shows n categories pending if Dorico is 

waiting for you to stop working for a moment so it can run its checks in the 

background. 

Navigating through issues. Simply click a result in the Proofreading panel, and Dorico 

brings that area into view. If it can highlight a specific item or bar, it shows an 

animated purple rectangle for a second or so to draw your eye: click the result again 

to run the animation again if you didn’t catch it the first time. If the result is instead 

reporting on the absence of something (for example, a missing time signature or 

dynamic), Dorico instead shows an animated purple arrow pointing at the relevant 

position. 

Resolving issues. To resolve an issue shown in the Proofreading panel, edit the score to 

address the reported issue. If you decide not to act, simply ignore the issue: you 

cannot manually dismiss a result, because as you continue to edit the music, Dorico 

will check it again, and the result could reappear. You can hide entire categories of 

results using the Categories filter. 

Disabling proofreading. If you prefer Dorico not to run its proofreading checks on your 

projects at all, you can disable them altogether. Either deactivate Enable 

proofreading on the Proofreading page of Preferences, or click the small power 

button icon in the indicator at the bottom of the Proofreading panel that reports 

whether proofreading is complete or tasks are pending. You can re-enable 

proofreading by clicking again on the indicator when it reads Enable Proofreading. 

Proofreading for meter. When Dorico checks your project for potential issues concerning 

meter and time signatures, this is what it is looking for: 

§ Hidden time signatures. For example, in a passage where 4/4 is the 

prevailing time signature, there are multiple bars of 3/4, because a time 

signature change has been created but has been hidden. Dorico won’t 



도리코 6판역사 

버튼 하단에 배지가 있습니다. 버튼을 클릭하거나 ► 패널 쓰기 ► Profreading을 선택하 

여 패널을 열 수 있습니다. 

패널 상단에 있는 범주 목록을 통해 보고 싶은 유형의 결과를 선택할 수 있습니 다. 카테고리를 

빠르게 찾으려면 필터 필드에 입력하세요. 전체 선택 또는 없음 선택을 클릭하여 모든 카테고 

리의 결과를 빠르게 포함하거나 제외합니다. 

필터 지우기 버튼을 클릭하면 필 O 터를 재설정하고 모든 카테고리의 결과를 보여 
줍니다. 

흐름 목록을 사용하면 결과를 보고 싶은 흐름을 선택할 수 있습니다: 흐름 편집 버튼을 

클릭하여 어떤 흐름을 포함할지 선택할 ‘’수 있는 드롭다운을 열 수 있습니다 

패널 하단에는 패널에 표시된 결과가 최신 상태인 경우 Proofreading 완료를 표시하거 

나, n개의 카테고리가 표시되어 있습니다. 도리코가 잠시 작동을 멈추기를 기다리고 있는 

경우 보류 중입니다 따라서 배경에서 확인을 실행할 수 있습니다. 

문제 탐색 Proofreading 패널에서 결과를 클릭하기만 하면 도리코가 그 영역을 볼 수 있습니다 특 

정 항목이나 막대를 강조 표시할수 있는 경우 애니메이션 보라색 직사각형을 1초 정도보여줍니다. 처 

음에 발견하지 못한 경우 애니메이션을 다시 실행하기 위해 결과를 다시 클릭합니다. 결과가 대신 무언 

가가 없음(예: 누락된 시간 서명 또는 동적)에 대해 보고하는 경우 도리코는 대신 애니메이션 보라색 

을 보여줍니다 화살표는 해당 위치를 가리키고 있습니다. 

문제 해결. Proofreading 패널에 표시된 문제를 해결하려면 보고된 문제를 해결하기 위해 악보를 편 

집합니다 행동하지 않기로 결정한 경우 문제를 무시하십시오. 음악을 계속 편집하면 도리코가 다시 

확인하기 때문에 결과를 수동으로 무시할 수 없습니다. 카테고리 필터를 사용하여 전체 범주의 결과를 

숨길 수 있습니다. 

교정 비활성화. 만약 당신이 도리코가 당신의 프로젝트에 대한 교정 검사를 전혀 실행하지 않기를 원 

하는 경우, 아예 비활성화할 수 있습니다. Preferences의 교정 페이지에서 교정 활성화를 비활성화하 

거나, 교정이 완료되었는지 또는 작업이 보류 증인지를 보고하는 Proofreading 패널 하단의 표시자 

에 있는 작은 전원 버튼 아이콘을 클릭하십시오. 활성화를 읽으면 표시자를 다시 클릭하여 교정을 다 

시 활성화할수 있습니다. 프루프 리딩 . 

미터기에 대한 증명. 도리코가 당신의 프로젝트에서 미터 및 시간 서명과 관련된 잠재적인 문제를 확 

인할 때, 이것이 바로 찾고 있는 것입니다. 

§ 숨겨진 박자 서명 예를 들어, 4/4가 지배적인 박자 서명인 대목에서는 박자 서명 변 

화가 생겼지만 숨겨져 있기 때문에 3/4의 마디가 여러 개 존재합니다. 도리코는 그렇 

지않을것입니다 

43 스타인버그 미디어 테크놀로지스 GmbH 

43/106 



 

 

Dorico 6 Version History 44 Steinberg Media Technologies GmbH 

report a hidden time signature that has the same duration and denominator 

as the prevailing time signature. 

§ Repeated time signatures. For example, if the prevailing time signature is 

4/4, but suddenly another 4/4 time signature appears. 

§ Irregular bars. For example, if the bar immediately preceding a change of 

time signature is shorter than the prevailing time signature, as can happen 

in Dorico when you create a new time signature earlier in the flow without 

activating Insert mode; or if a bar is too long, because a barline has been 

inadvertently deleted. Dorico is careful not to report pick-up bars, since 

they are expected to be irregular. 

§ Misaligned repeat structures. For example, if local time signatures are in use, 

and conflicting repeat barlines appear in both the global and local contexts. 

§ Missing double barlines. Pick-ups at the ends of phrases are often marked by 

a mid-bar double barline, so a bar in the prevailing time signature may be 

split into two irregular bars. If Dorico finds a mid-bar pick-up that has a 

single barline, rather than a double barline, it suggests you add a double 

barline to aid legibility. 

§ Jumps to different time signatures. Although Dorico cannot yet automatically 

display cautionary time signatures in repeat structures to show that you are 

jumping back to a different meter, it can nevertheless report these 

situations to you so you can decide whether to make manual adjustments. 

Proofreading for repeated key signatures. Dorico will report any of the following 

situations as suspect: 

§ a duplicated key signature with the same semantics and accidentals as the 

one that preceded it: for example, a G major key signature following another 

G major signature; 

§ a duplicated key signature with the same accidentals but different 

semantics: for example, an E minor key signature following a G major key 

signature; 

§ a jump to a different key signature that isn’t qualified at the location of the 

jump. For example, in a passage of D major, and following a start repeat 

barline there is a change to A major; at the end repeat barline, you are 

repeating back to D major, but without a cautionary key signature at the end 

repeat, you would be unsure whether to continue playing G sharp. Dorico 

will not, however, warn when there is a key change coinciding with the start 

repeat, or when the start repeat coincides with the start of a system, where 

a key signature will be shown anyway; 

§ as above, but where the jump back is to a key signature with the same 

accidentals but different semantics, e.g. a jump from D major to B minor. 



기존 박자 서명과 동일한 지속 시간과 분모를 갖는 숨겨진 박자 서명을 보고합니다. 

§ 

§ 

반복된 박자 서명 예를 들어, 기존의 박자 서명이 4/4인데 갑자기 또 다른 4/4 박 
자서명이 나타나는경우입니다 

불규칙한 막대 예를 들어, 시간 서명 변경 직전의 막대가 기존 시간 서명보다 짧은 경 

우, 삽입 모드를 활성화하지 않고 흐름 초기에 새로운 시간 서명을 만들 때 도리코에서 

발생할수 있습니댜 또는 막대가 너무 길 경우, 바라인이 부주의하게 삭제되었기 때문 

입니다 도리코는 픽업 막대가 불규칙할 것으로 예상되므로 보고하지 않도록 주의합니 

다. 

§ 

§ 

잘못 정렬된 반복 구조. 예를 들어, 로컬 시간 서명이 사용되고 있는 경우, 글로벌 및 로 

컬 컨텍스트 모두에서 상충되는 반복 바라인이 나타납니다. 

누락된 이중 바라인 . 악구의 끝에 있는 픽업은 종종 중간 바 이중 바라인으로 표시되므로 

기존 박자표의 막대는 두 개의 불규칙한 막대로 분할될 수 있습니 다. 도리코가 이중 바라 

인이 아닌 단일 바라인이 있는 중간 바 픽업을 발견하면 가독성을 돕기 위해 이중 바라인 

을 추가하는 것이 좋습니 다. 

§ 다른 시간 서명으로 점프합니다 도리코는 아직 반복 구조에 주의 시간 서명을 자동으로 

표시하여 다른 미터로 다시 점프하고 있음을 보여줄 수는 없지만, 그럼에도 불구하고 이러 

한 상황을 보고하여 수동 조정 여부를 결정할 수 있습니다. 

반복되는 키 서명에 대한 증거 확인. 도리코는 다음 상황 중 하나를 용의자로 보고할 것입니 

다. 

§ 이전의 것과 동일한 의미와 우연을 가진 복제된 조표: 예를 들어, 다른 G장조표 다음에 오 

는 G장조표; 

§ 같은 우연이지만 다른 의미를 가진 복제된 조표 서명: 예를 들어, G장조표 서명 뒤에 

오는 E단조표서명; 

§ 점프 위치에서 자격이 없는 다른 주요 서명으로의 점프입니다. 예를 들어, D장조의 한 대 

목에서 시작 반복 바라인을 따라가면 A장조로의 변화가 있습니다. 마지막 반복 바라인에 

서는 다시 D장조로 반복되지만, 반복 끝에 주의적인 조표가 없으면 G sharp를 계속 연주 

해야 할지 확신이 서지 않습니다. 그러나 도리코는 시작 반복과 일치하는 키 변경이 있거 

나 시작 반복이 시스템의 시작과 일치할 때 경고하지 않습니다. 어쨌든 키 서명이 표시됩 

니댜 

§ 위와 같지만, 여기서 다시 점프하는 것은 같은 우연적이지만 다른 의미를 가진 주요 

서명입니다 예를 들어, D장조에서 B단조로의 점프 같은 경우입니다. 
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Proofreading for repeated clefs. Dorico checks for the following situations: 

§ a duplicated clef: for example, a treble G clef following another treble G clef; 

§ a jump to a different clef: for example, a start repeat barline occurs after a 

change to the alto clef, and before the end repeat barline, a further change to 

the treble G clef occurs. When you jump back to the start repeat barline, you 

are once again reading the alto clef, but without a clef coinciding with the 

start of the repeat region, this is ambiguous. Dorico won’t warn where a clef 

change coincides with the start repeat, or when the start repeat coincides 

with the start of a system, in which case the clef will be shown anyway; 

§ a clef is showing an octave indication that contradicts the transposition of the 

instrument on which it’s been used: for example, using the treble G clef with 8 

above on the oboe makes little sense as the oboe doesn’t transpose, nor does 

it make sense for guitar, which is written an octave higher than it sounds, but 

it would be fine (if redundant) on piccolo; 

§ a clef is showing an octave indication that makes sense for the instrument, 

but a clef appeared earlier on without that qualification, or vice versa: for 

example, a piccolo part starts with a simple treble G clef, but later on, a treble 

G clef with 8 above is used; 

§ a clef has been explicitly hidden via the Hide clef property; 

§ a suspicious clef has been used for the instrument in question: for example, a 

percussion clef being used on a pitched instrument, a tab clef being used on a 

non-fretted instrument, etc. 

§ a clef has a custom octave shift via the Octave shift property; this is unusual 

enough that Dorico will always warn about it. 

Proofreading for repeated dynamics. Dorico checks for the following situations: 

§ a dynamic is present at a position at which no note is present, or gradual 

dynamics that begin or end at positions where no notes are present; 

§ two (or more) dynamics that coincide with or overlap each other; 

§ needlessly repeated dynamics: for example,   followed by another , though 

Dorico is careful not to report repeated hairpins in the same direction, or 

repeated force dynamics such as , , etc.; 

§ ambiguous dynamics at the start of repeat regions; 

§ truncated gradual dynamics and hairpins: for example, a hairpin that lasts for 

two bars, but is truncated halfway through the second bar by the presence of 

an immediate dynamic; 

§ suspicious dynamics at the ends of hairpins: for example, a diminuendo 

hairpin ending in a louder dynamic than the previous prevailing dynamic 

level that is not qualified with subito; 



반복되는 음열에 대한 교정. 도리코는 다음 상황을 확인합니 다. 

§ 복제된 음자리표: 예를 들어, 다른 고음 G 음자리표 다음에 오는 고음 G 음자리표; 

§ 다른 음자리표로의 점프: 예를 들어, 시작 반복 바라인은 알토 음자리표로 변경된 후에 발 

생하고, 종료 반복 바라인 전에 고음 G 음자리표로의 추가 변경이 발생합니다. 시작 반복 

영역으로 돌아가면, 다시 한 번 알토 음자리표를 읽게 되는 것이지만, 반복 영역의 시작과 

일치하는 음자리표가 없으면 이것은 모호합니다. 도리코는 음표 변경이 시작 반복과 일치 

하거나 시작 반복이 시스템의 시작과 일치하는 경우 경고하지 않을 것입니다. 이 경우 음 

표가표시됩니다. 

§ 음반은 그것이 사용된 악기의 전조와 모순되는 옥타브 표시를 보여줍니다. 예를 들어, 오 

보에 위에 8이 있는 고음 G 음반을 사용하는 것은 오보에가 전조되지 않기 때문에 거의 의 

미가 없으며, 기타가들리는 것보다 한옥타브 높게 쓰여진 것도 의미가 없지만, 피콜로에 

서는 괜찮을 것입니다. 

§ 음표는 악기에 적합한 옥타브 표시를 보여주고 있지만, 음표는 그 자격 없이 일찍 등장했 

거나그 반대의 경우도 있습니다. 예를 들어, 피콜로 부분은 간단한고음 G 음표로 시작하 

지만, 나중에는 위에서 8을 가진 고음 G 음표가 사용됩니다. 

§ 음자리표는 Hide 음자리표 속성을 통해 명시적으로 숨겨져 있습니다. 

§ 문제의 악기에 의심스러운 음정이 사용되었습니다 예를 들어, 음정이 높은 악기에 사용되 

는 타악기 음정, 비프레트 악기에 사용되는 탭 음정 등이 있습니다. 

§ 음정자리에는 옥타브 시프트 속성을 통해 맞춤형 옥타브 시프트가 있습니다. 이것은 도 

리코가 항상 그것에 대해 경고할 만큼 충분히 이례적입니다. 

반복되는 역학에 대한증명. 도리코는 다음 상황을 확인합니다. 

§ 음이 없는 위치에 동적이 존재하거나 음이 없는 위치에서 시작하거나 끝나는 점진적 

인동적이존재합니다 

§ 서로 일치하거나 겹치는 두 개의 역학 

§ 불필요하게 반복되는 동역학: 예를 들어, 도리코가 같은 방향으로 반복되는 헤어핀을 보고 

하지 않도록 주의하지만, 8, 섭 등과 같은 반복되는 힘 동역학이 뒤따르는 것입니다. 

§ 반복 영역의 시작 부분에서의 모호한 역학,. 

§ 잘린 점진적 역동성과 헤어핀: 예를 들어, 두 마디 동안 지속되지만 측각적인 역동성의 존 

재에 의해 두 번째 마디의 중간에서 잘린 헤어핀입니다. 

§ 
헤어핀 끝의 수상한 역학: 예를 들어, 서브키토로 자격이 없는 이전의 기존 동적 수 

준보다 더 큰 동적으로 끝나는 디미누엔도 헤어핀; 

도리코 6판역사 45 스타인버그 미디어 테크놀로지스 GmbH 

45/106 



 

 

Dorico 6 Version History 46 Steinberg Media Technologies GmbH 

§ a hairpin beginning or ending niente with another contradictory dynamic: for 

example, if a crescendo is marked both  and dal niente at its start, the  is 

redundant; 

§ no dynamic coinciding with the player’s first note or chord, unless the player’s 

music is completely devoid of dynamics, in which case the warning will not 

appear; 

§ no dynamic coinciding with the first note following an instrument change, 

unless (as above) the player’s part is completely devoid of dynamics; 

§ there are four or more empty bars preceding a new entry, and no dynamic 

marking is shown; 

§ a passage following a diminuendo to niente is missing a dynamic marking; 

§ a dynamic marking is present part-way through a note, not coinciding clearly 

with its onset. In such situations, it may be difficult to tell exactly where the 

change of dynamic should take effect; 

§ a gradual dynamic or hairpin ends at a rhythmic position that does not 

coincide with the end of note; 

§ either of the hairpins within a messa di voce has zero duration. 

Proofreading for repeated playing techniques. Dorico checks for the following situations: 

§ two identical playing techniques at the same position: for example, arco and 

arco; 

§ two contradictory playing techniques at the same position: for example, 

arco and pizz.; 

§ two synonymous playing techniques at the same position: for example, con 

sord. and with mute; 

§ two identical playing techniques, at least one of which has a duration, 

overlapping: for example, sul pont. and sul pont.; 

§ two contradictory playing techniques overlapping: for example, sul pont. 

and sul tasto; 

§ two synonymous playing techniques overlapping: for example, con sord. 

and with mute; 

§ a playing technique has a duration but shows no continuation line; 

§ a persistent playing technique is needlessly repeated: for example, arco 

followed by arco; 

§ a persistent playing technique is needlessly repeated as a synonym: for 

example, arco followed by nat. on violin; 

§ a persistent playing technique is repeated with less detail than its 

predecessor: for example, cup mute followed by con sord. on trumpet; 

§ the default playing technique for the instrument is stated at the start 

unnecessarily: for example, arco for violin. Dorico will look at the prevailing 



§ 
니엔테의 시작이나끝에 있는 머리핀은또 다른 모순된 역동성을 가지고 있습니다: 예를 

들어, 크레센도가 鄒와 달 니엔테 모두 표시되면, 그시작시에 g는 중복됩니다; 

§ 연주자의 음악에 역동성이 전혀 없는 한, 연주자의 첫 음이나 코드와 일치하는 역동성은 

없습니다 이 경우 경고가 나타나지 않습니다. 

§ 

§ 

악기 변경 후 첫 음과 일치하는 역학은 없습니다. （위와 같이) 연주자의 부분에 역학이 

완전히 없는한; 

새로운 진입 앞에 4개 이상의 빈 막대가있으며 동적 표시가표시되지 않습니다. 

§§ 디미누엔도에서 니엔테로 이어지는 구절에는 동적 표시가 없습니다. 

동적 표시는 노트의 일부를 통해 존재하며, 시작과 명확하게 일치하지 않습니다. 이러한 

상황에서는 역학의 변화가 정확히 어디에서 발생해야 하는지 말하기 어려울 수 있습니다. 

§ 

§ 

점진적인 다이내믹 또는 헤어핀은 그렇지 않은 리드미컬한 위치에서 끝납니다. 

노트의 끝과 일치합니다. 

메사 디 보이스 내의 두 헤어핀 중 하나는 지속 시간이 0입니다. 

반복적인 연주 기술에 대한 사전 확인. 도리코는 다음 상황을 확인합니다. 

§ 
같은 위치에서 두 가지 동일한 연주 기술, 예를 들어, 아르코와 아르코; 

§ 
같은 위치에서 두 가지 모순되는 연주 기술, 예룰 들어, 아르코와 피즈.; 

§ 
같은 위치에서 두 가지 동의어 연주 기술, 예를 들어, 콘 소드.와 음소거; 

§ 

§ 

두 가지 동일한 연주 기술 중 적어도 하나는 지속 시간이 있습니다. 예를 들어, 

술폰트.와술폰트.; 

두 가지 모순된 연주 기술이 겹치는데, 예를 들어, 술 폰트입니다. 

§ 
그리고 술맛; 

두 가지 동의어 연주 기술이 겹치는데, 예를 들어, 콘 소드입니다. 

§§ 

§ 

그리고 벙어리; 

연주 기술은 지속 시간이 있지만 연속선을 보여주지 않습니다. 

끈질긴 연주 기술이 불필요하게 반복됩니다: 예를 들어, 아르코 다음에는 아르코 

가뒤따르는것; 

끈질긴 연주 기술은 동의어로 불필요하게 반복됩니다. 예를 들어, 아르코 다음에 

는 낫 바이올린; 
§ 

끈질긴 연주 기술이 이전 기술보다 덜 세밀하게 반복됩니다. 예를 들어, 컵 음 

소거 다음에는 콘 소드. 트럽펫; 

§ 악기의 기본 연주 기술은 시작 부분에 불필요하게 명시되어 있습니 다: 예를 들어, 아르코 
바이올린을 위한 것입니다 도리코는 기존의 것을 살펴볼 것입니다. 
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playing technique at the end of the previous flow, if any, to decide whether 

to show this warning; 

§ if the prevailing playing technique at the end of the previous flow was not 

the default for the instrument, in which case Dorico will recommend adding 

the default playing technique at the start of the new flow; 

§ a playing technique has been used that is likely incompatible with the 

current instrument: for example, writing arco on flute; 

§ an ambiguous playing technique at the start of a repeat region: for example, 

a violinist might be playing arco before reaching a repeat region, then after 

the start repeat barline comes a change to pizz. After the jump back, it may 

not be clear whether they should now play arco or pizz.; 

§ an instantaneous technique is present at a position that doesn’t coincide 

with a note onset; for example, snap pizzicato; 

§ either the start, end, or the entirety of a playing technique with a duration 

does not coincide with a note onset, note end, or both, respectively; 

§ the technique to use at a change of divisi is ambiguous: for example, at the 

start of the flow, the violins are split into two sections, with one marked pizz. 

and the other marked arco. When the players return to playing in unison, it 

may not be clear whether they should all now play arco or pizz. 

Proofreading for instrument changes. When examining instrument changes, Dorico is 

looking for impractical or impossible instrument changes. It considers factors such 

as the size and portability of the instruments held by each player: for example, it 

takes less time for a player to place their flute on their lap in order to pick up their 

piccolo than it takes a double bass player to lay their instrument on the floor or rest 

it on a stand; similarly, when an instrument is stationary and the player is moving 

between them, such as a pianist moving to celeste, or a percussionist moving from 

marimba to glockenspiel. 

Dorico reports if the time between the end of the last note on the old instrument 

and the first note on the new instrument is likely to be too short for a comfortable 

change, or if in the worst case there is no time at all. 

Dorico also considers whether the two instruments in question could be played 

simultaneously and considers how many hands and feet the instrument requires to 

be played – not forgetting, of course, whether it needs to be blown. 

Finally, Dorico also warns if there is ambiguity about which instrument should be 

played after a repeat that jumps back to an earlier point in the flow. 

Proofreading for stringed instruments. This is the most complex of the categories, and 

involves detailed knowledge not only of human anatomy but also the physical 

properties of the instruments. It is difficult to calculate what kinds of chords will 

require painful or impossible stretches of the hand, considering the different 



이전 흐름의 끝에서 연주 기술이 있는 경우 이 경고를 표시할지 여부를 결정합니다. 

§ 이전 흐름의 끝에서 일반적인 연주 기법이 악기의 기본이 아니라면, 도리코는 새로운 

흐름의 시작 부분에서 기본 연주 기법을 추가할 것을 권장할 것입니다. 

§ 
현재 악기와 양립할 수 없는 연주 기술이 사용되었습니다. 예를 들어, 아르코 

플루트를 연주하는 것입니다. 
§ 

반복 영역이 시작될 때 모호한 연주 기술: 예를 들어, 바이올리니스트가 반복 영역에 도 

달하기 전에 아르코를 연주할수 있습니다. 시작후에 바라인이 피즈로 바뀝니다. 점프 

백 후에, 그들이 이제 아르코를 연주해야 하는지 아니 면 피즈. ; 

§ 순간적인 기술은 음 시작과 일치하지 않는 위치에 존재합니다 예를 들어, 스냅 피치 
?店토; 

§ 시작, 끝 또는 지속 시간이 있는 연주 기술의 전체가 각각음 시작, 음 끝 또는 둘 다 

와일치하지 않습니다. 

§ 제수의 변화에서 사용하는 기술은 모호합니다 예를 들어, 흐름이 시작될 때 바이올린 
은 두 부분으로 나뉘며, 하나는 표시된 피자입니다. 

그리고 다른 하나는 아르코입니다. 선수들이 일제히 경기에 복귀하면, 이제 모두 아르 

코를 해야 할지 모르겠습니다. 

악기 변경에 대한 증명. 악기 변경을 검토할 때 도리코는 비실용적이거나 불가능한 악기 변경을 찾고 

있습니다 각 연주자가 가지고 있는 악기의 크기와 휴대성과 같은 요소를 고려합니다. 예를 들어, 연주 

자가 피콜로를 집기 위해 플루트를 무릎에 놓는 시간이 더블 베이스 연주자가 악기를 바닥에 놓거나 스 

탠드에 놓는 데 걸리는 시간보다 적습니다. 마찬가지로 악기가 있을 때도 마찬가지입니다. 피아니스트 

가 셀레스트로 이동하거나 타악기 연주자가 마림바에서 굴로켄슈필로 이동하는 것처럼 정지 상태에 

있고 연주자는 그 사이를 이동합니 다. 

도리코는 이전 악기의 마지막 음이 끝나는 것과 새 악기의 첫 음 사이의 시간이 너무 짧아서 편 

안한 변화를 줄 수 없거나, 최악의 경우 시간이 전혀 없을 경우 보고합니다. 

도리코는 또한 문제의 두 악기를 동시에 연주할 수 있는지 여부를 고려하고 악기를 연주해야 하는 

지 여부를 고려합니다. 물론 불어야 하는지 여부를 잊지 않습니다. 

마지막으로,도리코는또한흐름의 이전 지점으로 다시 넘어가는 반복후에 어떤 악기를연주 

해야 하는지에 대한모호함이 있을 경우 경고합니다. 

현악기의 교정. 이것은 가장 복잡한 범주이며 인체 해부학뿐만 아니라 악기의 물리적 특성에 대한 

자세한 지식을 포함합니다 어떤 종류의 화음이 고통스럽거나 불가능한 손을 뻗어야 하는지 계산하 

기 어렵습니다. 
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combinations of strings on which a chord may be played, and the different fingers 

that can be used to stop them. Dorico only has this most detailed level of knowledge 

for a handful of the most common instruments, including violin, viola, cello, double 

bass, various guitars and bass guitars, mandolin, ukulele, and banjo. 

We have consulted with professional string players to verify our research, asked 

them to play all manner of difficult chords, and have listened to their feedback. 

The result is that Dorico can provide warnings about many situations that 

otherwise would require consultation with an experienced player of that 

instrument. The warnings should be considered only as advisory, and if you are 

unsure about anything, consult your own friendly neighborhood string or guitar 

player to ask their advice. 

With all that said, Dorico checks for the following situations: 

§ Impossible stretch: the chord requires the fingers to be contorted or 

stretched into a shape that isn’t viable. 

§ Impossible stretch using specified string(s): as above, but the chord is 

playable, just not on the string(s) specified via properties. 

§ Questionable stretch: the chord might be stretchable, but it’s at the verge of 

playability. 

§ Two or more notes require the same string: for example, imagine a chord of 

G3 and B3 written for violin; both these notes can only be played on the G 

string, so it’s impossible. 

§ Two or more notes require the same string using the specified string(s): as 

above, but the notes would be playable on other strings; the strings 

specified via properties make this impossible. 

§ Too many pitches in chord: for example, writing a five-note chord for violin. 

§ Impossible harmonic: the written harmonic can’t be produced on the 

instrument: for example, asking a violinist to play middle C as a harmonic. 

§ Impossible harmonic using specified string(s): as above, but the harmonic 

would be playable on another string; the string(s) specified via properties 

make this impossible. 

§ Dubious number of natural harmonics present: this is specific to the 

harmonic circle shown above the chord, and warns when the number of 

harmonic circles doesn’t match the number of notes in a chord; this 

warning only considers harmonics created by setting the Harmonic 

property, not those created as explicit playing techniques. 

§ Impossible fingered tremolo: although it is a little crude, this considers all the 

pitches in the tremolo as if they were a single chord and warns if the chord 

requires too many fingers or an impossible stretch. 



코드를 연주할 수 있는 현의 조합과 그것을 멈추기 위해 사용할 수 있는 다양한 손가락들입 니다. 

도리코는 바이올린, 비올라, 첼로, 더블 베이스, 다양한 기타 및 베이스 기타, 만돌린, 우쿨렐레, 밴 

조를포함한소수의 가장일반적인 악기들에 대한가장자세한수준의 지식만을 가지고있습니다. 

우리는 전문 현악 연주자들과 상의하여 우리의 연구를 확인하고, 그들에게 모든 종류의 어 려 

운 코드를 연주하도록 요청했으며, 그들의 피드백을 들었습니다. 

그 결과 도리코는 그 악기의 숙련된 연주자와 상담이 필요한 많은 상황에 대해 경고를 제공 

할수있습니다 경고는주의 사항으로만간주되어야하며,확신이 없는 경우에는자신의 친 

근한 동네 현이나 기타 연주자에게 조언을 구하세요. 

그렇게 말하면서도, 도리코는 다음과 같은 상황을 확인합니 다. 

§ 불가능한 스트레칭 코드는 손가락을 비틀거나 실행할 수 없는 모양으로 눌 
려야합니다 

§ 지정된 문자열을 사용하여 불가능한 스트레칭: 위와 같지만 코드는 속성을 통 
해 지정된 문자열에서만 연주할 수 있습니다. 

§ 
의심할 만한 신축성: 코드는 신축성이 있을 수 있지만 연주 가능성에 가까워졌습니다. 

§ 
두 개 이상의 음은 동일한 현을 필요로 합니다: 예를 들어, 바이올린을 위해 쓰여진 

G3와 83의 코드를 상상해 보세요; 이 두 음은 모두 G 현에서만 연주될 수 있으므로 

불가능합니다. 

§ 두 개 이상의 음표에는 지정된 문자열을 사용하여 동일한 문자열이 필요합니다. 
그러나 음표는 다른 문자열에서 연주할 수 있습니다. 속성을 통해 지정된 문자열 

은 이것을 불가능하게 만듭니 다. 

§ 화음의 음이 너무 많습니다: 예를 들어, 바이올린을 위한 5음 코드를 쓰는 것입니다. 

§ 불가능한 화성 악보의 화성은 악기에서 만들어질 수 없습니댜 예를 들어, 바이올리 
니스트에게 중간 C를 화성으로 연주해 달라고 요청하는 것입니다. 

§ 지정된 문자열을 사용하는 불가능한 고조파: 위와 같이, 그러 나 그 고조파는 다른 문 
자열에서 연주할수 있습니다;속성을통해 지정된 문자열은 이것을불가능하게 만듭 

니댜 

§ 존재하는 자연스러운 화성들의 수가 의심스럽습니댜 이것은 화음 위에 표시된 화 

성 원에만 해당되며, 화성 원의 수가 화음의 음 수와 일치하지 않을 때 경고합니다. 

이 경고는 화성 특성을 설정하여 만들어진 화성만을 고려하지 않습니다. 

§ 불가능한 손가락 트레올로 비록 약간 조잡하지만, 이것은 트레몰로의 모든 음정을 마 
치 하나의 화음인 것처럼 간주하고 화음이 너무 많은 손가락을 필요로 하거나 불가능 

한 스트레칭을 경고합니 다. 
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§ Requires use of thumb: on cello and double bass only, Dorico allows the use 

of the thumb on the left hand, but warns about it, as it’s not something the 

player can do without preparation and time to reposition their hand. 

§ Requires use of thumb with questionable stretch: as above, but the stretch 

between the thumb and other finger is extreme. As such, the chord might be 

stretchable, but if it is, it’s at the verge of playability. 

§ Cannot play snap pizzicato with other techniques: a warning that one or more 

notes are to be played snap pizzicato, but there are others in the same chord 

that require other techniques. 

§ Difficult to play dyads using snap pizzicato: a warning that snap pizzicato is 

possible on two adjacent strings, but it’s not particularly easy. 

§ Cannot play snap pizzicato on more than two strings: a chord is written with 

snap pizzicato comprising more than two pitches; this is not playable. 

§ Cannot play snap pizzicato on non-adjacent strings: a dyad is to be played 

snap pizzicato, but the two strings required to play the dyad aren’t adjacent; 

this is not playable. 

§ Cannot play snap pizzicato on specified non-adjacent strings: as above, but 

the dyad would be playable on another two strings; the strings specified via 

properties make this impossible. 

§ No finger left to perform left hand pizzicato: the chord requires the use of all 

four fingers on the left hand, but in addition a left-hand pizzicato marking is 

present; this is not playable, as there are no spare fingers left to do this. 

Cutaways 
Cutaway scores – also sometimes called scrapbook scores, or sparse scores – arose 

out of the avant garde musical practices of the 1950s and 1960s. There is some 

debate as to where the practice was first used, but Witold Lutosławski’s Jeux 

Vénetiens (1961) is one of the earliest examples. The practice was adopted by many 

composers around this time, including Ligeti, Berio, Penderecki, Xenakis, and 

Stravinsky. The following are the opening bars of the latter composer’s Requiem 

Canticles (1966): 

 

  
più che gli altri Vlns.


 





non ma ben marcato


non ma ben marcato

non ma ben marcato


non ma ben marcato

Tutte semicrome eguale, = 250

1Violin Solo
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§ 엄지 사용이 필요합니다: 첼로와 더블베이스만사용할수 있습니다. 도리코는 왼손에 

엄지손가락을 사용할 수 있지만, 플레이어가 손을 다시 위치시킬 준비와 시간 없이 할 

수 있는 일이 아니기 때문에 이에 대해 경고합니다. 

§ 
스트레치가 의심스러운 엄지손가락을 사용해야 합니다: 위와 같이 엄지손가락과 다른 손 

가락사이의 스트레치가 극심합니다. 따라서 코드는 신축성이 있을 수 있지만, 그렇다면 

연주 가능성에 가깝습니다. 

§ 다른 기법으로는 스냅 피치카토를 연주할 수 없습니다 스냅 피치카토를 연주해야 한다 
는 경고입니다 그러나 같은 코드로 다른 기법이 필요한 다른 음도 있습니다. 

§ 스냅 피치카토를 사용하여 쌍곡을 연주하는 것은 어렵습니다: 스냅 피치카토가 인접 
한두 줄에서 가능하지만, 특별히 쉽지는 않습니다. 

§ 두 개 이상의 현에서 스냅 피치카토를 연주할 수 없습니다 스냅 피치카토로 코드가 작 
성됩니다 두 개 이상의 음정으로 구성됩니다 이것은 연주할 수 없습니다. 

§ 인접하지 않은 현에서는 스냅 피치카토를 연주할 수 없습니다 스냅 피치카토를 연주 
해야 하지만, 다이애드를 연주하는 데 필요한 두 개의 현은 인접하지 않습니다. 이것은 

연주할수없습니다. 

§ 특정된 인접하지 않은 문자열에서는 스냅 피치카토를 연주할 수 없습니다: 위와 같이, 
그러 나 쌍은 다른 두 문자열에서 연주할 수 있습니 다. 속성을 통해 지정된 문자열은 이 

것을 불가능하게 만듭니다. 

§ 왼손피치카토를 연주할손가락이 남아있지 않습니다:코드는왼손의 네 손가락을모 
두 사용해야 하지만, 왼손 피치카토 표시가 있습니다. 이를 위해 사용할 수 있는 여분의 

손가락이 남아 있지 않기 때문에 연주할 수 없습니 다. 

피난민 

1950년대와 1960년대의 아방가르드 음악 관행에서 비롯된 컷어웨이 악보는 스크랩북 악보 또 

는드문드문 악보라고도불립니다. 이 관행이 어디서 처음사용되었는지에 대해서는약간의 논쟁 

이 있지만, 비틀드 루토스와프스키의 주 베네티엔스(1961)가 가장 초기 사례 증 하나입니다. 이 

관행은 이 무렵 리게티, 베리오, 펜데레츠키, 제나키스, 스트라빈스키를 포함한 많은 작곡가둘에 

의해 채택되었습니다 다음은 다음의 오프닝 바입니다. 후자의 작곡가의 레퀴엠 캔티클(1966): 
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The defining feature of a cutaway score is that when instruments are silent, their 

staves are not shown: they are literally cut away, leaving only white space, and 

creating a fragmented appearance. Proponents of the practice believe that it 

improves the readability of scores for large ensembles, especially in music with 

discontinuous or pointillistic texture, making it easier to focus on the key musical 

gestures and interactions – though there is debate about this, with other significant 

figures in the avant garde movement, including Pierre Boulez and Elliott Carter, 

being critical of their use. Some composers even use these approaches even in 

music for soloists, such as Iannis Xenakis’s Evryali for solo piano. 

This approach is certainly not suitable for every kind of score, but it has undeniably 

been influential over the past more than half a century, and Dorico 6 now includes 

comprehensive and sophisticated tools to produce cutaway scores. 

Enabling cutaways. Dorico can produce cutaway scores completely automatically, 

providing a good appearance by activating a single option. Of course, you can exert 

complete control over every aspect of the score’s appearance, but to get started, 

simply activate Automatically cut staves away in empty bars in the new Cutaways 

section of the Staves and Systems page of Layout Options. 

When this is activated, the following option Minimum number of empty bars 

before cutting away takes effect: the default value is 1, which means that Dorico 

will cut a staff away at the barline at the start of the first empty bar in an instrument. 

By default, Dorico will only cut away an instrument when all its staves contain bar 

rests: if you want to allow a grand staff instrument, such as a piano, to be cut away 

when only one of its staves has a bar rest, activate Allow each staff of grand staff 

instruments to be cut away independently. 

Cutaways are only visible in page view: in galley view and fill view, they are not 

shown. 

Automatic cutaways can not be used in layouts where multi-bar rests are visible. 

Editing music in a cutaway score. When a staff is cut away, it is still possible to input 

music there, which will cause the automatic cutaway points to be recalculated. By 

default, Dorico shows gray staff lines in cutaways, to show you where the staves are 

vertically on the page, and allowing you to double-click to show the caret and input 

music. 

These gray staff lines do not print and will be hidden when you hold down ~ to hide 

all invisible items. To hide them altogether, deactivate View ▶ Cutaway Staff Lines. 

Creating manual cutaways. You can create cutaways manually, regardless of whether 

Automatically cut away staves in empty bars is activated. By default, and 

matching most published examples, Dorico only automatically cuts away a staff at a 



도리코 6판역사 

컷어웨이 악보의 특징은 악기가 침묵할 때 오선지가 표시되지 않는다는 것입니다. 문자 그대로 

잘려 나가서 하얀 공간만 남고 조각난 모습을 만듭니다. 이 관행을 지지하는 사람들은 그것이 큰 

앙상블의 가독성을 향상시켜, 특히 불연속적이거나 점묘한 질감을 가진 음악에서 주요 음악적 제 

스처와 상호 작용에 더 쉽게 집중할 수 있다고 믿습니다. 이에 대한 논쟁이 있지만, 다른 중요한 

것들과의 상호 작용에 대한 논쟁이 있습니다. 아방가르드 악장에 등장하는 인물들, 예를 들어 피 

에르 불레즈와 엘리엇 카터 등은 그 사용에 비판적입니다. 일부 작곡가들은 심지어 이아니스 크세 

나키스의 에브리알리의 솔로 피아노를 위한 음악에서도 이러한 접근 방식을 사용합니다. 

이 접근 방식은 확실히 모든 종류의 점수에 적합하지는 않지만, 지난 반세기 이상 동안 영향을 미 

쳤다는 것은 부인할 수 없습니 다. 그리고 도리코 6에는 이제 컷어웨이 점수를 만들기 위한 포괄적 

이고 정교한도구가포함되어 있습니다. 

컷어웨이 활성화. 도리코는 단일 옵션을 활성화하여 컷어웨이 점수를 완전히 자동으로 생성할 수 있습 

니다 물론 악보의 모든 측면을 완전히 제어할 수 있지만, 시작하려면 레이아웃 옵션의 스테이브 및 시 

스템 페이지의 새로운 컷어웨이 섹션에서 빈 막대에서 자동으로 잘린 스테이브를 활성화하기만 하면 

됩니다 

이것이 활성화되면 다음 옵션이 적용됩니다. 절단하기 전에 최소 빈 막대 수가 발생합니다. 기본 

값은 1 이며, 이는도리코가 악기의 첫 번째 빈 막대가 시작될 때 막대선에서 직원을 절단한다는 

것을의미합니다 

기본적으로 도리코는 모든 오선보에 막대 받침대가 있을 때만 악기를 잘라냅니다. 피아노와 같 

은 그랜드 스태프 악기를 잘라내려면 오선보 중 하나에만 막대 받침대가 있을 때 잘라내야 합 

니다 그랜드 스태프 악기의 각 스태프를 독립적으로 잘라낼 수 있도록 활성화하십시오. 

컷웨이는 페이지 보기에서만볼 수 있습니다. 갤리 보기와 채우기 보기에서는 표시되지 

않습니댜 

자동 컷어웨이는 다중 막대 받침대가 보이는 레이아웃에서는 사용할 수 없습니다. 

악보로 음악을 편집합니다. 스태프가 잘려나간 경우에도 그곳에서 음악을 입력할 수 있으므로 자동 컷 

어웨이 포인트가 다시 계산됩니다. 기본적으로 도리코는 컷어웨이에 회색 스태프 라인을 표시하여 페 

이지에서 세로로 오선지가 있는 위치를 보여주고, 두 번 클릭하여 관리를 표시하고 음악을 입력할 수 

있습니다. 

이 회색 스태프 라인은 인쇄되지 않으며 누르면 숨겨져 있습니 다. 보이지 않는 모든 항목을 숨 

기기 위해서입니다 그것들을 완전히 숨기기 위해서는 직원 라인 ► 보기를 비활성화하세요. 

수동 컷어웨이 만들기. 빈 막대에서 자동으로 오선지를 자르는지 여부에 관계없이 수동으로 컷어웨이 

를 만들 수 있습니다. 기본적으로 대부분의 공개된 예제와 일치하여 도리코는 직원을 자동으로 잘라냅 

니다 
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barline, so if you want a staff to be cut away in the middle of a bar, this requires 

manual intervention. 

Similarly, if you want a staff to be cut away at the same position as another 

instrument, for example one in the same family, but material in each staff starts or 

stops in different bars, you will need to create manual cutaways to make them 

match. 

You can create both a manual cutaway start, which defines the position at which a 

staff becomes cut away, and a manual cutaway end, defining the position at which a 

staff reappears. 

To create both a manual cutaway start and end, first select an item at the position 

where you want the staff to stop, and another item at the position where you want 

the staff to reappear, then right-click to show the context menu, and from the Staff 

submenu choose Create Manual Cutaway. 

To create a manual cutaway start or end only, select an item at the relevant position 

on one or more staves, right-click, and from the Staff submenu in the context 

menu, choose Create Start Cutaway or Create End Cutaway. Manual cutaways are 

represented by signposts, which you can copy and paste, move to different 

positions, and delete. 

If you create a cutaway end before a staff that is cut away due to automatic behavior 

would reappear, the staff will reappear at your chosen cutaway end position. 

To override this behavior, such that the staff will either remain cut away or shown 

until the next manual cutaway, ignoring any automatic points at which Dorico 

would otherwise have cut away the staff or shown it again, select the cutaway 

signpost and activate Applies until next manual cutaway change in the Cutaways 

group in the Properties panel. 

By default, manual cutaways apply to all staves of an instrument: change this by 

deactivating the Applies to all staves property. 

Be aware that if automatic cutaways are disabled, when you create a cutaway start, 

the rest of the staff will be cut away, and you will need to create a cutaway end to 

make it reappear. 

If you want to quickly select and delete all manual cutaways in your project, you can 

use the dedicated quick filter, Edit ▶ Filter ▶ Cutaways. 

Staff line protrusion. By default, Dorico extends the staff lines beyond the cutaway start 

point by 1 space. You can adjust this via the Staff line protrusion at start of 

cutaway n spaces option on the new Cutaways page of Engraving Options. 



도리코 6판역사 

바라인, 그래서 바 중간에 직원을 자르려면 수동 개입이 필요합니다. 

마찬가지로, 만약 같은 계열의 다른 악기와 같은 위치에서 자르려면, 예를 들어 각스태프의 재 

료가 다른 막대에서 시작하거나 멈추게 되면, 이를 맞추기 위해 수동 절단 장치를 만들어야 합 

니다 

수동 컷어웨이 시작과 직원이 다시 나타나는 위치를 정의하는 수동 컷어웨이 끝을 모두 만들 수 

있습니댜 

수동 컷어웨이 시작과 끝을 모두 만들려면 먼저 직원이 멈추기를 원하는 위치의 항목을 선택하 

고 직원이 다시 나타나기를 원하는 위치의 다른 항목을 선택한 다음 오른쪽 버튼을 눌러 컨텍 

스트 메뉴를 표시하고 직원 메뉴에서 수동 컷어웨이 만들기를 선택합니다. 

수동 컷어웨이 시작또는 종료만을 만들려면 하나 이상의 스테이브에서 해당 위치의 항목을 선택 

하고 오른쪽 버튼을 누르고 컨텍스트 메뉴의 스태프 하위 메뉴에서 시작 컷어웨이 만들기 또는 종 

료 컷어웨이 만들기를 선택합니다. 수동 컷어웨이는 표지석으로 표시되며, 복사 및 붙여넣기, 다 

른 위치로 이동 및 삭제할 수 있습니다. 

자동 행동으로 인해 잘린 스태프가 다시 나타나기 전에 컷어웨이 엔드를 만들면, 스태프가 선택 

한 컷어웨이 엔드 위치에 다시 나타납니다. 

이 동작을 무시하기 위해, 도리코가 직원을 자르거나 다시 보여주었을 자동 지점을 무시하고, 

다음 수동 컷어웨이까지 직원이 잘린 상태로 남아 있거나표시되도록 하려면, 컷어웨이 표지판 

을 선택하고 속성 패널의 컷어웨이 그룹에서 다음 수동 컷어웨이 변경이 있을 때까지 애플리케 

이션을활성화합니다. 

기본적으로 수동 컷어웨이는 악기의 모든 스테이브에 적용됩니다. 모든 스테이브 속성에 대 

한 애플리케이션을 비활성화하여 변경합니다. 

자동 컷어웨이가 비활성화되면 컷어웨이 시작을 만들 때 나머지 직원들이 잘리게 되며, 다시 

나타나려면 컷어웨이 끝을 만들어야 합니다. 

프로젝트에서모든수동컷어웨이를빠르게선택하고삭제하려면전용퀵필터,편집 ► 필터 ► 

컷어웨이를 사용할 수 있습니다. 

직원 라인 돌출. 기본적으로 도리코는 직원 라인을 컷어웨이 시작점 너머로 1 칸 확장합니다. 컷어 

웨이 시작 시 직원 라인 돌출부를 통해 이를 조정할 수 있습니다. n칸 옵션 조각 페이지에서 옵션입 

니댜 

51 스타인버그 미디어 테크놀로지스 GmbH 

51 /106 



 

 

Dorico 6 Version History 52 Steinberg Media Technologies GmbH 

If you prefer Dorico to also extend the staff lines to the left of the cutaway end point, 

you can adjust Staff line protrusion at end of cutaway n spaces. 

A new Staff line protrusion property has been added, allowing you to override the 

amount by which staff lines protrude at manual cutaway starts and ends. Select the 

cutaway signpost in Engrave mode to find the property in the Cutaways group. 

Appearance at the start of the system. In some cutaway scores, the so-called preamble 

for each instrument (its staff label, clef, etc.) is shown even if the staff is cut away at 

the start of the system; in others, only those staves that are playing at the start of 

the system show their preamble. 

Use the Starts of systems with cutaways option on the Cutaways page of 

Engraving Options to choose between these different approaches: 

 
Both With brackets and solid systemic barline shows a preamble for every staff, so 

that all staff labels and clefs can be found at the left-hand margin. 

When any of the other three options is chosen, when a staff is cut away at the start 

of the system, its preamble is shifted to its first appearance on the system. These 

preambles do not take up rhythmic space, and protrude into the rhythmic space of 

the preceding cutaway. 

System items and cutaways. System items, such as tempo, rehearsal marks, time 

signatures shown above the staff, etc., will by default appear above the first visible 

staff if the staff above which they would ordinarily appear is cut away. 

You might prefer to keep such items at a consistent vertical position across the full 

width of the system, regardless of cutaways, in which case you should activate 

Show system-attached items above cutaways in the Cutaways section of the 

Staves and Systems page of Layout Options. 

Similarly, if you are showing bar numbers at positions other than the start of the 

system, you might find it helpful to see them at the same vertical position across the 

full width of the system: if so, activate Show bar numbers above cutaways. 

Staff labels. When staff labels are shown at the first appearance of an instrument in the 

middle of the system, there may be no bracket shown at that position, in which case 

the staff label should be positioned closer to the left-hand end of the staff. To 



도리코가 절단 끝 지점의 왼쪽으로 스태프 라인을 확장하는 것을 선호하는 경우 절단 끝에서 스 

태프 라인 돌출을 조정할 수 있습니다.n 공간. 

새로운 스태프 라인 돌출 속성이 추가되어 수동 절단 시작과 끝에서 스태프 라인이 돌출되는 양 

을 무시할 수 있습니다. 절단 표지판을 인그레이브 모드에서 선택하여 절단 표시 그룹의 속성을 

찾습니다. 

시스템 시작 시 등장합니다. 일부 컷어웨이 악보에서는 시스템 시작 시 스태프가 잘려도 각 악기에 대 

한소위 전문(스태프 레이블,클리프 등)이 표시됩니다. 다른 악보에서는 시스템 시작시 연주되는스 

테이브만이 전문을표시합니다. 

의 Cutaways 페이지에서 Cutaways 옵션이 있는 시스템의 시작을 사용합니다 

이러한 다양한접근 방식 중에서 선택할수 있는 옵션을 새깁니다. 
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괄호와 단단한 전신 막대선 모두 모든 스태프에 대한 전문을 보여주므로 모든 스태프 라벨과 클리 

프를 왼쪽 여백에서 찾을 수 있습니다. 

다른 세 가지 옵션 중 하나를 선택하면 시스템 시작 시 직원이 잘리면 그 전문이 시스템에 처음 

나타나는 것으로 이동합니다. 이 프리앰블들은 리드미컬한공간을 차지하지 않으며, 앞의 컷어 

웨이 부분의 리드미컬한공간으로 돌출됩니다. 

시스템 항목 및 컷어웨이. 템포, 리허셜 마크, 스태프 위에 표시된 시간 서명 등과 같은 시스템 항목 

은 일반적으로 나타나는 스태프가 잘리면 기본적으로 첫 번째 보이는 스태프 위에 나타납니다. 

이러한 항목을 컷어웨이에 관계없이 시스템 전체 너비에 걸쳐 일관된 수직 위치에 유지하는 것 

을선호할수 있습니다 이 경우 레이아웃옵션의 스테이브 및시스템 페이지의 컷어웨이 섹션 

에서 컷어웨이 위에 시스템 부착 항목을 표시해야 합니다. 

마찬가지로, 시스템의 시작 부분이 아닌 다른 위치에서 막대 번호를 표시하고 있다면, 시스템 전 

체 너비에서 동일한 수직 위치에서 보는 것이 도움이 될 수 있습니다: 그렇다면 컷어웨이 위의 막 

대 번호 표시를 활성화하세요. 

직원 라벨 시스템 중앙에 있는 기구의 첫 등장 시 직원 라벨이 표시되면 해당 위치에 브래킷이 표시되 

지 않을 수 있으며, 이 경우 직원 라벨은 직원의 왼쪽 끝에 더 가깝게 위치해야 합니다. 
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accommodate this, the options on the Staff Labels page of Engraving Options for 

the gaps between outer and inner staff labels and the systemic barline now have 

separate values for With brackets and Without brackets. 

In new projects, the Without brackets option is set to a smaller value than With 

brackets, but to preserve the appearance of existing projects, the values are set 

identically when opening projects last saved in a previous version. 

Player group labels. If players are grouped in the Players panel in Setup mode, and player 

group labels are shown, Dorico will try to consolidate group labels for players in the 

same group, even if they first appear on a system at different positions. Provided 

the cutaways end within less than half the width of the system, Dorico will prefer to 

create a player group label at the earliest possible position on the system, even if 

one or more of the players in the group does not appear at that position. 

Coordination lines 
Coordination lines – sometimes also called synchronization lines, or time 

alignment lines – are vertical lines that indicate the alignment of musical events 

happening in different instrumental parts. They are often, though not exclusively, 

used in cutaway scores, such as in Stravinsky’s Requiem Canticles (1966): 

 

accent in 




accent in 




accent in 


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

 harm.

 harm.
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이를 수용하기 위해, 인그레이빙 옵션의 스태프 라벨 페이지에 있는 옵션 외부 및 내부 스태프 

라벨과 시스템 바라인 사이의 간격에 대한 옵션에는 이제 괄호 없음과 괄호 없음에 대한 별도 

의값이있습니다 

신규 프로젝트에서는 With Bracket보다 Without Bracket 옵션이 작은 값으로 설정되지 

만, 기존 프로젝트의 외관을 유지하기 위해 이전 버전에서 마지막으로 저장된 프로젝트를 

열 때도 동일하게 설정됩니다. 

플레이어 그룹 레이블입니다. 설정 모드에서 플레이어 패널에 플레이어가 그룹화되고 플레이어 그룹 

레이블이 표시되면 도리코는 동일한 그룹의 플레이어에 대한 그룹 레이블을 통합하려고 합니다. 다른 

위치에서 시스템에 처음 나타나더라도 컷어웨이가 시스템 폭의 절반 미만에서 끝나면 도리코는 그룹 

의 플레이어 중 한 명 이상이 그렇지 않더라도 시스템에서 가능한 한 빨리 플레이어 그룹 레이블을 만 

드는 것을 선호합니다. 그 자세로 나타나세요. 

조정선 

조정선은 때로는 동기화선 또는 시간 정렬선이라고도 불립니다. 이는 서로 다른 악기 부분에 

서 발생하는 음악적 사건의 정렬을 나타내는 수직선입니다. 이들은 스트라빈스키의 레퀴엠 캔 

티클스(1966): 
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Dorico can display coordination lines between any pair of staves, and they can be 

positioned either relative to notes at any rhythmic position, or at barlines, where 

they can be aligned either to the barline itself, the time signature if present, or the 

note, chord, or rest at the start of the bar.  

Creating a coordination line. Coordination lines are created in Engrave mode, because 

they are specific not only to the layout in which they are created, but also the frame 

chain. In addition, it’s common for coordination lines to be aligned with barlines, 

and it is only possible to select individual barline sections that span different staves 

in Engrave mode. 

Select a note or barline on the staff where the top of the coordination line should 

appear and click Create Coordination Line in the left-hand panel in Engrave mode, 

or right-click and choose Staff ▶ Create Coordination Line. You can also use the 

jump bar. 

The new coordination line is drawn from the selected staff to the next visible staff. 

To adjust which staves are joined by the coordination line, switch to Write mode: 

the coordination line has circular handles at each end, and these can be dragged to 

the staff above or below. 

Changing the appearance of coordination lines. By default, coordination lines are drawn 

using a dashed line. You can choose which line style is used on the new 

Coordination Lines page of Engraving Options. 

Because coordination lines are often drawn at barline positions, by default 

whichever line style you choose will have its width adjusted to match the Thin 

barline thickness value on the Barlines page of Engraving Options. If you want to 

disable this width adjustment, deactivate Use barline width if applicable on the 

Coordination Lines page. (This does not apply to lines drawn with repeatable 

symbols or tapered curves.) 

Coordination lines are sometimes drawn with arrowheads at either or both ends. If 

you choose a line style with an arrowhead or other terminal symbol, and find that it 

appears at the wrong end of the coordination line, activate the Reverse checkbox. 

You can also override the appearance of any selected coordination line via the 

Properties panel: activate the Line style property to choose a different line style, 

and again you can Reverse it if necessary. 

Alignment of coordination lines. By default, when a coordination line is at a barline 

position, it is centered on the barline. On the Coordination Lines page of Engraving 

Options, you can specify whether coordination lines should be drawn on the barline 

or on the first note, chord, or rest in the bar; if drawn at the barline, whether it 

should be aligned with the barline itself, or with a time signature, if one is present; 
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도리코는 어떤 오선지 쌍 사이에 조율선을 표시할 수 있으며, 이들은 어떤 리듬 위치에서도 음 

표에 비해 위치할 수 있습니다. 이는 존재하는 경우 박자 기호, 또는 바라인 자체와 정렬될 수 

있습니다 

조정선 생성. 조정선은 생성된 레이아웃뿐만 아니라 프레임 체인에도 특정하기 때문에 앵그레이브 모 

드에서 생성됩니다 또한 조정선은 기준선과 정렬되는 것이 일반적이며, 앵그레이브 모드에서는 서로 

다른 오선에 걸쳐 있는 개별 기준선 섹션을 선택하는 것만 가능합니다. 

조정 라인의 상단이 나타나야 하는 부분의 메모나 바라인을 선택하고 왼쪽 패널의 조정 라인 만들 

기를클릭하거나오른쪽 버튼을눌러 조정 라인 만들기를선택하세요. 점프 바를사용할수도 있 

습니댜 

새로운 조정 라인은 선택된 직원에서 다음으로 보이는 직원으로 그려집니다. 

어떤 오선지가 조정 라인에 의해 연결되는지 조정하려면 쓰기 모드로 전환하십시오. 

조정 라인에는 양쪽 끝에 원형 손잡이가 있으며, 이 손잡이를 위나 아래 직원에게 끌고 갈 수 있습 

니댜 

코디 라인의 모양 변경. 기본적으로코디 라인은 점선을사용하여 그려집니다. 새로운 라인 스타일 

에사용될것을선택할수있습니다. 

옵션 조각 조정의 줄 페이지입니다 

조정선은 종종 기준선 위치에 그려지기 때문에, 어떤 선 스타일을 선택하든 기본적으로 각인 

옵션의 기준선 페이지의 얇은 기준선 두께 값과 일치하도록 너비가조정됩니다. 이 너비 조정 

을 비활성화하려면 조정 라인 페이지에서 해당되는 경우 사용 바라인 너비를 비활성화하십시 

오. （반복 가능한 기호나 테이퍼 곡선으로 그려진 선에는 해당되지 않습니다) 

조정선은 때때로 양쪽 끝에 화살촉으로 그립니다. 화살촉이나 다른 단자 기호가 있는 라인 스타일 

을 선택했는데, 조정 라인의 잘못된 끝에 나타나는 것을 발견하면, 리버스 체크박스를 활성화하세 

요. 

또한 속성 패널을 통해 선택한 조정 라인의 모양을 무시할 수 있습니다. 라인 스타일 속성을 

활성화하여 다른 라인 스타일을 선택하고 필요한 경우 다시 되돌릴 수 있습니다. 

조정선의 정렬 기본적으로 조정선이 기준선 위치에 있을 때는 기준선을 중심으로 합니다. 옵션 조각 

의 조정선 페이지에서 조정선이 기준선에 그려져야 하는지 또는 첫 음, 코드 또는 바에 있어야 하는지 

지정할 수 있습니다. 기준선에 그려진 경우, 기준선 자체와 정렬되어야 하는지 또는 박자 서명이 있는 

경우; 
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and if drawn at a note position, whether it should be left- or center-aligned with the 

notehead. 

Each of these alignment options can also be overridden using corresponding 

properties in the Coordination Lines group in the Properties panel. 

Graphical adjustments in Engrave mode. In Engrave mode, you can nudge a selected 

coordination line left or right to change its horizontal position, and square handles 

appear at each end, inset slightly to avoid colliding with the handles on barlines, 

allow you to make fine adjustments to the position of each end of the line. 

Coordination lines always remain vertical, so it is not possible to adjust the 

horizontal position of either end independently. 

Multiple lines of chord symbols 
It is sometimes necessary to show more than one line of chord symbols, for 

example to show alternate harmonies, as seen here in the first few bars of Joseph 

Kosma’s Autumn Leaves: 

 
Dorico 6 now makes it easy to create multiple lines of chord symbols. In the Shift+Q 

popover, press ↑/↓ to set the line number, which is indicated in the label at the left-

hand side. 

Changing the line for a chord symbol. If necessary, you can also change the line of an 

existing chord symbol, either by changing Chord symbol line in the Chord Symbols 

group in the Properties panel, or by right-clicking and choosing the target line from 

the Chord Symbols and Diagrams submenu in the context menu. 

Distance between lines. The default distance between lines of chord symbols can be 

adjusted by changing Distance between adjacent lines of chord symbols in the 

Position section of the Chord Symbols page of Engraving Options. 

Playback. Only the first line, closest to the staff, appears in the Chords track in Play mode 

and will play back. 

Chord symbol extender lines 
Chord symbols can now have their duration edited, either by clicking immediately 

to the right of the chord symbol in Write mode to reveal a circular handle that can 

be dragged to show a extender line; or lengthened or shortened using 

Shift+Alt+←/→. 




Cm7 F7 B maj7
(Bm7 E7

E maj7
B m7 E 7)

- - -The fall ing leaves drift by my win dow, The au tumn

A
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그리고 노트 위치에 그린 경우, 노트 헤드와 왼쪽 또는 중앙 정렬해야 합니다. 

이러한 각 정렬 옵션은 속성 패널의 조정 라인 그룹에 있는 해당 속성을 사용하여 무시될 

수도 있습니다. 

인그레이브 모드에서 그래픽 조정. 인그레이브 모드에서는 선택한 조정선을 왼쪽 또는 오른쪽으로 밀 

어 수평 위치를 변경할 수 있으며, 각 끝에 정사각형 핸들이 나타나 바라인의 핸들과 충돌하지 않도록 

약간 삽입되어 라인의 각 끝 위치를 미세하게 조정할 수 있습니다. 

조정선은 항상 수직으로 유지되므로 어느 쪽 끝의 수평 위치를 독립적으로 조정할 수 

는없습니다 

여러즐의화음 

때로는 한 줄 이상의 화음 기호를 보여주는 것이 필요합니다. 예를 들어, 조셉 코스마의 "가을 

잎”의 첫 몇 마디에서 볼 수 있듯이, 다른 화성을보여주기 위해서입니다: 

~Cm7 

몰락 나뭇잎 

대프7 

=E 그 
근5....L. 

(Bm7 
E7cB maj7 

다우 

Blm7 E 7) I, 

□l,Xl7 

오가을 

이제 도리코 6을 사용하면 여 러 줄의 코드 기호를 쉽게 만들 수 있습니 다. Shift+Qpopover에서 

T/!를 눌러 왼쪽에 표시된 라인 번호를 설정합니다. 

코드 기호에 대한 줄 변경. 필요한 경우 속성 패널의 코드 기호 그룹에서 코드 기호 줄을 변경하거나 

오른쪽 버튼을 눌러 컨텍스트 메뉴의 코드 기호 및 다이어그램 하위 매뉴에서 대상 줄을 선택하여 기 

존 코드 기호의 줄을 변경할수도 있습니다. 

줄 사이의 거라 코드 기호 줄 사이의 기본 거리는 옵션 조각 코드 기호 페이지의 위치 섹션에서 

인접한 코드 기호 줄 사이의 거리를 변경하여 조정할 수 있습니다. 

재생. 스티프와 가장 가까운 첫 번째 줄만 재생 모드에서 코드 트랙에 나타나 재생됩니다 

화음연장선 

코드 기호는 이제 쓰기 모드에서 코드 기호의 오른쪽을 즉시 클릭하여 확장기 선을 표시하기 

위해 끌 수 있는 원형 손잡이를 표시하거나 Shift+Alt+ +- ！－ 를 사용하여 길어지거나 짧아짐으 

로써 지속 시간을 편집할 수 있습니다. 
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Chord symbol extender lines extend from the right-hand side of the chord symbol 

and are truncated by the next chord symbol in the same line. 

By default, a solid line with an inward hook is used, but this can be changed in the 

Extender Lines section of the Chord Symbols page of Engraving Options, and it can 

also be overridden for an individual chord symbol via the new Extender line style 

property. 

Further properties are provided in Engrave mode for adjusting the vertical position 

of the extender line relative to the chord symbol, and for fine positioning of the end 

of the extender line. 

Editing chord symbol appearances 
Dorico provides dozens of options to tweak the appearance of chord symbols via the 

Chord Symbols page of Library ▶ Engraving Options. Nevertheless, it is sometimes 

necessary to adjust specific chord symbols to achieve a particular appearance. 

Dorico 6 introduces powerful new features for customizing existing chord symbols 

and even creating your own entirely new custom chord symbols. But before we 

describe these new features in detail, because Dorico now provides so many ways 

to edit chord symbol appearances it is worth summarizing the recommended way 

to work with these interlocking features. 

As you learn about these features, you may find it helpful to create a simple scratch 

project that contains a representative set of chord symbols so you can see how your 

edits take effect. We also recommend that you decide at the outset which text and 

music fonts you want to use for your chord symbols. Before you make further 

customizations, use Library ▶ Font Styles and edit the Chord Symbols Font and 

Chord Symbols Music Text Font font styles. 

Once you have created a project that includes a range of chord symbols and in 

which you have chosen your preferred fonts, we recommend working in this order: 

§ Choose the Chord symbol preset at the top of the Chord Symbols page of 

Engraving Options that gets closest to your preferred appearance. 

§ Carefully examine the individual options on the Chord Symbols page to 

bring specific chord symbols as close as possible to your preferred 

appearance. 

§ Check the Design section of the Chord Symbols page to adjust the offsets 

and scale factors for various components, as these can have a dramatic 

impact on the overall appearance of chord symbols, particularly when using 

different fonts. 

§ After you have exhausted the possibilities of the Engraving Options dialog, if 

you are unhappy with the precise horizontal spacing of individual 



코드 기호 연장선은 코드 기호의 오른쪽에서 연장되 며, 같은 선의 다음 코드 기호에 의해 잘립 

니댜 

가본적으로 안쪽으로 후크가 있는 실선이 사용되지만, 이는 옵션 조각 코드 심볼 페이지의 

Extender Lines 섹션에서 변경될 수 있으며, 새로운 Extender 라인 스타일 속성을 통해 개별 코 

드 심볼에 대해서도 무시될 수 있습니다. 

코드 기호에 대한 익스텐더 라인의 수직 위치를 조정하고 익스텐더 라인의 끝을 미세하게 배치하 

기 위해 추가 속성이 인그레이브 모드에서 제공됩니다. 

편집화음 

Dorico는 Library ► 각인 옵션의 코드 기호 페이지를 통해 코드 기호의 모양을 조정할 수 있는 

수십 가지 옵션을 제공합니다. 그럼에도 불구하고, 특정한 모습을 얻기 위해 특정 코드 기호를 조 

정해야 하는 경우가 있습니다. 

도리코 6는 기존 코드 심볼을 사용자 정의하고 완전히 새로운 사용자 정의 코드 심볼을 만들 수 

있는 강력한새로운 가능을 선보입니다. 하지만 이러한새로운특징들을 자세히 설명하기 전에, 

도리코는 이제 코드 기호 모양을 편집할 수 있는 많은 방법을 제공하고 있으므로, 이 러 한 연동 기 

능들을 다루는 권장되는 작업 방법을 요약할 가치가 있습니다. 

이러한 기능에 대해 배우면, 대표적인 코드 기호 세트를 포함하는 간단한 스크래치 프로젝트를 만 

드는 것이 도움이 될 수 있습니다. 그래서 편집이 어떻게 효과를 발휘하는지 볼 수 있습니다. 또 

한 코드 기호에 사용할 텍스트와 음악 글꼴을 처음부터 결정하는 것이 좋습니 다. 추가 사용자 정 

의를 내리기 전에 라이브러리 ► 폰트 스타일을 사용하고 코드 기호 글꼴과 코드 기호 음악 텍스 

트 폰트 스타일을 편집하세요. 

다양한 코드 기호를 포함하는 프로젝트를 만들고 선호하는 글꼴을 선택하면 이 순서대로 작업하 

는것이 좋습니다. 

§ 

§ 

옵션 조각 코드 기호 페이지 상단에 미리 설정된 코드 기호를 선택하여 선호하는 모 

양에 가장 가까운 옵션을 선택합니다. 

코드 기호 페이지의 개별 옵션을 주의 깊게 살펴보아 특정 코드 기호를 선호하는 

모양에 최대한가깝게 만듭니다. 

§ 코드 기호 페이지의 디자인 섹션을 확인하여 다양한 구성 요소에 대한 오프셋 및 스케일 

요소를 조정하십시오. 이러한 요소는 특히 다른 글꼴을 사용할 때 코드 기호의 전체적인 

모양에 극적인 영향을 미칠 수 있습니다. 

§ 
각인 옵션 대화의 가능성을 소진한 후, 개인의 정확한 수평 간격이 마음에 들지 않는 경우 
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components, use the Library ▶ Chord Symbol Kerning Pairs dialog (new in 

Dorico Pro 6) to adjust these kerning pairs – see Chord symbol kerning 

pairs below. 

§ Next, use Library ▶ Chord Symbols to adjust the appearance of whole chord 

symbol appearances, or individual components. There are new features in 

Dorico 6 to make this more powerful, described below. 

§ Finally, if you want to adjust the appearance of an individual chord symbol 

for a specific context – for example, where you need a narrower, more 

compact chord symbol in a series of rapid changes – double-click the chord 

symbol in Engrave mode to override the appearance of that single instance. 

If you discover that there is a specific type of chord symbol that you cannot create at 

all, Dorico 6 introduces a new way to create completely custom chord symbols – see 

Custom chord symbols below. 

Editing default chord symbol components. Library ▶ Chord Symbols allows you to edit the 

appearance of individual components within chord symbols, and entire chord 

symbols. A component is a single element of a chord symbol, such as the root note 

name, chord symbol quality, interval, individual alteration, parenthesis, and so on. 

To edit an individual component, enter a chord symbol that contains the 

component in the field at the top of the dialog, or choose one of the existing saved 

default chord symbols from the list on the left. In the main editing area, select the 

relevant component: it is highlighted in the row of compatible components below 

the editing area. Click the Edit Component button  in the action bar to open the 

symbol editor: any changes you make in this editor will be reflected in all chord 

symbols where that component is used. 

If you know you want to edit the component in a way that does not affect any other 

chord symbols, click Add Component  to create a new component based on the 

selected one. This new component will be saved to the project library, but will not be 

used in any chord symbols by default, unless you explicitly choose it from the row of 

compatible components when editing another chord symbol. 

Editing default chord symbol appearances. Editing an entire chord symbol appearance 

normally involves two aspects: choosing which components should be used; and 

determining how they should be positioned and scaled relative to one another. 

To choose which components are used, select each component in the editing area 

in turn: the row of compatible components below the editing area shows 

alternatives, and you can simply select another component from the row to replace 

the current one, editing it if necessary, or create a new one. 
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구성 요소, 라이브러리 ► 코드 심볼 커닝 쌍 대화(도리코 프로 6에서 새로 나온 것)를 

사용하여 이러한커닝 쌍을조정합니다. 아래코드심볼커닝쌍을참조하세요. 

§ 다음으로 라이브러리 ► 코드 기호를 사용하여 전체 코드 기호 모양 또는 개별 구성 요 

소의 모양을조정합니다. 도리코 6에는 이룰 더 강력하게 만들기 위한새로운 기능이 

있습니다 

§ 마지막으로, 특정 상황에 맞게 개별 코드 기호의 모양을 조정하려면, 예를 들어 일련의 

빠른 변화에서 더 좁고 컴팩트한 코드 기호가 필요한 경우, 인그레이브 모드에서 코드 

기호를 두 번 클릭하여 해당 단일 인스턴스의 모양을 무시합니다. 

만약 여러분이 전혀 만들 수 없는 특정 유형의 코드 기호가 있다는 것을 발견한다면, 도리코 6은 

완전히 맞춤형 코드 기호를 만드는 새로운 방법을 소개합니다. 아래의 맞촘형 코드 기호틀 참조하 

셰요. 

기본 코드 기호 구성 요소 편집. 라이브러 리 ► 코드 기호를 사용하면 코드 기호 내에서 개 별 구성 요 

소의 모양과 전체 코드 기호를 편집할 수 있습니 다. 구성 요소는 루트 음 이름, 코드 기호 품질, 간격, 개 

별 변경, 괄호 등과 같은 코드 기호의 단일 요소입니다. 

개별 구성 요소를 편집하려면 다음을 포함하는 코드 기호를 입력합니다. 

대화상단의 필드에 있는구성 요소를 선택하거나왼쪽목록에서 기존에 저장된 기본코드 기 

호중 하나를선택합니다 주요편집 영역에서 해당구성 요소를선택합니다: 편집 영역 아래 호 

환 가능한 구성 요소의 행에 강조 표시됩니다. 액션 바에 서 구성 요소 편집 버튼을 클릭 

하여 기호 편집기를 엽니다: 이 편집기에서 변경한모든 사 ’길항은 해당구성 요소가사용되 

는모든코드기호에 반영됩니다. 

다른코드기호에 영향을 미치지 않는 방식 으로구성 요소를편집하고싶다면,선택한구성 

요소를 추가하기를 클릭하여 새로운 구성 요口’소를 만듭니다. 이 새로운 구성 요소는 프로젝트 

라이브러리에 저장되지만, 다른코드 기호를편집할때 호환가능한구성 요소의 행에서 명시적으 

로 선택하지 않는 한, 기본적으로 어 떤 코드 기호에서도 사용되지 않습니 다. 

기본 코드 기호 모양 편집. 전체 코드 기호 모양을 편집하는 것은 일반적으로 두 가지 측면을 포함합 

니다: 어떤 구성 요소를 사용해야 하는지 선택하는 것과 서로에 대해 어떻게 배치되고 조정되어야 

하는지롤 결정하는 것입니다. 

어떤 구성 요소를 사용할지 선택하려면 편집 영역의 각 구성 요소를 차례로 선택합니다. 편집 영 

역 아래에 있는 호환 가능한 구성 요소의 행에는 대안이 표시되 며, 행에서 다른 구성 요소를 선택 

하여 현재의 구성 요소를 대체하거나 필요한 경우 편집하거나 새 구성 요소를 만들 수 있습니다. 
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To adjust the overall appearance of the chord symbol, select each component in the 

editing area and adjust its relative position and scale either with the mouse, or 

using the X offset, Y offset, and Scale controls at the bottom of the dialog. 

By default, any change you make in this dialog affects only the specific chord 

symbol you are looking at: for example, if you are editing “Gmaj7”, any changes you 

make will not apply to, say, “G♭maj7” or “Amaj7”. This is where Dorico 6’s new chord 

symbol appearances for all roots come into their own. 

Chord symbol appearances for all roots. To make the changes you have made to the 

appearance of a chord symbol in Library ▶ Chord Symbols apply to every root note, 

click Apply to All Roots in the action bar at the bottom of the list on the left-hand 

side of the dialog. You will be warned that this operation cannot be undone: if you 

choose to proceed, the root note in the editing area turns gray and can no longer be 

selected. Two new buttons, Prev root and Next root, appear at the top of the dialog, 

allowing you to cycle through different root notes, to check how your custom 

appearance looks on a variety of roots. 

Once you are satisfied with your chord symbol appearance for all roots, click OK to 

confirm the dialog. All chord symbols of the same type, on any root, is updated to 

use your new appearance, unless that chord symbol has already been individually 

overridden. 

Italic appearances. Chord symbols may be shown in italics if Capo chord symbol 

appearance is set to In italics on the Chord Symbols page of Engraving Options. 

Library ▶ Chord Symbols now allows you to view these different appearances by 

choosing them from the new Appearance toggle buttons above the editing area: 

 
If you want to tweak the italic appearance independently of the normal appearance, 

deactivate the Synchronize with normal appearance checkbox, and the chord 

symbol becomes editable in the editing area below. 

It is not possible to edit the placement of the parentheses relative to the chord 

symbol appearance: the size and position of the parentheses is always determined 

by the relevant settings in Engraving Options. 

Custom chord symbols 
Dorico’s approach to chord symbols, in common with its approach to all other 

aspects of music notation, is semantic. It is concerned not only with how the chord 

symbol should appear, but also its musical content and meaning: the intervallic 

relationship between the notes, and their function. This allows Dorico to choose an 

appropriate chord diagram for every fretted instrument, to play back the chord 

symbol, and to use the chord symbol as the basis for generating musical material. 



화人4 
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코드 기호의 전체적인 모양을조정하려면 편집 영역에서 각구성 요소를선택하고 마우스로또는 

대화 하단에 있는 X 오프셋, Y 오프셋 및 스케일 컨트롤을 사용하여 상대적인 위치와 스케일을 조 
정합니다 

기본적으로 이 대화에서 변경하는 경우 보고 있는 특정 코드 기호에만 영향을 미칩니다. 예를 들 

어, "Gmaj7'’을 편집하는 경우 변경 사항은 "Gbmaj7'' 또는 "Amaj7"에는 적용되지 않습니다 여 

기서 도리코 6의 모든 뿌리에 대한 새로운 코드 기호가 그들만의 것으로 나타나게 됩니다. 

모든 루트에 대한 코드 기호 표시. 라이브러리에서 코드 기호가 나타나도록 변경하려면 코드 기호가 

모든 루트 음에 적용됩 니 다. 대화의 왼쪽에 있는 목록 하단에 있는 액션 막대에서 모든 루트에 적용됩 

니다 이 작업을 취소할 수 없다는 경고를 받게 됩니다. 진행을 선택하면 편집 영역의 루트 음이 회색으 

로 변하여 더 이상 선택할수 없습니다. Prev 루트와 Next 루트라는두 개의 새로운 버튼이 나타납니 

댜 대화의 상단을 통해 다양한 루트 노트를 순환하여 다양한 루트에서 사용자 정의 모양이 어 떻게 보 

이는지 확인할 수 있습니 다. 

모든 루트에 대한 코드 기호 모양이 만족되면 확인을 클릭하여 대화를 확인하세요. 모든 동일 

한유형의코드기호는모든루트에서 업데이트되어 새로운외관을사용할수 있습니다. 단,그 

코드 기호가 이미 개별적으로 무시되지 않는 한 말입니다. 

이탤릭체로 표시됩니다 옵션 조각 코드 기호 페이지에 카포 코드 기호 표시가 이탤릭체로 표시 

되어 있는 경우 코드 기호가 표시될 수 있습니 다. 

라이브러리 ► 코드 기호를 사용하면 이러한 다양한 모습을 볼 수 있습니다. 

편집 영역 위의 새로운 외관 토글 버튼에서 선택: 

I 이모 정싱 이델릭체로 표사된 괄호 ；；1리된 이델릭체와 람호 표시 3 ' ' I ' | I | 
이탤릭체 모양을 정상 모양과 독립적으로 수정하려면, 동일화 체크박스를 비활성화하면 코드 기 

호가 아래 편집 영역에서 편집 가능합니다 

코드 기호모양에 대한괄호의 배치를 편집하는 것은불가능합니다: 괄호의 크기와위치는항 

상 각인 옵션의 관련 설정에 의해 결정됩니다. 

도리코의 코드 기호에 대한 접근 방식은 음악 기보의 다른 모든 측면에 대한 접근 방식과 마찬가 

지로 의미론적입니다 그것은 코드 기호가 어떻게 나타나야 하는지뿐만 아니라 그 음악적 내용과 

의미, 즉 음들사이의 음간 관계와그 기능에 관한 것입니다. 이를통해 도리코는 모든 프렛 악기 

에 적합한 코드 다이어그램을 선택하고, 코드 기호를 재생하며, 코드 기호를 음악적 자료룰 생성 

하기 위한 기초로 사용할 수 있습니 다. 
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One consequence of this semantic approach, however, is that it is not possible to 

paint outside the lines of Dorico’s understanding of the function and structure of 

chord symbols, and given the almost infinite variety of chord symbols in use (as the 

saying goes, the wonderful thing about standards is that there are so many of them), 

some chord symbols were hard to create. 

To address this, Dorico 6 introduces the ability to define a custom chord symbol: 

specify a pattern of intervals relative to a root, define its graphical appearance, and 

specify the text you need to enter in the Shift+Q popover to create it. 

Defining a custom chord symbol. To get started, choose Library ▶ Chord Symbols. In the 

Enter a chord symbol field in the top left, type the chord symbol you want to edit, in 

the way you would specify it in the Shift+Q popover: there’s a good chance that what 

you type will map onto an existing chord symbol that Dorico already supports, in 

which case that is what you will see. If, however, you type something that Dorico 

doesn’t recognize, it will prompt you to create a custom chord symbol: click OK, and 

the Create Custom Chord Symbol dialog appears: 

 
In the Chord Symbol Name section, specify the Name for your new custom chord 

symbol; this is the name that will appear in the list in Library ▶ Chord Symbols. 

Popover text defines what you must type into the popover to create this chord 

symbol: what you specify here does not include the root. So, for example, if you are 

creating a “sus6” chord (whatever such a fantastical beast might be), Popover text 

might be sus6, and in the popover you would type, say, C#sus6 to create a “sus6” 

chord on a root of C♯. 



도리코 6판역사 

그러나 이러한 의미론적 접근의 한 가지 결과는, 도리코가 이해한 코드 기호의 기능과 구조를 벗 

어나 그림을 그리는 것이 불가능하다는 점입니다. 그리고사용되는 코드 기호가 거의 무한히 다양 

하다는 점을 고려할 때(표준의 멋진 점은 그것들이 너무 많다는 것입니다)， 일부 코드 기호는 만들 

기가 어려웠습니다. 

이를 해결하기 위해 Dorico 6은 맞춤형 코드 기호를 정의하는 기능을 소개합니 다. 

루트에 대한 간격 패턴을 지정하고 그래픽 모양을 정의한 다음 Shift+Q 팝오버에 입력해야 하는 
텍스트를 지정하여 생성합니다. 

맞춤형 코드 기호 정의. 시작하려면 라이브러리 ► 코드 기호를 선택하십시오. 왼쪽 상단의 코드 기호 

필드를 입력하십시오. Shift+Q 팝오버에서 지정하는 방식으로 편집하려는 코드 기호를 입력합니다: 

입력하는 것이 도리코가 이미 지원하고 있는 기존 코드 기호에 매핑될 가능성이 높습니다. 이 경우에 

는 그렇게 됩니다. 그러나 도리코가 인식하지 못하는 것을 입력하면 맞춤형을 만들도록 유도합니다. 

코드 기호: 확인을 클릭하면 사용자 정의 코드 기호 만들기 대화가 나타납니다. 

코드 기호 이름 섹션에서 새 맞춤 코드 기호의 이름을 지정하십시오. 이것은 라이브러리 ► 코 

드 기호 목록에 표시될 이름입니다. 

Popover 텍스트는 이 코드 기호를 만들기 위해 Popover에 입력해야 하는 내용을 정의합니 

다: 여기에 지정된 내용에는 루트가 포함되지 않습니다. 예를 들어, 만약 당신이 "sus6" 코드를 

만들고 있다면(그런 환상적인 짐승이 무엇이든 간에), Popover 텍스트는 sus6일 수 있습니 

다 그리고 Popover에서 C#sus6이라고 입력하여 C#의 뿌리에 "sus6" 코드를 만듭니다. 
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To define the intervals in the chord symbol, you can either specify them from 

scratch or start from an existing chord symbol. When starting from an existing 

chord symbol, you can specify any root you like: the custom chord symbol you 

define here can be expressed relative to any root, and you can transpose the whole 

chord symbol up or down using the buttons in the action bar at the bottom of the 

dialog. 

To add an interval to the custom chord symbol: 

§ Choose the interval from the two drop-downs above the keyboard display, 

and click Add Interval; or 

§ Click on keys in the keyboard display to add or remove that note from the 

chord symbol; or 

§ Click MIDI Listen and then play a chord on your MIDI keyboard. 

In the keyboard display, the root of the chord is indicated with a red dot; the other 

notes are then expressed as intervals above that root. Each interval is also shown in 

the list on the right-hand side, and you can cycle through the different ways of 

expressing the interval enharmonically by clicking the button  in the action bar at 

the bottom of the list. 

When you confirm the Create Custom Chord Symbol dialog, you are returned to 

the Library ▶ Chord Symbols dialog, where you can edit the appearance of your new 

custom chord symbol. 

Chord symbol kerning pairs 
Kerning is the adjustment of space between individual letters to improve readability 

and visual balance in typography. Digital fonts include tables that specify kerning 

pairs, the precise horizontal position between a pair of two characters when they 

appear next to each other in text. 

In Dorico, chord symbols also employ kerning, but with the twist that adjacent 

characters in a chord symbol may come from different fonts. Chord symbols are 

drawn using characters from two font styles: Chord Symbols Font specifies the font 

used for the text parts of chord symbols, such as the root note (C, D, E), quality (min, 

maj, aug), interval and alteration numbers, etc.; Chord Symbols Music Text Font 

specifies the font used for the symbol parts, such as accidentals, the triangle 

sometimes used for major sevenths, the circle and slashed circle used for 

diminished and half-diminished chords, etc. 

Because two adjacent characters in a chord symbol may come from different fonts, 

and because the characters may also have unusual placement (the character on the 

right may be offset vertically, or scaled to a different size, or both), using the built-in 



코드 심볼의 간격을 정의하려면 처음부터 지정하거나 기존 코드 심볼에서 시작할 수 있습니 

다 기존 코드 기호에서 시작할 때, 마음에 드는 루트를 지정할 수 있습니다. 여기서 정의한 맞 

충 코드 기호는 어떤 루트에 대해서도 표현될 수 있으며, 대화 상자의 하단에 있는 액션 바의 버 

튼을 사용하여 전체 코드 기호를 위아래로 옮길 수 있습니다. 

맞춤 코드 기호에 음정을 추가하려면: 

§ 키보드 디스플레이 위의 두 드롭다운 중 간격을 선택하고 간격 추가를 클릭하세요. 

§ 키보드 디스플레이의 키를 클릭하여 해당 음을 추가하거나 제거합니다. 

§ 
화음 

미디 리스닝을 클릭한 다음 미디 키보드로 코드를 연주하세요. 

키보드 디스플레이에서 코드의 루트는 빨간 점으로 표시됩니다. 그런 다음 다른 음들은 그 루트 

위의 간격으로 표시됩니다. 각 간격은 오른쪽 목록에도 나와 있으며, 목록 하단에 있는 액션 바의 

버튼을 클릭하여 이 명동음으로 간격을 표현하는 다양한 방법을 순환할 수있습니다 

回

사용자 정의 코드 기호 만들기 대화를 확인하면 라이브러리 ► 코드 기호 대화로 반환되며, 여기 

서 새로운 사용자 정의 코드 기호의 모양을 편집할 수 있습니다. 

코드코드각화쌍 

Kerning은 타이포그래피에서 가독성을 향상시키고 시각적 균형을 맞추기 위해 개별 글자 사이 

의 공간을 조정하는 것입니다 디지털 폰트에는 Kerning 쌍을 지정하는 표가 포함되어 있습니 

댜 두 굴자가 텍스트에서 서로 옆에 나타날 때의 정확한 수평 위치입 니 다. 

도리코에서는 코드 기호도 케닝을 사용하지만, 코드 기호의 인접한 문자들이 다른 글꼴에서 나을 

수 있다는 반전이 있습니다. 코드 기호는 두 가지 글꼴 스타일의 문자를 사용하여 그려집니다: 코 

드 기호 폰트는 코드 기호의 텍스트 부분에 사용되는 글꼴을 지정합니 다. 예를 들어, 루트 음(C, 

D, E), 품질(min, maj, aug), 간격 및 변경 번호 등이 있습니다 코드 기호 음악 텍스트 폰트는 사 

고, 때때로 장 7도에 사용되는 삼각형, 축소 및 반 축소 코드에 사용되는 원 및 축소 원 등과 같은 

기호 부분에 사용되는 글꼴을 지정합니다. 

코드 기호에서 인접한 두 문자가 서로 다른 폰트에서 나을 수 있고, 문자가 특이한 배치를 가질 수 

도 있기 때문에(오른쪽 문자가 수직으로 오프셋되거나 다른 크기로 조정되거나 둘 다) 내장을 사 

용합니다. 
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kerning tables in fonts is insufficient to provide the fine control required to produce 

chord symbols with perfect kerning. 

Dorico therefore uses its own special kerning table to define the kerning between 

pairs of components used in chord symbols, but this kerning table was built with a 

single pair of fonts in mind: Academico for the text parts of chord symbols, and 

Bravura Text for the symbol parts. As such, when you use different fonts for chord 

symbols, the fixed values from Dorico’s built-in kerning table will often produce 

less optimal results. 

To address this, Dorico 6 introduces a new editor for chord symbol kerning pairs, 

allowing you to define your own kerning tables for any pair of fonts, and make fine 

adjustments to the horizontal positioning of any pair of chord symbol components. 

To get started, double-click a chord symbol in Engrave mode; this now opens the 

kerning pairs editor by default, instead of the chord symbol appearance editor. To 

change this default, set Double-click on a chord symbol in Engrave mode opens to 

Appearance Editor on the Note Input and Editing page of Preferences. 

Alternatively, choose Library ▶ Chord Symbol Kerning Pairs. This dialog appears: 

 
Defining a new kerning table. The list on the left of the dialog shows the kerning tables 

that are available. To create a new table for a new combination, select one of the 

existing kerning tables from the list, and click + in the action bar. A simple dialog 

appears in which you can choose the family and style for the Text font and Music 

font: 



폰트의 커닝 테이블은 완벽한 커닝으로 코드 기호를 생성하는 데 필요한 미세한 제어를 제공하기 

에충분하지않습니다 

따라서 Dorico는 자체적인 특수 커닝 테이블을 사용하여 코드 기호에 사용되는 구성 요소 쌍 

간의 커닝을 정의하지만, 이 커닝 테이블은 코드 기호의 텍스트 부분에 대한 Academico와 기 

호 부분에 대한 Bravura Text라는 단일 폰트 쌍을 염두에 두고 만들어졌습니 다. 따라서 코드 

기호에 대해 다른 글꼴을 사용할 때 도리코의 내장된 커닝 테이블의 고정된 값은 종종 덜 최적 

의 결과를생성합니다. 

이를 해결하기 위해 Dorico 6에서는 코드 심볼 커닝 쌍을 위한 새로운 편집기를 도입하여, 어 

떤 폰트 쌍에 대해서도 자신만의 커닝 테이블을 정의할 수 있으며, 코드 심볼 구성 요소 쌍의 수 

펑 위치를 미세하게 조정할 수 있습니다. 

시작하려면 Engrave 모드에서 코드 기호를 두 번 클릭하면 됩니다. 이제 코드 기호 모양 편집기 

가 아닌 커닝 쌍 편집기가 기본적으로 열립니다. 이 기본값을 변경하려면, 설정 모드에서 코드 기 

호를 더블 클릭하면 설정 설정의 노트 입력 및 편집 페이지에서 [등장 편집기]가 열립니다. 

또는 라이브러리 ► 코드 기호 커닝 페어를 선택하세요. 이 대화가 나타납니다: 
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새로운 커닝 테이블 정의. 대화 왼쪽에 있는 목록에는 사용 가능한 커닝 테이블이 표시됩니다. 새로 

운 조합에 대한새로운 테이블을 만들려면 목록에서 기존 커닝 테이블 중 하나를 선택하고 액션 바 

에서 +를 클릭합니다 텍스트 글꼴과 음악 글꼴에 대한 계열과 스타일을 선택할 수 있는 간단한 대 

화가 나타납니다. 
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The new kerning table will include all the pairs defined in the existing kerning table 

and provides a starting point for further editing. 

Choosing kerning pairs to edit. Type a full or partial chord symbol into the edit control at 

the top of the dialog: the chord symbol appears in the editing area below. 

In the editing area, two components of the chord symbols are shown with a light 

blue background, and the right-hand shaded component additionally has a blue 

outline. This indicates the component that will be moved if you use the key 

commands Alt+←/→. You can alternatively drag the component left and right with 

the mouse or enter a numeric value into the spin control below the editing area. To 

reset the kerning value for the selected pair, click Reset in the bottom right of the 

dialog. 

Three small preview panels below the editing area show how the chord symbol 

appears at different sizes, providing feedback on the impact of the kerning changes 

you are making. 

The three sets of paddles at the top right of the dialog allow you to cycle through 

different chord symbol components, so you can quickly check the kerning between, 

say, different roots and the “m” component for a minor chord: 

§ Root (shortcut ↑/↓) changes the root note 

§ Quality (shortcut Alt+↑/↓) cycles between major, minor, diminished, 

augmented, dominant seventh, etc. 

§ Interval (shortcut Ctrl+↑/↓ (Windows) or Command+↑/↓ (macOS)) cycles 

between seventh, ninth, eleventh, thirteenth, etc. 

Editing the kerning for stacked components. When a chord symbol contains stacked 

components – for example, a polychord, or a chord symbol with stacked alterations 

– hit I or double-click a component in the editing area to edit it in more detail. For 

stacked alterations, you can further double-click each alteration individually to edit 

the kerning between the accidental and the digits. 

Above the editing area, you will see a “breadcrumb trail”: 

 



도리코 6판역사 

새로운 커닝 테이블에는 기존 커닝 테이블에 정의된 모든쌍이 포함되며 추가편집을 위한출발점 

을제공합니다. 

편집할커닝 쌍을선택합니다. 대화상단의 편집 컨트롤에 전체 또는부분코드기호를 입력합니 

댜 코드 기호는 아래 편집 영역에 나타납니다. 

편집 영역에서는 코드 기호 중 두 가지 구성 요소가 하늘색 배경으로 표시되며, 오른쪽 음영 부분 

에는 파란색 윤곽이 추가로 표시됩니다. 이것은 키 명령어 Alt+ ._ I - 를 사용하면 이동할 구성 요 

소를 나타냅니다. 마우스로 구성 요소를 좌우로 드래그하거나 편집 영역 아래의 스핀 컨트롤에 숫 

자값을입력할수 있습니다. 선택한쌍의 커닝 값을재설정하려면 대화대화의 오른쪽 하단에 있 

는 리셋을클릭하세요. 

편집 영역 아래에 있는세 개의 작은 미리보기 패널은코드 기호가 다양한크기로 나타나는 방식 

을 보여주어, 당신이 하고 있는 커 닝 변화의 영향에 대한 피드백을 제공합니 다. 

대화의 오른쪽 상단에 있는 세 세트의 패들을 사용하면 서로 다른 코드 기호 성분을 순환할 수 있 

습니다 따라서 다른 뿌리와 단조 코드에 대한 '"' m성분 사이의 커닝을 빠르게 확인할 수 있습니 

다. 

§ 루트(바로가기 T/J)는 루트 음을 바꿉니 다 

§ 장조, 단조, 축소, 증강, 딸림 7도 등 사이의 품질(단축 Alt+t/! ) 사이클입니다. 

§ 7, 9, 11, 13 등 사이의 간격(Ctrl+r/ ! (Windows) 또는 Command+r/ ! (macOS) 주 
기) 주기입니다 

적층 구성 요소에 대한 커닝 편집 . 코드 기호에 적층 구성 요소가 포함되어 있는 경우(예: 폴리코드 또 

는 적층 변경이 있는 코드 기호) 편집 영역에서 구성 요소를 누르거나 두 번 클릭하여 더 자세히 편집합 

니다 적층 변경의 경우각변경을 개별적으로두 번 클릭하여 우발적인 부분과숫자사이의 커닝을 편 

집할수있습니다 

편집 영역 위에는 "빵가루 혼작'이 표시됩니다. 
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Hit O or click any of the buttons in the trail to move back up through the hierarchy 

of components. 

Using chord symbol kerning pair tables. Dorico looks for a chord symbol kerning pair 

table that matches the font family and style defined for the Chord Symbol Text Font 

and Chord Symbol Music Text Font font styles currently in use. If it cannot find a 

matching table, it falls back on the default table for Academico and Bravura Text. 

Separate tables are provided for italic fonts, which are typically only used if capo 

chord symbols are set to be drawn using italics. 

Saving chord symbol kerning pair tables as defaults. To save changes to one of the default 

tables, or to make your own custom table available in all future projects, click the 

star button  in the action bar: when the star is filled, the selected table is saved in 

the user library; when it is shown as an outline, the selected table is not saved in the 

user library. 

You can also update the chord symbol kerning pair tables in an existing project 

using the Library ▶ Library Manager dialog. 

Condensing 
Players holding multiple instruments. In previous versions of Dorico, only one 

instrument held by each player could be condensed; normally, this was the first 

instrument held by the first player in the condensing group, and then the matching 

instruments held by other players in the group, whether or not it is the first 

instrument held by subsequent players. 

Now, however, Dorico will allow other instruments held by each player to 

participate in condensing. For example, if two clarinet players each hold 

instruments in B♭ and in A, Dorico will allow both pairs of clarinets to be condensed, 

provided the matching instruments are played by each player at the same time: a B♭ 

clarinet will only condense with another B♭ clarinet. Of course, the music will only 

condense if all the other conditions for condensing are met. 

To enable this new functionality, activate the new Allow instrument changes on 

condensed staves option in the Condensing section of the Players page of Layout 

Options. This option is activated by default in new projects, but deactivated in 

existing projects to preserve their appearance. 

Transposition only labels. A new Show only the change of transposition when 

instruments match option has been added to the Instrument Changes section of 

the Players page of Layout Options. When activated, if a player changes instrument 

to a similar instrument with a different transposition ‒ for example, clarinet in B flat 

to clarinet in A ‒ then the instrument change label will read simply “in A” or “in B♭”, 

omitting “Clarinet.” 



응축 

도리코 6판역사 

O를 누르거나 트레일의 버튼 증 하나를 클릭하면 구성 요소의 계층 구조를 통해 다시 위로 이 

동할수있습니다. 

코드 심볼 커닝 페어 테이블 사용. 도리코는 현재 사용 중인 코드 심볼 텍스트 폰트 및 코드 심볼 음악 

텍스트 폰트 스타일에 대해 정의된 폰트 계열 및 스타일과 일치하는 코드 심볼 커닝 페어 테이블을 찾 

습니다 일치하는 테이블을 찾을 수 없으면 아카데믹 및 브라부라 텍스트의 기본 테이블에 다시 표시됩 

니다 

이탤릭체 글꼴에 대해 별도의 표가 제공되며, 이는 일반적으로 카포 코드 기호가 이탤릭체 

로 그려지도록 설정된 경우에만사용됩니다. 

코드 기호 커닝 쌍 테이블을 기본값으로 저장합니다. 기본 테이블 증 하나에 변경 사항을 저장하거나 

향후모든프로젝 

튼을클릭합니다. 

트에서 자신의 사용자 정의 테이블을 사용할 수 있도록 하려면 액션 바의 별 버 

圈별이 채워지면 선택한 테이블이 사용자 라이브러리에 저장됩니다 개요로 표시 
되면 선택한 테이블이 사용자 라이브러리에 저장되지 않습니다. 

또한 라이브러리 ► 라이브러리 관리자 다이얼로그를 사용하여 기존 프로젝트의 코드 기호 

커닝 쌍 테이블을 업데이트할 수 있습니다. 

여러 악기를 들고 있는 연주자들. 이전 버전의 도리코에서는 각 연주자가 들고 있는 악기가 하나만 응 

축될 수 있었습니다. 일반적으로 이것은 응축 그룹의 첫 번째 연주자가 들고 있는 첫 번째 악기였고, 

그 다음 그룹의 다른 연주자가 들고 있는 일치하는 악기였습니다. 그것이 후속 연주자들이 들고 있는 

첫 번째 악기이든 아니든. 

그러나 이제 도리코는 각 연주자가 가지고 있는 다른 악기들이 콘덴싱에 참여할 수 있도록 할 것 

입니다 예를들어, 두 명의 클라리넷 연주자가 각각 Bb와 A에서 악기를 들고 있다면,도리코는 

두 쌍의 클라리넷을 모두 응축할 수 있습니다. 만약 일치하는 악기가 각 연주자가 동시에 연주한 

다면, Bb 클라리 넷은 다른 Bb 클라리 넷과만 응축됩 니 다. 물론, 음악은 응축을 위한 다른 모든 조건 

이충족될때만응축됩니다. 

이 새로운 기능을 활성화하려면 레이아웃 옵션의 플레이어스 페이지의 응축 섹션에 있는 응축 

된 스테이브 옵션에서 새로운 허용 도구 변경을 활성화하십시오. 이 옵션은 새로운 프로젝트에 

서는 기본적으로 활성화되지만 기존 프로젝트에서는 비활성화되어 외관을 유지합니다. 

전치 라벨만표시합니다 새로운표시는악기 일치 옵션이 플레이어스페이지의 악기 변경 섹션에 추 

가되었을 때 전치 변경만 표시합니다. 활성화되면 플레이어가 다른 전치 -를 가진 유사한 악기로 악기 

를 변경하면, 예를 들어 B 플랫의 클라리넷에서 A의 클라리넷으로 -의 클라리넷으로 악기 변경 라벨 

이 "Clarinet"을 생략하고 단순히 ''A'' 또는 "Bb''로 읽힙니다 
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Cycle playback 
Cycle playback allows you to loop a section of one of the flows in your project during 

playback. 

Cycle locators. The section that will loop during playback is defined by the cycle locators, 

which are shown when View ▶ Cycle Locators is activated. By default, the cycle 

locators are set to the start of the flow, and are colored gray when cycle playback is 

disabled: 

 
You can click and drag the triangle handle at the top of each locator to move it. 

Alternatively, you can set the locator positions using commands in the Play ▶ 

Locators submenu: 

§ Set Cycle Locators From Selection sets the left locator at the position of the 

earliest selected item, and the right locator at the end of the latest selected 

item. 

§ Set Left Cycle Locator sets the left locator at the position of the earliest 

selected item. 

§ Set Right Cycle Locator sets the right locator at the position of the latest 

selected item. 

§ Clear Cycle Locators resets both the left and right locators back to the start 

of the flow. 

Each of these commands can also be triggered via the jump bar and can have 

custom shortcuts assigned via the Key Commands page of Preferences. If cycle 

locators were not already shown, setting the position of either or both locators will 

activate View ▶ Cycle Locators. 

When cycle playback is enabled, the locators are colored purple: 

 



사01롤 

사이클 재생을 통해 재생 중에 프로젝트의 흐름 증 하나의 섹션을 루프할 수 있습니 다. 

사이클 로케이터입니다 재생 증에 루프되는 섹션은 사이클 로케이터에 의해 정의되며, 이는 사이클 

로케이터 뷰 ► 활성화될 때 표시됩니다. 기본적으로 사이클 로케이터는 흐름의 시작 부분으로 설정되 

어 있으며 사이클 재생이 비활성화되면 회색으로 표시됩니다. 

각 로케이터 상단에 있는 삼각형 손잡이를 클릭하고 드래그하여 이동할 수 있습니다. 

또는 플레이 ► 위치 지정 하위 메뉴의 명령을 사용하여 위치 지정 위치를 설정할 수 있습 

니댜 

§ 
설정 주기 선택에서 왼쪽 위치 지정기는 가장 먼저 선택된 항목의 위치에, 오른쪽 위치 

지정기는 가장 최근에 선택된 항목의 끝에 설정합니다. 

§ 

§ 

§ 

왼쪽 주기 설정 위치 지정기는 왼쪽 위치 지정기를 가장 먼저 선택한 항목의 위치 

에설정합니댜 

설정 오른쪽 주기 위치 확인기는 선택한 최신 항목의 위치에 오른쪽 위치 확인기를 

설정합니댜 

클리어 사이클 로케이터는 왼쪽과오른쪽로케이터를 모두 흐름의 시작부분으로 다시 

설정합니다. 

이러한 각 명령은 점프 바를 통해 트리거될 수도 있으며, 설정의 주요 명령 페이지를 통해 사용 

자 지정 단축키를 할당할 수 있습니다. 사이클 로케이터가 이미 표시되지 않은 경우, 로케이터 

중하나또는둘모두의 위치를설정하면뷰 ► 사이클로케이터가활성화됩니다. 

사이클 재생이 활성화되면 위치 표시 장치가 보라색으로 표시됩니다. 
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You can adjust the active and inactive colors for cycle locators on the Colors page of 

Preferences if required. 

Cycle locators are also shown in the ruler in the Key Editor in the lower zone in 

Write and Play modes, and in the track overview in Play mode. You can drag the 

locators left and right in the ruler in the same way you can drag them in the score. 

Activating cycle playback. To activate cycle playback, choose Play ▶ Cycle, or click 

the Cycle button (shown on the right) in the mini transport on the toolbar, or 

in the Transport window if it is shown. 

During playback, you can edit the music in the section between the locators, and 

you will hear the edits on the next cycle. 

Limitations. There are some limitations with cycle playback in this release: 

§ If your flow has an attached video, the video soundtrack will not cycle 

correctly. 

§ If you are using Groove Agent SE or another plug-in that relies on the 

synchronization of playback position and tempo, the playback from that 

plug-in will not cycle correctly. 

§ If you record while cycling is enabled, the music you record will be inserted 

into the flow ignoring the cycle locators. 

We plan to address these limitations in future versions. 

Fill view 
Dorico 6 introduces a new type of view to accompany page view and galley view, 

called fill view. While page view shows the music laid out on pages exactly as it will 

be printed, and galley view shows the music on a single, continuous system, fill view 

(as its name suggests) shows the music in multiple systems sized to the width of the 

music area, allowing you to scroll vertically to proceed through the flows. 

Fill view is best for layouts with up to a few instruments, and for those kinds of 

ensembles, it can make more efficient use of the available space on your display. 

The settings on the Vertical Spacing page of Layout Options for the minimum gaps 

between staves within the system are used in fill view. A new option Inter-system 

gap in fill view determines the distance between systems in fill view. 

Because fill view, like galley view, does not use the real dimensions of the page size 

defined for the layout, condensing is not displayed. However, empty staves will be 

automatically hidden in fill view, following the settings on the Vertical Spacing page 

of Layout Options. 

Like galley view, fill view can only be used in Setup and Write modes; when you 

switch to Engrave mode, Dorico will automatically switch to page view. 



필요한 경우 Preferences의 Colors 페이지에서 사이클 로케이터에 대한 활성 및 비활성 색상을 

조정할수있습니다. 

사이클 로케이터는 또한 아래 영역의 키 편집기의 자와 재생 모드의 자, 재생 모드의 트랙 개요 

에도 표시됩니다 점수에서 드래그하는 것과 같은 방식으로 로케이터를 자로 왼쪽과 오른쪽으 

로드래그할수있습니다. 

사이클 재생 활성화. 사이클 재생을 활성화하려면 재생 ►룰 선택하거나, 툴바의 미니 전송 또 

는 전송 창에 있는 사이클 버튼(오른쪽에 표시됨)을 클릭하십시오. 

재생하는 동안 위치 확인자 사이의 섹션에서 음악을 편집할 수 있으며 다음 사이클에서 편 

집 내용을들을수있습니다. 

한계. 이 릴리스에는 사이클 재생에 몇 가지 제한 사항이 있습니다. 

§ 흐름에 첨부된 비디오가 있으면 비디오 사운드 트랙이 올바르게 순환되지 않습 

니다 

§ 그루브 에이전트 SE 또는 재생 위치와 템포의 동기화에 의존하는 다른 플러그인을 

사용하는 경우 해당 플러그인에서 재생이 올바르게 순환되지 않습니다. 

§ 사이클링이 활성화된 상태에서 녹음하면 녹음한 음악이 사이클 로케이터를 무시하고 

흐름에삽입됩니다 

우리는 향후 버전에서 이러한 한계를 해결할 계획입니다. 

평면도 

Dorico 6은 페이지 뷰와 갤리 뷰에 수반되는 새로운 유형의 뷰를 도입합니다, 채우기 뷰입니다. 

페이지 뷰는 인쇄될 페이지에 배치된 음악을 그대로 보여주고 갤리 뷰는 단일 연속 시스템에서 음 

악을 보여주는 반면, 채우기 뷰는 (이름)에서 알 수 있듯이 음악 영역의 너비에 맞는 크기의 여러 

시스템에서 음악을 보여주므로 흐름을 따라 수직으로 스크롤할 수 있습니다. 

채움 보기는 최대 몇 개의 악기가 있는 레이아웃에 가장 적합하며, 이러한 종류의 앙상블의 

경우 디스플레이에 사용 가능한 공간을 보다 효율적으로 사용할 수 있습니다. 

시스템 내 스테이브 사이의 최소 간격에 대한 레이아웃 옵션의 세로 간격 페이지의 설정은 채 

우기 보기에서 사용됩니다. 새로운 옵션인 시스템 간 채우기 보기 간격은 채우기 보기에서 시 

스템 간의 거리를 결정합니다. 

채우기 보가는 갤리 보기와 마찬가지로 레이아웃에 정의된 페이지 크기의 실제 치수를 사용하지 

않기 때문에, 축약이 표시되지 않습니다. 그러나 빈 오선지는 레이아웃 옵션의 세로 간격 페이지 

의 설정에 따라 채우기 보기에 자동으로 숨겨져 있습니 다. 

갤리 뷰와마찬가지로채우기 뷰는설정 및 쓰기 모드에서만사용할수있습니다. 엥그레이 

브 모드로 전환하면 도리코가 자동으로 페이지 뷰로 전환됩니다. 
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To switch to fill view, you can do any of the following: 

§ Choose View ▶ Fill View 

§ Use the default shortcut Ctrl+Alt+3 (Windows) or Command-Alt-3 (macOS) 

§ Click the Fill View toggle button towards the right-hand end of the status 

bar at the bottom of the project window. 

Bar numbers. A new command View ▶ Bar Numbers ▶ Fill View has been added, allowing 

you to choose whether bar numbers should be shown on every bar in fill view. 

Cycling or toggling between view types. With the addition of fill view, the Toggle View 

Type command from previous versions has been replaced by three new commands: 

§ Cycle View Type cycles through page view, galley view, and fill view 

§ Toggle Page and Galley View toggles between page view and galley view 

§ Toggle Page and Fill View toggles between page view and fill view 

These commands can all be found in the View category in the Key Commands page 

of Preferences, and can be triggered via the jump bar. 

Default view type. It is now possible to specify fill view as the default view type on the 

General page of Preferences. 

System-attached items 
By default, system-attached items – including tempos, system-attached text, 

rehearsal marks, repeat ending lines and repeat markers – appear above the top 

staff of the system, and optionally above the staff corresponding to the first 

instrument in the first bracket for the specified instrument family. 

If you require greater flexibility in determining where system-attached items 

appear, Dorico 6 now allows you to specify which types of system-attached item 

should appear above the first staff belonging to specific players. 

A new Show system-attached items above option has been added to the System-

attached Items section of the Staves and Systems page of Layout Options. For the 

default behavior, choose Families, and to enable the new behavior, choose Specific 

Players. 

When Specific Players is chosen, in place of the list of families above which system-

attached items should appear, a table is shown with a row for each player in the 

layout, and columns for each type of system-attached item. Simply activate the 

checkbox for each type of system-attached item for the players above which you 

want them to appear. 

If no staves belonging to the player above whom a type of system-attached item is 

set to appear are visible, Dorico will instead show that type of system item above the 
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채우기 보기로 전환하려 면 다음 증 하나를 수행할 수 있습니 다. 

§ 보기 ► 채우기를 선택하세요 

§ 기본 단축키 Ctrl+Alt+3(Windows) 또는 Command-Alt-3(mac0S)을 사용하십시오. 

§ 프로젝트 창 하단에 있는 상태 표시줄의 오른쪽 끝으로 채우기 보기 토글 버튼을 클 

릭합니다 

막대 번호. 채우기 보기 ► 막대 번호 ► 채우기 보기가 새로 추가되어 채우기 보기의 모든 막대에 막 

대 번호를 표시해야 하는지 여부를 선택할 수 있습니 다. 

뷰유형 간순환또는전환입니다. 채우기 뷰가추가되면서 이전 버전의 토글뷰유형 명령이 세 가지 

새로운 명령으로 대체되었습니다. 

§ 사이클뷰유형은페이지뷰,갤리뷰,채우기뷰로순환합니다. 

§ 페이지와 갤리뷰 전환 페이지와 갤리뷰 사이에서 전환 

§ 페이지 보기 및 채우기 보기 전환 페이지 보기와 채우기 보기 사이에서 전환 

이 명령들은 모두 설정의 주요 명령 페이지에 있는 보기 카테고리에서 찾을 수 있으며 점프 바를 

통해 트리거할 수 있습니다. 

기본 보기 유형. 이제 기본 설정 일반 페이지에서 채우기 보기를 기본 보기 유형으로 지정할 수 

있습니다 

부속폼 

기본적으로 템포, 시스템 부착 텍스트, 리허셜 마크, 반복 엔딩 라인 및 반복 마커를 포함한 시 

스템 부착 항목이 시스템의 상단 스태프 위에 표시되며, 선택적으로 지정된 악기 제품군의 첫 

번째 브래킷에 있는 첫 번째 악기에 해당하는 스태프 위에 표시됩니다. 

시스템 부착 항목이 나타나는 위치를 결정하는 데 더 큰 유연성이 필요하다면, 이제 도리코 

6에서는 특정 플레이어에 속한 첫 번째 스태프 위에 어떤 유형의 시스템 부착 항목이 나타나 

야하는지지정할수있습니다. 

위의 새로운 Show 시스템 부착 항목이 레이아웃 옵션의 Staves 및 시스템 페이지의 시스템 

부착 항목 섹션에 추가되었습니다. 기본 동작은 Family를 선택하고, 새로운 동작을 활성화하 

려면 특정 플레이어롤 선택하십시오. 

특정 플레이어가 선택되면, 시스템 부착 항목이 표시되어야 하는 패밀리 목록 대신에 레이아웃의 

각플레이어에 대한행과시스템 부착항목유형에 대한열이 있는표가표시됩니다. 위에 표시되 

기를 원하는 플레이어에 대한 시스템 부착 항목 유형별 체크박스를 활성화하기만 하면 됩니다. 

시스템 부착 항목의 유형이 표시되도록 설정된 플레이어에 속하는 스테이브가 보이지 않으면 도 

리코는 대신 위의 시스템 항목 유형을 표시합니다. 
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next player in the score order, unless there isn’t one, in which case it will show them 

above the previous player in the score order. 

Large time signatures 
Dorico can display large time signatures either above particular staves in the 

system – as defined by the System-attached Items section of the Staves and 

Systems page of Layout Options (see System-attached items above) – or crossing 

multiple staves. For the former, on the Time Signatures page of Layout Options, set 

Time signature position and size to Show above staves, and for the latter, choose 

Show once per bracket. 

When using Show once per bracket, Dorico has in the past not provided any 

further options to influence where the time signatures appear. In Dorico 6, it is now 

possible to exercise complete control over the placement of large time signatures. 

To use Dorico’s default behavior, where a large time signature is added to the first 

bracket belonging to each instrument family, set Large time signature behavior to 

Automatic. To configure the placement of large time signatures, choose Manual. 

 
When you first click Manual, Dorico will automatically populate the Large time 

signature groups list based on the brackets shown in the layout. A large time 

signature will be shown for each group. The Time Signatures column shows the 

first and last instruments in each group, while the Vertical alignment column 

shows whether the time signature will be aligned with the top, center, or bottom of 

the group. To edit the vertical alignment, double-click the alignment field for each 

row, and choose the desired alignment from the drop-down menu. 

To change the automatically created groups, select them in the right-hand list and 

click the Delete button in the action bar to return them to the Players list. Select 

players in the Players list and click the + button in the action bar to create a new 

group, which removes them from the list. 

Rulers and grid 
Rulers. Dorico 6 now includes rulers in Engrave mode, enabled via Engrave ▶ Rulers. The 

rulers follow the preferred measurement unit as defined on the General page of 
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큰서명 

자와격자 

다음 점수 순서대로 플레이어가 없는 경우, 그 경우에는 점수 순서대로 이전 플레이어보다 높은 

점수를 기록할 것입니다. 

Dorico는 시스템의 특정 스테이브 위에 큰 시간 서명을 표시할 수 있습니다. （위의 스테이브 및 

시스템 페이지의 시스템 부착 항목 섹션에 정의된 대로) 또는 여러 스테이브롤 교차합니다. 전자 

의 경우 레이아웃 옵션의 시간 서명 페이지에서 시간 서명 위치와 크기를 스테이브 위의 표시로 

설정하고 후자의 경우 괄호당 한 번 표시를 선택합니다. 

괄호당 한 번 쇼를 사용할 때, 도리코는 과거에 시간 서명이 나타나는 위치에 영향을 미칠 수 있 

는추가옵션을제공하지 않았습니다. 도리코 6에서는 이제큰시간서명 배치에 대한완전한제 

어를 행사할 수 있습니다. 

각 기기 계열에 속하는 첫 번째 괄호에 큰 시간 서명이 추가되는 도리코의 기본 동작을 사용하려 

면 큰 시간 서명 동작을 자동으로 설정합니다. 큰 시간 서명 배치를 설정하려면 수동을 선택하세 

요. 

"""" -• . 龜繼륄 
• . .... -.i` -.'뻬 

처음에 수동을 클릭하면 도리코가 레이아웃에 표시된 대괄호를 기반으로 대형 시간 서명 그룹 

목록을 자동으로 채울 것입니다. 각 그룹에 대해 큰 박자 표시가 표시됩니다. 시간 서명 열은 

각 그룹의 첫 번째 및 마지막 기기를 보여주고, 수직 정렬 열은 시간 서명이 그룹의 상단, 중앙 

또는 하단과 정렬되는지 여부를 보여줍니다. 수직 정렬을 편집하려면 각 행에 대한 정렬 필드 

를 두 번 클릭하고 드롭다운 메뉴에서 원하는 정렬을 선택합니다. 

자동으로 생성된 그룹을 변경하려면 오른쪽 목록에서 선택하고 액션 바의 삭제 버튼을 클릭하 

여 플레이어 목록으로 반환합니다. 플레이어 목록에서 플레이어를 선택하고 액션 바의 + 버튼 

을 클릭하여 새로운 그룹을 만들면 목록에서 플레이어를 제거합니다. 

자 도리코 6에는 이제 인그레이브 모드의 자들이 포함되어 있으며, 인그레이브 ► 자를 통해 활성화 

됩니다 자는 일반 페이지에 정의된 대로 선호하는 측정 단위를 따릅니다. 
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Preferences. As you move the mouse pointer over the page, the distance from the 

top left corner of the page is shown in a live label on the ruler, allowing you to 

determine the precise placement of each item on the page. 

The origin for the ruler is now reset at the start of each new page. Activate Continue 

ruler across spreads in the View section of the General page of Preferences, if you 

prefer the ruler to continue across both pages of a spread. 

Grid. Dorico 6 now also includes a grid in Engrave mode, enabled via Engrave ▶ Grid. By 

default, Dorico uses a 5mm grid, with bold lines at 25mm intervals, and you can use 

Engrave ▶ Grid Options to edit the grid to your preferences. Several preset grid 

configurations are provided; additionally, you can specify whether and how often 

bold grid lines should be used, and choose whether only horizontal or vertical grid 

lines should be shown. 

Although you cannot save your own grid presets, your preferred grid settings are 

included when you use Save as Default in View ▶ View Options, and are therefore 

available in new projects, or can be recalled in existing projects by clicking Reset to 

Saved Defaults. 

The colors used for the grid can be set on the Colors page of Preferences. You can 

also change the color and thickness of the crosshair drawn for the selected item in 

Engrave mode, which allows you to achieve greater contrast between the grid and 

crosshair if needed. 

OpenType features 
It is now possible to selectively enable or disable glyph positioning and glyph 

substitution features in OpenType fonts for paragraph, character, and font styles, 

greatly expanding the typographical possibilities of text in Dorico. Previously, 

certain font features were always enabled by default (for example, kerning and 

standard ligatures), but it was not possible to disable these features, or to enable 

other features. 

Supported features. Only features in the gpos (glyph positioning) and gsub (glyph 

substitution) tables are configurable in this release. This includes kerning, standard 

ligatures (e.g. “fi” and “fl”), contextual ligatures (based on surrounding text), 

discretionary ligatures (typically used for fancy typographical features), fractions, 

old-style and lining figures, small capitals, stylistic sets, and case-sensitive forms 

(often used to position punctuation differently depending on whether they are 

adjacent to lower-case or upper-case letters), among others. 

Enabling or disabling features in paragraph styles. In Library ▶ Paragraph Styles, a new 

OpenType features section can be found at the bottom of the scrollable right-hand 

pane. Click + to show a menu listing the features supported by the chosen font; if the 
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선호도. 마우스 포인터를 페이지 위로 이동시키면 페이지의 왼쪽 상단 모서리로부터의 거리가 

자에 라이브 라벨로 표시되어 페이지에 있는 각 항목의 정확한 배치를 결정할 수 있습니다. 

이제 새로운 페이지가 시작될 때마다 자의 원점이 재설정됩니다. 전체 참조 페이지의 보기 섹션에 

서 전체 가로 세로 자를 활성화하십시오. 자를 가로 세로 세로로 계속하기를 원하는 경우입 니 다. 

그리드. Dorico 6에는 이제 Engrave 모드의 그리드도 포함되어 있으며, Engrave ► 그리드를 통해 

활성화됩니다 기본적으로 도리코는 25mm 간격으로 굵은 선이 있는 5mm 그리드를 사용하며, 

Engrave ► 그리드 옵션을 사용하여 그리드를 원하는 대로 편집할 수 있습니다. 몇 가지 미리 설정된 

그리드 구성이 제공됩니다. 또한 굵은 그리드 라인을 사용해야 하는지 여부와 빈도를 지정하고 가로 또 

는 세로 그리드 라인만 표시해야 하는지 선택할 수 있습니 다. 

자신의 그리드 프리셋을 저장할 수는 없지만, 기본 설정 ► 보기 옵션으로 저장하기를 사용할 때 

선호하는 그리드 설정이 포함되어 있으므로 새 프로젝트에서 사용할 수 있거나 저장된 기본 설정 

으로재설정을클릭하여 기존프로젝트에서 회상할수있습니다. 

그리드에 사용된 색상은 선호도의 색상 페이지에서 설정할 수 있습니다. 또한 인그레이브 모드 

에서 선택한 항목에 대해 그려진 십자선의 색상과 두께를 변경할 수 있어 필요한 경우 그리드 

와 십자선의 대비를 더 크게 할 수 있습니다. 

오픈타입기능 

이제 문단, 문자, 폰트 스타일에 대해 OpenType 글꼴에서 글리프 위치 지정 및 글리프 대체 기 

능을 선택적으로 활성화하거나 비활성화할 수 있게 되어 도리코 텍스트의 타이포그래피 가능 

성이 크게 확장됩니다 이전에는 특정 폰트 기능이 항상 기본적으로 활성화되어 있었지만(예: 

커닝 및 표준 연결) 이러한 기능을 비활성화하거나 다른 기능을 활성화하는 것은 불가능했습니 

댜 

지원 기능. GPOS(glyph 위치 지정) 및 gsub(glyph 대체) 테이블의 기능만 이 릴리스에서 구성할 수 

있습니다 여기에는 커닝, 표준 연결(예: "fj '' 및 "fl")), 컨텍스트 연결(주변 텍스트 기반)， 재량 연결(일 

반적으로 화려한 타이포그래피 기능에 사용됨)， 분수, 오래된 스타일 및 라이닝 피규어, 작은 대문자, 스 

타일 세트 및 사례에 민감한 형태(종종 다르게 구두점을 배치하는 데 사용됨)가 포함됩니다. 소문자 또 

는 대문자에 인접해 있는지 여부에 관한 것입니다. 

단락스타일에서 기능을 활성화하거나 비활성화합니다. 라이브러리 ► 단락스타일에서 새로운 

OpenType 기능 섹션은 스크롤 가능한오른쪽 창 하단에서 찾을수 있습니다. ＋를클릭하여 선택한글 

꼴로 지원되는 기능을 나열하는 메뉴를 보여줍니다. 만약 

68 스타인버그 미디어 테크놀로지스 GmbH 

68/106 



 

 

Dorico 6 Version History 69 Steinberg Media Technologies GmbH 

button is disabled, the chosen font includes no OpenType features. Choose a feature 

from the menu and it is added to the table of features. By default, each feature you 

add is enabled, but you can disable it by deactivating its checkbox. 

When you change the font family used by the paragraph style, any chosen features 

that are not supported by the new font will be automatically removed from the list. 

In common with other properties of paragraph styles, OpenType features can be 

inherited by dependent styles or overridden in each style. 

Enabling or disabling features in character styles. To change the features that are enabled 

or disabled within a single run of text, apply a character style with the desired 

combination of enabled and disabled features. The same OpenType features list 

appears in Library ▶ Character Styles, though unless you have explicitly overridden 

the font family in your character style, the list of features that appears when you 

click + will list all glyph substitution and positioning features, since it is not known 

which font the character style will eventually be applied to. 

Note that due to the complexities of font shaping, you may find that certain features 

do not appear as expected when you apply a character style to part of a run of text in 

the text editor, but when you leave the editor, the feature will be correctly applied. 

For example, disabling standard ligatures (liga) may not appear correctly in the 

editor, while setting small caps (smcp) appears identically both in the editor and 

when the text is rendered in the score. 

Enabling or disabling features in font styles. Font styles are typically used for notations 

and not long runs of text; nevertheless, you may from time to time find it useful to 

enable OpenType features for some font styles. For example, you might want to use 

lining numbers for intervals and alterations in chord symbols, or when using a plain 

font for figured bass. 

As with paragraph and character styles, Library ▶ Font Styles now includes a new 

OpenType features list, allowing you to specify which features should be enabled or 

disabled for the current font style. 

Splentino font family 
Dorico 6 now includes a new text font family called Splentino, created by Ben 

Byram-Wigfield. Splentino is a new digital recreation of the Plantin typeface, 

designed by Frank Pierpont and Fritz Stelzer for Monotype in 1913 after a visit to the 

Plantin-Moretus Museum in Antwerp and inspired by a typeface by the 16th century 

typographer and printer Robert Granjon they had seen there. 

The digital version of Plantin created by Monotype has upper case characters 

around 10% wider than the original metal type version, and this additional width 

makes it less suitable for music typesetting, where horizontal space is at a 
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버튼이 비활성화되어 있으며, 선택한 글꼴에는 OpenType 기능이 포함되어 있지 않습니다. 메뉴 

에서 기능을 선택하면 기능 표에 추가됩니다. 기본적으로 추가하는 각 기능은 활성화되어 있지만 

체크박스를 비활성화하여 비활성화할수 있습니다. 

문단 스타일에서 사용하는 폰트 계열을 변경하면 새 폰트에서 지원되지 않는 선택한 기능이 목 

록에서 자동으로 제거됩니다. 

단락 스타일의 다른 속성과 마찬가지로 OpenType 기능은 종속 스타일에 의해 상속되거나 

각 스타일에서 무시될 수 있습니다. 

문자 스타일의 기능을 활성화 또는 비활성화합니다. 텍스트의 단일 실행 내에서 활성화 또는 비활성화 

된 기능을 변경하려면 활성화된 기능과 비활성화된 기능의 원하는 조합으로 문자 스타일을 적용합니 

댜 동일한 OpenType 기능 목록이 라이브러리 ► 문자스타일에 표시되지만,문자스타일에서 글꼴 

계열을 명시적으로 무시하지 않는 한 +를 클릭하면 나타나는 기능 목록에는 모든 문자 대체 및 위치 지 

정이 나열됩니다 어떤 글꼴에 캐릭터 스타일이 적용될지 알 수 없기 때문에 특징입니다. 

글꼴 형성의 복잡성으로 인해 텍스트 편집기의 일부에 문자 스타일을 적용할 때는 특정 기능이 예 

상대로 나타나지 않을 수 있지만 편집기를 떠나면 기능이 올바르게 적용됩니다. 

예를 들어, 표준 연결 해제(liga)가 편집기에 올바르게 나타나지 않을 수 있지만, 작은 갭 설 

정(smcp)은 편집기와 텍스트가 악보에 표시될 때 모두 동일하게 나타납니다 

폰트 스타일의 기능을 활성화하거나 비활성화합니다. 폰트 스타일은 일반적으로 기보에 사용되며 텍 

스트의 긴 실행이 아닙니다. 그럼에도 불구하고 때때로 일부 폰트 스타일에 대해 OpenType 기능을 

활성화하는 것이 유용합니다. 예를 들어, 코드 기호의 간격과 변경에 라이닝 번호를 사용하거나, 그림 

베이스에 일반폰트를사용할때사용할수 있습니다. 

단락 및 문자 스타일과 마찬가지로 라이브러리 ► 폰트 스타일에는 새로운 OpenType 기능 목록 

이 포함되어 있으므로 현재 폰트 스타일에 대해 어떤 기능을 활성화하거나 비활성화해야 하는지 

지정할수있습니다 

스플렌티노체 

도리코 6에는 이제 벤 바이램-위그필드가 만든 스플렌티노라는 새로운 텍스트 폰트 계열이 포함 

됩니다 스플렌티노는 1913년에 프랭크 피어폰트와 프리츠 스텔저가 안트베르펜의 플랜틴-모레 

투스 박물관을 방문한 후 모노타입을 위해 디자인한 플랜틴 서체의 새로운 디지털 레크리에이션 

으로, 그곳에서 본 16세기 타이포그래퍼이자 인쇄업자인 로버트 그랜존의 서체에서 영감을 받았 

습니다 

Monotype이 만든 Plantin의 디지털 버전은 원래의 금속 활자 버전보다 대문자가 약 10% 

더 넓으며, 이러한추가 너비로 인해 가로 공간이 a에 있는 음악조판에는 적합하지 않습니 

댜 
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premium. (The lower case characters are only fractionally wider then the metal 

type version in most cases, though some letters – including m – are noticeably 

wider.) 

Splentino has been created with reference to the original metal type of Plantin, 

including original specimen sheets from the Monotype Drawing Office, now held in 

the collection of the Science Museum in London, and Letraset dry transfer sheets. 

The typeface has been meticulously created in four weights – Regular, Italic, Bold, 

and Bold Italic – and small details of the original letterforms have been modified to 

improve consistency and balance. 

 

The counters (enclosed circles) of b, d, p and q have been made consistent, in their 

various orientations. The counters of a and e have been enlarged for greater 

legibility. (Type historians have pointed out that the letter a which Pierpont saw in 

the museum was an 18th-century design, rather than a 16th-century one.) A slight 

chamfer (diagonal cut) has been added to the top of lowercase vertical stems. 

Flow heading overrides 
Flow headings can be automatically inserted before the first system of each new 

flow in your project. They are enabled by the Show flow headings option in the 

Flows section of the Page Setup page of Layout Options. When flow headings are 

enabled, the default flow heading in the page template set used by the layout is 

inserted for each flow, according to whether you have chosen to insert them for all 

flows, or only for flows after the first. 

It is also possible to create a flow heading change in Engrave mode, specifying that 

on only the chosen page, or from that chosen page until the next flow heading 



흐름머리 

도리코 6판역사 

프리미엄입니다 (m을 포함한 일부 문자는 눈에 띄게 넓지만, 소문자는 대부분의 경우 금속 

활자 버전보다 부분적으로만 넓습니 다.) 

스플렌티노는 현재 런던 과학 박물관에 소장되어 있는 모노타입 드로잉 사무실의 원본 표본 시트 

와 레트라셋 건식 전사 시트를 포함하여 플랜틴의 원래 금속 유형을 참조하여 만들어졌습니다. 

서체는 일반형, 이탤릭체, 굵은 글씨체, 굵은 글씨체의 네 가지 가중치로 세심하게 만들어졌으며, 

일관성과 균형을 향상시키기 위해 원래 서체의 작은 세부 사항이 수정되었습니다. 

ABCDEFGHIJKLMNOPQRSTUVWXYZ&1£CE 

abcdefghijklmnopqrstuvwxyzfiflffiffi冠

ABCDEFGHIJKLMNOPQRSTUVWXYZ&JJ3(E 

abcdefghijklmnopqrstuvwxyzfififfiffi<2m 

1234567890 .,:; !?"" -([t+§£$*텐― ""?! ;:,. 1234567890 

ABCDEFGHIJKLMNOPQRSTIJVWXYZ&lE.<E 

abcdefghijklmnopqrstuvwxyzfiflffi.ffl죠 

ABCDEFGHIJKLMNOPQRSTUVWXYZ&IE(E 

abcdefghijklmnopqrstuvwxyzfiflffiffltea 

1234567890 .,:; !?"" -([tt§£$*덴- ""?I ;:,. 1234567890 

b, d, p 및 q의 카운터(밀폐된 원)는 다양한 방향으로 일관되게 만들어졌습니다. a와 e의 카운 

터는 더 가독성을 높이기 위해 확대되었습니다. (활자 역사가들은 피어폰트가 박물관에서 본 

문자 a가 16세기 디자인이 아니라 18세기의 디자인이라고 지적했습니다.） 소문자 수직 줄기 

의 상단에 약간의 챔퍼(대각 절단)가 추가되었습니다. 

흐름 제목은 프로젝트의 각 새로운 흐름의 첫 번째 시스템 앞에 자동으로 삽입될 수 있습니 다. 

레이아웃 옵션의 페이지 설정 페이지의 흐름 섹션에 있는 쇼 흐름 제목 옵션에 의해 활성화됩 

니다 흐름 헤딩이 활성화되면 레이아웃에서 사용하는 페이지 템플릿 세트의 기본 흐름 헤딩 

이 모든흐름에 대해삽입하기로선택했는지 아니면 첫 번째 이후의 흐름에 대해서만삽입됩니 

다. 

또한, 인그레이브 모드에서 흐름 제목 변경을 만들 수도 있습니다. 이를 선택한 페이지에만 지 

정하거나, 해당 선택한 페이지에서 다음 흐름 제목까지 지정합니다. 
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change, a different flow heading should be used for flows whose first system 

appears on those pages. 

However, in projects where multiple short flows may appear on the same page, it 

was previously impossible to specify a different flow heading for one or more of the 

flows on that page. 

With Dorico 6, we have now introduced flow heading overrides, which allow you to 

specify the flow heading that should be used for each flow in a layout, providing 

complete flexibility over the choice of flow heading and how much space should be 

added above and below each one. 

Creating a flow heading override. In Setup mode, select the layout in the right-hand 

Layouts panel where you want to create a flow heading override, then right-click to 

show the context menu, and choose Flow Heading Overrides. This dialog appears: 

 
To add a flow heading override for a flow, click + in the action bar to show a menu 

listing the flows that do not yet have an override defined: click the target flow, and it 

is added to the left-hand list in the dialog. 

Once the target flow is selected, set Use flow heading to the flow heading you want 

to appear before the first system of this flow; you can also specify (none) if you want 

no flow heading to appear for this flow. Set Heading top margin and Heading 

bottom margin if desired to alter the amount of space Dorico leaves above and 

below the flow heading. 

To remove a flow heading override, select the target flow in the left-hand list and 

click the Delete button in the action bar. 



변경, 첫 번째 시스템이 그 페이지에 나타나는 흐름에 대해서는 다른 흐름 제목을 사용해 

야합니다. 

그러나동일한페이지에 여러 개의 짧은흐름이 나타날수 있는프로젝트에서는 이전에는해당페 

이지의 하나 이상의 흐름에 대해 다른 흐름 방향을 지정하는 것이 불가능했습니다. 

Dorico 6을 통해 이제 플로우 헤딩 오버라이드를 도입했습니다. 이를 통해 레이아웃에서 각 흐 

름에 사용해야 하는 흐름 헤딩을 지정할 수 있어 흐름 헤딩 선택과 각 흐름 위와 아래에 추가해야 

하는 공간에 대한 완전한 유연성을 제공합니 다. 

흐름 헤딩 오버라이드 생성. 설정 모드에서 흐름 헤딩 오버라이드를 만들고자 하는 오른쪽 레이아웃 

패널의 레이아웃을 선택한 다음 오른쪽 버튼을 눌러 컨텍스트 메뉴를 표시하고 흐름 헤딩 오버라이드 

를 선택합니다 이 대화가 나타납니다. 

fhI 'I , |. 뵐''".I圖 

서석 , . · ' L IJII 스테이~I 「 I아선 、/'

--I"’ 
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흐름에 대한흐름헤딩 오버라이드를추가하려면 액션 바에서 +를클릭하여 아직 오버라이드가 

정의되지 않은흐름을 나열하는 메뉴를표시합니다: 대상흐름을클릭하면 대화의 왼쪽목록에 추 

가됩니다 

목표 흐름이 선택되면, 이 흐름의 첫 번째 시스템 앞에 나타나려는 흐름 헤딩을 사용하십시오. 이 

흐름에 대해 흐름 헤딩이 나타나지 않으려면 지정(없음)할수도 있습니다. 흐름 헤딩 위와 아래 

에 도리코가 남기는 공간의 양을 변경하려면 헤딩 상단 여백과 헤딩 하단 여백을 설정합니다. 

오버라이드로 향하는 흐름을 제거하려면 왼쪽 목록에서 대상 흐름을 선택하고 액션 바에서 삭 

제 버튼을 클릭합니다. 
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The Flow Heading Overrides dialog is non-modal and can be left open while you 

work. Click Apply to apply the current changes to the edited layout and leave the 

dialog open so you can continue to make further changes. The dialog always applies 

to the layout that was chosen in the Layouts panel in Setup mode, or the current 

layout if invoked outside Setup mode. If you switch to another layout and want to 

edit the flow heading overrides for that layout, you must close and reopen the 

dialog. The name of the layout to which the changes will apply is shown in the 

caption of the dialog. 

Propagate part formatting. Flow heading overrides can now optionally be propagated 

from one part layout to one or more other part layouts using Setup ▶ Propagate 

Part Formatting. 

Importing and exporting user settings 
Your single-user license for Dorico allows you to run the software on up to three 

computers for your own personal, non-simultaneous use. You may therefore want 

to set Dorico up in the same way on each of the computers on which you use it. 

Dorico 6 introduces a new feature to import and export user settings, making it 

easy to transfer your preferences to another computer. 

To get started, choose File ▶ Export User Settings. You are prompted to choose the 

folder where the exported user settings will be saved. A zip archive whose name 

begins Dorico User Settings (and includes today’s date and time) is exported to the 

chosen folder. Copy this zip archive to your other computer. 

To import these settings on your other computer, run Dorico, and choose File ▶ 

Import User Settings. In the picker that appears the Dorico User Settings archive 

you exported from your other computer. This dialog appears: 

 
Activate the checkboxes for the settings you want to import. Only those checkboxes 

corresponding to data that was present in the archive you exported from your other 



플로우헤딩 오버라이드 대화는모달식이 아니며 작업하는동안열어둘수 있습니다. 적용을클릭 

하여 편집된 레이아웃에 현재 변경 사항을 적용하고 대화를 열어 두면 계속 추가 변경을 할 수 있 

습니다 대화는 항상 설정 모드에서 레이아웃 패널에서 선택한 레이아웃 또는 설정 모드 외부에 

서 호출된 경우 현재 레이아웃에 적용됩니다. 다른 레이아웃으로 전환하고 해당 레이아웃의 오버 

라이드를 편집하려면 대화를 닫고 다시 열어야 합니다. 변경 사항이 적용될 레이아웃의 이름은 대 

화의 자막에 나와 있습니다. 

부분 형식을 전파합니다. 플로우 헤딩 오버라이드는 이제 설정 ► 을 사용하여 하나의 부품 레이 

아웃에서 하나 이상의 다른 부품 레이아웃으로 선택적으로 전파될 수 있습니다. 

부분형식화입니다 

사용자설정수출입 

도리코에 대한 단일 사용자 라이선스를 사용하면 최대 3대의 컴퓨터에서 소프트웨어를 실행하 

여 동시에 사용할 수 없습니다. 따라서 당신이 사용하는 각 컴퓨터에 동일한 방식으로 도리코 

롤 설정하는 것이 좋을 수 있습니다. 

도리코 6는 사용자 설정을 가져오고 내보내기 위한 새로운 기능을 도입하여, 다른 컴퓨터로 

쉽게 사용자의 선호도를 이전할 수 있습니다. 

시작하려면 파일 ► 내보내기 사용자 설정을 선택하십시오. 내보내진 사용자 설정이 저장될 폴 

더를 선택하라는 메시지가 표시됩니다. 이름이 도리코 사용자 설정(그리고 오늘 날짜와 시간 

포함)으로 시작되는 zip 아카이브가 선택한 폴더로 내보내집니다. 이 지퍼 아카이브를 다른 컴 

퓨터로복사하세요. 

이러한 설정을 다른 컴퓨터에서 가져오려면 도리코롤 실행하고 파일 ► 가져오기 사용자 설정 

을 선택하십시오. 표시되는 피커에는 다른 컴퓨터에서 내보낸 도리코 사용자 설정 아카이브가 

표시됩니다. 이 대화가 나타납니다: 
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가져오려는 설정에 대한 체크박스를 활성화합니다. 그 체크박스들만요. 

당신이 다른 사람으로부터 내보낸 아카이브에 있던 데이터에 해당합니다. 
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computer will be enabled. Clicking Import All or Import None activates or 

deactivates all enabled checkboxes. 

Backup existing settings is activated by default. When you click OK to confirm 

which settings you want to import, if Backup existing settings is activated, Dorico 

exports a Dorico User Settings archive of your current settings on this computer, so 

you have a backup if you inadvertently overwrite specific settings that you wanted 

to retain. 

Be aware that only user-specific settings are imported and exported. For example, if 

you have manually added library files to the system-wide DefaultLibraryAdditions 

location, these are not handled. 

View Options dialog 
A new View ▶ View Options dialog has been added, with default shortcut 

Ctrl+Shift+V (Windows) or Shift-Command-V (macOS), allowing central access to 

(almost) all the options in the View menu from a single dialog, and making it easy to 

save your preferred combination of options as a default for new projects. 

Saving default view options. Either set your preferred view options directly using the 

commands in the View menu, or using the new View Options dialog, then click Save 

as Default in View ▶ View Options. These options will then be applied to future new 

projects. 

Applying saved view options to an existing project. When you open a project created in an 

earlier version of Dorico, or sent to you by somebody else, the default state of new 

options (for example, to show cycle locators or token placeholders) may not match 

your saved defaults. To apply your defaults to the current project, simply choose 

View ▶ View Options and click Reset to Saved Defaults. 

Resetting to factory defaults. To reset the view options in the current project to the 

factory defaults, choose View ▶ View Options and click Reset to Factory. You can 

also click Remove Saved Defaults to remove your saved default view options, so 

projects you subsequently create will instead use the factory default view options. 

System track. The option Show system track in new projects in the Files section of the 

General page of Preferences has been removed, since it is now possible to control 

this via the new View Options dialog. 

View options selector. In addition to the new View Options dialog, a new selector has 

been added to the toolbar, replacing the show/hide tab bar button. 

 



도리코 6판역사 

컴퓨터가 활성화될 것입니다. 전체 가져오기 또는 없음을 클릭하면 활성화된 모든 

체크박스가 활성화되거나 비활성화됩니다. 

기존 설정을 백업하면 기본적으로 활성화됩니다. 어떤 설정을 가져오려는 설정을 확인하기 위해 

확인을 클릭하면 기존 설정 백업이 활성화되면 Dorico가 이 컴퓨터에서 현재 설정의 Dorico 사 

용자 설정 보관함을 내보내므로 유지하려는 특정 설정을 실수로 덮어쓰면 백업이 됩니다. 

사용자별 설정만 가져오고 내보냅니다. 예를 들어, 시스템 전체의 

DefaultlibraryAdditionslocation에 라이브러리 파일을 수동으로 추가한 경우에는 처리되지 

않습니다. 

뷰옵션대화 

새로운 뷰 ► 뷰 옵션 다이얼로그가 추가되었으며, 기본 바로가기 Ctrl+Shift+V(Windows) 또 

는 Shift-Command-V(macOS)가 있어 단일 다이얼로그에서 뷰 매뉴의 모든 옵션에 중앙 액세 

스할 수 있으며, 선호하는 옵션 조합을 새로운 프로젝트의 기본값으로 쉽게 저장할 수 있습니 다. 

기본보기 옵션 저장. 보기 메뉴의 명령을사용하여 선호하는보기 옵션을직접 설정하거나새로운보 

기 옵션 대화를 사용하여 기본 보기로 저장하기를 클릭하십시오. 그런 다음 이 러 한 옵션은 향후 새로 

운 프로젝트에 적용됩니다. 

저장된 보기 옵션을 기존 프로젝트에 적용합니다. 이전 버전의 도리코에서 만들어진 프로젝트를 열거 

나 다른사람이 보내준 경우, 새 옵션의 기본 상태(예: 사이클 로케이터 또는 토큰 플레이스홀더를표시 

함)가 저장된 기본값과 일치하지 않을 수 있습니 다. 기본값을 현재 프로젝트에 적용하려 면 보기 옵션 

을 선택하고 저장된 기본값으로 재설정을 클릭하기만 하면 됩니다. 

공장 기본값으로 재설정. 현재 프로젝트의 뷰 옵션을 공장 기본값으로 재설정하려 면 뷰 ► 뷰 옵션 

을 선택하고 공장으로의 재설정을 클릭하십시오. 저장된 기본값 제거를 클릭하여 저장된 기본값을 

제거할 수도 있으므로 이후에 생성하는 프로젝트는 공장 기본값 보기 옵션을 사용합니다. 

시스템 트렉 일반 참조 페이지의 파일 섹션에 있는 새로운 프로젝트의 시스템 트랙을 보여주는 옵 

션은 이제 새로운 옵션 대화를 통해 이를 제어할 수 있기 때문에 제거되었습니다. 

보기 옵션 선택기. 새로운 보기 옵션 대화상자 외에도 새로운 선택기가 도구 모음에 추가되어 보 

여주기/숨기기 탭 바 버튼을 대체했습니다. 
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When clicked, a selector appears in which you can activate or deactivate the system 

track, signposts, and cycle locators, as well as hiding or showing the tab bar. In 

Engrave mode, the selector allows you to activate or deactivate rulers and the grid. 

Jump bar 
First introduced in Dorico 4 as a way of quickly finding and executing commands 

and navigating through the project, the jump bar has been significantly enhanced 

in Dorico 6, and now allows you to search for and execute individual options from 

the Engraving Options, Layout Options, Notation Options, Note Input Options, and 

Playback Options dialogs. 

Finding and setting options. When you type into the jump bar in Commands mode, 

individual options that match your search string will be shown; if both commands 

and options match your search string, commands will be listed first, followed by 

options. Options show not only the name but also the dialog, page, and section in 

which they can be found; this extended description is also matched against your 

search string. 

After selecting an option, hit Return to edit it. The settings for that option appear 

immediately below the jump bar, and you can use the keyboard to directly set the 

option. Use Space to activate or deactivate a switch; use ←/→ to toggle between 

grouped buttons; use ↑/↓ to increase or decrease numeric values, or simply type 

the new value directly; hit Space to open a drop-down menu, and ↑/↓ to change 

the selected item. Hit Return again to confirm your choice and close the jump bar, 

which sets the option accordingly. 

You can alternatively hit Alt+Return to be taken to the relevant page in the 

appropriate options dialog to edit the option there. 

There are some limitations concerning options in the jump bar: 

§ Not all options appear in the jump bar. Options that use special, complex 

controls do not appear: only those that use standard controls (switches, toggle 

buttons, spin boxes, drop-down menus) can be set via the jump bar. 

§ Some options are naturally paired or grouped with other options in the dialogs, 

but all options appear singly in the jump bar. For example, on the Staves and 

Systems page of Layout Options, the option to enable a fixed number of bars per 

system is paired with the option that specifies the number of bars; these are 

separate options, and so have to be found and set individually via the jump bar. 

§ You cannot currently specify a jump bar alias for an individual command. We 

hope to relax this limitation in future. 

§ When you reopen the jump bar after editing an option, the same option does 

not reappear prepopulated in the jump bar by default. Again, we hope to relax 

this limitation in future. 



철봉 

도리코 6판역사 

클릭하면 시스템 트랙, 표지판, 사이클 로케이터를 활성화하거나 비활성화할 수 있는 선택기가 나 

타나며 탭 바를 숨기거나 보여줍니다. 인그레이브 모드에서는 선택기를 사용하여 자와 그리드를 

활성화하거나 비활성화할수 있습니다. 

명령을 빠르게 찾고 실행하며 프로젝트를 탐색하는 방법으로 도리코 4에서 처음 도입된 점프 

바는 도리코 6에서 대폭 강화되었으며, 이제 각인 옵션, 레이아웃 옵션, 노테이션 옵션, 노트 입 

력 옵션 및 재생 옵션 대화에서 개 별 옵션을 검색하고 실행할 수 있습니 다. 

옵션 찾기 및 설정. 명령 모드에서 점프 바를 입력하면 검색 문자열과 일치하는 개별 옵션이 표시됩 

니다 명령과 옵션이 모두 검색 문자열과 일치하면 명령이 먼저 나열되고 그 다음에 옵션이 표시됩 

니다 옵션에는 이름뿐만 아니라 대화, 페이지 및 찾을 수 있는 섹션도 표시됩니다. 이 확장된 설명 

은 검색 문자열과도 일치합니다. 

옵션을 선택한 후, 다시 돌아가기를 눌러 편집합니다. 해당 옵션에 대한 설정은 점프바 바로 아 

래에 나타나며, 키보드를사용하여 옵션을 직접 설정할수 있습니다. 스위치를 활성화하거나 

비활성화하려면 스페이스를 사용하세요; 그룹화된 버튼 사이를 전환하려면 ..... / ..... 를 사용하세 

요; 숫자 값을 늘리거나 줄이려면 f/ i를 사용하거나 새 값을 직접 입력하기만 하면 됩니다. 스 

페이스를 눌러 드롭다운 메뉴를 열고, t/!를 선택한 항목을 변경합니 다. 다시 반환 버튼을 눌 

러 선택을 확인하고 점프 바를 닫으면 그에 따라 옵션이 설정됩니다. 

또는 Alt+Return을 눌러 적절한 옵션 대화에서 해당 페이지로 이동하여 옵션을 편집 

할수 있습니다. 

점프 바에는 몇 가지 제한 사항이 있습니 다. 

§ 모든 옵션이 점프 바에 나타나는 것은 아닙 니 다. 특수하고 복잡한 컨트롤을 사용하는 옵 

션은 나타나지 않습니 다 표준 컨트롤(스위치, 토글 버튼, 스핀 박스, 드롭다운 메뉴)을 사 

용하는 옵션만 점프 바를 통해 설정할 수 있습니다. 

§ 일부 옵션은 대화 모음에서 자연스럽게 페어링되거나 다른 옵션과 그룹화되지만 모든 옵션 

은 점프 바에 단독으로 나타납니다. 예를 들어, 레이아웃 옵션의 스테이브 및 시스템 페이지 

에서 시스템당 고정된 수의 막대를 활성화하는 옵션과 막대 수를 지정하는 옵션이 짝을 이루 

고 있습니다 이는 별도의 옵션이므로 점프 바를 통해 개별적으로 찾고 설정해야 합니다. 

§ 현재 개별 명령에 대한점프바별칭을지정할수없습니다. 우리는 앞으로 이 제한을완화 

하기를 바랍니다. 

§ 옵션을 편집한 후 점프 바를 다시 열 때, 기본적으로 동일한 옵션이 점프 바에 미리 설정 

된 상태로 다시 나타나지 않습니 다. 다시 말하지만, 우리는 앞으로 이 제한을 완화하기를 

바랍니다. 
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Marching Percussion Basics 
Dorico 6 includes a new set of sounds for marching percussion, produced in 

partnership with Tapspace, developers of the acclaimed Virtual Drumline sound 

library. Marching Percussion Basics includes four patches, addressing the four 

main instruments of the drumline: 

§ Marching Basses: six bass drums, with left and right hits, rim hits, and roll; plus 

unison with all six drums playing. 

§ Marching Cymbals: flat crash, choke, sizzle, and crunch. 

§ Marching Snares: left and right hits, rim hits, and rim shots, plus roll. 

§ Marching Tenors: four tenor drums plus two smaller spocks, with left and right 

hits and rim hits, plus roll. 

To use these new sounds, choose a factory playback template with Marching Perc. 

in its name. If you always want these sounds available in new projects, change 

Default playback template on the Play page of Preferences. 

  



타악71 

도리코 6에는 호평을 받은 버추얼 드럼라인 사운드 라이브러리의 개발자인 탭스페이스와 협 

력하여 제작한 행진 타악기를 위한 새로운 사운드 세트가 포함되어 있습니 다. 행진 타악기 

기본에는 드럼라인의 네 가지 주요 악기를 다루는 네 가지 패치가 포함되어 있습니다. 

§ 마칭 베이스: 좌우 히트곡, 림 히트곡, 롤이 있는 6개의 베이스 드럼과 6개의 드럼이 모두 연 

주되는유니슨입니다. 

§§§ 
행진하는 심벌즈: 펑평한 층돌, 질식, 지글지글, 그리고 바삭바삭합니다. 

행진하는 올가미: 좌우 타격, 림 히트, 림 샷, 그리고 룰을 추가합니다. 

마칭 테너: 4개의 테너 드럼과 2개의 작은 스팍, 좌우 히트 및 림 히트, 그리고 를이 있습니 

다 

이 러한 새로운 사운드를 사용하려면 Marching Pere가 있는 공장 재생 템플릿을 선택하세요. 

그 이름으로요. 새로운 프로젝트에서 이 러한 사운드를 항상 사용할 수 있기를 원한다면, 

설정 재생 페이지에서 기본 재생 템플릿을 변경하세요. 
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Other improvements 

Accidentals 
Viewing contradictory accidentals. When you have notes of the same name at different 

octaves with different accidentals in the same instrument – for example, C3 in the 

left-hand staff of a piano and C♯5 in the right-hand staff –these are considered 

contradictory accidentals. Depending on musical context, you might find it 

unnecessary to show the natural on one or more of the notes. 

To help to locate these places, a new View ▶ Note and Rest Colors ▶ Contradictory 

Accidentals option has been added, complementing the existing Cautionary 

Accidentals and Forced Accidentals options. When activated, contradictory 

accidentals will be shown in a purple color: the color can be customized on the 

Colors page of Preferences if required. 

Audio engine 
Quitting Dorico. When quitting Dorico, Dorico now waits up to 10 seconds for the audio 

engine to exit completely before it exits. This should prevent you from attempting 

to restart Dorico before the audio engine has cleanly exited. 

Barlines 
Showing a double barline at the start of the system. A new option Barline at start of 

system with double barline at end of previous system has been added to the 

Barlines page of Notation Options: when Double barline is chosen, a double barline 

at the end of the system will also be shown as the systemic barline at the start of the 

next system. 

Bar numbers 
Bar numbers at the start of the system. It is now possible to specify that bar numbers 

shown at the start of the system should be center aligned. On the Bar Numbers 

page of Layout Options, set Alignment at start of system to Centered on barline. 

Selecting bar numbers. When bar numbers are shown at positions other than the start of 

the system, making a marquee selection will no longer include bar numbers, unless 

the bar number represents an explicit bar number change. In previous versions, 

when such bar numbers were included, copying and pasting that material could 

result in unexpected results, because the material would be pasted at an offset 

determined by the number of bars between the first selected bar number and the 

prevailing time signature. 

Beaming 
Beam positions relative to accidentals on beamed notes. When Dorico determines the 

vertical position of a beam, it snaps the beam to a legal sit/straddle/hang position 

relative to a staff line. This will often mean snapping the beam inwards, such that 



기타개선사항 

변고 

도리코 6판역사 

모순된 사고를 보기. 같은 악기에 다른 우연이 있는 다른 옥타브에서 같은 이름의 음이 있을 때, 예 

를 들어 피아노의 왼쪽 오보에 있는 C3와 오른쪽 오보에 있는 C#5는 모순된 사고로 간주됩니다. 음 

악적 맥락에 따라 하나 이상의 음에 자연스러운 것을 보여줄 필요가 없을 수도 있습니다. 

이 러한 장소를 찾는 데 도움이 되도록 기존의 주의 사고 및 강제 사고 옵션을 보완하여 새로운 

► 노트보기 및 휴식 색상 ► 옵션이 추가되었습니다. 활성화되면 모순되는사고가보라색으 

로 표시됩니다 필요한 경우 색상은 선호도 페이지에서 사용자 정의할 수 있습니다. 

오디오 

도리코 그만두기. 도리코를 그만둘 때, 도리코는 이제 오디오 엔진이 완전히 꺼질 때까지 최대 10초 

를 기다립니다 이것은 오디오 엔진이 깨끗하게 꺼지기 전에 도리코를 다시 시작하려는 시도를 방지 

할수있습니다. 

71준선 

시스템 시작 시 이중 바라인 표시. 이전 시스템 끝에 이중 바라인이 있는 시스템 시작 시 새로운 옵션 

바라인이 표시 옵션의 바라인 페이지에 추가되었습니다: 이중 바라인이 선택되면 시스템 끝에 있는 이 

증 바라인도 다음시스템 시작시 시스템 바라인으로표시됩니다. 

1:1~코드 

비밍 

시스템 시작 시 막대 번호입니다 이제 시스템 시작 시 표시된 막대 번호가 중앙 정렬되어야 함을 지 

정할 수 있습니다 레이아웃 옵션의 막대 번호 페이지에서 시스템 시작 시 정렬을 중앙에 설정합니 

댜 

막대 번호 선택. 막대 번호가 시스템 시작 이외의 위치에 표시될 때, 막대 번호가 명시적인 막대 번호 

변경을 나타내지 않는 한, 마르키 선택에는 더 이상 막대 번호가 포함되지 않습니다. 이전 버전에서는 

그러한 막대 번호가 포함되었을 때, 재료가 처음 선택된 막대 번호와 막대 번호 사이의 수에 의해 결정 

된 오프셋으로 붙여지기 때문에, 그 자료를 복사하고 붙이면 예상치 못한 결과가 발생할 수 있습니다. 

기존 박자표입니다. 

빔 노트의 우연에 대한 빔 위치. 도리코가 빔의 수직 위치를 결정하면, 그것은 빔을 스태프 라인에 

대한 합법적인 시트/스트래들/행 위치로 스냅합니다. 이것은 종종 빔을 안쪽으로 스냅하는 것을 의 

미합니다. 
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the length of one or more of the stems in the beamed groups is shortened. In 

previous versions, this could result in the beam colliding with an accidental 

belonging to a notehead in the beamed group. 

Dorico now avoids such collisions by default in new projects. If you want to enable 

this improvement in existing projects, activate the new option Strictly enforce 

minimum stem lengths and space for accidentals when snapping inwards in the 

Advanced Options section of the Vertical Position section of the Beams page of 

Engraving Options. 

Beaming across beat boundaries when ties are present. A new option Notes joined by ties 

in simple time signatures has been added to the Time Signatures With or Without 

a Half-bar section of the Note Grouping page of Notation Options. 

 
By default, Dorico breaks beams between tied noteheads that would otherwise be 

joined if they were separate notes; however, this is not a universal practice, so if you 

would prefer such tied noteheads not to break beams, choose Allow to cross beats. 

Chord symbols 
Selecting chord symbols. Because chord symbols are system-attached items, they are not 

included in selections made by clicking on a blank part of the staff, or when 

extending the selection with Shift+click. They can be selected by clicking on them 

and using Edit ▶ Select More, or selected along with material on all staves using the 

system track, but these selection methods require that you at least start the 

selection using the mouse. 

To make it possible to select chord symbols using only the keyboard, two new 

commands have been added that can be triggered via the jump bar, or to which you 

can assign your own custom shortcuts on the Key Commands page of Preferences. 

The first command, Select Chord Symbols, selects the chord symbols in the range 

described by the earliest and latest selected items: it clears the existing selection, 

and selects the chord symbols within that range. 

The second command, Add Chord Symbols to Selection, selects the chord symbols 

in the range described by the earliest and latest selected items, but without clearing 

the existing selection, so that the chord symbols are added to the selection. 



화음 

도리코 6판역사 

빔 그룹의 줄기 중 하나 이상의 길이가 짧아집니다. 이전 버전에서는 빔이 빔 그룹의 노트 

헤드에 속하는 우발적으로 충둘하는 결과를 초래할 수 있습니 다. 

도리코는 이제새로운프로젝트에서 이러한충돌을 기본적으로 방지합니다. 기존프로젝트의 이 

러한 개선을 가능하게 하려면 새 옵션을 활성화하십시오. 옵션 조각 페이지의 수직 위치 섹션의 

고급 옵션 섹션에서 안쪽으로 스냅할 때 최소 스템 길이와 사고에 대한 공간을 엄격하게 적용합니 

다. 

타이가 있을 때 경계를 넘어 비밍 . 노트 그룹화 페이지의 하프바가 있거나 없는 시간 서명에 간단한 시 

간서명으로 연결된새로운옵션 노트가추가되었습니다. 

간단한 시간 서영이 연결되어 있습니다. 

강 .. p ---- | 성’ 그7JJTI | 
인만 1포크로즈 바즈 빔HIC 겁거1난 '사1세요 

기본적으로 도리코는 묶인 노트헤드 사이의 빔을 끊습니다. 그렇지 않으면 별도의 노트라면 연결 

될 수 있습니다 그러나 이것은 보편적인 관행이 아니므로 이러한묶인 노트헤드가 빔을 깨지 않 

기를 원하는 경우 비트를 교차하도록 허용하십시오. 

코드 기호 선택. 코드 기호는 시스템에 부착된 항목이기 때문에 스태프의 빈 부분을 클릭하거나 

Shift+click으로 선택을 확장할 때 선택에 포함되지 않습니다. 클릭하여 편집 ► 더 많이 선택하거나 

시스템 트랙을사용하여 모든 오선지의 자료와 함께 선택할수 있지만 이러한 선택 방법은 최소한 마우 

스를 사용하여 선택을 시작해야 합니다. 

키보드만사용하여 코드 기호를 선택할수 있도록 점프 바를 통해 트리거할수 있거나 설정의 주 

요 명령 페이지에서 자신만의 맞춤형 단축키를 할당할 수 있는 두 가지 새로운 명령이 추가되었습 

니다 

첫 번째 명령인 코드 기호 선택은 가장 이른 시기의 선택 항목과 최신 선택 항목이 설명하는 범 

위의 코드 기호를 선택합니다: 기존 선택을 지우고 그 범위 내에서 코드 기호를 선택합니다. 

두 번째 명령인 코드 기호 추가는 가장 이른 항목과 가장 최근에 선택된 항목이 설명하는 범위의 

코드 기호를 선택하지만, 기존 선택을 지우지 않고 선택에 코드 기호를 추가합니다. 
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In addition, it is now possible to select a range of chord symbols by selecting one 

chord symbol, then holding Shift and clicking another chord symbol: all the 

intervening chord symbols are selected. 

Similarly, if you select one chord symbol and then select a later chord symbol using 

Ctrl+click (Windows) or Command-click (macOS), then use Edit ▶ Select More, 

Dorico will select all the intervening chord symbols. 

Vertical alignment of chord symbols. When some chord symbols on the system are 

presented as a single line, and others – such as polychords, or chords with altered 

bass notes using a stacked appearance – are presented as two lines, you can now 

specify their relative vertical alignment. A new option Alignment of multi-line 

chord symbols relative to single-line chord symbols has been added to the 

Position section of the Chord Symbols page of Engraving Options: 

 
 

Root notes. In German-speaking countries there are different conventions for how the 

pitches B♮ and B♭ should be named: very often, B♮ is named H and B♭ is named B. In 

chord symbols where B♭ is shown as B♭, some prefer the natural sign to be shown 

explicitly for B♮ to make clear that B does not mean B♭. (“Oh, that was easy,” says 

Man, and for an encore goes on to prove that black is white and gets killed on the 

next zebra crossing.) 

To use this convention, set Appearance of B and B flat to B natural and Bb in the 

Root section of the Chord Symbols page of Engraving Options. 

6/9 chord appearance. Two new options have been added to the Appearance of 6/9 

option in the Intervals section of the Chord Symbols page of Engraving Options: as 

their names suggest, 6 over 9 without line and 9 over 6 without line use stacked 

numerals with no line between them. 

Major seventh appearance. Some major publishers use a variation of the appearance for 

major seventh chords where “maj” is shown on the baseline and “7” is superscript. 

This can now be achieved in Dorico by setting the new Position of interval number 

when using baseline vertical position option in the Intervals section of the Chord 

Symbols page of Engraving Options. 



또한, 이제는 하나의 코드 기호를 선택한 다음 Shift를 잡고 다른 코드 기호롤 클릭하여 다양 

한코드 기호를 선택할수 있습니다: 모든 증간코드 기호가 선택됩니다. 

마찬가지로, 하나의 코드 기호를 선택한 다음 Ctrl+click(Windows) 또는 Command-

click(macOS)을 사용하여 나중의 코드 기호를 선택하면 편집 ► More를 선택하면 도리코가 모 

든 중간 코드 기호를 선택합니다. 

코드 기호의 수직 정렬. 시스템의 일부 코드 기호가 단일 선으로 표시되고, 다른 코드, 예를 들어 폴 

리코드 또는 쌓인 모양을 사용하여 베이스 음이 변경된 코드가 두 줄로 표시되면 이제 상대적인 수 

직 정렬을 지정할 수 있습니다. 단일 선 코드 기호에 대한 다중 선 코드 기호의 새로운 옵션 정렬이 

각인 옵션의 코드 기호 페이지의 위치 섹션에 추가되었습니다. 

C 씨 
비비 

C
Rh M c 

C 비비 

뿌리 메모독일어권국가에서는 Bu와요음정을어떻게 명명해야하는지에 대한 다양한관습이 있 

습니다 매우 자주 B~은 H로, Bb은 B로 명명됩니다 Bb가 B로 표시되는 코드 기호에서 일부는 B가 

Bb를 의미하지 않는다는 것을 분명히 하기 위해 B~에 대해 명시적으로 표시되는 것을 선호합니다. 

(“오, 쉬웠어요"라고 맨은 말합니다 그리고 앙코르를 위해 검은색이 흰색이고 다음 얼룩말교배에 

서죽임을증명합니다) 

이 규칙을 사용하려면, 옵션 조각코드 기호 페이지의 루트 부분에 B와 B의 출현을 B 자연과 B 
로 펑펑하게 설정하세요. 

6/9 코드 모양. 각인 옵션의 코드 기호 페이지의 간격 섹션에 6/9 옵션의 모양에 두 가지 새로운 옵션 

이 추가되었습니다 그들의 이름에서 알 수 있듯이, 줄 없이 6 over 9와 줄 없이 9 over 6입니다. 

장 7도 출현 일부 주요 출판사들은 장 7도 화음에 대해 "maj"가 기준선에 표시되고 "7"이 위첨자인 

변형을사용합니다. 

이것은 이제 도리코에서 새깅 옵션의 코드 기호 페이지의 간격 섹션에서 기준 수직 위치 옵션을 

사용할 때 간격 번호의 새로운 위치를 설정함으로써 달성할 수 있습니 다. 
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Minor seventh chords versus sixth chords in inversion. When interpreting chords played 

on a MIDI keyboard as a chord symbol, some collections of notes can be interpreted 

as several chords that are each common. For example, E,G,B,D could potentially be 

either Em7 or G6. Dorico prefers chords in root position, so E in the bass gives Em7 

and G gives G6; however, if D is in the bass Dorico prefers G6/D, whereas you might 

prefer Em7/D. 

To accommodate this choice, a new option Preference for sixth or minor seventh 

chords when in inversion has been added to the Chord Symbols page of Note Input 

Options. 

Boston preset. The Boston preset for chord symbols, as chosen on the Chord Symbols 

page of Engraving Options, has been updated to hew a little closer to the 

conventions taught at Berklee College of Music. 

Clefs 
Deleting initial clefs. When importing MusicXML files, it’s common for instruments to 

have explicit clef changes at the very start of the flow. A new Delete Initial Clefs 

command has been added: this removes all explicit clef changes at the start of every 

flow in the project. The command can be triggered via the jump bar, or you can 

assign a custom key command via the Key Commands page of Preferences. 

Dynamics 
Dynamics with hidden intensity markings. When a dynamic’s intensity marking is 

hidden, any remaining prefix/suffix should ideally be left-aligned on the note, 

rather than falling back on center alignment. A new option Alignment of text 

dynamics with intensity mark hidden has been added to the Horizontal Position 

section of the Dynamics page of Engraving Options allows you to enable or disable 

this behavior; by default, such dynamics will be left-aligned in new projects, but 

center-aligned in existing projects to preserve their appearance. 

Graphic slices 
Default graphic slice settings. You can now specify the default properties for graphic 

slices: create a slice, set the format, color depth, and resolution using the controls in 

the Graphic Slices panel in Engrave mode, then click Save as Default to save those 

choices for all future graphic slices in all projects. 

Natural sort order. Graphic slices are now listed in the panel according to natural sort 

order, rather than lexicographical sort order. 

Slice names. After creating a new slice, the name field in the panel is automatically 

opened for editing, so you can immediately type the name of the new slice. 



도리코 6판역사 

단7화음 대 6화음 반전. 화음 해석 시 

MIDI 키보드에서 코드 기호로서 일부 음 모음은 각각 공통적인 여러 코드로 해석될 수 있습니다 

예를 들어, E,G,B,D는 잠재적으로 Em7 또는 G6일 수 있습니다 도리코는 루트 위치의 코드를 선 

호하므로 베이스의 E는 Em7을 제공하고 G는 G6을 제공합니다 그러나 D가 베이스에 있는 경 

우 도리코는 G6/D를 선호하는 반면 Em7/D를 선호할 수 있습니다 

이 선택을 수용하기 위해, 반전 시 6도 또는 단 7도 코드에 대한 새로운 옵션 선호도가 노트 입력 

옵션의 코드 기호 페이지에 추가되었습니다. 

보스턴 프리셋. 음각 옵션의 코드 기호에 대한 보스턴 프리셋은 버클리 음악 대학에서 가르치는 관 

습에 조금 더 가깝게 업데이트되었습니다. 

롤리프 

초기 클리프 삭제. MusicXML 파일을 가져올 때 악기는 흐름의 시작 부분에서 명시적인 클리프 변경 

사항이 있는 것이 일반적입니다. 새로운 삭제 초기 클리프스커맨드가 추가되었습니다. 이것은 프로젝 

트의 모든 흐름이 시작될 때 모든 명시적인 클리프 변경 사항을 제거합니다. 명령은 점프 바를 통해 트 

리거되거나 기본 설정의 키 명령 페이지를 통해 사용자 정의 키 명령을 할당할수 있습니다. 

역동성 

강도 표시가 숨겨진 역학. 동적 강도 표시가 있을 때 

그래픽 

숨겨진, 남아 있는 접두사/접미사는 중앙 정렬에서 뒤로 떨어지지 않고 노트에 왼쪽으로 정렬 

되어야합니다 새로운옵션인 강도표시가숨겨진 텍스트 역학정렬을통해 이 동작을활성화 

하거나 비활성화할 수 있습니다. 기본적으로 이러한 역학은 새로운 프로젝트에서는 왼쪽으로 

정렬되지만 기존 프로젝트에서는 중앙 정렬되어 외관을 유지합니다. 

기본그래픽 슬라이스 설정. 이제 그래픽 슬라이스에 대한 기본 속성을 지정할수 있습니다. 슬라이스 

를 만들고, 그래픽 슬라이스 패널의 컨트롤을 사용하여 형식, 색상 깊이 및 해상도를 설정한 다음, 기본 

으로 저장하기를 클릭하여 모든 프로젝트에서 모든 미래 그래픽 슬라이스에 대한 선택을 저장합니다. 

자연 정렬 순서. 이제 그래픽 슬라이스는 사전식 정렬 순서가 아닌 자연 정렬 순서에 따라 패널에 나 

열됩니다. 

슬라이스 이름입니다 새 슬라이스를 만든 후에는 패널의 이름 필드가 자동으로 열려 편집이 

가능하므로새 슬라이스의 이름을바로 입력할수 있습니다. 
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Guitar tablature 
Moving notes between strings. If you have notation and tablature shown, you can move a 

note from one string to another by selecting it in the tab and typing N or M. 

However, there is no way to move the selection from the notation to the tab at the 

same rhythmic position without using the mouse, so you must click on the other 

representation to move the focus there. 

To address this, two new commands, Move to String Above and Move to String 

Below, have been added. When triggered, these commands move the selected note 

to the string above or below, regardless of whether the selection is in the tablature 

or the notation. If you edit a lot of music that includes tablature, you may find it 

helpful to assign custom key commands to these new commands via the Key 

Commands page of Preferences. 

Harmonics 
Harmonics on tied notes. A new option Natural harmonics on noteheads in tied notes 

has been added to a new Harmonics page in Engraving Options, allowing you to 

choose whether the natural harmonic symbol should be shown on all noteheads in 

the tie chain, or shown only on the first notehead. 

 

Harp pedaling 
Order of left and right pedals. By default, Dorico shows the pedals played by the right foot 

(EFGA) above the pedals played by the left foot (DCB). However, this convention is 

not universally followed so a new Vertical order of pedals option has been added to 

the Harp Pedals page of Engraving Options, allowing you to show the left pedals 

above the right if you prefer. 

Instrument editor 
Instrument name formatting. When editing the full and short instrument names for an 

instrument type in Library ▶ Instruments, any rich text formatting you specify in 

the Edit Instrument Names dialog will now be correctly preserved when the 

instrument is saved to your user library. 

Instrument types 
Fretted instrument tunings. It is now possible to specify a custom name for a modified or 

new fretted instrument tuning in the Edit Strings and Tuning dialog. After you 



도리코 6판역사 

기타타블레쳐 

음표를 줄 사이에 이동시키는 것. 만약 표시된 표기법과 표가 있다면, 탭에서 선택하고 N 또는 M을 입 
력하여 한 줄에서 다른 줄로 음표를 이동시길 수 있습니 다. 

조화학 

그러나 마우스를 사용하지 않고 같은 리듬 위치에서 선택을 표기에서 탭으로 이동할 방법이 없 

으므로 다른 표현을 클릭하여 초점을 그곳으로 이동해야 합니다. 

이를 해결하기 위해 위 문자열로 이동하기 및 아래 문자열로 이동하기라는 두 가지 새로운 명령 

이 추가되었습니다. 트리거되면, 이러한 명령은 선택이 표에 있든 표기법에 있든 상관없이 선택 

된 움을 위 또는 아래의 문자열로 이동시킵니다. 표가 포함된 많은 음악을 편집하면, 기본 설정의 

키 명령 페이지를통해 이러한새로운 명령에사용자정의 키 명령을 할당하는 것이 도움이 될 수 

있습니다 

묶인 노트의 조화음. 묶인 노트의 노트헤드에 있는 자연 조화음이 옵션 조각기의 새로운 조화음 페이 

지에 추가되어 자연 조화음 기호가 묶인 모든 노트헤드에 표시되어야 하는지 아니 면 첫 번째 노트헤드 

에만 표시되어야 하는지 선택할 수 있습니다. 

하프페달 

왼쪽 및 오른쪽 페달 순서입니다 기본적으로 도리코는 오른쪽 발(EFGA)이 연주하는 페달을 왼쪽 발 

(DCB)이 연주하는 페달 위에 표시합니다. 그러나 이 규칙은 보편적으로 적용되지 않으므로 옵션 조각 

기의 하프 페달 페이지에 새로운 수직 순서 옵션이 추가되어 원하는 경우 왼쪽 페달을 오른쪽 위에 표 

시할수있습니다 

악기편집기 

기기 이름 형식 지정 라이브러리 ► 기기에서 기기 유형에 대한 전체 및 짧은 기기 이름을 편집할 

때, 기기 이름 편집 대화에서 지정한 모든 풍부한 텍스트 형식은 기기가 사용자 라이브러리에 저장 

되면 올바르게 보존됩니다. 

악71종 

프렛 악기 튜닝. 이제 편집 스트링 및 튜닝 다이얼로그에서 수정되거나 새로운 프렛 악기 튜닝에 대한 

사용자 지정 이름을 지정할 수 있습니다. 당신 이후에. 
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modify the current tuning, the new Edit Name button becomes enabled: click this to 

specify a name for the tuning. 

The custom name is used wherever tunings are listed, including in the Chord 

Diagrams submenu for the context menu in the Players panel in Setup mode. 

Library Manager 
Import into all flows and layouts. It is now possible to import layout and notation options 

into all layouts and flows in the project respectively using the Library Manager. 

When you select Layout Options in the Options section of the left-hand list, a new 

button appears at the bottom left-hand corner of the window. The button reflects 

the type of the layout chosen in the Layout drop-down in the This project section at 

the top of the window. If you have a full score layout selected, the button reads Copy 

to All Full Score Layouts; if a part layout is selected, it reads Copy to All Part 

Layouts; and if a custom score is selected, it reads Copy to All Custom Score 

Layouts. 

When you select Notation Options in the Options section, the button reads Copy to 

All Flows. 

When you click this button, you are asked to confirm that you want to proceed, and 

all the layout or notation options are applied from the source library or project to all 

the layouts of the shown type, or to all flows. The changes are applied immediately, 

and the Library Manager updates right away. As with all changes made in the 

Library Manager, you can close the window and undo if you want to roll them back. 

Lines 
Tapered curve lines. It is now possible to create horizontal and vertical lines that are 

drawn using curves, and a couple of preset lines have been added to the panel. 

In the Horizontal section of the Lines panel, upward and downward curved lines 

with arrowheads are provided: these are sometimes used in teaching materials to 

indicate a harmonic resolution: 

 
In the Vertical section of the Lines panel, left- and right-pointing brace lines are 

provided. These are drawn using a pair of mirrored curved lines, rather than fixed 

symbols from the current music font. These are sometimes used in lyrics to indicate 

where lyrics for a refrain or repeated passage are the same on each repetition: 

F F7 B



현재 튜닝을 수정하면 새 이름 편집 버튼이 활성화됩니다. 이 버튼을 클릭하여 튜닝에 대한 이름 

을지정합니다 

사용자 정의 이름은 설정 모드의 플레이어스 패널의 컨텍스트 매뉴에 대한 코드 다이어그 

램 하위 매뉴를 포함하여 조정이 나열된 모든 곳에서 사용됩니다. 

도서관장 

모든 흐름과 레이아웃으로 가져오기. 이제 라이브러리 관리자를 사용하여 프로젝트의 모든 레이아웃 

과 흐름에 레이아웃 및 표기 옵션을 각각 가져올 수 있습니다. 

왼쪽 목록의 옵션 섹션에서 레이아웃 옵션을 선택하면 창의 왼쪽 하단에 새로운 버튼이 나타납니 

댜 버튼은 창 상단의 이 프로젝트 섹션에 있는 레이아웃 드롭다운에서 선택한 레이아웃 유형을 

반영합니다 전체 점수 레이아웃이 선택된 경우 버튼에는 전체 점수 레이아웃에 대한 복사라고 표 

시되고, 부품 레이아웃이 선택된 경우에는 전체 부품 레이아웃에 대한 복사라고 표시되며, 사용 

자지정 점수가선택된 경우에는전체 사용자지정 점수 레이아웃에 대한복사라고표시됩니다. 

옵션 섹션에서 Notation Options를 선택하면 버튼에 모든 흐름에 대한 복사라고 표시됩니다. 

이 버튼을 클릭하면 진행을 원하는지 확인하라는 요청이 들어오며, 모든 레이아웃 또는 표기 옵 

션은 소스 라이브러리 또는 프로젝트에서 표시된 유형의 모든 레이아웃 또는 모든 흐름에 적용됩 

니다 변경 사항은 즉시 적용되며 라이브러리 관리자가 즉시 업데이트됩니다. 라이브러리 관리자 

에서 변경된 모든 변경 사항과 마찬가지로 창을 닫고 되돌리려면 취소할 수 있습니다. 

선
 

테이퍼진 곡선 라인. 이제 곡선을 사용하여 그린 수평선과 수직선을 만들 수 있게 되었으며, 패널 

에 몇 개의 미리 설정된 선이 추가되었습니다. 

라인 패널의 수펑 부분에는 화살촉이 있는 위쪽과 아래쪽 곡선이 제공됩니다. 이것들은 때때 

로 고조파 해상도를 나타내기 위해 교재에 사용됩니다. 

에므L 에프7-一――-----... 을b 
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라인 패널의 수직 부분에는왼쪽과오른쪽을가리키는브레이스 라인이 제공됩니다. 이것들은 현 

재음악글꼴의 고정된 기호가아닌 거울처럼 보이는한쌍의 곡선을사용하여 그려집니다. 이것 

들은 때때로 가사에서 사용되어 후렴구나 반복되는 구절에 대한 가사가 반복될 때마다 동일한 경 

우를 나타냅니다. 
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To create your own line styles that use curves, choose Library ▶ Line Bodies and 

choose Tapered Curve from the Category drop-down in the top left corner. 

 
The Start/End control point and Y offset values are expressed as normalized values 

between 0 and 1, where 1 = 100% of the length of the line, and 0 = 0% of the length of 

the line. A threshold at 20 spaces prevents the control points and the Y offsets from 

growing any bigger: this is intended to stop the curve becoming excessively loopy as 

it gets longer. 

You can choose between four approaches for determining the thickness of the line 

using the Thickness type drop-down: 

§ Constant uses the input values without any adjustment, regardless of the 

length of the line. 

§ Proportional scales the values with the length of the line, which are 

clamped by default to prevent the line becoming either very thin at short 

lengths or very thick at long lengths. 

§ Threshold clamps the values to the specified thickness values at or below 

the Min length (expressed in spaces), then interpolates to 1.5× the specified 

values at or above the Max length. 

§ Exponential uses an exponential growth function, which means that it will 

move more quickly from the input thickness to the maximum thickness as 

the line grows longer. The Damping factor controls the rate at which the 

-
-

-
- -

ev
ev

’ry
’ry

where
where

an
a

“oink,
“quack,

oink,”
quack,”

Old Mac don ald



도리코 6판역사 

에브_볶음 어디 

에브_볶음 어디 
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곡선을 사용하는 자신만의 라인 스타일을 만들려면 라이브러리 ► 라인 바디를 선택하고 왼 

쪽 상단에 있는 카테고리 드롭다운에서 테이퍼드 커브를 선택하세요. 

시작/종료 제어점과 Y 오프셋 값은 0과 1 사이의 정규화된 값으로 표시되며, 여기서 1 = 선 길이 

의 100%, 0 = 선 길이의 0%입니다 20칸의 임계값은 제어점과 Y 오프셋이 더 이상 커지는 것을 

방지합니다: 이것은 곡선이 길어짐에 따라 과도하게 고리 모양이 되는 것을 방지하기 위한 것입니 

댜 

선의 두께를 결정하기 위해 네 가지 접근 방식 증에서 선택할 수 있습니다. 

두께 유형 드롭다운을 사용합니다. 

§ 상수는 선의 길이에 관계없이 입력 값을 조정 없이 사용합니다. 

§ 비율은 선의 길이에 따라 값을 확장하며, 이는 줄이 짧은 길이에서 매우 얇거나 긴 길 

이에서 매우 두꺼워지는 것을 방지하기 위해 기본적으로 고정됩니다. 

§ 임계값은 Min 길이 이하의 지정된 두께 값으로 값을 고정한 다음(공간으로 표시됨) 최 

대 길이 이상의 지정된 값을 1 . 5배로 보간합니다. 

§ 지수 함수는 지수 성장 함수를 사용하는데, 이는 선이 길어질수록 입력 두께에서 최대 

두께로 더 빠르게 이동한다는 것을 의미합니다. 감쇠 계수는 그 속도를 조절합니다. 
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thickness scales in response to the curve length: higher values cause the 

thickness to increase more rapidly. 

Once you have designed one or more tapered curve line bodies, you can use these 

in Library ▶ Lines to design horizontal or vertical lines that appear in the Lines 

panel. 

It is not possible to set annotations in horizontal or vertical line styles that use 

tapered curve bodies. Vertical lines that use tapered curve bodies do not avoid 

collisions. 

Collision avoidance. Horizontal lines placed outside the staff can now be excluded from 

collision avoidance by activating the new Avoid collisions property in the 

Horizontal Lines group in the Properties panel. This property is not available for 

note-attached lines. 

Lyrics 
Editing lyric durations. In situations where you’re adding lyrics to music in multiple 

voices, or between a pair of staves (e.g. for barbershop music written in short score), 

you may need to show an extender line for a lyric even though the specific voice 

against which the lyric has been input doesn’t show a melisma, because another 

voice on the same or another staff that is nominally sharing the same lyric does. 

To allow this, it is now possible to edit the duration of a lyric using Shift+Alt+←/→: a 

lyric that shows no extender line can be lengthened to show one, and a lyric with an 

extender line can be shortened such that the extender line no longer appears. 

Moving lyrics in Write mode. Alt+←/→ now moves lyrics to the previous/next note rather 

than to the previous/next rhythmic grid position, as in earlier versions; use 

Ctrl+Alt+←/→ (Windows) or Opt-Command-←/→ (macOS) to move by the grid. It is 

also now possible to drag lyrics left and right in Write mode, which moves them 

between notes (the equivalent of Alt+←/→). 

Markers 
Choosing which time components appear. The Show in timecode options on the Markers 

page of Engraving Options now apply to the timecode shown in markers as well as 

to timecode shown at the start of the system or on the timecode staff. 

MIDI import and export 
Lyrics. Dorico now imports lyrics when importing MIDI files, and includes lyrics when 

exporting MIDI. There is no universally agreed standard for how lyrics should be 

encoded in MIDI files, so it’s not always possible to determine the correct syllable 

type for every lyric: imported lyrics can be edited in the usual way to correct them, 

either directly via the popover, or using the Properties panel. 
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작사 

마커 

두께는 곡선 길이에 따라 확장됩니다: 값이 높을수록 두께가 더 빠르게 증가합니다. 

일단 하나 이상의 테이퍼진 곡선 라인 본체를 설계하면 라이브러리 ► 라인에서 이를 사용하 

여 라인 패널에 나타나는 수평 또는 수직 라인을 설계할 수 있습니다. 

테이퍼진 곡선 본체를 사용하는 가로 또는 세로 라인 스타일로 주석을 설정하는 것은 불 

가능합니다 테이퍼진 커브 본체를 사용하는 수직선은 충돌을 피하지 않습니다. 

충돌 회파 이제 특성 패널의 수평선 그룹에서 새로운 충돌 회피 속성을 활성화하여 직원 외부에 배 

치된 수평선을 충돌 회피에서 제외할 수 있습니다. 이 속성은 노트에 부착된 라인에서는 사용할 수 

없습니다 

가사시간편집. 여러 목소리로음악에 가사를 추가하거나한쌍의 오선지 사이에 가사를추가하는상 

황에서(예: 짧은 악보로 쓰인 이발소 음악의 경우) 가사를 위한 확장 라인을 보여야 할 수도 있습니다. 

가사가 입력된 특정 목소리가 멜리스마를 나타내지 않더라도, 같은 가사의 다른 목소리나 명목상 동일 

한 가사를 공유하는 다른 스태프의 다른 목소리가 그렇기 때문입니다. 

이를 위해 이제 Shift+Alt+ .... / ..... 률 사용하여 가사의 지속 시간을 편집할 수 있습니다: 확장 라인 

이 없는 가사는 하나를 보여주기 위해 길게 할 수 있으며, 확장 라인이 있는 가사는 더 이상 확장 

라인이 나타나지 않도록 짧게 할 수 있습니 다. 

쓰기 모드에서 가사 이동. Alt+ ― / --+ 는 이제 이전 버전에서와 같이 이전/다음 리듬 그리드 위치가 아 

닌 이전/다음 음으로 가사를 이동합니다. Ctrl+Alt+ ,_ / --+ (Windows) 또는 Opt-Command- ... / 

--+ （macOS)를 사용하여 그리드로 이동합니 다 또한 이제는 쓰기 모드에서 가사를 좌우로 드래그할 

수 있으며, 이는 음 사이에서 이동합니다(Alt+ ― / --+ 에 해당). 

어떤 시간 구성 요소가 나타날지 선택합니다. 각인 옵션의 마커 페이지의 표시 표시에 있는 타임코드 

옵션은 이제 마커에 표시된 타임코드뿐만아니라시스템 시작부분이나타임코드스태프에 표시된 타 

임코드에도적용됩니다 

중간수출입 

가사. Dorico는 이제 MIDI 파일을 가져올 때 가사를 가져오고 MIDI를 보낼 때 가사를 포함합니댜 

가사를 MIDI 파일에서 인코딩하는 방법에 대한 보편적으로 합의된 표준이 없으므로 모든 가사에 대 

해 올바른 음절 유형을 결정하는 것이 항상 가능한 것은 아닙 니 다. 가져온 가사는 팝오버를 통해 직 

접 또는 속성 패널을 사용하여 수정하기 위해 일반적인 방법으로 편집할 수 있습니다. 
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When exporting lyrics, Dorico does its best to assign lyrics belonging to separate 

lines to repeated passages if possible; if there are multiple lines of lyrics but no 

repeats, only the first line of lyrics is exported. 

Music fonts 
Font updates. Academico has been updated to version 0.905, which includes improved 

kerning for numerals. Petaluma has been updated to version 1.065, and Petaluma 

Text to version 1.066. These are very minor updates, adding the left- and right-

pointing arrows for tempo equations, and revising the width of the space character 

in Petaluma Text. 

Golden Age has been updated to version 1.05, Sebastian to version 1.21, and 

Nepomuk to version 2.52. 

Music symbol editor 
The music symbols editor is used in several places in Dorico – for example, when 

double-clicking a chord symbol in Engrave mode; Library ▶ Music Symbols, Library 

▶ Playing Techniques, Library ▶ Chord Symbols, etc. – and has been revised to 

make it easier to use. 

Better defaults. Depending on the context in which it appears, Dorico now chooses a 

different default SMuFL range on the Glyphs tab, font style on the Text tab, and 

composite category on the Composites tab. 

Information read-out. A read-out has been added to the Component panel below the 

main editor, showing information about the text content, font style and font for text 

components, the name of composite components, and the glyph name, codepoint, 

font style and font name for glyph components. 

Scaling components. In the panel of controls below the preview, a single Scale spin box 

now appears, unless the selected component type is a graphic; only graphics can be 

scaled by different amounts in the horizontal and vertical dimensions. 

Filtering long lists. Filter line edits have been added to the Glyph, Text and Composite 

tabs, allowing you to type in a search term to narrow down the results in the 

lists/grids below. 

Furthermore, the SMuFL range menu on the Glyph tab now itself contains a filter 

line edit, allowing you to search within the list of ranges by name to narrow down 

your search. 

Deleting graphic components. On the Graphics tab, Dorico now allows you to delete a 

graphic that is not used by any music symbol. This operation is carried out 

immediately, and cannot be undone, so use it with caution. 
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악보 

가사를 내보낼 때 도리코는 가능하면 반복되는 구절에 별도의 줄에 속하는 가사를 할당하기 

위해 최선을 다합니다 가사가 여러 줄 있지만 반복되지 않는 경우에는 첫 줄의 가사만 내보 

냅니댜 

글꼴 업데이트입니다. Academico는 숫자에 대한 개선된 커닝을 포함하는 버전 0.905로 업데이트되 

었습니다. 페탈루마는 버전 1.065로, 페탈루마 텍스트는 버전 1.066으로 업데이트되었습니다. 이것 

들은 템포 방정식에 대한 왼쪽과 오른쪽을 가리키는 화살표를 추가하고 페탈루마 텍스트의 공백 문자 

너비를 수정하는 아주 사소한 업데이트입니다. 

골든 에이지는 1.05 버전으로, 세바스찬은 1.21 버전으로, 네포묵은 2.52 버전으로 업 

데이트되었습니다 

음보편자 

뮤직 심볼 에디터는 도리코의 여러 곳에서 사용되며, 예를 들어, ► 음악 심볼, 라이브러리 ► 재 

생 기술, 라이브러리 ► 코드 심볼 등에서 코드 심볼을 더블 클릭할 때 사용됩니다. 

더 나은 기본값입니다 나타나는 맥락에 따라 도리코는 이제 Glyphs 탭에서 다른 기본 SMuFL 

범위를, Texttab에서 글꼴 스타일을, Composites 탭에서 합성 카테고리를 선택합니다 

정보 읽기. 읽기는 메인 에디터 아래의 구성 요소 패널에 추가되어 텍스트 구성 요소에 대한 텍스트 내 

용, 폰트 스타일 및 폰트, 복합 구성 요소의 이름, 글리프 이름, 코드포인트, 폰트 스타일 및 폰트 이름에 

대한정보를보여줍니다 

구성 요소 스케일링 미리보기 아래의 컨트롤 패널에는 선택한 구성 요소 유형이 그래픽이 아닌 한 단 

일 스케일 스핀 상자가 나타납니다. 그래픽만수평 및 수직 차원에서 다른양으로조정할수 있습니다. 

긴 목록 필터링. Glyph, Text 및 Compositetabs에 필터 라인 편집이 추가되어 검색어를 입력 

하여 아래 목록/그리드의 결과를 좁힐 수 있습니다. 

또한 Glyph 탭의 SMuFL 범위 매뉴 자체에는 이제 필터 라인 편집이 포함되어 있어 이름별 범 

위 목록 내에서 검색을 할 수 있어 검색 범위를 좁힐 수 있습니다. 

그래픽 구성 요소 삭제. 그래픽 탭에서 도리코는 이제 어떤 음악 기호에서도 사용하지 않는 그래 

픽을 삭제할 수 있습니다. 이 작업은 즉시 수행되며 취소할 수 없으므로 주의해서 사용하세요. 

84 스타인버그 미디어 테크놀로지스 GmbH 

84/106 



 

 

Dorico 6 Version History 85 Steinberg Media Technologies GmbH 

Improved previews. The appearance of the items in the Text, Graphics and Composites 

tabs has been thoroughly reworked; in particular, the previews on the Graphics and 

Composites tabs are now much more useful than before. 

MusicXML export 
Instruments showing both notation and tablature. When a fretted instrument shows both 

staff notation and tablature, when exporting MusicXML, Dorico now treats these 

representations independently, exporting each one as a separate instrument (or 

part, in MusicXML’s terminology). 

Transposing instruments. Applications vary in their interpretation of instrument 

transpositions, especially for octave transposing instruments, in MusicXML files. 

We have reviewed in detail Dorico’s behavior both when importing and exporting 

transposing instruments, and it is exporting transpositions and pitches correctly. 

You may nevertheless encounter notes appearing an octave too high or low when 

you import files exported from Dorico into Finale or MuseScore Studio, due to 

issues in their interpretation of clefs with octave indicators. 

Font information for lyrics. Basic information about the fonts used for lyrics is now 

exported to MusicXML. 

Finer positioning of items with duration. Dorico now specifies information about the 

graphical positions of the starts and ends of non-note items with rhythmic 

durations, including gradual dynamics and octave lines. 

Different applications interpret this information differently, so if you are planning 

to import the MusicXML exported from Dorico in a specific application, you may 

wish to adjust the options in the new Export section of the MusicXML page in 

Preferences. 

For exporting to Sibelius, deactivate all three options (Include suppressed system 

and frame breaks, Split ongoing items at system and frame breaks, and Items at 

the end of the bar naturally relative to barline). 

For exporting to Finale, activate all three options. 

For exporting to Noteflight, deactivate Split ongoing items at system and frame 

breaks. 

Note input 
Popovers. Popovers have been tweaked to make some of their hidden superpowers more 

visible. 

Several popovers – including bars and barlines, chord symbols, figured bass, key 

signatures, and time signatures – normally create items that apply to all staves, but 

if you hold Alt when confirming the popover, the created item will instead apply 
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미리보기 개선. 텍스트, 그래픽 및 컴포지스 탭의 항목 외관이 철저히 재작업되었습니다. 특히 그래픽 

및 컴포지스 탭의 미리보기는 이전보다 훨씬 더 유용합니다. 

뮤직XML 수출 

노트 

기보와표를 모두보여주는 악기입니다. 프렛 악기가오선보와표를 모두 보여줄 때, MusicXML을 내 

보낼 때, 도리코는 이제 이러한 표현들을 독립적으로 취급하여 각각을 별도의 악기로 내보냅니다(또 

는 음악XML의 용어로). 

악기를 전치합니다. 응용 프로그램은 특히 MusicXML 파일의 옥타브 전치 악기에 대한 해석이 다 

양합니다 

우리는 조옮김 기구를 수입할 때와 수출할 때 도리코의 행동을 자세히 검토했으며, 그것은 조 

옮김과 음정을 율바르게 내보내고 있습니 다. 

그럼에도 불구하고 도리코에서 피날레 또는 뮤즈스코어 스튜디오로 내보낸 파일을 가져올 때 

옥타브 표시기가 있는 음표 해석에 문제가 있어 너무 높거나 낮게 나타나는 음표를 만날 수 있 

습니다 

가사에 대한 글꼴 정보. 이제 가사에 사용된 글꼴에 대한 기본 정보가 MusicXML로 전송됩니 

댜 

지속 시간에 따른 항목의 더 미세한 위치 지정. 도리코는 이제 점진적인 다이내믹과 옥타브 라인 

을 포함하여 리드미컬한 지속 시간을 가진 비음표 항목의 시작과 끝의 그래픽 위치에 대한 정보 

롤지정합니다 

응용 프로그램마다 이 정보를 다르게 해석하므로 특정 응용 프로그램에서 도리코에서 내보낸 

MusicXML을 가져올 계획이라면, 미리보기에서 MusicXML 페이지의 새로운 내보내기 섹션 

의 옵션을 조정하려고 할 수 있습니 다. 

Sibelius로 내보내기를 위해 세 가지 옵션을 모두 비활성화합니다(억제된 시스템 및 프레임 파 

손 포함, 시스템 및 프레임 파손 시 진행 중인 항목 분할, 막대 끝에 있는 항목을 바라인에 자연스 

럽게 포함). 

피날레로 내보내기를 위해 세 가지 옵션을 모두 활성화하세요. 

Noteflight로 내보내기를 위해 시스템 및 프레임 파손 시 진행 증인 항목을 분할하십시오. 

팝오버 팝오버는 숨겨진 초능력을 더 잘 보이게 하기 위해 조정되었습니다 

막대와 막대, 코드 기호, 피규어 베이스, 키 서명 및 박자서명을 포함한 여러 팝오버는 일반적으 

로 모든 오선지에 적용되는 항목을 생성하지만 팝오버를 확인할 때 Alt를 유지하면 생성된 항목 

이 대신 적용됩니다 
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only to the current staff. (The dynamics popover is similar, but a little different: 

when you hold Alt, the dynamic is created in the current voice as specified by the 

caret, rather than applying to all voices.) 

To make this more obvious, these popovers now show an additional button to the 

right of the text field: as you hold Alt it becomes activated. You can also click the 

button, and then confirm the popover in the usual way (for example, by hitting 

Return, or for popovers that can advance, by pressing Space, Tab, or →). 

The chord symbols and lyrics popovers allow you to input items on multiple lines 

above or below the staff. The line number is now shown in a spin control to the right 

of the text field. It’s read-only, so you can’t type into it, but you can click the paddles 

to move to the next or previous line, and you can of course use ↑/↓ to change line, 

as before. 

The lyrics and fingering popovers can also show an extra information label to the 

right of the text field or spin control. For lyrics, this indicates whether you are 

inputting lyrics above or below the staff; for fingering, if you are writing on a fretted 

instrument, it shows whether you are inputting right- or left-hand fingering. Click 

the label to swap between these states. 

Instrument filters. When working in galley view with an active instrument filter, Dorico 

now ignores the instruments hidden by the filter when inputting and editing notes. 

For example, when you extend the caret with Shift+↑/↓, notes will no longer be 

input on instruments that are hidden by the filter; similarly, multi-paste, explode, 

moving or duplicating notes to the staff above or below, and so on. 

MIDI input in the background. When Dorico is in the background, by default it continues 

to receive MIDI input from your connected MIDI devices. This is helpful if you are, 

for example, copying material from a PDF or transcribing audio played in another 

application, and need to temporarily have that other application in focus. 

However, if you are working with multiple applications that receive MIDI input, or if 

you like to noodle on your keyboard at other times, if you left note input active in 

Dorico before switching to another application, you may be surprised to find 

unwanted music has been input when you switch back to Dorico. 

To avoid this, a new Suspend when in background option has been added to the 

Play page in Preferences. Activate this if you want Dorico to receive MIDI input only 

when it is the active foreground application. 

Pitch before duration input. When using pitch before duration input, and the option 

Specify accidental, rhythm dot and articulations is set to After inputting note, it is 

now possible to add multiple notes at the same rhythmic position to build chords by 

moving the shadow note with Alt+↑/↓, then typing the duration key again. 
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현재 직원에게만 해당됩니댜 (다이내믹스 팝오버는 비슷하지만 약간 다룹니다. 

Alt를 잡으면 모든 음성에 적용되는 것이 아니라 현재 음성에서 캐럿이 지정한 대로 다이내믹 

이 생성됩니다) 

이를 더 명확하게 하기 위해, 이러한 팝오버는 이제 텍스트 필드의 오른쪽에 추가 버튼을 보여 

줍니다: Altit을 누르면 활성화됩니다 버튼을 클릭한 다음 일반적인 방법으로 팝오버를 확인 

할수도 있습니다(예: 반환을 누르거나 진행할수 있는 팝오버의 경우 Space.Tab 또는 - 를 

눌러서 확인). 

코드 기호와 가사 팝오버를 통해 스태프 위 또는 아래의 여러 줄에 항목을 입력할 수 있습니다. 

그 줄 번호는 이제 텍스트 필드의 오른쪽에 있는 스핀 컨트롤로 표시되어 있습니다. 읽기 전용이 

라 입력할 수는 없지만, 패들을 클릭하여 다음 줄이나 이전 줄로 이동할 수 있으며, 물론 이전과 같 

이 f/ i를 사용하여 줄을 변경할 수 있습니다. 

가사와 운지 팝오버는 텍스트 필드의 오른쪽에 추가 정보 라벨을 표시하거나 스핀 컨트롤을 표시 

할수도있습니다 가사의 경우, 이것은 당신이 악보위에 가사를입력하고있는지 아래에 가사를 

입력하고 있는지를 나타냅니다. 운지법은 당신이 악기에 글을 쓰고 있다면, 당신이 오른손으로 또 

는 왼손으로 운지법을 입력하고 있는지를 나타냅니다. 레이블을 클릭하여 이 상태들을 교환합니 

다. 

악기 필터 액티브 악기 필터로 갤리 뷰에서 작업할 때, 도리코는 이제 노트를 입력하고 편집할 때 필 

터에 가려진 악기를 무시합니다. 

예를 들어, Shift+ t/ !로 케럿율 확장하면 필터에 가려진 악기에 더 이상 음이 입력되지 않습니 

댜 마찬가지로, 다중 붙여넣기, 폭발, 위나 아래 직원에게 음을 옮기거나 복제하는 등의 작업 

이있습니다 

배경에서 MIDI 입력 도리코가 배경에 있을 때 기본적으로 연결된 MIDI 장치에서 계속 MIDI 입력을 

받습니다. 이것은 예를 들어 PDF에서 자료를 복사하거나 다른 응용 프로그램에서 재생되는 오디오를 

전사하는 경우에 도움이 됩니다. 

그러나 MIDI 입력을 받는 여러 응용 프로그램에서 작업하거나 다른 시간에 키보드를 누르는 것 

을 좋아하는 경우, 다른 응용 프로그램으로 전환하기 전에 도리코에 매모 입력을 활성화 상태로 

두었다면 도리코로 다시 전환할 때 원치 않는 음악이 입력되었다는 사실에 놀랄 수 있습니다. 

이를 방지하기 위해 배경 설정 시 새로운 일시 중지 옵션이 설정의 재생 페이지에 추가되었습니 

다 도리코가 활성 전경 애플리케이션일 때만 MIDI 입력을 받도록 하려면 이것을 활성화하세요. 

지속 시간 입력 전 음정 지속 시간 입력 전 음정을 사용할 때, 그리고 옵션 지정, 리듬 도트 및 아티큘 

레이션이 설정됩니다. 음을 입력한후, 이제 동일한 리듬 위치에서 여러 음을 추가하여 음을 만들 수 있 

습니다 Alt+ t /!로 움을 이동시킨 후, 지속 시간 키를 다시 입력하여 코드를 구축할 수 있습니다. 
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Numbered bar regions 
Options precedence. The behavior of the options and properties for numbered bar 

regions has been tweaked to make the relationship between the options on the Bar 

Repeats page of Engraving Options and the properties that override them clearer. 

The appearance for bar count numbers that appear due to the specified interval 

(Number every n bars), i.e. whether they should be parenthesized, now take 

precedence over the options for the appearance of the bar count at the end of the 

system and at the end of the region. If a bar would be numbered naturally due to its 

interval from the start of the region, the Appearance of bar count option always 

takes precedence; only if the bar would not naturally show a number will the 

options for the appearance of the bar count at the end of the system or the end of 

the region be applied. The Properties now always act as overrides, as expected. 

Percussion 
Percussion legends. A new option Show percussion legends on grids has been added to 

the Percussion section of the Players page of Layout Options. When activated, 

percussion legends will appear when created on percussion kits shown using the 

grid presentation type. This may be useful if, for example, you choose not to show 

staff labels at the start of each system. 

Percussion Maps dialog. The Library ▶ Percussion Maps dialog has been updated to 

make it a little easier to work with. 

It is now possible to use the standard shortcuts for copy and paste to duplicate the 

selected row in the Drum Kit Note Map section; you can also now hit Delete to clear 

the selected row. 

It is no longer necessary to click Apply in the Edit Drum Kit Note section when 

editing a selected row: the edits you make are now reflected as soon as you make 

them. 

Playback 
Navigating between flows. The commands that move between flows – for example, Edit ▶ 

Go To ▶ Go To Previous/Next Flow, or using the Go To mode in the jump bar – now 

also move the playhead to the start of the target flow. 

Tenuto articulations. In some musical idioms, the tenuto articulation is expected to 

produce an increase in dynamic in addition to, or perhaps instead of, an extension 

of the played duration of the note. A new option has been added to the Dynamics 

page of Playback Options to specify by how much a tenuto articulation should 

increase the dynamic level; by default, this is set to 0. This can also be overridden in 

an expression map using the corresponding setting in the Playback Options 

Overrides section of Library ▶ Expression Maps. 
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난립 

옵션 우선입니다 번호가 매겨진 막대 영역에 대한옵션 및 속성의 동작은옵션 조각기의 막대 반복페 

이지에 있는 옵션과 이룰 무시하는 속성 간의 관계를 더 명확하게 조정했습니다. 

지정된 간격(매 n 막대)으로 인해 나타나는 막대 수 수의 출현, 즉 괄호를 쳐야 하는지 여부는 이 

제 시스템의 끝과 영역의 끝에서 막대 수의 출현 옵션보다 우선합니다. 막대가 영역의 시작과 간 

격으로 인해 자연스럽게 번호가 매겨지는 경우 막대 수 옵션의 출현이 항상 우선합니다. 막대가 

자연스럽게 숫자를 표시하지 않는 경우에만 해당됩니다. 시스템의 끝이나 지역의 끝에 막대 카운 

트가 나타나는 옵션이 적용됩니다. 속성은 이제 예상대로 항상 무시되는 역할을 합니다. 

타악71 

재생 

타악기 전설. 플레이어즈 페이지의 타악기 섹션에 새로운 옵션 표시 그리드에 타악기 전설이 추가되었 

습니다 활성화되면 그리드 프레젠테이션 유형을 사용하여 표시되는 타악기 키트에 생성될 때 타악기 

전설이 나타납니다. 예를 들어, 각 시스템이 시작될 때 직원 라벨을 표시하지 않기로 선택한 경우 유용 

할수 있습니다. 

퍼커션 맵 대화자. 라이브러리 ► 퍼커션 맵 대화자는 작업하기 조금 더 쉽게 업데이트되었습니 

댜 

이제 복사 및 붙여 넣기를 위한 표준 단축키를 사용하여 드럼 키트 노트 지도 섹션에서 선택한 행 

을 복제할 수 있습니다. 이제 삭제 버튼을 눌러 선택한 행을 지울 수도 있습니다. 

선택한 행을 편집할 때 더 이상 편집 드럼 키트 노트 섹션에서 신청하기를 클릭할 필요가 없습 

니다 당신이 만든 편집은 이제 만들자마자 반영됩니다. 

흐름 간 탐색 . 플로우 사이롤 이동하는 명령(예: ► Go To ► Go To 이전/다음 흐름으로 이동하거나 

점프 바에서 Go To 모드를 사용하는 것)도 이제 플레이헤드를 대상 흐름의 시작 부분으로 이동합니 

댜 

테누토 아티큘레이션. 일부 음악 관용구에서는 테누토 아티큘레이션이 음의 재생 기간을 연장하는 것 

외에도 또는 그 대신에 동적인 증가를 일으킬 것으로 예상됩니다. 재생 옵션의 동적 페이지에 새로운 

옵션이 추가되어 테누토 아티큘레이션이 동적 수준을 얼마나 증가시켜야 하는지 지정합니다. 기본적 

으로 이것은 0으로 설정되어 있습니다. 이것은 재생의 해당 설정을 사용하여 표현 지도에서 무시될 수 

도 있습니다. 옵션은 라이브러리 ► 표현 지도 섹션을 무시합니다. 
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Humanize note end positions. Dorico has always made tiny random adjustments to the 

start positions of notes to simulate the natural irregularities of human performers, 

but the end positions of notes were always precisely metronomic. 

To address this, a new Humanize end positions of notes by n% option has been 

added to the Timing page of Playback Options. This is set to 30% in new projects, but 

0% in existing projects to avoid changing their playback unexpectedly. 

Starting playback. The Play ▶ Start or Stop Playback command in the Key Commands 

page of Preferences now includes the left and right locators. You can assign a 

custom shortcut to start playback from either locator if you wish. 

Play mode 
Hiding all VST plug-in windows. A new command Hide All VST Plug-in Windows has 

been added to the Play category in the Key Commands page in Preferences. You can 

assign a custom shortcut to this command or access it via the jump bar. As its name 

suggests, it will close all open VST plug-in windows that belong to the active project. 

Playing techniques 
Glyph playing techniques and tied notes. A new option Repeat signs on every notehead 

in tie chain has been added to the Continuation tab in Library ▶ Playing 

Techniques, enabled only when glyph playing techniques have Continuation type 

set to Repeat the signs. This setting can also be overridden for an individual playing 

technique via the Properties panel. 

Parenthesized playing techniques. A new Parenthesized property has been added. When 

activated, the selected playing technique will be enclosed in parentheses. 

To specify via the Shift+P popover that the playing technique you are creating 

should be parenthesized, simply enclose the popover text in parentheses: for 

example, type (pizz.) to create a parenthesized pizz. playing technique. 

In previous versions, using parentheses in the popover would result in the playing 

technique being hidden: to create a hidden playing technique in Dorico 6, enclose 

the popover text in square brackets: for example, [pizz.] will create a hidden pizz. 

playing technique. 

Assigning key commands. It is now possible to assign key commands to individual 

playing techniques, which you might find quicker than using the Shift+P popover 

for those playing techniques you create most often. 

On the Key Commands page of Preferences, navigate to Note Input ▶ Create 

Playing Technique, and all the playing techniques from the factory library and your 

own custom playing techniques saved to your user library are listed. 



도리코 6판역사 

음 끝 위치를 인간화합니다. 도리코는 항상 인간 연주자들의 자연스러운 불규칙성을 시뮬레이션하기 

위해 음의 시작 위치를 약간 무작위로 조정했지만, 음 끝 위치는 항상 정확하게 매트로노믹했습니다. 

이를 해결하기 위해 새로운 휴머나이즈 노트 위치를 n% 옵션이 재생 옵션의 타이밍 페이지에 추 

가되었습니다 이는 새로운 프로젝트에서는 30%로 설정되었지만 기존 프로젝트에서는 0%로 설 

정되어 있습니다 예기치 않게 재생이 변경되지 않도록 합니다. 

재생 시작. 설정 키 명령판의 재생 ► 시작또는 중지 명령에는 이제 왼쪽 및 오른쪽 위치 확인기가 

포함되어 있습니다. 원하는 경우 두 위치 확인기에서 재생을 시작할 수 있는 사용자 지정 단축키를 

지정할수있습니다 

플레이모드 

주법 

모든 VST 플러그인 창 숨기기. 모든 VST 플러그인 창숨기기라는 새로운 명령이 설정의 키 명령 페이 

지의 Play 카테고리에 추가되었습니다. 이 명령에 사용자 지정 단축키를 지정하거나 점프 바를 통해 

액세스할 수 있습니다 이름에서 알 수 있듯이 활성 프로젝트에 속하는 모든 열린 VST 플러그인 창을 

닫습니다. 

글리프 연주 기법과 타이 노트. 타이 체인의 모든 노트헤드에 있는 새로운 옵션 반복 표시가 라이브러 

리 ► 재생 기술의 계속 탭에 추가되었으며, 글리프 연주 기법에 계속 입력이 있는 경우에만 가능합니 

댜 이 설정은 속성 패널을 통해 개별 연주 기법에 대해서도 무시할 수 있습니다. 

괄호 안에 표시된 연주 기법입니다. 괄호 안에 새로운 속성이 추가되었습니다. 활성화되면 선택한 연 

주 기법이 괄호 안에 동봉됩니다. 

Shift+P 팝오버를 통해 만들고 있는 재생 기술이 괄호로 묶어야 함을 지정하려면, 팝오 

버 텍스트를 괄호 안에 묶기만 하면 됩니다. 예를 들어, 괄호로 묶인 pizz, 재생 기술입니 

댜 

이전 버전에서는 팝오버에서 괄호를 사용하면 연주 기법이 숨겨집니다: 도리코 6에서 숨겨진 

연주 기법을 만들기 위해 팝오버 텍스트롤 대괄호로 묶습니다: 예를 들어, [pizz .］는 숨겨진 

pizz를 만듭니다 

주법입니댜 

주요 명령 할당 이제 개별 플레이 기술에 주요 명령을 할당할 수 있게 되었습니다. 이는 가장 자주 

만드는 플레이 기술에 Shift+P 팝오버를 사용하는 것보다 더 빠를 수 있습니다. 

기본 설정의 주요 명령 페이지에서 노트 입력 ► 재생 기술을 만들기로 이동하면 공장 라이브러 

리의 모든 재생 기술과사용자 라이브러리에 저장된 사용자 맞춤형 재생 기술이 나열됩니다. 
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If you do not see a playing technique that you expect to be there, go to Library ▶ 

Playing Techniques and ensure that the playing technique in question is saved as a 

default. 

Playing techniques in slash regions. In previous versions, playing techniques are only 

shown in rhythmic slash regions when the Show other voices property is active. To 

provide greater flexibility, a new option has been added to the Rhythmic Slashes 

section of the Playing Techniques page of Engraving Options. 

 
You can now set Playing techniques in rhythmic slash regions such that playing 

techniques in slash regions will Never show, Always show, or Show when other 

voices shown. 

This choice can be overridden for an individual slash region by activating the new 

Show playing techniques property in the Slash Regions group in the Properties 

panel. 

Project files 
Default file name. When you first save a newly created project, the default suggested file 

name is now based on the project title as specified in File ▶ Project Info. 

Properties 
Keyboard access to Properties filter. In Dorico 3.5, it was possible to set the keyboard 

focus in the Search field in the Properties toolbar by typing Alt+8. When the lower 

zone was expanded in Dorico 4, this functionality was removed, but it has finally 

been restored. Type Alt+8 to move the focus to the Search field, and type to filter the 

Properties panel. 

One useful tip is that you can type any part of a properties group name (for example, 

Fingering, Harmonics, Beaming, etc.) to show only that group. 

Improved property groups for selected notes and chords. If you use Edit ▶ Filter ▶ Notes 

and Chords, your selection may include notes, grace notes, rests, and tuplets in any 

combination. With one or more tuplets selected, the set of properties available in 

the panel was previously limited to only the Common group. Now, the properties 

common to notes, grace notes, and rests will additionally appear, allowing you to 

edit the playback offset and velocity properties, and to set some beaming 

properties. 



도리코 6판역사 

거기에 있을 것으로 예상되는 연주 기법이 보이지 않으면 라이브러리 ► 플레이 기법으로 이동하 

여 문제의 연주 기법이 기본값으로 저장되어 있는지 확인하십시오. 

슬래시 영역에서의 재생 기술. 이전 버전에서는 다른 음성 속성을 보여주는 것이 활성화되어 있을 때 

만 재생 기술이 리듬 슬래시 영역에 표시됩니다. 더 큰 유연성율 제공하기 위해 새로운 옵션이 각인 옵 

션의 재생 기술 페이지의 리듬 슬래시 섹션에 추가되었습니다. 

幸
밍01리 

22f· ? 葬

이제 리듬이 있는 슬래시 지역의 연주 기법을 설정할수 있습니다. 그러면 슬래시 지역의 연주 

기법은 다른 목소리가 표시될 때 절대 항상 표시되지 않거나, 표시되지 않을 것입니다. 

이 선택은 속성 패널의 슬래시 영역 그룹에서 새로운 쇼 재생 기술 속성을 활성화하여 개별 슬 

래시 영역에 대해무시할수있습니다. 

프로젝트파일 

기본 파일 이름입니다 처음에 새로 생성된 프로젝트를 저장할 때, 기본 제안 파일 이름은 이제 파일 

► 프로젝트 정보에 명시된 프로젝트 제목을 기반으로 합니다. 

부등산 

프로퍼티즈 필터에 대한 키보드 액세스. 도리코 3.5에서는 Alt+8을 입력하여 프로퍼티즈 툴바의 검 

색 필드에 키보드 초점을 설정할 수 있었습니다. 도리코 4에서 하단 영역이 확장되었을 때 이 기능이 

제거되었지만 마침내 복원되었습니다. Alt+8을 입력하여 검색 필드로 초점을 이동하고, 입력하여 프 

로퍼티즈 패널을 필터링합니다. 

한 가지 유용한 팁은 속성 그룹 이름의 일부를 입력하여 해당 그룹만 표시할 수 있다는 것입니다. 

선택된 음표와코드에 대한속성 그룹 개선. 편집 ► 필터를사용하여 음표와코드► 사용하는 경우 

선택에는 음표, 그레이스 음표, 휴식 및 튜플렛이 포함될 수 있습니다. 하나 이상의 튜플렛이 선택되면 

패널에서 사용할 수 있는 속성 세트는 이전에는 공통 그룹으로만 제한되었습니다. 이제 음표, 그레이 

스 음표 및 휴식에 공통적인 속성이 추가로 나타나 재생 오프셋 및 속도 속성을 편집하고 설정할 수 있 

습니다 몇 가지 빛나는 특성들입니다. 
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Showing all properties for selected items. By default, the Properties panel shows only the 

properties that are common to all the selected items: this typically means only the 

Common group, and for other specific combinations of items, a handful of other 

properties may appear. This helps to keep the number of Properties you see at any 

given moment manageable – but it has the disadvantage that you must reselect 

different types of items to access their properties. 

Dorico 6 makes it possible to see all properties for the selected items, regardless of 

the number of different types of items in the selection. To enable this, set When 

selecting multiple items of different types to Show all properties on the Note 

Input and Editing page of Preferences. 

For selections with many types of items, this will make a very large number of 

Properties available in the panel, so you would be well advised to use the filter field 

in the Properties panel toolbar to find the specific properties you are looking for. 

Setup mode 
Creating default part layouts. Setup ▶ Create Default Part Layouts now creates a part 

layout for any player that does not have its own individual part layout; previously, 

any player that was present in at least one part layout, even in combination with 

another player, would not have an individual part layout created. 

Staff labels 
Staff labels and page margins. By default, the total width of the system including its staff 

labels can never exceed the width of the music frame: Dorico calculates the 

maximum width required for the widest staff label on the system, and subtracts 

that from the frame width to determine the width of the system. 

This has the advantage of ensuring that staff labels are never printed closer to the 

edge of the page than the left-hand edge of the music frame, but it also has the 

consequence that the width of each system can vary – for example, when empty 

staves are hidden, or when the condensing differs from one system to the next, 

resulting in a different maximum width for staff labels. 

Some publishers prefer the width of each system to be precisely the same, even if 

the staff labels differ. To achieve this, a new option has been added to the Staves 

and Systems page of Layout Options: set Position staff labels to Outside music 

frame. 

In addition to changing this option, you need to edit the page templates you are 

using, since by default the music frames in factory page templates fill the whole 

width of the page between the defined left and right page margins. For this new 

approach to work acceptably, you need to decide for yourself how much room to 

allow for staff labels and adjust the width of the music frame on each page template 



도리코 6판역사 

선택한 항목에 대한 모든 속성 표시. 기본적으로 속성 패널은 선택한 모든 항목에 공통적인 속성만 표 

시합니다 이것은 일반적으로 공통 그룹만을 의미하며, 다른 특정 항목 조합의 경우 몇 가지 다른 속성 

이 나타날 수 있습니다. 이것은 주어진 순간에 볼 수 있는 속성 수를 관리 가능하게 유지하는 데 도움 

이 되지만 속성에 액세스하려면 다른 유형의 항목을 다시 선택해야 한다는 단점이 있습니다. 

도리코 6을 사용하면 선택 항목의 종류에 관계없이 선택된 항목에 대한 모든 속성을 볼 수 있 

습니댜 이를 가능하게 하려면 여러 유형의 항목을 선택할 때 설정 설정 설정하십시오. 모든 속 

성을 참조의 노트 입력 및 편집 페이지에 표시합니다. 

다양한 유형의 항목이 있는 선택의 경우, 이를 통해 패널에서 매우 많은 수의 속성을 사용할 수 

있으므로 속성 패널 도구 모음의 필터 필드를 사용하여 찾고자 하는 특정 속성을 찾는 것이 좋 

습니댜 

설정모드 

라벨 

기본 부품 레이아웃 생성. 설정 ► 기본 부품 레이아웃 생성은 이제 자체 개별 부품 레이아웃이 없 

는 모든 플레이어에 대한 부품 레이아웃을 만듭니다. 이전에는 적어도 하나의 부품 레이아웃에 존재 

했던 플레이어가 다른 플레이어와 결합하더라도 개별 부품 레이아웃이 생성되지 않았습니다. 

스태프 레이블과 페이지 여백. 기본적으로 스태프 레이블을 포함한 시스템의 총 너비는 음악 프레임 

의 너비를 초과할 수 없습니다. 도리코는 시스템에서 가장 넓은 스태프 레이블에 필요한 최대 너비를 

계산하고 프레임 너비에서 이를 빼서 시스템의 너비를 결정합니다. 

이것은 스태프 라벨이 음악 프레임의 왼쪽 가장자리보다 페이지의 가장자리에 더 가깝게 인쇄 

되지 않도록 하는 장점이 있지만, 예를 들어 빈 스테이브가 숨겨져 있거나 응축이 시스템마다 

다를 때 각 시스템의 너비가 다를 수 있다는 결과도 있습니다. 

일부 게시자는 직원 라벨이 다르더라도 각 시스템의 너비가 정확히 동일한 것을 선호합니다. 

이를 달성하기 위해 레이아웃 옵션의 스테이브 및 시스템 페이지에 새로운 옵션이 추가되었습 

니다: 위치 스태프 레이블을 외부 음악 프레임으로 설정합니다. 

이 옵션을 변경하는 것 외에도 사용 중인 페이지 템플릿을 편집해야 합니다. 기본적으로 공장 페 

이지 템플릿의 음악프레임이 정의된 왼쪽과오른쪽페이지 여백사이의 페이지 전체 너비를채우 

기 때문입니다 이 새로운 접근 방식이 수용 가능하게 작동하려면 직원 레이블을 허용할 공간을 

스스로 결정하고 각 페이지 템플릿의 음악 프레임 너비를 조정해야 합니다. 
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accordingly. You might, for example, want to make the music frame narrower on 

the First page template to allow for full staff labels on the first page of each flow, and 

then slightly wider on the Default page template to allow for short staff labels on 

subsequent pages. 

Editing staff labels. It is now possible to select staff labels and hit Return (or double-click 

the staff label) to open the Edit Instrument Name dialog to edit the name of the 

instrument that contributes to that staff label. 

If the staff label is using the player name, rather than the name of an instrument 

held by the player, double-clicking the staff label will instead open the Edit Player 

Name dialog. 

For condensed staves that show separate inner labels for each instrument 

appearing on the staff, double-clicking the inner label (typically the instrument 

number) will edit the name for that instrument. For divisi staves, double-clicking a 

label will edit the name for the instrument, not the individual divisi section label: to 

edit the prevailing divisi group labels, find the previous divisi signpost and double-

click that, or select it and hit Return. 

Editing player group labels. It is also now possible to select player group labels and hit 

Return (or double-click the player group label) to open the Rename Player Group 

dialog. 

Players with custom staff size. Sometimes one or more of the instruments in a layout will 

use a smaller staff size than the default for the layout – for example, showing a solo 

instrument in a layout for a piano accompanist – which is achieved by choosing a 

staff size scale factor from the Edit ▶ Notation ▶ Staff Size submenu. 

In previous versions of Dorico, the staff labels for any staff using a custom scale 

factor were always drawn at the same size as those on staves using the default staff 

size. To instead scale the staff label for an instrument by the same scale factor used 

for the staff, set Staff labels on staves with custom staff size to Scale with staff 

size in the new Scale section of the Staff Labels page of Engraving Options. 

Showing player group labels when staff labels are not shown. In previous versions of 

Dorico, player group labels are only shown when staff labels are shown for a system. 

Sometimes it may be preferable for player group labels to be shown even when 

there are no staff labels. To enable this behavior, on the Staves and Systems page of 

Layout Options set Show player group labels to Always; by default, this option is set 

to When staff labels shown. 

A new Gap between player group labels and systemic barline option has been 

added to the Staff Labels page of Engraving Options, used when a player group label 

is shown but no staff labels are visible. 



도리코 6판역사 

따라서요. 예를 들어, 첫 페이지 템플릿에서는 음악 프레임을 좁게 만들어 각 흐름의 첫 페이지에 

전체 스태프 라벨을 허용하고, 그 다음 페이지에서는 짧은 스태프 라벨을 허용하기 위해 기본 페 

이지 템플릿에서는 약간 더 넓게 만들 수 있습니다. 

직원 라벨 편집 이제 직원 라벨을 선택하고 반환(또는 직원 라벨을 두 번 클릭)을 눌러 해당 직원 라벨 

에 기여하는 악기의 이름을 편집할수 있습니다. 

스태프 레이블이 플레이어가 가지고 있는 악기의 이름이 아닌 플레이어 이름을 사용하고 있는 

경우 스태프 레이블을 두 번 클릭하면 플레이어 이름 편집 대화가 열립니다. 

악보에 나타나는 각 악기에 대해 별도의 내부 라벨을 표시하는 응축된 오선지의 경우, 내부 라벨 

(일반적으로 악기 번호)을 두 번 클릭하면 해당 악기의 이름이 편집됩니다. 분할 스테이브의 경 

우 레이블을 두 번 클릭하면 개별 분할 섹션 레이블이 아닌 악기의 이름이 편집됩니다. 기존 분할 

그룹 레이블을 편집하려면 이전 분할 표지판을 찾아 두 번 클릭하거나 선택하고 반환을 누릅니다. 

플레이어 그룹 레이블 편집. 이제 플레이어 그룹 레이블을 선택하고 리턴(또는 플레이어 그룹 레이 

블을 두 번 클릭)을 눌러 플레이어 그룹 대화 이름을 여는 것도 가능합니다. 

맞춤형 스태프 크기를 가진 연주자들. 때때로 레이아웃의 하나 이상의 악기는 레이아웃의 기본값보다 

작은 스태프 크기를 사용합니 다. 예를 들어 피아노 반주자를 위한 레이아웃에서 솔로 악기를 보여주는 

것과 같은 스태프 크기 하위 메뉴 편집 ► 표기법에서 스태프 크기 척도 계수를 선택하여 달성됩니다. 

이전 버전의 도리코에서는 맞춤형 눈금 계수률 사용하는 모든 스태프의 스태프 라벨이 기본 스태 

프크기를사용하여 스테이브에 있는 것과항상동일한크기로그려졌습니다. 대신 악기에 대한 

스태프 라벨을 스태프에게 사용되는 것과 동일한 스케일 계수로 조정하려면, 각인 옵션의 스태프 

라벨 페이지의 새 스케일 섹션에서 맞춤형 스태프 크기가 있는 스테이브에 스태프 라벨을 스태프 

크기가 있는 스케일로 설정합니다. 

스태프 라벨이 표시되지 않을 때 플레이어 그룹 라벨을 보여줍니다. 이전 버전의 도리코에서는 시스템 

에 대해 스태프 라벨이 표시될 때만 플레이어 그룹 라벨이 표시됩니다. 

때로는 스태프 라벨이 없을 때에도 선수 그룹 라벨이 표시되는 것이 바람직할 수 있습니다. 이 동 

작을 활성화하려면 레이아웃 옵션의 스테이브 및 시스템 페이지에서 "Show'' 플레이어 그룹 레이 

블을 항상으로 설정합니다. 기본적으로 이 옵션은 "Step 레이블이 표시될 때'＇로 설정됩니다. 

플레이어 그룹 레이블이 표시되지만 스태프 레이블이 보이지 않을 때 사용되는 인그레이빙 옵션 

의 스태프 레이블 페이지에 플레이어 그룹 레이블과 시스템 기준선 옵션 사이의 새로운 간격이 추 

가되었습니다. 
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Player group labels at breaks. It is now possible to choose whether player group labels 

appear for a particular system by creating a system or frame break, then overriding 

the new Show player group labels property on the break. 

Using the property, you can either prevent the player group label from appearing 

on one system when it would otherwise be shown on all systems, or that it should 

appear on a system when it would otherwise not be shown on any system. 

Staff spacing 
Calculating staff gaps relative to default space size. By default, Dorico calculates the gap 

between a pair of staves relative to the scale factor of the upper of the two staves. 

When a player’s staff size is scaled to a value other than 100% – for example, when a 

cue staff showing a solo instrument in a layout for solo instrument and piano is 

shown at 60% the size of the piano staves – the gap between that staff and the staff 

below is scaled proportionately. 

If you would prefer the gaps between staves to be calculated according to the 

default space size, ignoring custom staff scaling, set the new Gap values are 

relative to option on the Vertical Spacing page of Layout Options to Default staff 

size. 

Tempo 
Paragraph styles. Tempo markings are now drawn using paragraph styles, rather than 

font styles. Paragraph styles allow you to define a different size for full score and 

part layouts, which is important if the full score uses a smaller staff size than the 

parts and you want the tempo to be proportionally larger relative to the staff size in 

the score than in the parts. 

Immediate, relative and reset tempos are now drawn using the Tempo (immediate) 

paragraph style, gradual tempos are drawn using the Tempo (gradual) style, and 

metronome marks are drawn using the Tempo (metronome mark) style. 

A new Metronome Mark Music Text character style has been added, used for the 

notes and rhythm dots in metronome marks. This allows independent control of the 

appearance of metronome marks, without affecting music symbols drawn using 

the existing Music Text character style. 

When you first open an existing project, Dorico will set up the new paragraph and 

character styles to match as closely as possible the corresponding legacy font styles 

that were used in previous versions. 

When you save your project, Dorico will also update the legacy font styles to match 

the current paragraph style settings, so that, as far as possible, tempo marks will 

look the same when your project is opened in previous versions of the software. If 

you specify a different size in parts for any of the new paragraph styles, that will not 



간격 

템포 

도리코 6판역사 

휴식 시간에 플레이어 그룹 레이블입니다. 이제 시스템이나 프레임 휴식을 만든 다음 휴식 시간에 새 

로운 쇼 플레이어 그룹 레이블 속성을 무시하여 특정 시스템에 대해 플레이어 그룹 레이블이 나타나는 

지 여부를 선택할 수 있습니다 

이 속성을 사용하면 플레이어 그룹 레이블이 모든 시스템에 표시되지 않도록 하거나, 그렇지 

않으면 어떤 시스템에도 표시되지 않을 시스템에 표시되어야 합니다. 

기본 공간 크기에 대한 스태프 간격 계산. 기본적으로 도리코는 두 오선지 중 위쪽의 눈금 계수에 대 

한 한쌍의 오선지 사이의 간격을 계산합니다. 

연주자의 스태프 크기가 100%가 아닌 값으로 조정되면, 예를 들어 솔로 악기와 피아노를 위한 레 

이아웃에서 솔로 악기를 보여주는 큐 스태프가 피아노 오선보 크기의 60%로 표시되면, 그 스태프 

와 아래 스태프 사이의 간격은 비례적으로 조정됩니다. 

사용자 지정 스태프 스케일링을 무시하고 기본 공간 크기에 따라 스테이브 사이의 간격을 계산 

하는 것을 선호하는 경우, 새 Gap 값을 기본 스태프 크기에 대한 레이아웃 옵션의 세로 간격 페 

이지의 옵션과 관련이 있도록 설정합니다. 

문단 스타일. 템포 표시는 이제 글꼴 스타일이 아닌 문단 스타일을 사용하여 그려집니다. 문단 스타일 

을 사용하면 전체 악보와 부분 레이아웃에 대해 다른 크기를 정의할 수 있습니다. 이는 전체 악보가 부 

분보다작은스태프크기를사용하고 템포가부분보다악보의 스태프크기에 비례하여 더 크게 되기를 

원하는 경우에 중요합니다. 

현재는 템포(즉각) 단락 스타일을 사용하여, 점진적 템포는 템포(점진) 스타일을 사용하여, 매트 

로놈 표시는 템포(메트로놈 표시) 스타일을 사용하여 그려집니다. 

새로운 메트로놈 마크 음악 텍스트 문자 스타일이 추가되어 메트로놈 마크의 음과 리듬 도트에 사 

용됩니다 이를 통해 기존의 뮤직 텍스트 문자 스타일을 사용하여 그려진 음악 기호에 영향을 미 

치지 않으면서 메트로놈 표시의 모양을 독립적으로 제어할 수 있습니다. 

기존 프로젝트를 처음 열 때, 도리코는 이전 버전에서 사용되었던 해당 레거시 폰트 스타일과 최 

대한 일치하도록 새로운 단락과 문자 스타일을 설정합니다. 

프로젝트를 저장하면 도리코는 현재 단락 스타일 설정과 일치하도록 레거시 폰트 스타일을 업데 

이트하여 이전 버전의 소프트웨어에서 프로젝트가열릴 때 템포표시가동일하게 보이도록합니 

댜 새로운 단락 스타일에 대해 다른 크기를 부품 단위로 지정하면 그렇지 않습니다. 
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be preserved when the project is opened in a previous version, as font styles do not 

allow different sizes in score and part layouts. 

Due to small differences in how text drawn using font styles and paragraph styles is 

measured, you may find that tempo marks in existing projects appear slightly 

further away from the staff than in previous versions; however, we have done our 

best to minimize these differences as far as possible. 

Relative tempo changes and a tempo. Some published scores show relative tempo 

changes (e.g. meno mosso) and a tempo instructions using the same appearance as 

gradual tempo changes (e.g. accel.). 

To enable this, set Paragraph style for relative changes and ‘a tempo’ markings to 

Tempo (gradual) in the new Relative Changes section of the Tempo page of 

Engraving Options. 

Circa in metronome marks. A new Circa text style option has been added to the Absolute 

Changes section of the Tempo page of Engraving Options, allowing you to choose 

whether they should be shown in roman or italic type. 

Popover syntax changes. To create a hidden tempo via the Shift+T popover, you should 

now enclose the input string in square brackets, e.g. [Andante]. This change allows 

Dorico to preserve the parentheses on metronome marks when editing existing 

tempos. 

Text 
Default placement and position. It is now possible to specify in each paragraph style the 

default placement above or below the staff, the default vertical distance from the 

staff, and a default horizontal offset relative to the rhythmic position at which a text 

item using that paragraph style appears. It is also possible to specify whether text in 

that paragraph style should avoid collisions by default. 

Because of these changes, the Default distance from staff option on the Text page 

of Engraving Options has been removed, since each paragraph style now specifies 

its own value. When opening an existing project in Dorico 6, all paragraph styles are 

updated to use the value of this engraving option by default, to preserve their 

appearance. 

In a similar vein, the Placement property, which was previously always set for every 

text item, can now be deactivated, allowing a text item’s placement to be 

determined by the default value in the paragraph style itself. When opening an 

existing project in Dorico 6, all text items have the existing placement set as a global 

property, again to preserve their appearance. 

Default case. A new Case option has been added to Library ▶ Paragraph Styles, allowing 

you to specify whether text in that paragraph style should automatically have its 



글꼴 스타일은 점수와 부분 레이아웃에서 다른 크기를 허용하지 않기 떄문에 이전 버전에서 프 

로젝트를 열 때 보존됩니다. 

폰트 스타일과 단락 스타일을 사용하여 그린 텍스트를 측정하는 방식의 작은 차이로 인해 기존 프 

로젝트의 템포 표시가 이전 버전보다 직원에게서 약간 더 멀리 떨어져 보이는 경우가 있습니다. 

그러나 우리는 이러한 차이를 최대한 최소화하기 위해 최선을 다했습니다. 

상대적인 템포 변화와 템포. 일부 발표된 악보는 상대적인 템포 변화를 보여줍니다(예:메노 모소)와 

템포 지시를 점진적인 템포 변화와 동일한 모양을 사용합니 다(예 : accel.). 

이를 가능하게 하기 위해 상대적인 변화와 템포' 표시에 대한 단락 스타일을 설정합니다. 

옵션 조각 템포 페이지의 새로운 상대 변경 섹션에 템포(점진)가 있습니다. 

매트로놈표시의 C. 앱솔루트에 새로운 C. 텍스트 스타일 옵션이 추가되었습니다. 

옵션 조각기의 템포 페이지 섹션을 변경하여 로마자 또는 이탤릭체로 표시할지 선택할 수 있습 

니다. 

Popover 구문 변경 Shift+T popover를 통해 숨겨진 템포를 만들려면 입력 문자열을 대괄호로 묶어 

야 합니다 예를 들어 [Andante]. 이 변경을 통해 도리코는 기존 템포률 편집할 때 매트로놈 표시의 괄 

호롤보존할수있습니다. 

글
 

기본 배치 및 위치. 이제 각 단락 스타일에서 스태프 위 또는 아래의 기본 배치, 스태프로부터의 기본 

수직 거리 및 해당 단락 스타일을 사용하는 텍스트 항목이 나타나는 리듬 위치에 대한 기본 수평 오프 

셋을 지정할 수 있습니다. 또한 해당 단락 스타일의 텍스트가 기본적으로 층둘을 피해야 하는지 여부 

를 지정할수도 있습니다. 

이러한 변경으로 인해 각 단락 스타일이 고유한 값을 지정하기 때문에 각 옵션의 텍스트 페이지에 

서 직원 옵션과의 기본 거리가 제거되었습니다. 도리코 6에서 기존 프로젝트롤 열 때 모든 문단 

스타일은 기본적으로 이 새기기 옵션의 가치를 사용하여 외관을 유지하도록 업데이트됩니다. 

비슷한 맥락에서, 이전에는 모든 텍스트 항목에 대해 항상 설정되어 있던 배치 속성이 이제 비활 

성화되어 텍스트 항목의 배치가 단락 스타일의 기본값에 의해 결정될 수 있습니다. 도리코 6에서 

기존 프로젝트를 열 때, 모든 텍스트 항목은 기존 배치를 글로벌 속성으로 설정하여 다시 외관을 

유지합니다 

기본사례. 라이브러리 ► 문단스타일에 새로운사례 옵션이 추가되어 해당문단스타일의 텍스트에 

자동으로 자가 있어야 하는지 여부를 지정할 수 있습니다. 
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case transformed, e.g. to all upper case, all lower case, sentence case (where the 

first letter of the first word is capitalized), or title case (where the first letter of every 

word is capitalized). 

Note that if you want to use small capitals, this can be specified for fonts that 

support this typographical feature by activating the Small Capitals font feature 

instead of using the Case drop-down. 

Dorico’s implementation of title case capitalizes the first letter of each word based 

on locale and Unicode word boundaries, but it does not follow style-guide rules for 

title casing, so it will capitalize small words like “the” or “of” regardless of context. It 

provides linguistic casing, but does not support stylistic conventions like those in 

APA or Chicago Manual of Style. 

It is also possible to specify a case transformation in a character style if needed. 

Extended font family support on Windows. In previous versions of Dorico, font families 

with multiple weights were handled quite differently between macOS and 

Windows. A family like Minion Pro with multiple weights, such as Bold, Semibold, 

Condensed, Bold Condensed, and so on, would appear as a single family Minion Pro 

on macOS, with each of the weights listed as separate styles. On Windows, however, 

styles were limited to four standard values: Regular, Italic, Bold, and Bold Italic, so 

font families with multiple weights would instead be listed as multiple families: 

Minion Pro, Minion Pro Semibold, Minion Pro Condensed, and so on. In Dorico 6, 

this limitation has been removed, and font families appear in the same way on 

Windows as they always have done on macOS. 

One consequence of this is that when you open existing projects for the first time in 

Dorico 6, any extended weights in use in your project will be reported as missing in 

the Missing Fonts dialog that appears during project opening. This dialog has been 

enhanced such that each choice you make in the dialog will be remembered and 

automatically populated when opening future projects, so you need make the 

mapping from the old font name to the new once. 

Editing text frames. When you double-click a text frame to edit its contents, if that frame 

uses a token to show information from the File ▶ Project Info dialog – such as the 

project or flow title, composer, lyricist, or copyright – Dorico now asks whether you 

want to edit the contents of the text frame directly, or rather go to the Project Info 

dialog to edit the field used by the token. 

If possible, you should avoid editing the contents of text frames directly in the 

layout, because this will always create a page template override. In general, it is 

better either to edit the field in Project Info to change the text that appears in the 

frame, or to edit the page template itself in Engrave mode (in Dorico Pro only). 
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예를 들어, 모든 대문자, 모든 소문자, 문장 대문자(첫 단어의 첫 글자가 대문자로 표시됨) 또는 제 

목 대문자(모든 단어의 첫 글자가 대문자로 표시됨)로 변환된 경우입니다. 

작은 대문자를 사용하려 면 Case drop-down을 사용하는 대신 작은 대문자 글꼴 기능을 활 

성화하여 이 타이포그래피 기능을지원하는글꼴에 대해 지정할수 있습니다. 

Dorico의 제목 대문자 구현은 locale 및 Unicode 단어 경계를 기반으로 각 단어의 첫 글자를 대 

문자로 사용하지만 제목 케이스에 대한 스타일 가이드 규칙을 따르지 않으므로 문맥에 관계없이 

"the’' 또는 "of"와 같은 작은 단어를 대문자로 사용합니다. 언어적 케이스를 제공하지만 APA 또 

는 시카고 스타일 매뉴얼과 같은 스타일 관습을 지원하지는 않습니다. 

필요한 경우 캐릭터 스타일로 케이스 변환을 지정하는 것도 가능합니다. 

Windows에서 확장된 폰트 패밀리 지원. 이전 버전의 도리코에서는 여러 가중치를 가진 폰트 패밀리 

가 macOS와 Windows 간에 상당히 다르게 처리되었습니다 Bold, Semibold, Condensed, Bold 

Condensed 등과 같은 여러 가중치를 가진 Minion Pro와 같은 패밀리는 단일 패밀리 Minion 

Proon macOS로 나타나며, 각 가중치는 별도의 스타일로 나열됩 니 다 그러 나 Windows에서는 스타 

일이 일반, 이탈리아어, Bold 및 Bold의 4가지 표준 값으로 제한되었습니다. 이탤릭체, 따라서 여러 가 

중치를 가진 폰트 계열은 대신 여러 계열로 나열됩니다. 

미니언 프로, 미니언 프로 세미볼드, 미니언 프로 컨덴스 등입니다. 도리코 6에서는 이러한 제 

한이 제거되었으며, 폰트 패밀리가 MacOS에서 항상 해왔던 것과 동일하게 Windows에서도 

나타납니다. 

이로 인해 기존 프로젝트롤 처음으로 도리코 6에서 열 때, 프로젝트에 사용 증인 확장 가중치가 

프로젝트 열 때 나타나는 Missing Font 대화에서 누락된 것으로 보고됩니다 이 대화는 대화에 

서 선택한 각 항목이 기억되고 향후 프로젝트롤 열 때 자동으로 채워지도록 향상되었으므로 이전 

폰트 이름에서 새 폰트 이름으로 매핑해야 합니다. 

텍스트 프레임 편집. 텍스트 프레임을 두 번 클릭하여 내용을 편집할 때, 해당 프레임이 프로젝트 또 

는 흐름 제목, 작곡가, 작사가 또는 저작권과 같은 파일 ► 프로젝트 인포 대화의 정보를 보여주기 위 

해 토큰을 사용하는 경우, 도리코는 이제 텍스트 프레임의 내용을 직접 편집할 것인지, 아니면 토큰이 

사용하는 필드를 편집하기 위해 프로젝트 인포디로그로 이동할 것인지 묻습니다. 

가능한 경우 레이아웃에서 텍스트 프레임의 내용을 직접 편집하는 것은 피해야 합니다. 그렇 

게 하면 항상 페이지 템플릿이 무시되기 때문입니다. 일반적으로, 프레임에 나타나는 텍스트 

률 변경하기 위해 프로젝트 인포에서 필드률 편집하거나, 페이지 템플릿 자체를 인그레이브 모 

드(도리코 프로에서만)로 편집하는 것이 좋습니다 

94 스타인버그 미디어 테크놀로지스 GmbH 

94/106 



 

 

Dorico 6 Version History 95 Steinberg Media Technologies GmbH 

If a text frame uses a token that shows information from Project Info, but that field 

is empty, Dorico now shows the name of the field as a placeholder in the frame in 

light gray. This placeholder is not printed or included when you export graphics, but 

it is helpful to show where text frames are, and what fields they are using. 

A new View ▶ Token Placeholders command has been added, allowing you to 

choose whether these placeholders appear. 

Letter spacing for accidentals in text tokens. Side bearings are the left and right margins 

for a glyph in a font, and determine how tight the spacing is between neighboring 

characters. The side bearings for the accidental symbols in Bravura Text and other 

SMuFL-compliant fonts are, per the specification, as small as possible. This means 

that, for example, an accidental following a note name, as they appear in staff labels, 

layout names, and harp pedal changes, can look too tight by default. 

To address this, a new Letter spacing before accidental option has been added to 

the Text page of Engraving Options. To preserve appearance, it is set to 0pt in 

existing projects, but in new projects it is set to 0.75pt. This value is only applied in 

the places where Dorico adds the accidental itself, typically in tokens. 

Instrument list tokens. {@instrumentNames@} and {@instrumentList@} tokens have 

been added, allowing you to create a comma- or newline-separated list of the 

instruments in the layout. This is most useful in part layouts, allowing you to create 

an automatic list of the instruments held by the player for that part. Percussion kits 

are handled specially: standard drum kits are always listed using the name of the 

overall kit instrument, while non-drum set kits will list the instruments in the kit, 

unless the player is also holding other instruments, in which case only the name of 

the kit will be listed. 

Filter by paragraph style. A new Edit ▶ Filter ▶ Text Using Paragraph Style dialog has 

been added, allowing you to quickly select or deselect all text items use a specific 

paragraph style. This is helpful if you then want to, for example, use Change 

Paragraph Style, or the following new feature. 

Converting staff-attached to system-attached text. To convert staff-attached text created 

via Shift+X to system-attached text created via Shift+Alt+X, select one or more text 

items, and either choose Text ▶ Change Text to System Text from the context 

menu, or use the jump bar to execute Change Text to System Text. 

Choosing a new font style for a paragraph style. If you have specified that a paragraph 

style uses a font family with a particular set of styles, and then change the family, 

Dorico tries to maintain the same style name for the newly chosen family, but if an 

identically named style isn’t available, it now tries to find a fallback style that is as 

close as possible to the original style. 
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텍스트 프레임이 프로젝트 인포의 정보를 보여주는 토큰을 사용하지만 그 필드가 비어 있다면, 도 

리코는 이제 프레임에서 필드의 이름을 플레이스홀더로 표시합니다. 이 플레이스홀더는 그래픽 

을 내보낼 때 인쇄되거나 포함되지 않지만 텍스트 프레임이 어디에 있는지, 어떤 필드를 사용하 

고 있는지 보여주는 데 도움이 됩니다. 

토큰플레이스홀더 보기 명령 ► 가새롭게 추가되어 이러한플레이스홀더가 나타나는지 

여부를 선택할 수 있습니다. 

텍스트 토큰의 우발적인 문자 간격. 사이드 베어링은 글꼴의 왼쪽과 오른쪽 여백이며, 이웃 문자사이 

의 간격이 얼마나 좁은지를 결정합니다. Bravura Text 및 기타 SMuFL 준수 글꼴의 우발적인 기호에 

대한사이드 베어링은 사양에 따라 가능한한 작습니다. 이것은 예를 들어, 직원 라벨, 레이아웃 이름 

및 하프 페달 변경에 나타나는 것처럼 노트 이름을 따르는 우발적인 것도 보일 수 있음을 의미합니다. 

기본적으로 꽉 끼어 있습니다. 

이를 해결하기 위해 옵션 조각 텍스트 페이지에 우발적 옵션 이전의 새로운 글자 간격이 추가 

되었습니다 외관을 보존하기 위해 기존 프로젝트에서는 Opt로 설정되어 있지만, 새로운 프로 

젝트에서는 0.75pt로 설정되어 있습니다. 이 값은 도리코가 우연 자체를 더하는 곳, 일반적으 

로 토큰에서만 적용됩니다. 

악기 목록 토큰입니다{@instrumentNames@} 및 {@instrumentlist@} 토큰이 추가되어 레이아 

웃에서 쉽표 또는 새로운 줄로 구분된 악기 목록을 만들 수 있습니다. 이것은 부분 레이아웃에서 가장 

유용하므로 해당 부분에 대해 플레이어가 보유한 악기 목록을 자동으로 만들 수 있습니다. 타악기 키트 

는 특별히 취급됩니다. 표준 드럼 키트는 항상 전체 키트 악기의 이름을 사용하여 나열되는 반면, 드럼 

이 아닌 세트 키트는 나열됩니다. 플레이어가 다른 악기를 들고 있지 않는 한 키트에 있는 악기는 키트 

의 이름만 나열됩니다. 

문단 스타일별 필터 . 문단 스타일을 사용하는 ► 텍스트를 사용하는 새로운 편집 ► 필터가 추가되 

어 특정 문단 스타일을 사용하는 모든 텍스트 항목을 빠르게 선택하거나 선택 해제할 수 있습니다. 

예를 들어, 문단 스타일 변경 또는 다음과 같은 새로운 기능을 사용하려는 경우에 도움이 됩니다. 

직원을 시스템 부착 텍스트로 변환합니 다. Shift+X를 통해 생성된 직원 부착 텍스트를 Shift+Alt+X 

를 통해 생성된 시스템 부착 텍스트로 변환하려면 하나 이상의 텍스트 항목을 선택하고 컨텍스트 메뉴 

에서 텍스트를 시스템 텍스트로 변경하거나 점프 바를 사용하여 텍스트롤 시스템 텍스트로 변경합니 

댜 

단락 스타일에 대한 새로운 글꼴 스타일 선택. 단락 스타일이 특정 스타일 세트의 글꼴 패밀리를 사 

용하도록지정한후패밀리를 변경하면 도리코는새로선택한패밀리에 대해 동일한스타일 이름을 

유지하려고 노력하지만 동일한 이름의 스타일을 사용할 수 없는 경우 이제 원래 스타일에 가능한 

한 가까운 폴백 스타일을 찾으려고 합니 다. 
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If the new family has an identically named style, that is of course chosen. But if the 

style names differ, Dorico tries to find italic or roman style with the same or the 

closest weight; if it can’t find one with the same weight, it will choose the one with 

the smallest difference in weight, and if two styles are available with equal 

difference in weight, Dorico prefers the lighter one. This fallback procedure applies 

not only to the edited paragraph style, but also any child paragraph styles. 

This fallback procedure also applies when editing a font style, but for font styles, 

this is limited only to the edited font styles, and not any child font styles. 

Missing font substitution. When you specify a replacement font family and style in the 

Missing Fonts dialog when opening a project, Dorico now ensures that both the font 

family and style are correctly overridden in the paragraph or font style as 

appropriate, ensuring that both the chosen family and style will be used. 

Text export. File ▶ Export ▶ Text now includes an extra field that shows whether the text, 

tempo or playing technique item is hidden. In addition, quotation marks in text 

items are now correctly escaped in the output comma-separated values file. 

Crosshair. System-attached text now shows a crosshair when selected in Engrave mode. 

Ties 
Tie endpoint positioning for stemless notes. A new option Consider ‘Hide stem’ property 

when positioning tie endpoints has been added to the Advanced Options section 

of the Avoiding Collisions section of the Ties page of Engraving Options. When 

activated, Dorico will allow ties to be positioned on notes that would normally show 

stems, but which are hidden via the Hide stem property, in the same way that they 

are positioned on naturally stemless notes, i.e. whole notes (breves or longer. 

Time signatures 
Time signatures shown above the staff. Large time signatures shown above the staff now 

respect both the Cautionary time signature at end of system option on the Time 

Signatures page of Notation Options, and the similarly-named property in the Time 

Signatures group of the Properties panel. 

When Position of time signatures relative to coincident tempo and rehearsal 

marks is set to Below on the Time Signatures page of Engraving Options, a time 

signature shown above the staff will now be positioned outside all staff-attached 

items, and inside other system-attached items like system-attached text, tempos, 

and so on. 

Trills 
Horizontal offset for trill mark. A new option Horizontal offset for trill when aligned 

with notehead has been added to the Trills section of the Ornaments page of 



넥타이 

박표 

드릴 
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만약 새로운 가족이 동일한 이름의 스타일을 가지고 있다면, 그것은 물론 선택된 것입니다. 하지 

만스타일 이름이 다르면 도리코는 같거나가장가까운무게를가진 이탤릭체나로마체 스타일을 

찾으려고 합니 다. 같은 무게를 가진 스타일을 찾을 수 없다면 무게 차이가 가장 작은 스타일을 선 

택할 것이고, 무게 차이가 같은 두 스타일을 사용할 수 있다면 도리코는 더 가벼운 스타일을 선호 

합니다 이 폴백 절차는 편집된 단락 스타일뿐만 아니라 모든 어린이 단락스타일에도 적용됩니 

댜 

이 폴백 절차는 폰트 스타일을 편집할 때에도 적용되지만, 폰트 스타일의 경우에는 편집된 

폰트 스타일에만 적용되며, 자식 폰트 스타일은 적용되지 않습니다. 

누락된 폰트 대체. 교체 폰트 패밀리와스타일을 지정할 때 

프로젝트를 시작할 때 폰트 대화가 누락되었으므로, 도리코는 이제 적절한 단락이나 폰트 스타일 

에 폰트 계열과 스타일이 모두 올바르게 무시되도록 하여 선택한 계열과 스타일이 모두 사용되도 

록합니다 

텍스트 내보내기. 파일 ► 내보내기 ► 텍스트에는 텍스트, 템포 또는 연주 기술 항목이 숨겨져 있는 

지 여부를 보여주는 추가 필드가 포함되어 있습니다. 또한 텍스트 항목의 따옴표는 이제 출력 쉼표 분 

리 값 파일에서 을바르게 빠져나갑니다. 

크로스헤어. 시스템에 첨부된 텍스트는 이제 인그레이브 모드에서 선택하면 크로스헤어가 표시됩니다. 

스템이 없는 노트를 위한 타이 엔드포인트 위치 지정. 새로운 옵션은 타이 엔드포인트를 위치 지정할 

때 줄 숨기가 속성을 고려하십시오. 타이 페이지의 충돌 방지 섹션의 고급 옵션 섹션에 추가되었습니 

다 활성화되면 도리코는 일반적으로 스템을 표시하지만 숨기기 스템 속성을 통해 숨겨진 노트에 타이 

를 배치할 수 있도록 합니다 자연스럽게 스템이 없는 노트, 즉 전체 노트(브리브)에 배치되는 것과 같 

은 방식으로. 아니면 그 이상입니다. 

직원 위에 표시된 시간 서명입니다 직원 위에 표시된 큰 시간 서명은 이제 Notation Options의 시 

간 서명 페이지에 있는 시스템 종료 시 주의 시간 서명과속성 패널의 시간서명 그룹에 있는 유사한 이 

름의 속성을 모두 존중합니 다. 

일치하는 템포 및 리허설 표시에 대한 시간 서명 위치가 옵션 조각의 시간 서명 페이지 아래로 

설정되면, 스태프 위에 표시된 시간 서명은 이제 모든 스태프 부착 항목 외부에, 시스템 부착 텍 

스트, 템포 등과 같은 다른 시스템 부착 항목 내부에 위치하게 됩니다. 

트릴 표시를 위한 수펑 오프셋. 노트헤드와 정렬될 때 트릴을 위한 새로운 옵션 수평 오프셋이 장 

식 페이지의 트릴 섹션에 추가되었습니다. 

96 스타인버그 미디어 테크놀로지스 GmbH 

96/106 



 

 

Dorico 6 Version History 97 Steinberg Media Technologies GmbH 

Engraving Options, allowing you to specify the precise horizontal placement of the 

tr mark relative to the notehead. 

Signposts. If a trill shows neither its tr mark nor its wiggly extender line, it will now show 

a signpost if View ▶ Signposts ▶ Trills is activated. 

Tuplets 
Placement. In the Placement section of the Tuplets page of Engraving Options, the 

existing option to specify that tuplets should always be placed above notes on vocal 

instruments has been extended to allow tuplets to be placed above notes for all 

instruments. 

Horizontal position of number or ratio. A new Number x offset property has been added 

to the Tuplets group in Engrave mode, allowing you to adjust the horizontal position 

of the tuplet number or ratio relative to its bracket. 

Nudging in Engrave mode. It is now possible to nudge a selected tuplet bracket or 

number horizontally with Alt+←/→ in Engrave mode. 

User interface 
Popover vertical position. Popovers now show a small handle at the left-hand side, 

allowing you to adjust their vertical position relative to the staff. Dorico remembers 

any vertical adjustment independently for each popover, and these adjustments are 

persistent between sessions. 

Popovers now also show an attachment line, so you can tell precisely at which 

rhythmic position you are creating an item if the caret is not shown. 

Editing font settings for selected items. Many items shown in your score are drawn using 

text fonts, but it is not obvious whether an item uses a font style, which can be 

edited in Library ▶ Font Styles, or a paragraph style, edited in Library ▶ Paragraph 

Styles. 

To make it easy to change the appearance of such items, you can now right-click a 

selected item and choose Edit Font from the context menu to be taken directly to 

edit the font or paragraph style used by that item. 

This is supported for chord symbols, divisi, dynamics, figured bass, glissando lines, 

harp pedaling, lyrics, markers, percussion legends, player group labels, playing 

techniques, rehearsal marks, repeat endings, repeat markers, staff labels, text 

items, time signatures, and tuplets. 

Text editor in dialogs. In dialogs where Dorico’s rich text editor appears – for example, 

Edit Single Lyric, Edit Instrument Names, Change Divisi – the standard shortcuts 

that work when editing text directly in the score (for bold, italic, underline, 
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tr 마크를 노트헤드에 대해 정확한수평 배치를 지정할수 있도록 옵션을새깁니다. 

표지판 트릴이 트릴 표시나 위글리 익스텐더 라인을 나타내지 않으면 트릴 ► 보기 ► 표지판이 활성 

화되면 이제 표지판이 표시됩니다. 

쌍둥01 

배치. 각인 옵션의 튜플렛 페이지의 배치 섹션에서는 튜플렛이 항상 음 위에 배치되어야 한다고 지정 

하는 기존 옵션이 확장되어 모든 악기에 대해 튜플렛을 음 위에 배치할 수 있습니다. 

숫자 또는 비율의 수평 위치. 인그레이브 모드에서 튜플렛 그룹에 새로운 숫자 x 오프셋 속성이 추가 

되어 괄호에 대한튜플렛 숫자또는 비율의 수평 위치를조정할수있습니다. 

인그레이브 모드에서 넛지합니다. 이제 인그레이브 모드에서 Alt+ - / .... 로 선택한 튜플렛 브 

래킷 또는 숫자를 수펑으로 녓지할 수 있습니다. 

인터페이스 

팝오버 수직 위치. 팝오버는 이제 왼쪽에 작은 손잡이를 보여주므로 스태프에 대한 수직 위치를 조정 

할 수 있습니다. 도리코는 각 팝오버에 대해 독립적으로 수직 조정을 기억하며 이러한 조정은 세션 사 

이에도지속됩니다 

팝오버도 이제 첨부 파일을 보여주기 때문에, 케어가 표시되지 않으면 어 떤 리듬 위치에 

서 아이템을 만들고 있는지 정확하게 알 수 있습니다. 

선택한 항목에 대한 글꼴 설정 편집. 점수에 표시된 많은 항목은 텍스트 글꼴로 그려져 있지만, 라이브 

러리 ► 폰트 스타일에서 편집할 수 있는 글꼴 스타일을 사용하는지, 아니면 라이브러리 ► 문단 스타 

일에서 편집할 수 있는 문단 스타일을 사용하는지는 분명하지 않습니다. 

이러한 항목의 모양을 쉽게 변경할 수 있도록 선택한 항목을 마우스 오른쪽 버튼으로 클릭하 

고 컨텍스트 매뉴에서 "편집'＇을 선택하여 해당 항목에서 사용하는 글꼴 또는 단락 스타일을 직 

접편집할수있습니다. 

이것은 코드 심볼, 디비시, 다이내믹스, 피규어 베이스, 글리산도 라인, 하프 페달링, 가사, 마커, 

타악기 전설, 연주자 그룹 레이블, 연주 기술, 리허설 마크, 반복 엔딩, 반복 마커, 스태프 레이 

블 텍스트항목, 시간서명 및 튜플렛에 지원됩니다 

대화에서 텍스트 편집기. 도리코의 풍부한 텍스트 편집기가 등장하는 대화에서는 - 단일 작사 편 

집, 악기 이름 편집, 변경 분할 등 - 악보에서 직접 텍스트를 편집할 때 작동하는 표준 단축키입니다. 
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increasing/decreasing the font size, and Alt+X to convert to and from Unicode 

codepoints) are all now operational. 

Handles and frames. The appearance of circular handles in Write mode and square 

handles in Engrave mode has been refined, such that they are proportionally 

smaller at higher zoom levels. Handles are also more translucent at higher zoom 

levels, and are drawn using lines that are similarly thinner at higher zoom levels. 

This means that doing fine work at high zoom levels is easier, because the handles 

obscure the items you are editing. 

In a similar vein, music, text, graphics and graphic slice frames are also drawn 

using lines that are thinner at high zoom levels. 

In Write mode, the bar numbers shown by the options in the View ▶ Bar Numbers 

submenu, and the instrument names shown above each staff in galley view, are also 

proportionally smaller at high zoom levels, so they obscure less of the music you are 

editing. 

Status bar information. The informational read-out at the left-hand side of the status bar 

has been expanded to provide more information. In addition to the information 

about the selected item and the bar in which it appears, in page view Dorico now 

shows the number of the page, or range of pages, on which the selection appears; 

and it also displays the timecode position of a single item, or the time range for a 

multiple selection. For a multiple selection, Dorico also shows the duration between 

the first and last selected items in minutes and seconds (though repeats are not 

considered). 

Refreshed appearance. Multiple list view and grid view controls across the application 

have been visually redesigned to reduce their intensity and prominence. This is 

most immediately obvious on the Open Recent and Create New pages of the Hub. 

List, table and tree views across Dorico have been similarly updated, including in 

the sidebars of the library and options dialogs. 

Hub. A new What’s New page has been added to the Hub window, which is populated 

with information about new features and capabilities added in the current version. 

This data is downloaded from the Internet, so the page will only appear if you have 

an active connection, and if there is relevant information available. 

Zoom recent project thumbnails. When mousing over a recent project in the Hub’s grid 

view, a new control appears that, while pressed, will magnify the top portion of the 

selected project’s thumbnail. This helps discern between otherwise similar looking 

items. 

Follow operating system theme. The Theme drop-down in the Window section of the 

General page of Preferences now has a new Auto value. When set to Auto, Dorico 
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폰트 크기를 늘리거나 줄이고, Alt+X를 유니코드 코드포인트로 변환하고 변환할 수 있습 

니다. 

손잡이와 프레임. 쓰기 모드의 원형 손잡이와 새기 모드의 정사각형 손잡이의 모양이 개선되어 더 

높은 줌 수준에서 비례적으로 작아집니다. 핸들은 또한 더 높은 줌 수준에서 더 반투명하며, 더 높은 

줌 수준에서도 비슷하게 더 얇은 선을 사용하여 그려집니다. 

즉, 핸들이 편집 중인 항목을 가려서 높은 줌 수준에서 작업을 수행하는 것이 더 쉽습니 다. 

비슷한 맥락에서, 음악, 텍스트, 그래픽 및 그래픽 슬라이스 프레임도 높은 줌 레벨에서 더 

얇은 선을사용하여 그려집니다. 

쓰기 모드에서는 뷰 ► 바 넘버 서브메뉴의 옵션에 표시된 바 번호와 갤리 뷰의 각 스태프 위에 표 

시된 악기 이름도 고줌 레벨에서 비례적으로 작기 때문에 편집 중인 음악의 흐림이 줄어듭니다. 

상태 표시줄 정보. 상태 표시줄 왼쪽에 있는 정보 판독값이 더 많은 정보를 제공하기 위해 확장되었습 

니다 선택된 항목과 표시줄에 대한 정보 외에도 페이지 보기에서 도리코는 이제 선택이 표시되는 페이 

지 수 또는 페이지 범위를 표시합니다. 또한 단일 항목의 타임코드 위치 또는 다중 선택의 시간 범위를 

표시합니다 다중 선택의 경우 도리코도 표시합니다. 처음 선택된 항목과 마지막으로 선택된 항목 사 

이의 지속 시간은 몇 분, 몇 초 단위입니다(반복은 고려되지 않습니다). 

새로워진 외관 애플리케이션 전체의 여러 목록 보기 및 그리드 보기 컨트롤이 시각적으로 재설계 

되어 강도와 두드러짐을 줄였습니다. 이것은 허브의 Open Recent 및 Create New 페이지에서 가 

장즉각적으로 나타납니다. 

라이브러리 및 옵션 대화의 측면 표시를 포함하여 도리코 전역의 목록, 테이블 및 트리 보기가 

유사하게 업데이트되었습니다. 

허브 Hub 창에 새로운 What's New 페이지가 추가되었으며, 이는 현재 버전에 추가된 새로운 기능 

과 기능에 대한 정보로 가득 차 있습니 다. 

이 데이터는 인터넷에서 다운로드한 것이므로 연결 상태가 활성화되어 있고 관련 정보가 있는 

경우에만 페이지가 나타납니다. 

최근 프로젝트 썸네일을 확대합니다. 허브의 그리드 뷰에서 최근 프로젝트를 촬영할 때, 누르는 동안 

선택된 프로젝트의 썸네일의 상단 부분을 확대하는 새로운 컨트롤이 나타납니다. 이것은 다른 비슷해 

보이는 항목을 식별하는 데 도움이 됩니다. 

운영체제 테마를 따르세요. 일반설정 페이지의 창섹션에 있는 테마드롭다운에는 이제 새로운 

Auto 값이 있습니다 Auto로 설정되면 도리코입니다 
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will automatically switch between using its dark or light appearance according to 

the overall setting for dark or light appearance in macOS and Windows. 

Showing suppressed warnings. Some warning messages that appear when using Dorico 

have a checkbox allowing you to tell Dorico not to show them again. To clear the 

history of messages you have suppressed so that Dorico is free to show them to you 

again, click Reset Warnings in the Suppressed Messages section of the General 

page of Preferences. 

Instrument filters. If you have shortcuts assigned to the commands to activate 

instrument filters and use one of those shortcuts when in page view, Dorico shows a 

message informing you that you must be in galley view to use instrument filters, 

and asking if you want to switch to galley view and activate the instrument filter. 

This message now includes a Don’t say this again checkbox, so you can decide 

whether Dorico should always switch to galley view, or never switch. 

User settings. In previous versions, some user settings – for things like jump bar aliases, 

recently-used music symbols, and saved dialog and window positions – were saved 

in property list files in the user-level Preferences folder (macOS) or in the Windows 

Registry (Windows). All user settings are now saved in the Dorico 6 folder in the 

user-level application data folder on both platforms, which makes them easier to 

manage. 

Confirming modal dialogs. It is now possible to confirm all modal dialogs by typing 

Ctrl+Return (Windows) or Command-Return (macOS). Modal dialogs typically have 

OK and Cancel buttons and prevent you from interacting with any other part of the 

application until you confirm or cancel the dialog. 

Export File Names dialog. The behavior of inserting filename ingredients in the Export 

File Names dialog has been improved: the ingredient is now inserted at the current 

cursor position. 

Selected chord symbols. The Keyboard panel will show the pitches represented by a 

selected chord symbol; these pitches are also now shown in the information read-

out in the status bar. 

Changed terminology. The term “system object”, meaning items like tempos, rehearsal 

marks, repeat markers and endings, etc., has been removed from the application, 

replaced by “system-attached item.” 

Font selectors. The menus used to choose font families, for example in Library ▶ 

Paragraph Styles, and in the text editing controls, now use a menu with embedded 

filter, allowing you to type part of the name of the font you want to choose, quickly 

narrowing down the long list of available fonts. 
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macOS와 Windows에서 어둡거나 밝은 모양에 대한 전체 설정에 따라 어둡거나 밝은 모양 

을 사용하는 것 사이를 자동으로 전환합니 다. 

억제된 경고 표시. 도리코를 사용할 때 나타나는 일부 경고 매시지에는 확인란이 있어 도리코에게 다 

시는 보여주지 말라고 말할 수 있습니다. 도리코가 다시 보여줄 수 있도록 억제된 메시지의 기록을 지 

우려면, 일반 페이지의 억제 메시지 섹션에서 경고 설정을 클릭하십시오. 

기기 필터 기기 필터를 활성화하고 페이지 보기에 있을 때 해당 단축키 중 하나를 사용하라는 명령에 

단축키가 할당되어 있는 경우, 도리코는 기기 필터를 사용하려면 갤리 뷰에 있어야 함을 알리고, 갤리 

뷰로 전환하여 기기 필터를 활성화하려면 매시지를 보여줍니다. 

이 메시지에는 이제 다시는 하지 마세요 체크박스가 포함되어 있어서 도리코가 항상 갤리 뷰 

로 전환해야 할지 아니면 절대 전환하지 않아야 할지를 결정할수 있습니다. 

사용자 설정. 이전 버전에서는 점프 바 별칭, 최근에 사용된 음악 기호, 저장된 대화 및 창 위치와 같은 

일부 사용자 설정이 사용자 수준 선호도 폴더(macOS) 또는 윈도우 레지스트리{Windows)의 속성 목 

록 파일에 저장되었습니다. 모든 사용자 설정은 이제 두 플랫폼의 사용자 수준 응용 프로그램 데이터 

폴더에 있는 도리코 6 폴더에 저장되어 관리가 더 쉽습니다. 

모달 대화 확인. 이제 타이핑을 통해 모든 모달 대화를 확인할 수 있습니다. 

Ctrl+Return(Windows) 또는 Command-Return(macOS)입니다 모달 대화에는 일반적으로 

확인 및 취소 버튼이 있으며 대화를 확인하거나 취소할 때까지 애플리케이션의 다른 부분과 상호 

작용하지 않도록 합니다. 

파일 이름 내보내기 대화상자. 파일 이름 내보내기 대화상자에 파일 이름 성분을 삽입하는 동작이 개 

선되었습니다: 성분이 현재 커서 위치에 삽입됩니다. 

선택된 코드 기호. 키보드 패널에는 선택된 코드 기호로 표시되는 음높이가 표시됩니다. 이러한음 

높이는 이제 상태 표시줄의 정보 판독값에도 표시됩니다. 

변경된 용어 . 템포, 리허설 마크, 반복 마커 및 어미 등과 같은 항목을 의미하는 "시스템 객체'’라는 

용어가 응용 프로그램에서 제거되고 "시스템 부착 항목’’으로 대체되었습니다. 

글꼴 선택기. 라이브러리 ► 에서 글꼴 패밀리를 선택하는 데 사용되는 매뉴입니다. 

스타일 문단, 그리고 텍스트 편집 컨트롤에서 이제 필터가 내장된 메뉴를 사용하여 선택하려는 글 

꼴 이름의 일부를 입력할수있으므로사용 가능한글꼴의 긴 목록을빠르게 좁힐 수있습니다. 
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Go To Bar dialog. The Edit ▶ Go To Bar dialog now only lists flows attached to the current 

layout, rather than all flows in the project. 

Missing Fonts dialog. When moving your mouse over the column header row in the table 

in the Missing Fonts dialog (and other similar dialogs), the pointer now changes 

shape to indicate that you can resize the columns. You can also now double-click a 

column heading to resize that column to the size of the longest item in that column. 

Furthermore, Dorico now shows a visual indicator in cells in the table that will show 

a drop-down menu when clicked. 

Video 
Improved color management. Dorico’s support for attached video files has been 

improved. Video resolutions up to 8K are now supported, though playback of 8K 

video is computationally expensive. HDR video files now have improved color 

reproduction when displayed on non-HDR sRGB displays. 

  



도리코 6판역사 

Go To Bar 대화 대화를 시작합니다 편집 ► Go To Bar 대화 대화는 이제 프로젝트의 모든 흐름이 
아닌 현재 레이아웃에 첨부된 흐름만 나열합니다. 

글꼴문자누락대화자입니다글꼴문자누락 대화자(및유사한다른 대화자)에서 테이블의 열 헤더 

행 위로 마우스를 이동할때 포인터가모양을 변경하여 열의 크기를조정할수있음을 나타냅니다. 또 

한 열 제목을 두 번 클릭하여 해당 열의 가장 긴 항목의 크기로 조정할 수 있습니 다. 

비디오 

또한, 도리코는 이제 클릭하면 드롭다운 매뉴를 표시하는 시각적 표시기를 테이블의 셀에 표시합 

니다 

색상 관리 개선. 첨부된 비디오 파일에 대한 도리코의 지원이 향상되었습니다. 8K 비디오 재생 

은 계산 비용이 많이 들지만 이제 최대 8K의 비디오 해상도가 지원됩니다. HDR 비디오 파일은 

이제 비 HOR sRGB 디스플레이에 표시될 때 색상 재현이 향상되었습니다. 
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Issues resolved 
Component Issue 

Accidentals When ledger line shortening is disabled, sharp and natural accidentals could in some 

circumstances be positioned such that they abut the ledger line; this has now been fixed. 

Audio engine Some VST plug-ins built on the JUCE framework crashed as the audio engine is shut down 

when you quit Dorico; this has now been fixed. 

Bar numbers When no clef is shown at the start of a single-staff system because Clefs at start of systems 

following first system is set to Hide clefs, the offset to avoid the prevailing clef specified on 

the Bar Numbers page of Engraving Options is no longer applied. 

Chord diagrams When the option to align chord symbols across the width of the system is disabled, the grid of 

used chord diagrams at the start of the flow could be poorly aligned; this is now fixed. 

Chord symbols When selecting music on multiple instruments with a mixture of local and global chord 

symbols, trying to use Generate Notes from Chord Symbols in Selection will now always 

show the expected warning if the chord progression differs on the selected instruments. 

Clefs Creating or deleting a clef change preceding a run of grace notes with a clef interspersed 

between grace notes, or to the right of all grace notes, now correctly updates the staff position 

of the grace notes preceding the next clef change. 

Comments The Comments panel now only shows comments belonging to instruments directly assigned 

to a layout; comments belonging to instruments that are present in the layout only because 

they are cued are now excluded. 

Condensing The option to consolidate consecutive player numbers into a range on the Condensing page of 

Engraving Options now applies to Roman numerals as well as Arabic ones. 

Cues Hidden tuplets that show neither bracket nor ratio in cues no longer incorrectly show a 

signpost. 

Dynamics Under some circumstances, editing music within the span of a gradual dynamic that shows no 

continuation line could cause other items within that range to move unexpectedly; this has 

now been fixed. 

Dynamics When Position end of hairpin relative to note or chord is set to Right side of note on main 

stem, Dorico will nevertheless stop the hairpin at the left of the last note if the hairpin ends 

niente. 

Engrave mode Dragging or nudging beams in Engrave mode in condensed music where mid-phrase unisons 

are prevented now works as expected. 

Flows Write ▶ Split Flow no longer incorrectly applies layout-specific items like breaks and note 

spacing changes from other layouts into the current layout. 



과제 

성분 

변고 

오디오 

바코드 

코드도 

화음 

클리프 

댓글 

응축 

단서 

역동성 

역동성 

앵그레이브모드 

흐름 

도리코 6판역사 

문제 

장부선 단축이 비활성화되면 어떤 상황에서는 날카롭고 자연스러운 사고가 장부선에 인접하도록 배치 

될 수 있습니다. 이것은 이제 수정되었습니다. 

JUCE 프레임워크에 내장된 일부 VST 플러그인이 도리코를 그만둘 때 오디오 엔진이 꺼지면서 충돌했 
습니다 이것은 이제 수정되었습니다 

첫 번째 시스템 다음 시스템 시작 시 클레프가 Hide 클레프로 설정되어 있기 때문에 단일 스태프 시스템 

시작 시 클레프가 표시되지 않으면, 각인 옵션의 Bar 번호 페이지에 지정된 일반적인 클레프를 피하기 위 

한오프셋이 더 이상적용되지 않습니다. 

코드 기호를 시스템 너비에 걸쳐 정렬하는 옵션이 비활성화되면 흐름이 시작될 때 사용된 코드 다이어그램 

의 그리드가 제대로 정렬되지 않을 수 있습니다. 이제 이것이 고정되었습니다. 

지역 코드 기호와 글로벌 코드 기호가 혼합된 여 러 악기에서 음악을 선택할 때, 선택에서 코드 기호로 

부터의 생성 음표를 사용하려고 하면 선택된 악기에서 코드 진행이 다를 경우 항상 예상되는 경고가 표 

시됩니댜 

그레이스 노트의 앞에 있는 클리브 변경을 생성하거나 삭제하면, 그레이스 노트 사이에 클리브가 산재되어 

있거나 모든 그레이스 노트의 오른쪽에 있습니다. 이제 다음 클리브 변경에 앞서 있는 그레이스 노트의 오 

선 위치를 올바르게 업데이트합니다. 

이제 의견 패널은 레이아웃에 직접 할당된 도구에 속하는 의견만 표시합니다. 이제는 큐가 있기 때문에 레 

이아웃에 존재하는 도구에 속하는 의견은 제외됩니다. 

연속 플레이어 번호를 각인 옵션의 응축 페이지에 있는 범위로 통합할 수 있는 옵션은 이제 아라비아 숫자뿐 

만 아니라 로마 숫자에도 적용됩니다. 

신호에서 괄호나 비율을 나타내지 않는 숨겨진 쌍쌍은 더 이상 표지판을 잘못 표시하지 않습니다. 

어떤 상황에서는 연속선이 보이지 않는 점진적인 역학 범위 내에서 음악을 편집하면 해당 범위 내의 다른 항목 

이 예기치 않게 이동할수 있습니다. 이것은 이제 수정되었습니다. 

음이나 코드에 대한 헤어핀의 위치 끝이 원줄기에서 오른쪽 음으로 설정되면, 도리코는 헤어핀이 끝나면 마 

지막 음의 왼쪽에 있는 헤어핀을 멈출 것입니다. 

증간 악구 연결이 방지되는 응축된 음악에서 인그레이브 모드에서 빔을 드래그하거나 녓징하는 것은 이제 

예상대로작동합니다. 

► 쓰기 분할 흐름은 더 이상 다른 레이아웃의 중단 및 노트 간격 변경과 같은 레이아웃별 항목을 현재 

레이아웃에 잘못적용하지 않습니다. 
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Component Issue 

Grace notes In rare circumstances, crossing a grace note to the staff above or below could cause a crash; 

this has now been fixed. 

Guitar notation When editing notes that show bends such that they overlap or end up at the same position, 

any affected guitar bends are now correctly removed. 

Guitar tablature Under some circumstances, re-choosing one of the default fretted instrument tunings from 

the drop-down in Edit Strings and Tuning after editing one or more strings in the current 

tuning could crash; this has now been fixed. 

Holds and pauses When creating a breath mark on a tied note, Dorico now snaps the breath mark forward to the 

position of the final notehead in the tie chain; this prevents the breath mark from 

unexpectedly disappearing if the tied note is split over a system break. 

Instrument families Adding a new family based on an existing family in Library ▶ Instrument Families no longer 

unexpectedly causes the list of families to be sorted alphabetically. 

Instrument filters A long-standing unreliability that could cause some instruments that should be hidden by an 

instrument filter to nevertheless appear has been fixed. 

Instrument score 

orders 

Alto trombone is now correctly positioned before tenor trombone in the factory default 

instrument score orders. 

Instrument types After saving a custom tuning to the user library as a default for future projects, you can now 

correctly choose that custom tuning in the Edit Strings and Tuning dialog for a different 

fretted instrument. 

Jump bar Under some circumstances, Dorico could trigger the most frequently used command instead 

of the command shown in the jump bar when reopened; this has now been fixed. 

Key Editor Changing the start and end offsets of notes using the commands Decrease Playback End 

Offset and Increase Playback End Offset now correctly immediately updates the display in 

the piano roll. 

Library Manager When importing library items using the Library Manager, Dorico would incorrectly omit some 

dependent items, resulting in imported items sometimes not having the expected 

appearance; this has now been fixed. 

Library Manager Under some circumstances, changing the Layout or Flow drop-down in the Library Manager 

would not result in the correct status being shown for options or collections; this has now 

been fixed. 

Lines Hyphenated text annotations are now drawn with the correct rotation for vertical lines. 



성분 문제 

꾸밈음 드문 경우지만 위나 아래 직원에게 그레이스노트를 건드리면 충돌이 발생할 수 있습니다. 이것은 이제 해 

결되었습니댜 

기타표기법 구부러짐이 겹치거나 같은 위치에 있도록 표시된 메모를 편집할 때, 영향을 받은 기타 구부러짐은 이제 

올바르게 제거됩니다. 

기타타블레쳐 어떤 상황에서는 현재 튜닝에서 하나 이상의 스트링을 편집한 후 편집 스트링 및 튜닝의 드롭다운에서 기 

본 프렛 악기 튜닝 중 하나를 다시 선택하면 충돌할 수 있습니다. 이것은 이제 수정되었습니다. 

보류 묶인 음에 호흡 표시를 만들 때, 도리코는 이제 호흡 표시를 타이 체인의 마지막 노트헤드 위치로 앞으로 찍 

습니다 이것은 묶인 음이 시스템 브레이크로 인해 분할되면 호흡 표시가 예기치 않게 사라지는 것을 방지 

합니다 

악기가족 라이브러리 ► 악기 패밀리에 기존 가족을 기반으로 새로운 가족을 추가하면 더 이상 가족 목록이 알파벳 

순으로 정렬되지 않습니다 

필터 기기 필터로 가려져야 하는 일부 기기가 나타나게 할 수 있는 오랜 신뢰성이 수정되었습니다. 

악보 

명령 

알토 트롬본은 이제 공장 기본 악기 악보 주문에서 테너 트롬본 앞에 올바르게 배치되었습니다. 

악기종 사용자 라이브러리에 대한 맞춤형 튜닝을 향후 프로젝트의 기본값으로 저장한 후, 이제 편집 문자열 및 

다른 프렛 악기에 대한 튜닝 다이얼로그에서 해당 맞춤형 튜닝을 을바르게 선택할 수 있습니다. 

철봉 어떤 상황에서는 도리코가 다시 열 때 점프 바에 표시된 명령 대신 가장 자주 사용되는 명령을 트리거할 수 

있습니다 이것은 이제 수정되었습니다. 

주필 재생 종료 오프셋 감소 및 재생 종료 오프셋 증가 명령을 사용하여 음의 시작 및 종료 오프셋을 변경하면 

이제 피아노 를의 디스플레이가 율바르게 업데이트됩니다. 

도서관장 라이브러리 관리자를 사용하여 라이브러리 항목을 가져율 때 도리코가 일부 종속 항목을 잘못 누락하여 예상 

되는 항목이 나타나지 않는 경우가 있습니다. 이는 이제 수정되었습니다. 

도서관장 어떤 상황에서는 라이브러리 관리자에서 레이아웃 또는 흐름 드롭다운을 변경해도 옵션이나 컬렉션에 대 

한 을바른 상태가 표시되지 않습니다. 이것은 이제 수정되었습니다. 

선
 

이제 수직선에 대한 을바른 회전으로 하이픈 텍스트 주석이 그려집니다. 
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Component Issue 

Lyrics If the Lyrics (Verse Numbers) paragraph style is a different size to the Lyrics paragraph style, 

verse numbers would be incorrectly vertically aligned relative to the lyrics to their right; this 

has now been fixed. 

Lyrics When inputting Latin alphabetic lyrics when the Korean IME is active, it is now possible to 

create hyphens, as expected. 

Lyrics When exporting lyrics to a text file, they are now always correctly exported in line order. 

MusicXML export Dorico no longer incorrectly treats numbered bar regions like bar repeat regions in MusicXML 

export. 

MusicXML import In rare circumstances, Dorico could create paragraph styles with no specified font during 

MusicXML import, which could lead to instability when working with the project; this has now 

been fixed. 

Navigation When navigating to rehearsal marks via the jump bar or the Go To dialog, Dorico now better 

handles rehearsal mark sequences with an overridden starting index. 

Note input Some note input commands, such as specifying a new duration in duration before pitch input, 

were unnecessarily triggering Dorico to recalculate playback information, which was 

noticeable in larger projects; this has now been fixed. 

Note input Step-time note input from MIDI devices that produce copious MIDI CC data, such as wind 

controllers, now works more reliably. 

Note input When adding bars using the Shift+B popover, Dorico now correctly accounts for the total 

length of aggregate time signatures. 

Note input Moving the caret up and down between staves when multiple windows are open on the same 

project now works reliably. 

Percussion When saving a percussion instrument to your user library, Dorico now ensures that the 

percussion playing technique data for each saved instrument is correctly saved 

independently; previously it was possible for the playing technique data for one instrument to 

be overwritten by the data for another. 

Percussion Under some circumstances, inputting a grace note inside a tuplet in a percussion kit using the 

five-line staff presentation type could fail, or result in unwanted rests being created in other 

voices; this has now been fixed. 

Platform support Dorico will now start correctly if it is installed in a path containing one or more characters 

with diacritics (Windows only). 

Platform support When Dorico is set to quit after the last project window is closed, and the Mixer is open, the 

application no longer crashes on exit (Windows only). 



성분 

작A| 

작Af 

작A~ 

뮤직XML 수출 

뮤직XML 수입 

항해 

노트 

노트 

노트 

노트 

타악기 

타악기 

플랫폼지원 

플랫폼지원 

도리코 6판역사 

문제 

가사 문단 스타일이 가사 문단 스타일과 다른 크기라면, 가사 숫자가 오른쪽에 있는 가사에 비해 잘못 수직 

으로 정렬되어 있율 것입니다. 이것은 이제 수정되었습니다. 

한국어 IME가 활성화되어 있을 때 라틴어 알파벳 가사를 입력하면, 예상대로 하이픈을 만들 수 있습니 

다. 

텍스트 파일로 가사를 내보낼 때, 이제는 항상 줄 순서대로 올바르게 내보냅니다. 

도리코는 더 이상 MusicXML 내보내기에서 번호가 매겨진 막대 영역을 막대 반복 영역처럼 잘못 취급하지 않 
습니다 

드문 경우지만, 도리코는 MusicXML 가져오기 중에 지정된 글꼴이 없는 단락 스타일을 만들 수 있었으며, 

이는 프로젝트 작업 시 불안정성을 초래할 수 있습니다. 이것은 이제 수정되었습니다. 

점프 바나 Go To 다이얼로그를 통해 리허설 마크로 이동할 때, 도리코는 이제 시작 인덱스가 무시된 리허 

설 마크 시퀀스롤 더 잘 처리합니다. 

피치 입력 전에 새로운 지속 시간을 지정하는 것과 같은 일부 메모 입력 명령은 도리코가 재생 정보를 다시 

계산하도록 불필요하게 트리거했습니다. 이는 더 큰 프로젝트에서 두드러졌습니다. 이제 이것이 수정되었 

습니다 

풍력 컨트롤러와 같이 방대한 MIDI CC 데이터를 생성하는 MIDI 장치에서 입력되는 단계별 메모는 이 
제 더 안정적으로 작동합니다. 

Shift+B 팝오버를 사용하여 막대를 추가할 때, 도리코는 이제 총 시간 서명의 길이를 정확하게 설명합 

니다 

같은 프로젝트에서 여러 창문이 열려 있을 때 스테이브 사이를 위아래로 옮기는 것이 이제 안정적으로 작동 

합니댜 

타악기를 사용자 라이브러리에 저장할 때, Dorico는 이제 저장된 각 악기의 타악기 연주 기술 데이터가 독 

립적으로 올바르게 저장되도록 합니다. 이전에는 한 악기의 연주 기술 데이터가 다른 악기의 데이터에 의 

해 덮어쓰는 것이 가능했습니다. 

어떤 상황에서는 5줄짜리 스태프 프레젠테이션 유형을 사용하여 타악기 키트의 튜플렛 안에 그레이스 노트를 

입력하는 것이 실패하거나 다른 목소리에서 원치 않는 휴식이 생성될 수 있습니다. 이것은 이제 수정되었습니 

다. 

도리코는 이제 발음이 있는 하나 이상의 문자가 포함된 경로에 설치되면 올바르게 시작됩니다(윈도우 전 

용). 

마지막 프로젝트 창이 닫히고 믹서가 열려 있으면 애플리케이션이 더 이상 출구(윈도우 전용)에서 충둘 

하지 않습니다. 
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Component Issue 

Playback Under some circumstances, a fermata following an a tempo marking could play excessively 

long, if a hidden tempo preceded the a tempo; this has now been fixed. 

Playback A hidden tempo at the start of the flow is now correctly considered when working out the 

restorative tempo after a fermata. 

Playback Under some circumstances, Dorico could hang indefinitely when calculating polyphonic voice 

balancing; this has now been fixed. 

Playing techniques When editing an existing hidden or parenthesized playing technique via the Shift+P popover, 

the populated text now shows parentheses and/or brackets as appropriate. 

Playing techniques Clicking a playing technique into the score from the panel could erroneously also create a 

second playing technique on the following note; this has now been fixed. 

Playing techniques Creating multiple piano pedal lines in succession from a loaded mouse pointer now works 

reliably. 

Playing techniques Playing techniques now appear correctly on grace note runs in percussion kits shown in the 

five-line staff or grid presentation types. 

Playing techniques Under some circumstances, deleting a playing technique and then undoing its deletion would 

result in the playing technique initially reappearing at the wrong vertical position; this has 

now been fixed. 

Print mode If auto-save is triggered while Dorico is preparing layouts for printing or exporting in Print 

mode, Dorico could crash; this has now been fixed. 

Rehearsal marks Under some circumstances, changing the Instrument transition position option on the 

Players page of Layout Options could cause rehearsal marks at the transition position to 

temporarily disappear; this has now been fixed. 

Selections Making a block selection with Shift+click on a staff now reliably selects any material that is 

played by other instruments held by the player and shown due to instrument changes. 

Selections Under some circumstances, Dorico could crash when using Edit ▶ Select More; this has now 

been fixed. 

Text The calculation of missing fonts when opening an existing project has been improved, and 

correctly handles font and paragraph styles with overridden styles but inherited families. 

Text The {@staffLabelsFull@} and {@staffLabelsShort@} tokens now correctly inherit an 

overridden font, if set in the text editor. 

Time signatures Using the Pick-up bar of option in the Create Time Signature section of the Time Signatures 

panel now works more reliably. 



人1 므 
ot 문제 

재생 어떤 상황에서는 템포 표시 뒤에 오는 페르마타가 템포보다 숨겨진 템포가 앞서면 너무 오래 연주될 수 

있습니다 이것은 이제 고정되었습니다 

재생 흐름이 시작될 때 숨겨진 템포는 이제 페르마타 이후의 복원 템포를 계산할 때 율바르게 고려됩니다. 

재생 어떤 상황에서는 도리코가 다성 음성 균형을 계산할 때 무기한 매달릴 수 있었습니다. 이것은 이제 해결되었습 

니댜 

주법 Shift+P 팝오버를 통해 기존의 숨겨진 또는 괄호 처리 기술을 편집할 때, 채워진 텍스트는 이제 적절한 괄 

호 및/또는 괄호를 표시합니다. 

주법 패널의 악보에 연주 기술을 클릭하면 다음 음에서 두 번째 연주 기술이 잘못 생성될 수도 있습니다. 이 

것은 이제 수정되었습니다. 

주법 로드된 마우스 포인터에서 여러 개의 피아노 페달 라인을 연속적으로 만드는 것은 이제 안정적으로 작동 

합니다 

주법 연주 기술은 이제 5줄짜리 스태프 또는 그리드 프레젠테이션 유형에 표시된 타악기 키트의 그레이스 노 

트 실행에 올바르게 나타납니다. 

주법 어떤 상황에서는 연주 기법을 삭제한 후 삭제를 취소하면 처음에는 잘못된 수직 위치에서 연주 기법이 다 

시 나타나게 됩니다 이것은 이제 고정되었습니다. 

인쇄모드 도리코가 인쇄 모드에서 인쇄 또는 내보내기롤 위한 레이아웃을 준비하는 동안 자동 저장이 작동하면 도 

리코가 충돌할 수 있습니다. 이제 이것이 수정되었습니다. 

연습판 어떤 상황에서는 레이아웃 옵션의 플레이어스 페이지에서 악기 전환 위치 옵션을 변경하면 전환 위치 

의 리허설 표시가 일시적으로 사라질 수 있습니다. 이는 이제 수정되었습니다. 

선정 Shift+클릭으로 스태프를 사용하여 블록을 선택하면 이제 연주자가 가지고 있는 다른 악기로 연주되고 

악기 변경으로 인해 표시되는 모든 재료를 안정적으로 선택할 수 있습니다. 

서저 ‘-O 어떤 상황에서는 편집 ► 더 많이 선택하기률 사용할 때 도리코가 충돌할 수 있습니다. 이것은 이제 수정되 

었습니댜 

글
 

기존 프로젝트롤 개설할 때 누락된 글꼴에 대한 계산이 개선되었으며, 스타일은 무시되었지만 가족율 물 

려받은 글꼴과 단락 스타일을 올바르게 처리합니다. 

글
 

{@stafflabelsFull@} 및 {@stafflabelsShort@}tokens는 텍스트 편집기에 설정된 경우 무 

시된 글꼴을 을바르게 상속합니다. 

박표 Time Signatures 패널의 Create Time Signature 섹션에서 옵션의 픽업 바를 사용하면 이제 더 안정적 

으로작동합니다. 
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Component Issue 

Time signatures The Cautionary time signature at end of system option on the Time Signatures page of 

Notation Options no longer incorrectly takes effect in galley view. 

Time signatures In rare circumstances, music could be rebarred differently after re-opening a saved project, 

because Dorico was discarding which of the aggregate time signatures in a set should be used 

at e.g. a special barline; this has now been fixed. 

User interface Under some circumstances, the gradient previews in the Colors page of Preferences did not 

always update immediately after choosing a preset gradient; this has now been fixed. 

User interface In some dialogs, inputting floating point values into spin boxes did not work correctly; this has 

now been fixed. 

User interface Menu items in the Write menu that trigger popovers are now correctly disabled if nothing is 

selected and/or the caret is not visible. 

User interface Right-clicking on a player, layout, or flow now ensures that the list item is correctly selected 

before the context menu appears, so all menu items are appropriately enabled or disabled. 

User interface It is now possible to use Return/Enter to open the highlighted project on the Open Recent 

page of the Hub, when either the grid or list view is shown. 

User interface Flow names that include characters that could be interpreted as an ordered or unordered list 

in Markdown now appear correctly in the project window title bar. 

User interface Selecting a line with a hyphenated text annotation in Library ▶ Lines now correctly updates 

the annotation controls on the right-hand side of the dialog. 

User interface Zoom commands now include the word “zoom” in their names in the jump bar. 

User interface Hide All VST Plug-in Windows can now be used in any mode, not only in Play mode. 

User interface The Paragraph Styles and Character Styles dialog now independently remember their size 

and position. 

User interface Move View to Next Page/Spread now work reliably in all circumstances. 

User interface Navigating to a specific page now always works correctly at all zoom levels; previously, in long 

projects at zoom levels around 100% it was possible for Dorico to overshoot the target page. 

User interface All the library editing dialogs in the Library menu now correctly save and restore their size 

and position independently of each other. 

User interface Under some circumstances, hopping the selection left when out of view to the right, or 

hopping the selection right when out of view to the left, would not cause the new selection to 

be brought into view; this has now been fixed. 



성분 

박표 

박표 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페01스 

인터페이스 

인터페이스 

도리코 6판역사 

문제 

Notation Options의 Time Signatures 페이지에 있는 시스템 옵션 종료 시 주의 시간 서명은 더 이 
상 갤리 뷰에서 잘못 적용되지 않습니다. 

드문 경우지만, 저장된 프로젝트를 다시 연 후에 음악을 다르게 철근할 수 있습니다. 왜냐하면 도리코는 세 

트의 집계 시간 서명 중 어떤 것을 사용해야 하는지를 폐기하고 있었기 때문입니다. 이것은 이제 수정되었 

습니다 

어떤 상황에서는 미리 설정된 기울기를 선택한 후에 미리 설정된 기울기 페이지에 있는 기울기 미리보기 

가 항상 업데이트되는 것은 아닙니다. 이것은 이제 수정되었습니다. 

일부 대화에서는 부동 소수점 값을 스핀 박스에 입력하는 것이 제대로 작동하지 않았습니다. 이제 이것이 

수정되었습니다. 

팝오버를유발하는쓰기 메뉴의 메뉴항목은선택되지 않거나관리 장치가보이지 않는 경우올바르게 비 

활성화됩니다. 

플레이어, 레이아웃 또는 흐름을 마우스 오른쪽 버튼으로 클릭하면 컨텍스트 메뉴가 나타나기 전에 목록 

항목이 올바르게 선택되므로 모든 메뉴 항목이 적절하게 활성화되거나 비활성화됩니다. 

이제 그리드 또는 목록 보기가 표시되면 Return/Enter를 사용하여 허브의 Open Recentpage에서 
강조 표시된 프로젝트를 열 수 있습니다. 

마크다운에서 순서가 있거나 순서가 없는 목록으로 해석될 수 있는 문자를 포함하는 흐름 이름이 이제 프로 

젝트 창 제목 표시줄에 올바르게 나타납니다. 

라이브러리 ►에서 하이픈 텍스트주석이 있는줄을 선택하면 이제 대화의 오른쪽에 있는주석 컨트롤이 

올바르게 업데이트됩니다 

줌 명령에는 이제 점프 바에 이름을 확대하라는 단어가 포함됩니다. 

모든 VST 플러그인 윈도우 숨기기는 이제 플레이 모드뿐만 아니라 모든 모드에서 사용할 수 있습니다. 

문단 스타일과 캐릭터 스타일 대화는 이제 독립적으로 그 크기와 위치를 기억합니다. 

다음 페이지/확산으로 보기 이동하기 이제 모든 상황에서 안정적으로 작동합니다. 

특정 페이지로 이동하는 것은 이제 모든 줌 수준에서 항상 올바르게 작동합니다. 이전에는 약 100% 줌 수 

준의 긴 프로젝트에서 도리코가 대상 페이지를 초과하는 것이 가능했습니다. 

이제 라이브러리 메뉴의 모든 라이브러리 편집 대화자는 서로 독립적으로 크기와 위치를 을바르게 저장 

하고복원합니다. 

어떤 상황에서는 시야에서 벗어나 있을 때 선택지를 왼쪽으로 호핑하거나 시야에서 벗어나 있을 때 선택지 

를 오른쪽으로 호핑해도 새로운 선택지가 시야에 들어오지 않습니다. 이것은 이제 수정되었습니다. 
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